Note

CHAPTER

Alarm Troubleshooting

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's
path protection feature, which may be used in any topological network configuration. Cisco does not
recommend using its path protection feature in any particular topological network configuration.

This chapter gives a description, severity, and troubleshooting procedure for each commonly
encountered Cisco ONS 15454 alarm and condition. Tables 2-1 through 2-5 provide lists of ONS 15454
alarms organized by severity. Table 2-6 on page 2-10 provides a list of alarms organized alphabetically.
Table 2-7 gives definitions of all ONS 15454 alarm logical objects, which are the basis of the alarm
profile list in Table 2-8 on page 2-21. For a comprehensive list of all conditions and instructions for
using TL1 commands, refer to the Cisco ONS SONET TLI Command Guide .

An alarm’s troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and TL1
version of that alarm. If the troubleshooting procedure does not clear the alarm, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call the Cisco Technical
Assistance Center 1 800 553-2447.

Alarms can occur even in those cards that are not explicitly mentioned in the Alarm sections. When an
alarm is raised, refer to its clearing procedure.

For more information about alarm profiles, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

2.1 Alarm Indexes by Default Severity

Note

The following tables group alarms and conditions by their default severities in the ONS 15454 system.
These severities are the same whether they are reported in the CTC Alarms window severity (SEV)
column or in TL1.

The CTC default alarm profile contains some alarms or conditions that are not currently implemented
but are reserved for future use.
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Note  The CTC default alarm profile in some cases contains two severities for one alarm (for example,
MIJ/MN). The ONS 15454 platform default severity comes first (in this example, MJ), but the alarm can
be demoted to the second severity in the presence of a higher-ranking alarm. This is in accordance with
Telcordia GR-474.

2.1.1 Critical Alarms (CR)

Table 2-1 alphabetically lists ONS 15454 Critical (CR) alarms.

Table 2-1 ONS 15454 Critical Alarm List

AUTOLSROFF (OCN)

LOF (TRUNK)

OPWR-HFAIL (OMS)

AWG-FAIL (OTS)

LOM (STSMON)

OPWR-HFAIL (OTS)

AWG-OVERTEMP (OTS)

LOM (STSTRM)

OPWR-LFAIL (AOTS)

BKUPMEMP (EQPT)

LOM (TRUNK)

OPWR-LFAIL (OCH)

COMIOXC (EQPT)

LOP-P (STSMON)

OPWR-LFAIL (OMS)

CONTBUS-DISABLED (EQPT)

LOP-P (STSTRM)

OPWR-LFAIL (OTS)

CTNEQPT-PBPROT (EQPT) LOS (2R) OTUK-LOF (TRUNK)
CTNEQPT-PBWORK (EQPT) LOS (DS3) OTUK-TIM (TRUNK)
ENCAP-MISMATCH-P (STSTRM) LOS (EC1) PLM-P (STSMON)

EQPT (AICI-AEP) LOS (ESCON) PLM-P (STSTRM)

EQPT (AICI-AIE) LOS (ISC) PORT-ADD-PWR-FAIL-HIGH (OCH)
EQPT (EQPT) LOS (OCN) PORT-ADD-PWR-FAIL-LOW (OCH)
EQPT (PPM) LOS (OTS) PORT-FAIL (OCH)

EQPT-DIAG (EQPT) LOS (TRUNK) SQM (STSTRM)

EQPT-MISS (FAN) LOS-P (OCH) SWMTXMOD-PROT (EQPT)

FAN (FAN) LOS-P (OMS) SWMTXMOD-WORK (EQPT)
GAIN-HFAIL (AOTS) LOS-P (OTS) TIM (OCN)

GAIN-LFAIL (AOTS) LOS-P (TRUNK) TIM (TRUNK)

GE-OOSYNC (FC) MEA (AIP) TIM-P (STSTRM)

GE-OOSYNC (GE) MEA (BIC) TIM-S (EC1)

GE-OOSYNC (ISC) MEA (EQPT) TIM-S (OCN)

GE-OOSYNC (TRUNK) MEA (FAN) UNEQ-P (STSMON)

HITEMP (NE) MEA (PPM) UNEQ-P (STSTRM)

I-HITEMP (NE)

MFGMEM (AICI-AEP)

VOA-HFAIL (AOTS)

IMPROPRMVL (EQPT) MFGMEM (AICI-AIE) VOA-HFAIL (OCH)
IMPROPRMVL (PPM) MFGMEM (AIP) VOA-HFAIL (OMS)
LOA (VCG) MFGMEM (BPLANE) VOA-HFAIL (OTS)

LOF (DS3) MFGMEM (FAN) VOA-LFAIL (AOTS)

R7.0

[l Cisco ONS 15454 Troubleshooting Guide,

November 2009 |



| Chapter2  Alarm Troubleshooting

212 Major Alarms (MJ)

Table 2-1 ONS 15454 Critical Alarm List (continued)
LOF (EC1) MFGMEM (PPM) VOA-LFAIL (OCH)
LOF (OCN) OPWR-HFAIL (AOTYS) VOA-LFAIL (OMS)

LOF (STSTRM)

OPWR-HFAIL (OCH)

VOA-LFAIL (OTS)

2.1.2 Major Alarms (MJ)

Table 2-2 alphabetically lists ONS 15454 Major (MJ) alarms.

Table 2-2

ONS 15454 Major Alarm List

APSCM (OCN)

GFP-EX-MISMATCH (FCMR)

PROV-MISMATCH (TRUNK)

APSCNMIS (OCN)

GFP-EX-MISMATCH (GFP-FAC)

PTIM (TRUNK)

BAT-FAIL (PWR)

GFP-LFD (CE1000)

RCVR-MISS (DS1)

BLSROSYNC (OCN)

GFP-LFD (CE100T)

RCVR-MISS (E1)

BLSR-SW-VER-MISM (OCN)

GFP-LFD (FCMR)

RING-ID-MIS (OCN)

CARLOSS (ML1000)

GFP-LFD (GFP-FAC)

RING-ID-MIS (OSC-RING)

CARLOSS (CE1000)

GFP-LFD (LOGFAC)

RING-MISMATCH (OCN)

CARLOSS (CE100T)

GFP-LFD (ML1000)

SHELF-COMM-FAIL (SHELF)

CARLOSS (E1000F)

GFP-LFD (ML100T)

SIGLOSS (ESCON)

CARLOSS (E100T)

GFP-LFD (MLFX)

SIGLOSS (FC)

CARLOSS (EQPT)

GFP-NO-BUFFERS (FCMR)

SIGLOSS (FCMR)

CARLOSS (FC)

GFP-NO-BUFFERS (GFP-FAC)

SIGLOSS (GE)

CARLOSS (G1000)

GFP-UP-MISMATCH (CE1000)

SIGLOSS (ISC)

CARLOSS (GE)

GFP-UP-MISMATCH (CE100T)

SIGLOSS (TRUNK)

CARLOSS (ISC)

GFP-UP-MISMATCH (FCMR)

SQM (VT-TERM)

CARLOSS (LOGFAC)

GFP-UP-MISMATCH (GFP-FAC)

SYNCLOSS (FC)

CARLOSS (ML100T)

GFP-UP-MISMATCH (LOGFAC)

SYNCLOSS (FCMR)

CARLOSS (MLFX)

GFP-UP-MISMATCH (ML1000)

SYNCLOSS (GE)

CARLOSS (TRUNK)

GFP-UP-MISMATCH (ML100T)

SYNCLOSS (ISC)

DBOSYNC (NE)

GFP-UP-MISMATCH (MLFX)

SYNCLOSS (TRUNK)

DSP-COMM-FAIL (TRUNK)

HIBATVG (PWR)

SYNCPRI (NE-SREF)

DSP-FAIL (TRUNK)

INVMACADR (AIP)

SYSBOOT (NE)

DUP-SHELF-ID (SHELF)

LASERBIAS-FAIL (AOTS)

TIM-V (VT-TERM)

EHIBATVG (PWR)

LOF (DS1)

TPTFAIL (CE1000)

ELWBATVG (PWR)

LOF (E1)

TPTFAIL (CE100T)

E-W-MISMATCH (OCN)

LOM (VT-TERM)

TPTFAIL (FCMR)

EXTRA-TRAF-PREEMPT (OCN)

LOP-V (VI-MON)

TPTFAIL (G1000)

FC-NO-CREDITS (FC)

LOP-V (VT-TERM)

TPTFAIL (LOGFAC)
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Table 2-2 ONS 15454 Major Alarm List (continued)

FC-NO-CREDITS (FCMR) LOS (DS1) TPTFAIL (ML1000)
FC-NO-CREDITS (TRUNK) LOS (El) TPTFAIL (ML100T)
GFP-CSF (CE1000) LWBATVG (PWR) TPTFAIL (MLFX)
GFP-CSF (CE100T) MEA (SHELF) TRMT (DS1)
GFP-CSF (FCMR) MEM-GONE (EQPT) TRMT (El)

GFP-CSF (GFP-FAC)

ODUK-TIM-PM (TRUNK)

TRMT-MISS (DS1)

GFP-CSF (LOGFAC)

OPTNTWMIS (NE)

TRMT-MISS (E1)

GFP-CSF (ML100T)

OUT-OF-SYNC (FC)

UNEQ-V (VI-MON)

GFP-CSF (ML1000)

OUT-OF-SYNC (GE)

UNEQ-V (VT-TERM)

GFP-CSF (MLFX)

OUT-OF-SYNC (TRUNK)

UT-COMM-FAIL (TRUNK)

GFP-DE-MISMATCH (FCMR)

PEER-NORESPONSE (EQPT)

UT-FAIL (TRUNK)

GFP-DE-MISMATCH (GFP-FAC)

PLM-V (VI-TERM)

WVL-MISMATCH (TRUNK)

GFP-EX-MISMATCH (CE1000)

PRC-DUPID (OCN)

2.1.3 Minor Alarms (MN)

Table 2-3 alphabetically lists ONS 15454 Minor (MN) alarms.

Table 2-3

ONS 15454 Minor Alarm List

APSB (OCN)

HI-RXPOWER (FC)

MEM-LOW (EQPT)

APSCDFLTK (OCN)

HI-RXPOWER (GE)

OPWR-HDEG (AOTS)

APSC-IMP (OCN)

HI-RXPOWER (ISC)

OPWR-HDEG (OCH)

APSCINCON (OCN)

HI-RXPOWER (OCN)

OPWR-HDEG (OMS)

APSIMP (OCN)

HITEMP (EQPT)

OPWR-HDEG (OTS)

APS-INV-PRIM (OCN)

HI-TXPOWER (2R)

OPWR-LDEG (AOTS)

APSMM (OCN)

HI-TXPOWER (EQPT)

OPWR-LDEG (OCH)

APS-PRIM-SEC-MISM (OCN)

HI-TXPOWER (ESCON)

OPWR-LDEG (OMS)

AUTORESET (EQPT)

HI-TXPOWER (FC)

OPWR-LDEG (OTS)

AUTOSW-UNEQ (VT-MON)

HI-TXPOWER (GE)

OTUK-IAE (TRUNK)

AWG-DEG (OTS)

HI-TXPOWER (ISC)

PORT-ADD-PWR-DEG-HI (OCH)

BPV (BITS)

HI-TXPOWER (OCN)

PORT-ADD-PWR-DEG-LOW (OCH)

CASETEMP-DEG (AOTS)

HI-TXPOWER (PPM)

PROTNA (EQPT)

COMM-FAIL (EQPT)

ISIS-ADIJ-FAIL (OCN)

PROV-MISMATCH (PPM)

CONTBUS-A-18 (EQPT)

KBYTE-APS-CHANNEL-FAILURE
(OCN)

PWR-FAIL-A (EQPT)

CONTBUS-B-18 (EQPT)

LASERBIAS-DEG (AOTS)

PWR-FAIL-B (EQPT)

CONTBUS-IO-A (EQPT)

LASERBIAS-DEG (OTS)

PWR-FAIL-RET-A (EQPT)

CONTBUS-IO-B (EQPT)

LASEREOL (OCN)

PWR-FAIL-RET-B (EQPT)
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Table 2-3 ONS 15454 Minor Alarm List (continued)

21.4 NA Conditions H

DATAFLT (NE)

LASERTEMP-DEG (AOTS)

SFTWDOWN (EQPT)

DUP-IPADDR (NE)

LOF (BITS)

SH-INS-LOSS-VAR-DEG-HIGH (OTS)

DUP-NODENAME (NE)

LO-LASERBIAS (EQPT)

SH-INS-LOSS-VAR-DEG-LOW (OTS)

EOC (OCN)

LO-LASERBIAS (OCN)

SNTP-HOST (NE)

EOC (TRUNK)

LO-LASERBIAS (PPM)

SPANLENGTH-OUT-OF-RANGE
(OTS)

EOC-L (OCN)

LO-LASERTEMP (EQPT)

SSM-FAIL (BITS)

EOC-L (TRUNK)

LO-LASERTEMP (OCN)

SSM-FAIL (DS1)

ERROR-CONFIG (EQPT)

LO-LASERTEMP (PPM)

SSM-FAIL (E1)

EXCCOL (EQPT)

LO-RXPOWER (2R)

SSM-FAIL (OCN)

EXT (ENVALRM)

LO-RXPOWER (ESCON)

SSM-FAIL (TRUNK)

FEPRLF (OCN)

LO-RXPOWER (FC)

SYNCPRI (EXT-SREF)

FIBERTEMP-DEG (AOTS)

LO-RXPOWER (GE)

SYNCSEC (EXT-SREF)

GAIN-HDEG (AOTS)

LO-RXPOWER (ISC)

SYNCSEC (NE-SREF)

GAIN-LDEG (AOTS)

LO-RXPOWER (OCN)

SYNCTHIRD (EXT-SREF)

GCC-EOC (TRUNK)

LO-TXPOWER (2R)

SYNCTHIRD (NE-SREF)

HI-LASERBIAS (2R) LOS (BITS) TIM-MON (OCN)

HI-LASERBIAS (EQPT) LOS (FUDC) TIM-MON (TRUNK)

HI-LASERBIAS (ESCON) LOS (MSUDC) TIM-P (STSMON)

HI-LASERBIAS (FC) LOS-O (OCH) UNREACHABLE-TARGET-POWER
(OCH)

HI-LASERBIAS (GE) LOS-0O (OMS) VOA-HDEG (AOTS)

HI-LASERBIAS (ISC) LOS-O (OTS) VOA-HDEG (OCH)

HI-LASERBIAS (OCN)

LO-TXPOWER (EQPT)

VOA-HDEG (OMS)

HI-LASERBIAS (PPM)

LO-TXPOWER (ESCON)

VOA-HDEG (OTS)

HI-LASERTEMP (EQPT)

LO-TXPOWER (FC)

VOA-LDEG (AOTS)

HI-LASERTEMP (OCN)

LO-TXPOWER (GE)

VOA-LDEG (OCH)

HI-LASERTEMP (PPM)

LO-TXPOWER (ISC)

VOA-LDEG (OMS)

HI-RXPOWER (2R)

LO-TXPOWER (OCN)

VOA-LDEG (OTS)

HI-RXPOWER (ESCON)

LO-TXPOWER (PPM)

2.1.4 NA Conditions

Table 2-4 alphabetically lists ONS 15454 Not Alarmed (NA) conditions.

Table 2-4 ONS 15454 NA Conditions List

ALS (2R)

FRCDSWTOPRI (EXT-SREF)

SD-V (VI-TERM)

ALS (AOTS)

FRCDSWTOPRI (NE-SREF)

SF (DS1)
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Table 2-4 ONS 15454 NA Conditions List (continued)

ALS (ESCON) FRCDSWTOSEC (EXT-SREF) SF (DS3)
ALS (FC) FRCDSWTOSEC (NE-SREF) SF (E1)

ALS (GE) FRCDSWTOTHIRD (EXT-SREF) SF (TRUNK)
ALS (ISC) FRCDSWTOTHIRD (NE-SREF) SF-L (EC1)
ALS (OCN) FRNGSYNC (NE-SREF) SF-L (OCN)

ALS (TRUNK)

FSTSYNC (NE-SREF)

SF-L (TRUNK)

AMPLI-INIT (AOTS)

FULLPASSTHR-BI (OCN)

SF-P (STSMON)

APC-CORRECTION-SKIPPED (AOTS)

HELLO (OCN)

SF-P (STSTRM)

APC-CORRECTION-SKIPPED (OCH)

HELLO (TRUNK)

SF-V (VI-MON)

APC-CORRECTION-SKIPPED (OMS)

HI-CCVOLT (BITS)

SF-V (VT-TERM)

APC-CORRECTION-SKIPPED (OTS)

HLDOVRSYNC (NE-SREF)

SHUTTER-OPEN (OTS)

APC-DISABLED (NE)

INC-ISD (DS3)

SPAN-NOT-MEASURED (OTS)

APC-END (NE)

INHSWPR (EQPT)

SPAN-SW-EAST (OCN)

APC-OUT-OF-RANGE (AOTS)

INHSWWKG (EQPT)

SPAN-SW-WEST (OCN)

APC-OUT-OF-RANGE (OCH)

INTRUSION-PSWD (NE)

SQUELCH (OCN)

APC-OUT-OF-RANGE (OMS)

I0OSCFGCOPY (EQPT)

SQUELCHED (ESCON)

APC-OUT-OF-RANGE (OTS)

KB-PASSTHR (OCN)

SQUELCHED (2R)

APS-PRIM-FAC (OCN)

LAN-POL-REV (NE)

SQUELCHED (FC)

AS-CMD (2R)

LASER-APR (AOTS)

SQUELCHED (GE)

AS-CMD (AOTS)

LCAS-CRC (STSTRM)

SQUELCHED (ISC)

AS-CMD (BPLANE)

LCAS-CRC (VT-TERM)

SQUELCHED (OCN)

AS-CMD (CE1000)

LCAS-RX-FAIL (STSTRM)

SQUELCHED (TRUNK)

AS-CMD (CE100T)

LCAS-RX-FAIL (VT-TERM)

SSM-DUS (BITS)

AS-CMD (DS1)

LCAS-TX-ADD (STSTRM)

SSM-DUS (DS1)

AS-CMD (DS3)

LCAS-TX-ADD (VI-TERM)

SSM-DUS (E1)

AS-CMD (El)

LCAS-TX-DNU (STSTRM)

SSM-DUS (OCN)

AS-CMD (E1000F)

LCAS-TX-DNU (VT-TERM)

SSM-DUS (TRUNK)

AS-CMD (E100T)

LKOUTPR-S (OCN)

SSM-LNC (BITS)

AS-CMD (EC1)

LOCKOUT-REQ (2R)

SSM-LNC (NE-SREF)

AS-CMD (EQPT)

LOCKOUT-REQ (EQPT)

SSM-LNC (TRUNK)

AS-CMD (ESCON)

LOCKOUT-REQ (ESCON)

SSM-OFF (BITS)

AS-CMD (FC)

LOCKOUT-REQ (FC)

SSM-OFF (DS1)

AS-CMD (FCMR)

LOCKOUT-REQ (GE)

SSM-OFF (E1)

AS-CMD (G1000)

LOCKOUT-REQ (ISC)

SSM-OFF (OCN)

AS-CMD (GE)

LOCKOUT-REQ (OCN)

SSM-OFF (TRUNK)

AS-CMD (GFP-FAC)

LOCKOUT-REQ (STSMON)

SSM-PRC (BITS)

AS-CMD (ISC)

LOCKOUT-REQ (TRUNK)

SSM-PRC (NE-SREF)
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Table 2-4 ONS 15454 NA Conditions List (continued)

2.1.4 NA Conditions

AS-CMD (LOGFAC)

LOCKOUT-REQ (VT-MON)

SSM-PRC (TRUNK)

AS-CMD (ML1000)

LPBKCRS (STSMON)

SSM-PRS (BITS)

AS-CMD (ML100T)

LPBKCRS (STSTRM)

SSM-PRS (DS1)

AS-CMD (MLFX)

LPBKDSIFEAC-CMD (DS1)

SSM-PRS (E1)

AS-CMD (NE)

LPBKDS3FEAC (DS3)

SSM-PRS (NE-SREF)

AS-CMD (OCH)

LPBKDS3FEAC-CMD (DS3)

SSM-PRS (OCN)

AS-CMD (OCN)

LPBKFACILITY (CE1000)

SSM-PRS (TRUNK)

AS-CMD (OMS)

LPBKFACILITY (CE100T)

SSM-RES (BITS)

AS-CMD (OTS)

LPBKFACILITY (DS1)

SSM-RES (DS1)

AS-CMD (PPM)

LPBKFACILITY (DS3)

SSM-RES (E1)

AS-CMD (PWR)

LPBKFACILITY (E1)

SSM-RES (NE-SREF)

AS-CMD (SHELF)

LPBKFACILITY (EC1)

SSM-RES (OCN)

AS-CMD (TRUNK)

LPBKFACILITY (ESCON)

SSM-RES (TRUNK)

AS-MT (2R)

LPBKFACILITY (FC)

SSM-SDH-TN (OCN)

AS-MT (AOTS)

LPBKFACILITY (FCMR)

SSM-SDH-TN (TRUNK)

AS-MT (CE1000)

LPBKFACILITY (G1000)

SSM-SETS (BITS)

AS-MT (CE100T)

LPBKFACILITY (GE)

SSM-SETS (NE-SREF)

AS-MT (DS1) LPBKFACILITY (ISC) SSM-SETS (TRUNK)
AS-MT (DS3) LPBKFACILITY (OCN) SSM-SMC (BITS)
AS-MT (E1) LPBKFACILITY (TRUNK) SSM-SMC (DS1)
AS-MT (EC1) LPBKTERMINAL (CE1000) SSM-SMC (E1)

AS-MT (EQPT)

LPBKTERMINAL (CE100T)

SSM-SMC (NE-SREF)

AS-MT (ESCON)

LPBKTERMINAL (DS1)

SSM-SMC (OCN)

AS-MT (FC)

LPBKTERMINAL (DS3)

SSM-SMC (TRUNK)

AS-MT (FCMR)

LPBKTERMINAL (El)

SSM-ST2 (BITS)

AS-MT (G1000)

LPBKTERMINAL (EC1)

SSM-ST2 (DS1)

AS-MT (GE) LPBKTERMINAL (ESCON) SSM-ST2 (E1)
AS-MT (GFP-FAC) LPBKTERMINAL (FC) SSM-ST?2 (NE-SREF)
AS-MT (ISC) LPBKTERMINAL (FCMR) SSM-ST2 (OCN)
AS-MT (LOGFAC) LPBKTERMINAL (G1000) SSM-ST2 (TRUNK)

AS-MT (ML1000)

LPBKTERMINAL (GE)

SSM-ST3 (BITS)

AS-MT (ML100T)

LPBKTERMINAL (ISC)

SSM-ST3 (DS1)

AS-MT (MLFX)

LPBKTERMINAL (OCN)

SSM-ST3 (El)

AS-MT (OCH) LPBKTERMINAL (TRUNK) SSM-ST3 (NE-SREF)
AS-MT (OCN) MAN-REQ (EQPT) SSM-ST3 (OCN)
AS-MT (OMS) MAN-REQ (STSMON) SSM-ST3 (TRUNK)
AS-MT (OTS) MAN-REQ (VT-MON) SSM-ST3E (BITS)
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Table 2-4 ONS 15454 NA Conditions List (continued)

AS-MT (PPM)

MANRESET (EQPT)

SSM-ST3E (DS1)

AS-MT (SHELF)

MANSWTOINT (NE-SREF)

SSM-ST3E (E1)

AS-MT (TRUNK)

MANSWTOPRI (EXT-SREF)

SSM-ST3E (NE-SREF)

AS-MT-O0G (STSTRM)

MANSWTOPRI (NE-SREF)

SSM-ST3E (OCN)

AS-MT-O0G (VT-TERM)

MANSWTOSEC (EXT-SREF)

SSM-ST3E (TRUNK)

AUD-LOG-LOSS (NE)

MANSWTOSEC (NE-SREF)

SSM-ST4 (BITS)

AUD-LOG-LOW (NE)

MANSWTOTHIRD (EXT-SREF)

SSM-ST4 (DS1)

AUTOSW-LOP (STSMON)

MANSWTOTHIRD (NE-SREF)

SSM-ST4 (El)

AUTOSW-LOP (VI-MON)

MANUAL-REQ-RING (OCN)

SSM-ST4 (NE-SREF)

AUTOSW-PDI (STSMON)

MANUAL-REQ-SPAN (2R)

SSM-ST4 (OCN)

AUTOSW-SDBER (STSMON)

MANUAL-REQ-SPAN (ESCON)

SSM-ST4 (TRUNK)

AUTOSW-SFBER (STSMON)

MANUAL-REQ-SPAN (FC)

SSM-STU (BITS)

AUTOSW-UNEQ (STSMON)

MANUAL-REQ-SPAN (GE)

SSM-STU (DS1)

AWG-WARM-UP (OTS)

MANUAL-REQ-SPAN (ISC)

SSM-STU (E1)

CLDRESTART (EQPT)

MANUAL-REQ-SPAN (OCN)

SSM-STU (NE-SREF)

CTNEQPT-MISMATCH (EQPT)

MANUAL-REQ-SPAN (TRUNK)

SSM-STU (OCN)

DS3-MISM (DS3)

NO-CONFIG (EQPT)

SSM-STU (TRUNK)

ETH-LINKLOSS (NE)

OCHNC-INC (OCHNC-CONN)

SSM-TNC (BITS)

EXERCISE-RING-FAIL (OCN)

OCHTERM-INC (OCH-TERM)

SSM-TNC (NE-SREF)

EXERCISE-SPAN-FAIL (OCN)

ODUK-SD-PM (TRUNK)

SSM-TNC (TRUNK)

FAILTOSW (2R)

ODUK-SF-PM (TRUNK)

STS-SQUELCH-L (OCN)

FAILTOSW (EQPT)

OOU-TPT (STSTRM)

SW-MISMATCH (EQPT)

FAILTOSW (ESCON)

OOU-TPT (VT-TERM)

SWTOPRI (EXT-SREF)

FAILTOSW (FC)

OPEN-SLOT (EQPT)

SWTOPRI (NE-SREF)

FAILTOSW (GE)

OSRION (AOTS)

SWTOSEC (EXT-SREF)

FAILTOSW (ISC)

OSRION (OTS)

SWTOSEC (NE-SREF)

FAILTOSW (OCN)

OTUK-SD (TRUNK)

SWTOTHIRD (EXT-SREF)

FAILTOSW (TRUNK)

OTUK-SF (TRUNK)

SWTOTHIRD (NE-SREF)

FAILTOSW-PATH (STSMON)

OUT-OF-SYNC (ISC)

SYNC-FREQ (BITS)

FAILTOSW-PATH (VT-MON)

PARAM-MISM (AOTS)

SYNC-FREQ (DS1)

FAILTOSWR (OCN)

PARAM-MISM (OCH)

SYNC-FREQ (E1)

FAILTOSWS (OCN)

PARAM-MISM (OMS)

SYNC-FREQ (OCN)

FDI (OCH)

PARAM-MISM (OTS)

SYNC-FREQ (TRUNK)

FE-AIS (DS3)

PDI-P (STSMON)

TEMP-MISM (NE)

FEC-MISM (TRUNK)

PDI-P (STSTRM)

TRAIL-SIGNAL-FAIL (TRUNK)

FE-DS1-MULTLOS (DS3)

PMI (OMS)

TRAIL-SIGNAL-FAIL (OCH)

FE-DS1-NSA (DS3)

PMI (OTS)

TX-RAI (DS1)
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Table 2-4

ONS 15454 NA Conditions List (continued)

2.1.5 NR Conditions

FE-DS1-SA (DS3)

PORT-MISMATCH (FCMR)

TX-RAI (DS3)

FE-DS1-SNGLLOS (DS3) RAI (DS1) TX-RAI (E1)
FE-DS3-NSA (DS3) RAI (DS3) UNC-WORD (TRUNK)
FE-DS3-SA (DS3) RAI (E1) VCG-DEG (VCG)

FE-EQPT-NSA (DS3)

RING-SW-EAST (OCN)

VCG-DOWN (VCG)

FE-FRCDWKSWBK-SPAN (OCN)

RING-SW-WEST (OCN)

VOLT-MISM (PWR)

FE-FRCDWKSWPR-RING (OCN)

ROLL (STSMON)

VT-SQUELCH-L (OCN)

FE-FRCDWKSWPR-SPAN (OCN)

ROLL (STSTRM)

WKSWPR (2R)

FE-IDLE (DS3)

ROLL (VT-MON)

WKSWPR (EQPT)

FE-LOCKOUTOFPR-SPAN (OCN)

ROLL-PEND (STSMON)

WKSWPR (ESCON)

FE-LOF (DS3)

ROLL-PEND (VI-MON)

WKSWPR (FC)

FE-LOS (DS3)

RPRW (LOGFAC)

WKSWPR (GE)

FE-MANWKSWBK-SPAN (OCN)

RPRW (ML1000)

WKSWPR (ISC)

FE-MANWKSWPR-RING (OCN)

RPRW (ML100T)

WKSWPR (OCN)

FE-MANWKSWPR-SPAN (OCN)

RPRW (MLFX)

WKSWPR (STSMON)

FORCED-REQ (STSMON)

RUNCFG-SAVENEED (EQPT)

WKSWPR (VT-MON)

FORCED-REQ (EQPT) SD (DS1) WTR (2R)
FORCED-REQ (VT-MON) SD (DS3) WTR (EQPT)
FORCED-REQ-RING (OCN) SD (El) WTR (ESCON)
FORCED-REQ-SPAN (2R) SD (TRUNK) WTR (FC)
FORCED-REQ-SPAN (ESCON) SD-L (EC1) WTR (GE)
FORCED-REQ-SPAN (FC) SD-L (OCN) WTR (ISC)
FORCED-REQ-SPAN (GE) SD-L (TRUNK) WTR (OCN)

FORCED-REQ-SPAN (ISC)

SD-P (STSMON)

WTR (STSMON)

FORCED-REQ-SPAN (OCN)

SD-P (STSTRM)

WTR (TRUNK)

FORCED-REQ-SPAN (TRUNK)

SD-V (VT-MON)

WTR (VT-MON)

FRCDSWTOINT (NE-SREF)

2.1.5 NR Conditions

Table 2-5 alphabetically lists ONS 15454 Not Reported (NR) conditions.

Table 2-5 ONS 15454 NR Conditions List

AIS (BITS) ERFI-P-CONN (STSMON) OTUK-BDI (TRUNK)
AIS (DS1) ERFI-P-CONN (STSTRM) RFI (TRUNK)

AIS (DS3) ERFI-P-PAYLD (STSMON) RFI-L (EC1)

AIS (E1) ERFI-P-PAYLD (STSTRM) RFI-L (OCN)

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R7.0 g



Chapter2  Alarm Troubleshooting |

Bl 22 Alarms and Conditions Listed By Alphabetical Entry

Table 2-5 ONS 15454 NR Conditions List (continued)

AIS (FUDC)

ERFI-P-SRVR (STSMON)

RFI-L (TRUNK)

AIS (MSUDC)

ERFI-P-SRVR (STSTRM)

RFI-P (STSMON)

AIS (TRUNK)

ODUK-1-AIS-PM (TRUNK)

RFI-P (STSTRM)

AIS-L (EC1)

ODUK-2-AIS-PM (TRUNK)

RFI-V (VI-MON)

AIS-L (OCN)

ODUK-3-AIS-PM (TRUNK)

RFI-V (VI-TERM)

AIS-L (TRUNK)

ODUK-4-AIS-PM (TRUNK)

ROLL-PEND (STSTRM)

AIS-P (STSMON)

ODUK-AIS-PM (TRUNK)

TX-AIS (DS1)

AIS-P (STSTRM)

ODUK-BDI-PM (TRUNK)

TX-AIS (DS3)

AIS-V (VT-MON) ODUK-LCK-PM (TRUNK) TX-AIS (El)
AIS-V (VT-TERM) ODUK-OCI-PM (TRUNK) TX-LOF (DS1)
AUTOSW-AIS (STSMON) OTUK-AIS (TRUNK) TX-LOF (E1)

AUTOSW-AIS (VI-MON)

2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 alphabetically lists all ONS 15454 alarms and conditions.

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List

AIS (BITS) GFP-LFD (FCMR) PORT-ADD-PWR-FAIL-LOW (OCH)
AIS (DS1) GFP-LFD (GFP-FAC) PORT-FAIL (OCH)

AIS (DS3) GFP-LFD (LOGFAC) PORT-MISMATCH (FCMR)

AIS (El) GFP-LFD (ML1000) PRC-DUPID (OCN)

AIS (FUDC) GFP-LFD (ML100T) PROTNA (EQPT)

AIS (MSUDC)

GFP-LFD (MLFX)

PROV-MISMATCH (PPM)

AIS (TRUNK)

GFP-NO-BUFFERS (FCMR)

PROV-MISMATCH (TRUNK)

AIS-L (EC1)

GFP-NO-BUFFERS (GFP-FAC)

PTIM (TRUNK)

AIS-L (OCN)

GFP-UP-MISMATCH (CE1000)

PWR-FAIL-A (EQPT)

AIS-L (TRUNK)

GFP-UP-MISMATCH (CE100T)

PWR-FAIL-B (EQPT)

AIS-P (STSMON)

GFP-UP-MISMATCH (FCMR)

PWR-FAIL-RET-A (EQPT)

AIS-P (STSTRM)

GFP-UP-MISMATCH (GFP-FAC)

PWR-FAIL-RET-B (EQPT)

AIS-V (VT-MON)

GFP-UP-MISMATCH (LOGFAC)

RAI (DS1)

AIS-V (VT-TERM)

GFP-UP-MISMATCH (ML1000)

RAI (DS3)

ALS (2R)

GFP-UP-MISMATCH (ML100T)

RAI (E1)

ALS (AOTS) GFP-UP-MISMATCH (MLFX) RCVR-MISS (DS1)
ALS (ESCON) HELLO (OCN) RCVR-MISS (E1)
ALS (FC) HELLO (TRUNK) RFI (TRUNK)

ALS (GE) HIBATVG (PWR) RFI-L (EC1)
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2.2 Alarms and Conditions Listed By Alphabetical Entry ||

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

ALS (ISC)

HI-CCVOLT (BITS)

RFI-L (OCN)

ALS (OCN)

HI-LASERBIAS (2R)

RFI-L (TRUNK)

ALS (TRUNK)

HI-LASERBIAS (EQPT)

RFI-P (STSMON)

AMPLI-INIT (AOTS)

HI-LASERBIAS (ESCON)

RFI-P (STSTRM)

APC-CORRECTION-SKIPPED (AOTS)

HI-LASERBIAS (FC)

RFI-V (VI-MON)

APC-CORRECTION-SKIPPED (OCH)

HI-LASERBIAS (GE)

RFI-V (VT-TERM)

APC-CORRECTION-SKIPPED (OMS)

HI-LASERBIAS (ISC)

RING-ID-MIS (OCN)

APC-CORRECTION-SKIPPED (OTS)

HI-LASERBIAS (OCN)

RING-ID-MIS (OSC-RING)

APC-DISABLED (NE)

HI-LASERBIAS (PPM)

RING-MISMATCH (OCN)

APC-END (NE)

HI-LASERTEMP (EQPT)

RING-SW-EAST (OCN)

APC-OUT-OF-RANGE (AOTS)

HI-LASERTEMP (OCN)

RING-SW-WEST (OCN)

APC-OUT-OF-RANGE (OCH)

HI-LASERTEMP (PPM)

ROLL (STSMON)

APC-OUT-OF-RANGE (OMS)

HI-RXPOWER (2R)

ROLL (STSTRM)

APC-OUT-OF-RANGE (OTS)

HI-RXPOWER (ESCON)

ROLL (VT-MON)

APSB (OCN)

HI-RXPOWER (FC)

ROLL-PEND (STSMON)

APSCDFLTK (OCN)

HI-RXPOWER (GE)

ROLL-PEND (STSTRM)

APSC-IMP (OCN)

HI-RXPOWER (ISC)

ROLL-PEND (VT-MON)

APSCINCON (OCN)

HI-RXPOWER (OCN)

RPRW (LOGFAC)

APSCM (OCN)

HITEMP (EQPT)

RPRW (ML1000)

APSCNMIS (OCN)

HITEMP (NE)

RPRW (ML100T)

APSIMP (OCN)

HI-TXPOWER (2R)

RPRW (MLFX)

APS-INV-PRIM (OCN)

HI-TXPOWER (EQPT)

RUNCFG-SAVENEED (EQPT)

APSMM (OCN)

HI-TXPOWER (ESCON)

SD (DS1)

APS-PRIM-FAC (OCN) HI-TXPOWER (FC) SD (DS3)
APS-PRIM-SEC-MISM (OCN) HI-TXPOWER (GE) SD (E1)
AS-CMD (2R) HI-TXPOWER (ISC) SD (TRUNK)
AS-CMD (AOTS) HI-TXPOWER (OCN) SD-L (EC1)
AS-CMD (BPLANE) HI-TXPOWER (PPM) SD-L (OCN)

AS-CMD (CE1000)

HLDOVRSYNC (NE-SREF)

SD-L (TRUNK)

AS-CMD (CE100T)

I-HITEMP (NE)

SD-P (STSMON)

AS-CMD (DS1)

IMPROPRMVL (EQPT)

SD-P (STSTRM)

AS-CMD (DS3) IMPROPRMVL (PPM) SD-V (VI-MON)
AS-CMD (E1) INC-ISD (DS3) SD-V (VT-TERM)
AS-CMD (E1000F) INHSWPR (EQPT) SF (DS1)
AS-CMD (E100T) INHSWWKG (EQPT) SF (DS3)
AS-CMD (EC1) INTRUSION-PSWD (NE) SF (E1)

AS-CMD (EQPT) INVMACADR (AIP) SF (TRUNK)
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Table 2-6

ONS 15454 Alarm and Condition Alphabetical List (continued)

AS-CMD (ESCON)

IOSCFGCOPY (EQPT)

SF-L (EC1)

AS-CMD (FC)

ISIS-ADJ-FAIL (OCN)

SF-L (OCN)

AS-CMD (FCMR)

KB-PASSTHR (OCN)

SF-L (TRUNK)

AS-CMD (G1000)

KBYTE-APS-CHANNEL-FAILURE
(OCN)

SF-P (STSMON)

AS-CMD (GE)

LAN-POL-REV (NE)

SF-P (STSTRM)

AS-CMD (GFP-FAC)

LASER-APR (AOTS)

SFTWDOWN (EQPT)

AS-CMD (ISC)

LASERBIAS-DEG (AOTS)

SF-V (VI-MON)

AS-CMD (LOGFAC)

LASERBIAS-DEG (OTS)

SF-V (VI-TERM)

AS-CMD (ML1000)

LASERBIAS-FAIL (AOTS)

SHELF-COMM-FAIL (SHELF)

AS-CMD (ML100T)

LASEREOL (OCN)

SH-INS-LOSS-VAR-DEG-HIGH (OTS)

AS-CMD (MLFX)

LASERTEMP-DEG (AOTS)

SH-INS-LOSS-VAR-DEG-LOW (OTS)

AS-CMD (NE)

LCAS-CRC (STSTRM)

SHUTTER-OPEN (OTS)

AS-CMD (OCH)

LCAS-CRC (VT-TERM)

SIGLOSS (ESCON)

AS-CMD (OCN)

LCAS-RX-FAIL (STSTRM)

SIGLOSS (FC)

AS-CMD (OMS)

LCAS-RX-FAIL (VT-TERM)

SIGLOSS (FCMR)

AS-CMD (OTS)

LCAS-TX-ADD (STSTRM)

SIGLOSS (GE)

AS-CMD (PPM)

LCAS-TX-ADD (VT-TERM)

SIGLOSS (ISC)

AS-CMD (PWR)

LCAS-TX-DNU (STSTRM)

SIGLOSS (TRUNK)

AS-CMD (SHELF)

LCAS-TX-DNU (VT-TERM)

SNTP-HOST (NE)

AS-CMD (TRUNK)

LKOUTPR-S (OCN)

SPANLENGTH-OUT-OF-RANGE
(OTS)

AS-MT (2R)

LOA (VCG)

SPAN-NOT-MEASURED (OTS)

AS-MT (AOTS)

LOCKOUT-REQ (2R)

SPAN-SW-EAST (OCN)

AS-MT (CE1000)

LOCKOUT-REQ (EQPT)

SPAN-SW-WEST (OCN)

AS-MT (CE100T)

LOCKOUT-REQ (ESCON)

SQM (STSTRM)

AS-MT (DS1) LOCKOUT-REQ (FC) SQM (VT-TERM)
AS-MT (DS3) LOCKOUT-REQ (GE) SQUELCH (OCN)
AS-MT (E1) LOCKOUT-REQ (ISC) SQUELCHED (ESCON)
AS-MT (EC1) LOCKOUT-REQ (OCN) SQUELCHED (2R)

AS-MT (EQPT)

LOCKOUT-REQ (STSMON)

SQUELCHED (FC)

AS-MT (ESCON)

LOCKOUT-REQ (TRUNK)

SQUELCHED (GE)

AS-MT (FC)

LOCKOUT-REQ (VT-MON)

SQUELCHED (ISC)

AS-MT (FCMR) LOF (BITS) SQUELCHED (OCN)
AS-MT (G1000) LOF (DS1) SQUELCHED (TRUNK)
AS-MT (GE) LOF (DS3) SSM-DUS (BITS)
AS-MT (GFP-FAC) LOF (El) SSM-DUS (DS1)
AS-MT (ISC) LOF (EC1) SSM-DUS (E1)
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Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

AS-MT (LOGFAC) LOF (OCN) SSM-DUS (OCN)
AS-MT (ML1000) LOF (STSTRM) SSM-DUS (TRUNK)
AS-MT (ML100T) LOF (TRUNK) SSM-FAIL (BITS)

AS-MT (MLFX)

LO-LASERBIAS (EQPT)

SSM-FAIL (DS1)

AS-MT (OCH) LO-LASERBIAS (OCN) SSM-FAIL (E1)
AS-MT (OCN) LO-LASERBIAS (PPM) SSM-FAIL (OCN)
AS-MT (OMS) LO-LASERTEMP (EQPT) SSM-FAIL (TRUNK)
AS-MT (OTS) LO-LASERTEMP (OCN) SSM-LNC (BITS)
AS-MT (PPM) LO-LASERTEMP (PPM) SSM-LNC (NE-SREF)

AS-MT (SHELF)

LOM (STSMON)

SSM-LNC (TRUNK)

AS-MT (TRUNK)

LOM (STSTRM)

SSM-OFF (BITS)

AS-MT-O0G (STSTRM)

LOM (TRUNK)

SSM-OFF (DS1)

AS-MT-O0G (VT-TERM)

LOM (VT-TERM)

SSM-OFF (E1)

AUD-LOG-LOSS (NE)

LOP-P (STSMON)

SSM-OFF (OCN)

AUD-LOG-LOW (NE)

LOP-P (STSTRM)

SSM-OFF (TRUNK)

AUTOLSROFF (OCN)

LOP-V (VIT-MON)

SSM-PRC (BITS)

AUTORESET (EQPT)

LOP-V (VI-TERM)

SSM-PRC (NE-SREF)

AUTOSW-AIS (STSMON)

LO-RXPOWER (2R)

SSM-PRC (TRUNK)

AUTOSW-AIS (VI-MON)

LO-RXPOWER (ESCON)

SSM-PRS (BITS)

AUTOSW-LOP (STSMON)

LO-RXPOWER (FC)

SSM-PRS (DS1)

AUTOSW-LOP (VI-MON)

LO-RXPOWER (GE)

SSM-PRS (E1)

AUTOSW-PDI (STSMON)

LO-RXPOWER (ISC)

SSM-PRS (NE-SREF)

AUTOSW-SDBER (STSMON)

LO-RXPOWER (OCN)

SSM-PRS (OCN)

AUTOSW-SFBER (STSMON)

LO-TXPOWER (2R)

SSM-PRS (TRUNK)

AUTOSW-UNEQ (STSMON)

LOS (2R)

SSM-RES (BITS)

AUTOSW-UNEQ (VT-MON) LOS (BITS) SSM-RES (DS1)
AWG-DEG (OTS) LOS (DS1) SSM-RES (E1)
AWG-FAIL (OTS) LOS (DS3) SSM-RES (NE-SREF)
AWG-OVERTEMP (OTS) LOS (El) SSM-RES (OCN)
AWG-WARM-UP (OTS) LOS (EC1) SSM-RES (TRUNK)
BAT-FAIL (PWR) LOS (ESCON) SSM-SDH-TN (OCN)
BKUPMEMP (EQPT) LOS (FUDC) SSM-SDH-TN (TRUNK)
BLSROSYNC (OCN) LOS (ISC) SSM-SETS (BITS)
BLSR-SW-VER-MISM (OCN) LOS (MSUDC) SSM-SETS (NE-SREF)
BPV (BITS) LOS (OCN) SSM-SETS (TRUNK)
CARLOSS (ML1000) LOS (OTS) SSM-SMC (BITS)

CARLOSS (CE1000)

LOS (TRUNK)

SSM-SMC (DS1)
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Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

CARLOSS (CE100T) LOS-0 (OCH) SSM-SMC (E1)
CARLOSS (E1000F) LOS-O (OMS) SSM-SMC (NE-SREF)
CARLOSS (E100T) LOS-0 (OTS) SSM-SMC (OCN)
CARLOSS (EQPT) LOS-P (OCH) SSM-SMC (TRUNK)
CARLOSS (FC) LOS-P (OMS) SSM-ST2 (BITS)
CARLOSS (G1000) LOS-P (OTS) SSM-ST2 (DS1)

CARLOSS (GE)

LOS-P (TRUNK)

SSM-ST2 (El)

CARLOSS (ISC)

LO-TXPOWER (EQPT)

SSM-ST2 (NE-SREF)

CARLOSS (LOGFAC)

LO-TXPOWER (ESCON)

SSM-ST2 (OCN)

CARLOSS (ML100T)

LO-TXPOWER (FC)

SSM-ST2 (TRUNK)

CARLOSS (MLFX)

LO-TXPOWER (GE)

SSM-ST3 (BITS)

CARLOSS (TRUNK)

LO-TXPOWER (ISC)

SSM-ST3 (DS1)

CASETEMP-DEG (AOTS)

LO-TXPOWER (OCN)

SSM-ST3 (El)

CLDRESTART (EQPT)

LO-TXPOWER (PPM)

SSM-ST3 (NE-SREF)

COMIOXC (EQPT)

LPBKCRS (STSMON)

SSM-ST3 (OCN)

COMM-FAIL (EQPT)

LPBKCRS (STSTRM)

SSM-ST3 (TRUNK)

CONTBUS-A-18 (EQPT)

LPBKDS1FEAC-CMD (DS1)

SSM-ST3E (BITS)

CONTBUS-B-18 (EQPT)

LPBKDS3FEAC (DS3)

SSM-ST3E (DS1)

CONTBUS-DISABLED (EQPT)

LPBKDS3FEAC-CMD (DS3)

SSM-ST3E (E1)

CONTBUS-IO-A (EQPT)

LPBKFACILITY (CE1000)

SSM-ST3E (NE-SREF)

CONTBUS-IO-B (EQPT)

LPBKFACILITY (CE100T)

SSM-ST3E (OCN)

CTNEQPT-MISMATCH (EQPT)

LPBKFACILITY (DS1)

SSM-ST3E (TRUNK)

CTNEQPT-PBPROT (EQPT)

LPBKFACILITY (DS3)

SSM-ST4 (BITS)

CTNEQPT-PBWORK (EQPT)

LPBKFACILITY (E1)

SSM-ST4 (DS1)

DATAFLT (NE)

LPBKFACILITY (EC1)

SSM-ST4 (El)

DBOSYNC (NE)

LPBKFACILITY (ESCON)

SSM-ST4 (NE-SREF)

DS3-MISM (DS3)

LPBKFACILITY (FC)

SSM-ST4 (OCN)

DSP-COMM-FAIL (TRUNK)

LPBKFACILITY (FCMR)

SSM-ST4 (TRUNK)

DSP-FAIL (TRUNK)

LPBKFACILITY (G1000)

SSM-STU (BITS)

DUP-IPADDR (NE)

LPBKFACILITY (GE)

SSM-STU (DS1)

DUP-NODENAME (NE)

LPBKFACILITY (ISC)

SSM-STU (E1)

DUP-SHELF-ID (SHELF)

LPBKFACILITY (OCN)

SSM-STU (NE-SREF)

EHIBATVG (PWR)

LPBKFACILITY (TRUNK)

SSM-STU (OCN)

ELWBATVG (PWR)

LPBKTERMINAL (CE1000)

SSM-STU (TRUNK)

ENCAP-MISMATCH-P (STSTRM)

LPBKTERMINAL (CE100T)

SSM-TNC (BITS)

EOC (OCN)

LPBKTERMINAL (DS1)

SSM-TNC (NE-SREF)

EOC (TRUNK)

LPBKTERMINAL (DS3)

SSM-TNC (TRUNK)
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ONS 15454 Alarm and Condition Alphabetical List (continued)

EOC-L (OCN)

LPBKTERMINAL (El)

STS-SQUELCH-L (OCN)

EOC-L (TRUNK)

LPBKTERMINAL (EC1)

SW-MISMATCH (EQPT)

EQPT (AICI-AEP)

LPBKTERMINAL (ESCON)

SWMTXMOD-PROT (EQPT)

EQPT (AICI-AIE)

LPBKTERMINAL (FC)

SWMTXMOD-WORK (EQPT)

EQPT (EQPT)

LPBKTERMINAL (FCMR)

SWTOPRI (EXT-SREF)

EQPT (PPM)

LPBKTERMINAL (G1000)

SWTOPRI (NE-SREF)

EQPT-DIAG (EQPT)

LPBKTERMINAL (GE)

SWTOSEC (EXT-SREF)

EQPT-MISS (FAN)

LPBKTERMINAL (ISC)

SWTOSEC (NE-SREF)

ERFI-P-CONN (STSMON)

LPBKTERMINAL (OCN)

SWTOTHIRD (EXT-SREF)

ERFI-P-CONN (STSTRM)

LPBKTERMINAL (TRUNK)

SWTOTHIRD (NE-SREF)

ERFI-P-PAYLD (STSMON)

LWBATVG (PWR)

SYNC-FREQ (BITS)

ERFI-P-PAYLD (STSTRM)

MAN-REQ (EQPT)

SYNC-FREQ (DS1)

ERFI-P-SRVR (STSMON)

MAN-REQ (STSMON)

SYNC-FREQ (E1)

ERFI-P-SRVR (STSTRM)

MAN-REQ (VT-MON)

SYNC-FREQ (OCN)

ERROR-CONFIG (EQPT)

MANRESET (EQPT)

SYNC-FREQ (TRUNK)

ETH-LINKLOSS (NE)

MANSWTOINT (NE-SREF)

SYNCLOSS (FC)

E-W-MISMATCH (OCN)

MANSWTOPRI (EXT-SREF)

SYNCLOSS (FCMR)

EXCCOL (EQPT)

MANSWTOPRI (NE-SREF)

SYNCLOSS (GE)

EXERCISE-RING-FAIL (OCN)

MANSWTOSEC (EXT-SREF)

SYNCLOSS (ISC)

EXERCISE-SPAN-FAIL (OCN)

MANSWTOSEC (NE-SREF)

SYNCLOSS (TRUNK)

EXT (ENVALRM)

MANSWTOTHIRD (EXT-SREF)

SYNCPRI (EXT-SREF)

EXTRA-TRAF-PREEMPT (OCN)

MANSWTOTHIRD (NE-SREF)

SYNCPRI (NE-SREF)

FAILTOSW (2R)

MANUAL-REQ-RING (OCN)

SYNCSEC (EXT-SREF)

FAILTOSW (EQPT)

MANUAL-REQ-SPAN (2R)

SYNCSEC (NE-SREF)

FAILTOSW (ESCON)

MANUAL-REQ-SPAN (ESCON)

SYNCTHIRD (EXT-SREF)

FAILTOSW (FC)

MANUAL-REQ-SPAN (FC)

SYNCTHIRD (NE-SREF)

FAILTOSW (GE)

MANUAL-REQ-SPAN (GE)

SYSBOOT (NE)

FAILTOSW (ISC)

MANUAL-REQ-SPAN (ISC)

TEMP-MISM (NE)

FAILTOSW (OCN)

MANUAL-REQ-SPAN (OCN)

TIM (OCN)

FAILTOSW (TRUNK)

MANUAL-REQ-SPAN (TRUNK)

TIM (TRUNK)

FAILTOSW-PATH (STSMON) MEA (AIP) TIM-MON (OCN)
FAILTOSW-PATH (VT-MON) MEA (BIC) TIM-MON (TRUNK)
FAILTOSWR (OCN) MEA (EQPT) TIM-P (STSMON)
FAILTOSWS (OCN) MEA (FAN) TIM-P (STSTRM)
FAN (FAN) MEA (PPM) TIM-S (EC1)
FC-NO-CREDITS (FC) MEA (SHELF) TIM-S (OCN)

FC-NO-CREDITS (FCMR)

MEM-GONE (EQPT)

TIM-V (VT-TERM)
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Table 2-6

ONS 15454 Alarm and Condition Alphabetical List (continued)

FC-NO-CREDITS (TRUNK)

MEM-LOW (EQPT)

TPTFAIL (CE1000)

FDI (OCH) MFGMEM (AICI-AEP) TPTFAIL (CE100T)
FDI (OMS) MFGMEM (AICI-AIE) TPTFAIL (FCMR)
FDI (OTS) MFGMEM (AIP) TPTFAIL (G1000)

FE-AIS (DS3)

MFGMEM (BPLANE)

TPTFAIL (LOGFAC)

FEC-MISM (TRUNK)

MFGMEM (FAN)

TPTFAIL (ML1000)

FE-DS1-MULTLOS (DS3)

MFGMEM (PPM)

TPTFAIL (ML100T)

FE-DS1-NSA (DS3)

NO-CONFIG (EQPT)

TPTFAIL (MLFX)

FE-DS1-SA (DS3)

OCHNC-INC (OCHNC-CONN)

TRAIL-SIGNAL-FAIL (TRUNK)

FE-DS1-SNGLLOS (DS3)

OCHTERM-INC (OCH-TERM)

TRAIL-SIGNAL-FAIL (OCH)

FE-DS3-NSA (DS3)

ODUK-1-AIS-PM (TRUNK)

TRMT (DS1)

FE-DS3-SA (DS3)

ODUK-2-AIS-PM (TRUNK)

TRMT (E1)

FE-EQPT-NSA (DS3)

ODUK-3-AIS-PM (TRUNK)

TRMT-MISS (DS1)

FE-FRCDWKSWBK-SPAN (OCN)

ODUK-4-AIS-PM (TRUNK)

TRMT-MISS (E1)

FE-FRCDWKSWPR-RING (OCN)

ODUK-AIS-PM (TRUNK)

TX-AIS (DS1)

FE-FRCDWKSWPR-SPAN (OCN)

ODUK-BDI-PM (TRUNK)

TX-AIS (DS3)

FE-IDLE (DS3) ODUK-LCK-PM (TRUNK) TX-AIS (El)
FE-LOCKOUTOFPR-SPAN (OCN) ODUK-OCI-PM (TRUNK) TX-LOF (DS1)
FE-LOF (DS3) ODUK-SD-PM (TRUNK) TX-LOF (El)

FE-LOS (DS3)

ODUK-SF-PM (TRUNK)

TX-RAI (DS1)

FE-MANWKSWBK-SPAN (OCN)

ODUK-TIM-PM (TRUNK)

TX-RAI (DS3)

FE-MANWKSWPR-RING (OCN)

OOU-TPT (STSTRM)

TX-RAI (E1)

FE-MANWKSWPR-SPAN (OCN)

OOU-TPT (VT-TERM)

UNC-WORD (TRUNK)

FEPRLF (OCN)

OPEN-SLOT (EQPT)

UNEQ-P (STSMON)

FIBERTEMP-DEG (AOTS)

OPTNTWMIS (NE)

UNEQ-P (STSTRM)

FORCED-REQ (STSMON)

OPWR-HDEG (AOTS)

UNEQ-V (VT-MON)

FORCED-REQ (EQPT)

OPWR-HDEG (OCH)

UNEQ-V (VT-TERM)

FORCED-REQ (VT-MON)

OPWR-HDEG (OMS)

UNREACHABLE-TARGET-POWER
(OCH)

FORCED-REQ-RING (OCN)

OPWR-HDEG (OTS)

UT-COMM-FAIL (TRUNK)

FORCED-REQ-SPAN (2R)

OPWR-HFAIL (AOTS)

UT-FAIL (TRUNK)

FORCED-REQ-SPAN (ESCON)

OPWR-HFAIL (OCH)

VCG-DEG (VCG)

FORCED-REQ-SPAN (FC)

OPWR-HFAIL (OMS)

VCG-DOWN (VCG)

FORCED-REQ-SPAN (GE)

OPWR-HFAIL (OTS)

VOA-HDEG (AOTS)

FORCED-REQ-SPAN (ISC)

OPWR-LDEG (AOTS)

VOA-HDEG (OCH)

FORCED-REQ-SPAN (OCN)

OPWR-LDEG (OCH)

VOA-HDEG (OMS)

FORCED-REQ-SPAN (TRUNK)

OPWR-LDEG (OMS)

VOA-HDEG (OTS)
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Table 2-6

2.2 Alarms and Conditions Listed By Alphabetical Entry ||

ONS 15454 Alarm and Condition Alphabetical List (continued)

FRCDSWTOINT (NE-SREF)

OPWR-LDEG (OTS)

VOA-HFAIL (AOTS)

FRCDSWTOPRI (EXT-SREF)

OPWR-LFAIL (AOTS)

VOA-HFAIL (OCH)

FRCDSWTOPRI (NE-SREF)

OPWR-LFAIL (OCH)

VOA-HFAIL (OMS)

FRCDSWTOSEC (EXT-SREF)

OPWR-LFAIL (OMS)

VOA-HFAIL (OTS)

FRCDSWTOSEC (NE-SREF)

OPWR-LFAIL (OTS)

VOA-LDEG (AOTS)

FRCDSWTOTHIRD (EXT-SREF)

OSRION (AOTS)

VOA-LDEG (OCH)

FRCDSWTOTHIRD (NE-SREF)

OSRION (OTS)

VOA-LDEG (OMS)

FRNGSYNC (NE-SREF)

OTUK-AIS (TRUNK)

VOA-LDEG (OTS)

FSTSYNC (NE-SREF)

OTUK-BDI (TRUNK)

VOA-LFAIL (AOTS)

FULLPASSTHR-BI (OCN)

OTUK-IAE (TRUNK)

VOA-LFAIL (OCH)

GAIN-HDEG (AOTS)

OTUK-LOF (TRUNK)

VOA-LFAIL (OMS)

GAIN-HFAIL (AOTS)

OTUK-SD (TRUNK)

VOA-LFAIL (OTS)

GAIN-LDEG (AOTS)

OTUK-SF (TRUNK)

VOLT-MISM (PWR)

GAIN-LFAIL (AOTS)

OTUK-TIM (TRUNK)

VT-SQUELCH-L (OCN)

GCC-EOC (TRUNK) OUT-OF-SYNC (FC) WKSWPR (2R)
GE-OOSYNC (FC) OUT-OF-SYNC (GE) WKSWPR (EQPT)
GE-OOSYNC (GE) OUT-OF-SYNC (ISC) WKSWPR (ESCON)

GE-OOSYNC (ISC)

OUT-OF-SYNC (TRUNK)

WKSWPR (FC)

GE-OOSYNC (TRUNK)

PARAM-MISM (AOTS)

WKSWPR (GE)

GFP-CSF (CE1000)

PARAM-MISM (OCH)

WKSWPR (ISC)

GFP-CSF (CE100T)

PARAM-MISM (OMS)

WKSWPR (OCN)

GFP-CSF (FCMR)

PARAM-MISM (OTS)

WKSWPR (STSMON)

GFP-CSF (GFP-FAC)

PDI-P (STSMON)

WKSWPR (VT-MON)

GFP-CSF (LOGFAC) PDI-P (STSTRM) WTR (2R)
GFP-CSF (ML100T) PEER-NORESPONSE (EQPT) WTR (EQPT)
GFP-CSF (ML1000) PLM-P (STSMON) WTR (ESCON)
GFP-CSF (MLFX) PLM-P (STSTRM) WTR (FC)
GFP-DE-MISMATCH (FCMR) PLM-V (VI-TERM) WTR (GE)
GFP-DE-MISMATCH (GFP-FAC) PMI (OCH) WTR (ISC)
GFP-EX-MISMATCH (CE1000) PMI (OMS) WTR (OCN)
GFP-EX-MISMATCH (FCMR) PMI (OTS) WTR (STSMON)

GFP-EX-MISMATCH (GFP-FAC)

PORT-ADD-PWR-DEG-HI (OCH)

WTR (TRUNK)

GFP-LED (CE1000)

PORT-ADD-PWR-DEG-LOW (OCH)

WTR (VT-MON)

GFP-LFD (CE100T)

PORT-ADD-PWR-FAIL-HIGH
(OCH)

WVL-MISMATCH (TRUNK)
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2.3 Alarm Logical Objects

The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are
raised against. These logical objects represent physical objects such as cards, logical objects such as
circuits, or transport and signal monitoring entities such as the SONET or ITU-T G.709 optical overhead
bits. One alarm can appear in multiple entries. It can be raised against multiple objects. For example, the
loss of signal (LOS) alarm can be raised against the optical signal (OC-N) or the optical transport layer
overhead (OTN) as well as other objects. Therefore, both OCN: LOS and OTN: LOS appear in the list
(as well as the other objects).

Alarm profile list objects are defined in Table 2-7.

Note  Alarm logical object names can appear as abbreviated versions of standard terms used in the system and
the documentation. For example, the “OCN” logical object refers to the OC-N signal. Logical object
names or industry-standard terms are used within the entries as appropriate.

Table 2-7 Alarm Logical Object Type Definitions

Logical Object Definition

2R Reshape and retransmit (used for transponder [TXP] cards).

AICI-AEP Alarm Interface Controller—International/alarm expansion panel. A combination
term that refers to this platform’s AIC-I card.

AICI-AIE Alarm Interface Controller-International/Alarm Interface Extension. A
combination term that refers to this platform's AIC-I card.

AOTS Amplified optical transport section. For information about AOTS alarms, refer to
the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM
Troubleshooting Guide.

BIC Backplane interface connector.

BITS Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE The backplane.

CE100T CE-100T-8 card.

DS1 A DS-1 line on a DS-1 or DS-3 electrical card (DS1-14, DS3N-12E, DS3XM-6,
DS3XM-12).

DS3 A DS-3 line on a DS3-12, DS3N-12, DS3-12E, DS3XM-6, DS3XM-12,
DS3/EC1-48 card.

El An E1 line on a DS1/E1-56 card.

E1000F An E1000 Ethernet card (E1000-2, E1000-2G).

E100T An E100 Ethernet card (E100T-12, E100T-G).

EC1 Any EC-1 port (including EC1-12 card ports).

ENVALRM An environmental alarm port.

EQPT A card, its physical objects, and its logical objects as they are located in any of the

eight noncommon card slots. The EQPT object is used for alarms that refer to the
card itself and all other objects on the card including ports, lines, synchronous
transport signals (STS), and virtual tributaries (VT).
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2.3 Alarm Logical Objects

Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition

ESCON Enterprise System Connection fiber optic technology, referring to the following
TXP cards: TXP_MR_2.5G, TXPP_MR_2.5G. For more information about ESCON
alarms, refer to the “Alarm Troubleshooting” chapter in the

Cisco ONS 15454 DWDM Troubleshooting Guide.

EXT-SREF BITS outgoing references (SYNC-BITS1, SYNC-BITS2).
FAN Fan-tray assembly.
FC Fibre channel data transfer architecture, referring to the following muxponder

(MXP) or TXP cards: MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E. For more information about FC alarms, refer to
the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM
Troubleshooting Guide.

FCMR An FC_MR-4 Fibre Channel card.

FUDC SONET F1 byte user data channel for ONS 15454 ML-Series Ethernet cards.

G1000 A G-Series Ethernet card.

GE Gigabit Ethernet, referring to the following MXP or TXP cards: MXP_MR_2.5G,
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10G.

GFP-FAC Generic framing procedure facility port, referring to all MXP and TXP cards.

ISC Inter-service channel, referring to TXPP_MR_2.5G or TXP_MR_2.5G cards. For

more information about ISC alarms, refer to the “Alarm Troubleshooting” chapter
in the Cisco ONS 15454 DWDM Troubleshooting Guide.

LOGFAC The LOGFAC object is not used in this platform in this release.

ML1000 An ML1000 Ethernet card (ML1000-2).

ML100T An ML100 Ethernet card (ML100T-12).

MLFX An ML100X-8 Ethernet card.

MSUDC Multiplex section user data channel.

NE The entire network element.

NE-SREF The timing status of the NE.

OCH The optical channel, referring to dense wavelength division multiplexing (DWDM)

cards. For more information about OCH alarms, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

OCHNC-CONN |The optical channel network connection, referring to DWDM cards. For more
information about OCHNC-CONN alarms, refer to the “Alarm Troubleshooting”
chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

OCN An OC-N line on any OC-N card.
OMS Optical multiplex section.
OSC-RING Optical service channel ring. For more information about OSC-RING alarms, refer

to the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM
Troubleshooting Guide.

Cisco ONS 15454 Troubleshooting Guide, R7.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

B 24 Alarm List by Logical Object Type

Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition

OTS Optical transport section. For more information about OTS alarms, refer to the
“Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting
Guide.

PPM Pluggable port module (PPM), referring to MXP and TXP cards. For more

information about PPM alarms, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide.

PWR Power equipment.

STSMON STS alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSMON, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.

STSTRM STS alarm detection at termination (downstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSTRM, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.

TRUNK The optical or DWDM card carrying the high-speed signal; referring to MXP or
TXP cards. For more information about TRUNK alarms, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

VCG A virtual concatenation group of VTs.

VT-MON VTI1 alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of VI-MON, if
available, should be changed to the same severity as the customized severity
for a specific VT alarm.

VT-TERM VTI alarm detection at termination (downstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of VI-TERM, if
available, should be changed to the same severity as the customized severity
for a specific VT alarm.

2.4 Alarm List by Logical Object Type

Table 2-8 lists all ONS 15454 Release 7.0 alarms and logical objects as they are given in the system
alarm profile. The list entries are organized by logical object name and then by alarm or condition name.
Where appropriate, the alarm entries also contain troubleshooting procedures.
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2.4 Alarm List by Logical Object Type

Note

In a mixed network containing different types of nodes (such as ONS 15310-CL, ONS 15454, and

ONS 15600), the initially displayed alarm list in the Provisioning > Alarm Profiles > Alarm Profile
Editor tab lists all conditions that are applicable to all nodes in the network. However, when you load
the default severity profile from a node, only applicable alarms will display severity levels.

Nonapplicable alarms can display “use default” or “unset.”

~

Note

In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.

Table 2-8 Alarm List by Logical Object in Alarm Profile

2R: ALS (NA) EXT-SREF: SWTOTHIRD (NA) OCN: PRC-DUPID (MJ)

2R: AS-CMD (NA) EXT-SREF: SYNCPRI (MN) OCN: RFI-L (NR)

2R: AS-MT (NA) EXT-SREF: SYNCSEC (MN) OCN: RING-ID-MIS (MJ)
2R: FAILTOSW (NA) EXT-SREF: SYNCTHIRD (MN) OCN: RING-MISMATCH (MJ)
2R: FORCED-REQ-SPAN (NA) FAN: EQPT-MISS (CR) OCN: RING-SW-EAST (NA)
2R: HI-LASERBIAS (MN) FAN: FAN (CR) OCN: RING-SW-WEST (NA)
2R: HI-RXPOWER (MN) FAN: MEA (CR) OCN: SD-L (NA)

2R: HI-TXPOWER (MN) FAN: MFGMEM (CR) OCN: SF-L (NA)

2R: LO-RXPOWER (MN) FC: ALS (NA) OCN: SPAN-SW-EAST (NA)
2R: LO-TXPOWER (MN) FC: AS-CMD (NA) OCN: SPAN-SW-WEST (NA)
2R: LOCKOUT-REQ (NA) FC: AS-MT (NA) OCN: SQUELCH (NA)

2R: LOS (CR) FC: CARLOSS (MJ) OCN: SQUELCHED (NA)
2R: MANUAL-REQ-SPAN (NA) FC: FAILTOSW (NA) OCN: SSM-DUS (NA)

2R: SQUELCHED (NA) FC: FCC-NO-CREDITS (MJ) OCN: SSM-FAIL (MN)

2R: WKSWPR (NA) FC: FORCED-REQ-SPAN (NA) OCN: SSM-OFF (NA)

2R: WTR (NA) FC: GE-OOSYNC (CR) OCN: SSM-PRS (NA)

AICI-AEP: EQPT (CR)

FC: HI-LASERBIAS (MN)

OCN:

SSM-RES (NA)

AICI-AEP: MFGMEM (CR)

FC: HI-RXPOWER (MN)

OCN:

SSM-SDH-TN (NA)

AICI-AIE: EQPT (CR)

FC: HI-TXPOWER (MN)

OCN:

SSM-SMC (NA)

AICI-AIE: MFGMEM (CR)

FC: LO-RXPOWER (MN)

OCN:

SSM-ST2 (NA)

AIP: INVMACADR (MJ)

FC: LO-TXPOWER (MN)

OCN:

SSM-ST3 (NA)

AIP: MEA (CR)

FC: LOCKOUT-REQ (NA)

OCN:

SSM-ST3E (NA)

AIP: MFGMEM (CR)

FC: LPBKFACILITY (NA)

OCN:

SSM-ST4 (NA)

AOTS: ALS (NA)

FC: LPBKTERMINAL (NA)

OCN:

SSM-STU (NA)

AOTS: AMPLI-INIT (NA)

FC: MANUAL-REQ-SPAN (NA)

OCN:

STS-SQUELCH-L (NA)

AOTS: FC: OUT-OF-SYNC (MJ) OCN: SYNC-FREQ (NA)
APC-CORRECTION-SKIPPED (NA)

AOTS: APC-OUT-OF-RANGE (NA) |FC: SIGLOSS (MJ) OCN: TIM (CR)

AOTS: AS-CMD (NA) FC: SQUELCHED (NA) OCN: TIM-MON (MN)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

AOTS: AS-MT (NA)

FC: SYNCLOSS (MJ)

OCN: TIM-S (CR)

AOTS: CASETEMP-DEG (MN)

FC: WKSWPR (NA)

OCN: VT-SQUELCH-L (NA)

AOTS: FIBERTEMP-DEG (MN) FC: WTR (NA) OCN: WKSWPR (NA)

AOTS: GAIN-HDEG (MN) FCMR: AS-CMD (NA) OCN: WTR (NA)

AOTS: GAIN-HFAIL (CR) FCMR: AS-MT (NA) OMS: APC-CORRECTION-SKIPPED
(NA)

AOTS: GAIN-LDEG (MN) FCMR: FC-NO-CREDITS (MJ) OMS: APC-OUT-OF-RANGE (NA)

AOTS: GAIN-LFAIL (CR)

FCMR:

GFP-CSF (MJ)

OMS: AS-CMD (NA)

AOTS: LASER-APR (NA)

FCMR:

GFP-DE-MISMATCH (MJ)

OMS: AS-MT (NA)

AOTS: LASERBIAS-DEG (MN)

FCMR:

GFP-EX-MISMATCH (MJ)

OMS: FDI

AOTS: LASERBIAS-FAIL (MJ)

FCMR:

GFP-LFD (MJ)

OMS: LOS-O (MN)

AOTS: LASERTEMP-DEG (MN)

FCMR:

GFP-NO-BUFFERS (MJ)

OMS: LOS-P (CR)

AOTS: OPWR-HDEG (MN)

FCMR:

GFP-UP-MISMATCH (MJ)

OMS: OPWR-HDEG (MN)

AOTS: OPWR-HFAIL (CR)

FCMR:

LPBKFACILITY (NA)

OMS: OPWR-HFAIL (CR)

AOTS: OPWR-LDEG (MN)

FCMR:

LPBKTERMINAL (NA)

OMS: OPWR-LDEG (MN)

AOTS: OPWR-LFAIL (CR)

FCMR:

PORT-MISMATCH (NA)

OMS: OPWR-LFAIL (CR)

AOTS: OSRION (NA)

FCMR:

SIGLOSS (MJ)

OMS: PARAM-MISM (NA)

AOTS: PARAM-MISM (NA)

FCMR:

SYNCLOSS (MJ)

OMS: PMI (NA)

AOTS: VOA-HDEG (MN)

FCMR:

TPTFAIL (MJ)

OMS: VOA-HDEG (MN)

AOTS: VOA-HFAIL (CR) FUDC: AIS (NR) OMS: VOA-HFAIL (CR)

AOTS: VOA-LDEG (MN) FUDC: LOS (MN) OMS: VOA-LDEG (MN)

AOTS: VOA-LFAIL (CR) G1000: AS-CMD (NA) OMS: VOA-LFAIL (CR)

BIC: MEA (CR) G1000: AS-MT (NA) OSC-RING: RING-ID-MIS (MJ)
BITS: AIS (NR) G1000: CARLOSS (MJ) OTS: APC-CORRECTION-SKIPPED

(NA)

BITS: BPV (MN)

G1000:

LPBKFACILITY (NA)

OTS: APC-OUT-OF-RANGE (NA)

BITS: HI-CCVOLT (NA)

G1000:

LPBKTERMINAL (NA)

OTS: AS-CMD (NA)

BITS: LOF (MN)

G1000:

TPTFAIL (MJ)

OTS: AS-MT (NA)

BITS: LOS (MN)

GE: ALS (NA)

OTS: AWG-DEG (MN)

BITS: SSM-DUS (NA)

GE: AS-CMD (NA)

OTS: AWG-FAIL (CR)

BITS: SSM-FAIL (MN)

GE: AS-MT (NA)

OTS: AWG-OVERTEMP (CR)

BITS: SSM-LNC (NA)

GE: CARLOSS (MJ)

OTS: AWG-WARM-UP (NA)

BITS: SSM-OFF (NA)

GE: FAILTOSW (NA)

OTS: FDI

BITS: SSM-PRC (NA)

GE: FORCED-REQ-SPAN (NA)

OTS: LASERBIAS-DEG (MN)

BITS: SSM-PRS (NA)

GE: GE-OOSYNC (CR)

OTS: LOS (CR)

BITS: SSM-RES (NA)

GE: HI-LASERBIAS (MN)

OTS: LOS-O (MN)

BITS: SSM-SETS (NA)

GE: HI-RXPOWER (MN)

OTS: LOS-P (CR)

BITS: SSM-SMC (NA)

GE: HI-TXPOWER (MN)

OTS: OPWR-HDEG (MN)
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2.4 Alarm List by Logical Object Type

BITS:

SSM-ST2 (NA)

GE:

LO-RXPOWER (MN)

OTS:

OPWR-HFAIL (CR)

BITS:

SSM-ST3 (NA)

GE:

LO-TXPOWER (MN)

OTS:

OPWR-LDEG (MN)

BITS:

SSM-ST3E (NA)

GE:

LOCKOUT-REQ (NA)

OTS:

OPWR-LFAIL (CR)

BITS:

SSM-ST4 (NA)

GE:

LPBKFACILITY (NA)

OTS:

OSRION (NA)

BITS: SSM-STU (NA) GE: LPBKTERMINAL (NA) OTS: PARAM-MISM (NA)

BITS: SSM-TNC (NA) GE: MANUAL-REQ-SPAN (NA) OTS: PMI (NA)

BITS: SYNC-FREQ (NA) GE: OUT-OF-SYNC (MJ) OTS: SH-INS-LOSS-VAR-DEG-HIGH
(MN)

BPLANE: AS-CMD (NA) GE: SIGLOSS (MJ) OTS: SH-INS-LOSS-VAR-DEG-LOW
(MN)

BPLANE: MEGMEM (CR) GE: SQUELCHED (NA) OTS: SHUTTER-OPEN (NA)

CE1000: AS-CMD (NA) GE: SYNCLOSS (MJ) OTS: SPAN-NOT-MEASURED (NA)

CE1000: AS-MT (NA) GE: WKSWPR (NA) OTS: SPANLENGTH-OUT-OF-RANGE
(MN)

CE1000: CARLOSS (MJ) GE: WTR (NA) OTS: VOA-HDEG (MN)

CE1000: GFP-CSF (MJ) GFP-FAC: AS-CMD (NA) OTS: VOA-HFAIL (CR)

CE1000: GFP-EX-MISMATCH (MJ) |GFP-FAC: AS-MT (NA) OTS: VOA-LDEG (MN)

CE1000: GFP-LFD (MJ) GFP-FAC: GFP-CSF (MJ) OTS: VOA-LFAIL (CR)

CE1000: GFP-UP-MISMATCH (MJ) |GFP-FAC: GFP-DE-MISMATCH (MJ) |PPM: AS-CMD (NA)

CE1000: LPBKFACILITY (NA) GFP-FAC: GFP-EX-MISMATCH (MJ) |PPM: AS-MT (NA)

CE1000: LPBKTERMINAL (NA)  |GFP-FAC: GFP-LFD (MJ) PPM: EQPT (CR)

CE1000: TPTFAIL (MJ) GFP-FAC: GFP-NO-BUFFERS (MJ) PPM: HI-LASERBIAS (MN)

CE100T: AS-CMD (NA) GFP-FAC: GFP-UP-MISMATCH (MJ) |PPM: HI-LASERTEMP (MN)

CE100T: AS-MT (NA) ISC: ALS (NA) PPM: HI-TXPOWER (MN)

CE100T: CARLOSS (MJ) ISC: AS-CMD (NA) PPM: IMPROPRMVL (CR)

CE100T: GFP-CSF (MJ) ISC: AS-MT (NA) PPM: LO-LASERBIAS (MN)

CE100T: GFP-LFD (MJ) ISC: CARLOSS (MJ) PPM: LO-LASERTEMP (MN)

CE100T:

GFP-UP-MISMATCH (MJ)

ISC:

FAILTOSW (NA)

PPM:

LO-TXPOWER (MN)

CE100T:

LPBKFACILITY (NA)

ISC:

FORCED-REQ-SPAN (NA)

PPM:

MEA (CR)

CE100T:

LPBKTERMINAL (NA)

ISC:

GE-OOSYNC (CR)

PPM:

MFGMEM (CR)

CE100T:

TPTFAIL (MJ)

ISC:

HI-LASERBIAS (MN)

PPM:

PROV-MISMATCH (MN)

DS1: AIS (NR) ISC: HI-RXPOWER (MN) PWR: AS-CMD (NA)
DS1: AS-CMD (NA) ISC: HI-TXPOWER (MN) PWR: BAT-FAIL (MJ)
DS1: AS-MT (NA) ISC: LO-RXPOWER (MN) PWR: EHIBATVG (MJ)
DS1: LOF (MJ) ISC: LO-TXPOWER (MN) PWR: ELWBATVG (MJ)
DS1: LOS (MJ) ISC: LOCKOUT-REQ (NA) PWR: HIBATVG (MJ)
DS1: LPBKDS1FEAC-CMD (NA) ISC: LOS (CR) PWR: LWBATVG (MJ)

DS1:

LPBKFACILITY (NA)

ISC:

LPBKFACILITY (NA)

PWR:

VOLT-MISM (NA)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

DS1: LPBKTERMINAL (NA) ISC: LPBKTERMINAL (NA) SHELF: AS-CMD (NA)

DS1: RAI (NA) ISC: MANUAL-REQ-SPAN (NA) SHELF: AS-MT (NA)

DS1: RCVR-MISS (MJ) ISC: OUT-OF-SYNC (NA) SHELF: DUP-SHELF-ID (MJ)
DS1: SD (NA) ISC: SIGLOSS (MJ) SHELF: MEA (MJ)

DS1: SF (NA) ISC: SQUELCHED (NA) SHELF: SHELF-COMM-FAIL (MJ)
DS1: SSM-DUS (NA) ISC: SYNCLOSS (MJ) STSMON: AIS-P (NR)

DS1: SSM-FAIL (MN) ISC: WKSWPR (NA) STSMON: AUTOSW-AIS (NR)
DS1: SSM-OFF (NA) ISC: WTR (NA) STSMON: AUTOSW-LOP (NA)
DS1: SSM-PRS (NA) LOGFAC: AS-CMD (NA) STSMON: AUTOSW-PDI (NA)
DS1: SSM-RES (NA) LOGFAC: AS-MT (NA) STSMON: AUTOSW-SDBER (NA)
DS1: SSM-SMC (NA) LOGFAC: CARLOSS (MJ) STSMON: AUTOSW-SFBER (NA)
DS1: SSM-ST2 (NA) LOGFAC: GFP-CSF (MJ) STSMON: AUTOSW-UNEQ (NA)
DS1: SSM-ST3 (NA) LOGFAC: GFP-LFD (MJ) STSMON: ERFI-P-CONN (NR)
DS1: SSM-ST3E (NA) LOGFAC: GFP-UP-MISMATCH (MJ) STSMON: ERFI-P-PAYLD (NR)
DS1: SSM-ST4 (NA) LOGFAC: RPRW (NA) STSMON: ERFI-P-SRVR (NR)
DS1: SSM-STU (NA) LOGFAC: TPTFAIL (MJ) STSMON: FAILTOSW-PATH (NA)
DS1: SYNC-FREQ (NA) ML1000: AS-CMD (NA) STSMON: FORCED-REQ (NA)
DS1: TRMT (MJ) ML1000: AS-MT (NA) STSMON: LOCKOUT-REQ (NA)
DS1: TRMT-MISS (MJ) ML1000: CARLOSS (MJ) STSMON: LOM (CR)

DS1: TX-AIS (NR) ML1000: GFP-CSF (MJ) STSMON: LOP-P (CR)

DS1: TX-LOF (NR) ML1000: GFP-LFD (MJ) STSMON: LPBKCRS (NA)

DS1: TX-RAI (NA) ML1000: GFP-UP-MISMATCH (MJ) STSMON: MAN-REQ (NA)

DS3: AIS (NR) ML1000: RPRW (NA) STSMON: PDI-P (NA)

DS3: AS-CMD (NA) ML1000: TPTFAIL (MJ) STSMON: PLM-P (CR)

DS3: AS-MT (NA) ML100T: AS-CMD (NA) STSMON: RFI-P (NR)

DS3: DS3-MISM (NA) ML100T: AS-MT (NA) STSMON: ROLL (NA)

DS3: FE-AIS (NA) ML100T: CARLOSS (MJ) STSMON: ROLL-PEND (NA)
DS3: FE-DS1-MULTLOS (NA) ML100T: GFP-CSF (MJ) STSMON: SD-P (NA)

DS3: FE-DS1-NSA (NA) ML100T: GFP-LFD (MJ) STSMON: SF-P (NA)

DS3: FE-DS1-SA (NA) ML100T: GFP-UP-MISMATCH (M1J) STSMON: TIM-P (MN)

DS3: FE-DS1-SNGLLOS (NA) ML100T: RPRW (NA) STSMON: UNEQ-P (CR)

DS3: FE-DS3-NSA (NA) ML100T: TPTFAIL (MJ) STSMON: WKSWPR (NA)

DS3: FE-DS3-SA (NA) MLEFX: AS-CMD (NA) STSMON: WTR (NA)

DS3: FE-EQPT-NSA (NA) MLEX: AS-MT (NA) STSTRM: AIS-P (NR)

DS3: FE-IDLE (NA) MLFX: CARLOSS (MJ) STSTRM: AS-MT-O0G (NA)
DS3: FE-LOF (NA) MLEX: GFP-CSF (MJ) STSTRM: ENCAP-MISMATCH-P (CR)
DS3: FE-LOS (NA) MLFX: GFP-LFD (MJ) STSTRM: ERFI-P-CONN (NR)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

DS3: INC-ISD (NA) MLFX: GFP-UP-MISMATCH (MJ) STSTRM: ERFI-P-PAYLD (NR)
DS3: LOF (CR) MLFX: RPRW (NA) STSTRM: ERFI-P-SRVR (NR)
DS3: LOS (CR) MLFX: TPTFAIL (MJ) STSTRM: LCAS-CRC (NA)
DS3: LPBKDS3FEAC (NA) MSUDC: AIS (NR) STSTRM: LCAS-RX-FAIL (NA)
DS3: LPBKDS3FEAC-CMD (NA) MSUDC: LOS (MN) STSTRM: LCAS-TX-ADD (NA)
DS3: LPBKFACILITY (NA) NE-SREF: FRCDSWTOINT (NA) STSTRM: LCAS-TX-DNU (NA)
DS3: LPBKTERMINAL (NA) NE-SREF: FRCDSWTOPRI (NA) STSTRM: LOF (CR)

DS3: RAI (NA) NE-SREF: FRCDSWTOSEC (NA) STSTRM: LOM (CR)

DS3: SD (NA) NE-SREF: FRCDSWTOTHIRD (NA) STSTRM: LOP-P (CR)

DS3: SF (NA) NE-SREF: FRNGSYNC (NA) STSTRM: LPBKCRS (NA)

DS3: TX-AIS (NR) NE-SREF: FSTSYNC (NA) STSTRM: OOU-TPT (NA)

DS3: TX-RAI (NA) NE-SREF: HLDOVRSYNC (NA) STSTRM: PDI-P (NA)

E1000F: AS-CMD (NA) NE-SREF: MANSWTOINT (NA) STSTRM: PLM-P (CR)

E1000F: CARLOSS (MJ) NE-SREF: MANSWTOPRI (NA) STSTRM: RFI-P (NR)

E100T: AS-CMD (NA) NE-SREF: MANSWTOSEC (NA) STSTRM: ROLL (NA)

E100T: CARLOSS (MJ) NE-SREF: MANSWTOTHIRD (NA) STSTRM: ROLL-PEND (NR)
El: AIS (NR) NE-SREF: SSM-LNC (NA) STSTRM: SD-P (NA)

El: AS-CMD (NA) NE-SREF: SSM-PRC (NA) STSTRM: SF-P (NA)

El: AS-MT (NA) NE-SREF: SSM-PRS (NA) STSTRM: SQM (CR)

El: LOF (MJ) NE-SREF: SSM-RES (NA) STSTRM: TIM-P (CR)

E1: LOS (MJ) NE-SREF: SSM-SETS (NA) STSTRM: UNEQ-P (CR)

El: LPBKFACILITY (NA) NE-SREF: SSM-SMC (NA) TRUNK: AIS (NR)

El: LPBKTERMINAL (NA) NE-SREF: SSM-ST2 (NA) TRUNK: AIS-L (NR)

El: RAI (NA) NE-SREF: SSM-ST3 (NA) TRUNK: ALS (NA)

E1l: RCVR-MISS (MJ) NE-SREF: SSM-ST3E (NA) TRUNK: AS-CMD (NA)

El: SD (NA) NE-SREF: SSM-ST4 (NA) TRUNK: AS-MT (NA)

El: SF (NA) NE-SREF: SSM-STU (NA) TRUNK: CARLOSS (MJ)

El: SSM-DUS (NA) NE-SREF: SSM-TNC (NA) TRUNK: DSP-COMM-FAIL (MJ)
E1l: SSM-FAIL (MN) NE-SREF: SWTOPRI (NA) TRUNK: DSP-FAIL (MJ)

E1l: SSM-OFF (NA) NE-SREF: SWTOSEC (NA) TRUNK: EOC (MN)

El: SSM-PRS (NA) NE-SREF: SWTOTHIRD (NA) TRUNK: EOC-L (MN)

El: SSM-RES (NA) NE-SREF: SYNCPRI (MJ) TRUNK: FAILTOSW (NA)

El: SSM-SMC (NA) NE-SREF: SYNCSEC (MN) TRUNK: FC-NO-CREDITS (MJ)
El: SSM-ST2 (NA) NE-SREF: SYNCTHIRD (MN) TRUNK: FEC-MISM (NA)

El: SSM-ST3 (NA) NE: APC-DISABLED (NA) TRUNK: FORCED-REQ-SPAN (NA)
El: SSM-ST3E (NA) NE: APC-END (NA) TRUNK: GCC-EOC (MN)

El: SSM-ST4 (NA) NE: AS-CMD (NA) TRUNK: GE-OOSYNC (CR)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
E1l: SSM-STU (NA) NE: AUD-LOG-LOSS (NA) TRUNK: HELLO (NA)
El: SYNC-FREQ (NA) NE: AUD-LOG-LOW (NA) TRUNK: LOCKOUT-REQ (NA)
El: TRMT (MJ) NE: DATAFLT (MN) TRUNK: LOF (CR)
El: TRMT-MISS (MJ) NE: DBOSYNC (MJ) TRUNK: LOM (CR)
El: TX-AIS (NR) NE: DUP-IPADDR (MN) TRUNK: LOS (CR)
El: TX-LOF (NR) NE: DUP-NODENAME (MN) TRUNK: LOS-P (CR)
El: TX-RAI (NA) NE: ETH-LINKLOSS (NA) TRUNK: LPBKFACILITY (NA)
ECI1: AIS-L (NR) NE: HITEMP (CR) TRUNK: LPBKTERMINAL (NA)
ECI1: AS-CMD (NA) NE: I-HITEMP (CR) TRUNK: MANUAL-REQ-SPAN (NA)
EC1: AS-MT (NA) NE: INTRUSION-PSWD (NA) TRUNK: ODUK-1-AIS-PM (NR)
EC1: LOF (CR) NE: LAN-POL-REV (NA) TRUNK: ODUK-2-AIS-PM (NR)
EC1: LOS (CR) NE: OPTNTWMIS (MJ) TRUNK: ODUK-3-AIS-PM (NR)
ECI1: LPBKFACILITY (NA) NE: SNTP-HOST (MN) TRUNK: ODUK-4-AIS-PM (NR)
EC1: LPBKTERMINAL (NA) NE: SYSBOOT (MJ) TRUNK: ODUK-AIS-PM (NR)
EC1: RFI-L (NR) NE: TEMP-MISM (NA) TRUNK: ODUK-BDI-PM (NR)
EC1: SD-L (NA) OCH-TERM: OCHTERM-INC (NA) TRUNK: ODUK-LCK-PM (NR)
ECI1: SF-L (NA) OCH: APC-CORRECTION-SKIPPED | TRUNK: ODUK-OCI-PM (NR)

(NA)
EC1: TIM-S (CR) OCH: APC-OUT-OF-RANGE (NA) TRUNK: ODUK-SD-PM (NA)
ENVALRM: EXT (MN) OCH: AS-CMD (NA) TRUNK: ODUK-SF-PM (NA)
EQPT: AS-CMD (NA) OCH: AS-MT (NA) TRUNK: ODUK-TIM-PM (MJ)
EQPT: AS-MT (NA) OCH: FDI (NA) TRUNK: OTUK-AIS (NR)
EQPT: AUTORESET (MN) OCH: LOS-0O (MN) TRUNK: OTUK-BDI (NR)
EQPT: BKUPMEMP (CR) OCH: LOS-P (CR) TRUNK: OTUK-IAE (MN)
EQPT: CARLOSS (MJ) OCH: OPWR-HDEG (MN) TRUNK: OTUK-LOF (CR)
EQPT: CLDRESTART (NA) OCH: OPWR-HFAIL (CR) TRUNK: OTUK-SD (NA)
EQPT: COMIOXC (CR) OCH: OPWR-LDEG (MN) TRUNK: OTUK-SF (NA)
EQPT: COMM-FAIL (MN) OCH: OPWR-LFAIL (CR) TRUNK: OTUK-TIM (CR)
EQPT: CONTBUS-A-18 (MN) OCH: PARAM-MISM (NA) TRUNK: OUT-OF-SYNC (MJ)
EQPT: CONTBUS-B-18 (MN) OCH: PMI TRUNK: PROV-MISMATCH (MJ)
EQPT: CONTBUS-DISABLED (CR) |OCH: PORT-ADD-PWR-DEG-HI (MN) | TRUNK: PTIM (MJ)
EQPT: CONTBUS-IO-A (MN) OCH: PORT-ADD-PWR-DEG-LOW TRUNK: RFI (NR)

(MN)
EQPT: CONTBUS-IO-B (MN) OCH: PORT-ADD-PWR-FAIL-HIGH TRUNK: RFI-L (NR)

(CR)
EQPT: CTNEQPT-MISMATCH (NA) |OCH: PORT-ADD-PWR-FAIL-LOW TRUNK: SD (NA)

(CR)
EQPT: CTNEQPT-PBPROT (CR) OCH: PORT-FAIL (CR) TRUNK: SD-L (NA)
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EQPT: CTNEQPT-PBWORK (CR) OCH: TRAIL-SIGNAL-FAIL (NA) TRUNK: SF (NA)
EQPT: EQPT (CR) OCH: TRUNK: SF-L (NA)
UNREACHABLE-TARGET-POWER
(MN)
EQPT: EQPT-DIAG (CR) OCH: VOA-HDEG (MN) TRUNK: SIGLOSS (MJ)
EQPT: ERROR-CONFIG (MN) OCH: VOA-HFAIL (CR) TRUNK: SQUELCHED (NA)
EQPT: EXCCOL (MN) OCH: VOA-LDEG (MN) TRUNK: SSM-DUS (NA)
EQPT: FAILTOSW (NA) OCH: VOA-LFAIL (CR) TRUNK: SSM-FAIL (MN)
EQPT: FORCED-REQ (NA) OCHNC-CONN: OCHNC-INC (NA) TRUNK: SSM-LNC (NA)
EQPT: HI-LASERBIAS (MN) OCN: AIS-L (NR) TRUNK: SSM-OFF (NA)
EQPT: HI-LASERTEMP (MN) OCN: ALS (NA) TRUNK: SSM-PRC (NA)
EQPT: HI-TXPOWER (MN) OCN: APS-INV-PRIM (MN) TRUNK: SSM-PRS (NA)
EQPT: HITEMP (MN) OCN: APS-PRIM-FAC (NA) TRUNK: SSM-RES (NA)
EQPT: IMPROPRMVL (CR) OCN: APS-PRIM-SEC-MISM (MN) TRUNK: SSM-SDH-TN (NA)
EQPT: INHSWPR (NA) OCN: APSB (MN) TRUNK: SSM-SETS (NA)
EQPT: INHSWWKG (NA) OCN: APSC-IMP (MN) TRUNK: SSM-SMC (NA)
EQPT: IOSCFGCOPY (NA) OCN: APSCDFLTK (MN) TRUNK: SSM-ST2 (NA)
EQPT: LO-LASERBIAS (MN) OCN: APSCINCON (MN) TRUNK: SSM-ST3 (NA)
EQPT: LO-LASERTEMP (MN) OCN: APSCM (MJ) TRUNK: SSM-ST3E (NA)
EQPT: LO-TXPOWER (MN) OCN: APSCNMIS (MJ) TRUNK: SSM-ST4 (NA)
EQPT: LOCKOUT-REQ (NA) OCN: APSIMP (MN) TRUNK: SSM-STU (NA)
EQPT: MAN-REQ (NA) OCN: APSMM (MN) TRUNK: SSM-TNC (NA)
EQPT: MANRESET (NA) OCN: AS-CMD (NA) TRUNK: SYNC-FREQ (NA)
EQPT: MEA (CR) OCN: AS-MT (NA) TRUNK: SYNCLOSS (MJ)
EQPT: MEM-GONE (MJ) OCN: AUTOLSROFF (CR) TRUNK: TIM (CR)
EQPT: MEM-LOW (MN) OCN: BLSR-SW-VER-MISM (MJ) TRUNK: TIM-MON (MN)
EQPT: NO-CONFIG (NA) OCN: BLSROSYNC (MJ) TRUNK: TRAIL-SIGNAL-FAIL (NA)
EQPT: OPEN-SLOT (NA) OCN: E-W-MISMATCH (M1J) TRUNK: UNC-WORD (NA)
EQPT: PEER-NORESPONSE (MJ) |OCN: EOC (MN) TRUNK: UT-COMM-FAIL (MJ)
EQPT: PROTNA (MN) OCN: EOC-L (MN) TRUNK: UT-FAIL (MJ)
EQPT: PWR-FAIL-A (MN) OCN: EXERCISE-RING-FAIL (NA) TRUNK: WTR (NA)
EQPT: PWR-FAIL-B (MN) OCN: EXERCISE-SPAN-FAIL (NA) TRUNK: WVL-MISMATCH (MJ)
EQPT: PWR-FAIL-RET-A (MN) OCN: EXTRA-TRAF-PREEMPT (MJ) |VCG: LOA (CR)
EQPT: PWR-FAIL-RET-B (MN) OCN: FAILTOSW (NA) VCG: VCG-DEG (NA)
EQPT: RUNCFG-SAVENEED (NA) |OCN: FAILTOSWR (NA) VCG: VCG-DOWN (NA)
EQPT: SFTWDOWN (MN) OCN: FAILTOSWS (NA) VT-MON: AIS-V (NR)
EQPT: SW-MISMATCH (NA) OCN: FE-FRCDWKSWBK-SPAN (NA) |VT-MON: AUTOSW-AIS (NR)
EQPT: SWMTXMOD-PROT (CR) OCN: FE-FRCDWKSWPR-RING (NA) |VT-MON: AUTOSW-LOP (NA)
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EQPT: SWMTXMOD-WORK (CR) |OCN: FE-FRCDWKSWPR-SPAN (NA) |VT-MON: AUTOSW-UNEQ (MN)
EQPT: WKSWPR (NA) OCN: FE-LOCKOUTOFPR-SPAN (NA) |VT-MON: FAILTOSW-PATH (NA)
EQPT: WTR (NA) OCN: FE-MANWKSWBK-SPAN (NA) |VT-MON: FORCED-REQ (NA)
ESCON: ALS (NA) OCN: FE-MANWKSWPR-RING (NA) |VT-MON: LOCKOUT-REQ (NA)
ESCON: AS-CMD (NA) OCN: FE-MANWKSWPR-SPAN (NA) |VT-MON: LOP-V (MJ)
ESCON: AS-MT (NA) OCN: FEPRLF (MN) VT-MON: MAN-REQ (NA)
ESCON: FAILTOSW (NA) OCN: FORCED-REQ-RING (NA) VT-MON: RFI-V (NR)
ESCON: FORCED-REQ-SPAN (NA) |OCN: FORCED-REQ-SPAN (NA) VT-MON: ROLL (NA)
ESCON: HI-LASERBIAS (MN) OCN: FULLPASSTHR-BI (NA) VT-MON: ROLL-PEND (NA)
ESCON: HI-RXPOWER (MN) OCN: HELLO (NA) VT-MON: SD-V (NA)
ESCON: HI-TXPOWER (MN) OCN: HI-LASERBIAS (MN) VT-MON: SF-V (NA)
ESCON: LO-RXPOWER (MN) OCN: HI-LASERTEMP (MN) VT-MON: UNEQ-V (MJ)
ESCON: LO-TXPOWER (MN) OCN: HI-RXPOWER (MN) VT-MON: WKSWPR (NA)
ESCON: LOCKOUT-REQ (NA) OCN: HI-TXPOWER (MN) VT-MON: WTR (NA)
ESCON: LOS (CR) OCN: ISIS-ADIJ-FAIL (MN) VT-TERM: AIS-V (NR)
ESCON: LPBKFACILITY (NA) OCN: KB-PASSTHR (NA) VT-TERM: AS-MT-O0G (NA)
ESCON: LPBKTERMINAL (NA) OCN: VT-TERM: LCAS-CRC (NA)
KBYTE-APS-CHANNEL-FAILURE
(MN)
ESCON: MANUAL-REQ-SPAN OCN: LASEREOL (MN) VT-TERM: LCAS-RX-FAIL (NA)
(NA)
ESCON: SIGLOSS OCN: LKOUTPR-S (NA) VT-TERM: LCAS-TX-ADD (NA)
ESCON: SQUELCHED (NA) OCN: LO-LASERBIAS (MN) VT-TERM: LCAS-TX-DNU (NA)
ESCON: WKSWPR (NA) OCN: LO-LASERTEMP (MN) VT-TERM: LOM (MJ)
ESCON: WTR (NA) OCN: LO-RXPOWER (MN) VT-TERM: LOP-V (MJ)
EXT-SREF: FRCDSWTOPRI (NA) |OCN: LO-TXPOWER (MN) VT-TERM: OOU-TPT (NA)
EXT-SREF: FRCDSWTOSEC (NA) |OCN: LOCKOUT-REQ (NA) VT-TERM: PLM-V (MJ)
EXT-SREF: FRCDSWTOTHIRD OCN: LOF (CR) VT-TERM: RFI-V (NR)
(NA)
EXT-SREF: MANSWTOPRI (NA) OCN: LOS (CR) VT-TERM: SD-V (NA)
EXT-SREF: MANSWTOSEC (NA) |OCN: LPBKFACILITY (NA) VT-TERM: SF-V (NA)
EXT-SREF: MANSWTOTHIRD OCN: LPBKTERMINAL (NA) VT-TERM: SQM (MJ)
(NA)
EXT-SREF: SWTOPRI (NA) OCN: MANUAL-REQ-RING (NA) VT-TERM: TIM-V (MJ)
EXT-SREF: SWTOSEC (NA) OCN: MANUAL-REQ-SPAN (NA) VT-TERM: UNEQ-V (MJ) (CR)
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2.5 Trouble Notifications

The ONS 15454 system reports trouble by utilizing standard alarm and condition characteristics,
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI)
state indicators.These notifications are described in the following paragraphs.

The ONS 15454 uses standard Telcordia categories to characterize levels of trouble. The system reports
trouble notifications as alarms and status or descriptive notifications (if configured to do so) as
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy,
such as a loss of signal. Conditions do not necessarily require troubleshooting.

25.1 Alarm Characteristics

The ONS 15454 uses standard alarm entities to identify what is causing trouble. All alarms stem from
hardware, software, environment, or operator-originated problems whether or not they affect service.
Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In addition,
cleared alarms are also found in the History tab.)

2.5.2 Condition Characteristics

Conditions include any problem detected on an ONS 15454 shelf. They can include standing or transient
notifications. A snapshot of all current raised, standing conditions on the network, node, or card can be
retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In addition,
some but not all cleared conditions are also found in the History tab.)

For a comprehensive list of all conditions, refer to the Cisco ONS SONET TL1 Command Guide . For
more information about transient conditions, see Chapter 3, “Transient Conditions.”

Note  When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity and alarms and events appear on the Conditions tab. You can change this behavior for the
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the
NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT value to TRUE on the NE Defaults tab.
For more information about changing NE defaults, refer to the “Maintain the Node” chapter in the
Cisco ONS 15454 Procedure Guide.

25.3 Severities

The ONS 15454 uses Telcordia-devised standard severities for alarms and conditions: Critical (CR),
Major (MJ), Minor (MN), Not Alarmed (NA) and Not Reported (NR). These are described below:

¢ A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs
immediate correction. Loss of traffic on an STS-1, which can hold 28 DS-1 circuits, would be a
Critical (CR), Service-Affecting (SA) alarm.

e A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network. For example,
loss of traffic on more than five DS-1 circuits is Critical (CR), but loss of traffic on one to four DS-1
circuits is Major (MJ).
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e Minor (MN) alarms generally are those that do not affect service. For example, the automatic
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic
switch.

e Not Alarmed (NA) conditions are information indicators, such as for free-run synchronization state
(FRNGSYNC) or a forced-switch to primary (FRCSWTOPRI) timing event. They could or could
not require troubleshooting, as indicated in the entries.

e Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are
to be expected in the presence of primary alarms.

Severities can be customized for an entire network or for single nodes, from the network level down to
the port level by changing or downloading customized alarm profiles. These custom severities are
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE and shown in the
“2.5.4 Alarm Hierarchy” section on page 2-30. Procedures for customizing alarm severities are located
in the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

2.5.4 Alarm Hierarchy

All alarm, condition, and unreported event severities listed in this manual are default profile settings.
However in situations when traffic is not lost, such as when the alarm occurs on protected ports or
circuits, alarms having Critical (CR) or Major (MJ) default severities can be demoted to lower severities
such as Minor (MN) or Non-Service-Affecting (NSA) as defined in Telcordia GR-474-CORE.

A path alarm can be demoted if a higher-ranking alarm is raised for the same object. For example, If a
path trace identifier mismatch (TIM-P) is raised on a circuit path and then a loss of pointer on the path
(LOP-P) is raised on the path, the LOP-P alarm stands and the TIM-P closes. The path alarm hierarchy
used in the ONS 15454 system is shown in Table 2-9.

Table 2-9 Path Alarm Hierarchy

Priority Condition Type
Highest AIS-P

— LOP-P

— UNEQ-P
Lowest TIM-P

Facility (port) alarms also follow a hierarchy, which means that lower-ranking alarms are closed by
higher-ranking alarms. The facility alarm hierarchy used in the ONS 15454 is shown in Table 2-10.

Table 2-10 Facility Alarm Hierarchy

Priority Condition Type
Highest LOS

— LOF

— AIS-L

— SF-L

Cisco ONS 15454 Troubleshooting Guide, R7.0
m. November 2009 |



| Chapter2  Alarm Troubleshooting

Table 2-10

Facility Alarm Hierarchy

Priority

Condition Type

SD-L

RFI-L

TIM-S

AIS-P

LOP-P

SF-P

SD-P

UNEQ-P

TIM-P

Lowest

PLM-P

254 Alarm Hierarchy W

Near-end failures and far-end failures follow different hierarchies. Near-end failures stand according to
whether they are for the entire signal (LOS, LOF), facility (AIS-L), path (AIS-P, etc.) or VT (AIS-V,
etc.). The full hierarchy for near-end failures is shown in Table 2-11. This table is taken from

Telcordia GR-253-CORE.

Table 2-11

Near-End Alarm Hierarchy

Priority

Condition Type

Highest

LOS

LOF

AIS-L

AIS-P!

LOP-P?

UNEQ-P

TIM-P

PLM-P

AIS-V!

LOP-V?

UNEQ-V

PLM-V

Lowest

DS-N AIS (if reported for
outgoing DS-N signals)

1. Although it is not defined as a defect or failure, all-ones STS pointer relay is also
higher priority than LOP-P. Similarly, all-ones VT pointer relay is higher priority

than LOP-V.

2. LOP-Pis also higher priority than the far-end failure RFI-P, which does not affect
the detection of any near-end failures. Similarly, LOP-V is higher priority than

RFI-V.

The far-end failure alarm hierarchy is shown in Table 2-12, as given in Telcordia GR-253-CORE.
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Table 2-12 Far-End Alarm Hierarchy

Priority Condition Type
Highest RFI-L
— RFI-P
Lowest RFI-V

255 Service Effect

2.5.6 States

Service-Affecting (SA) alarms—those that interrupt service—could be Critical (CR), Major (MJ), or
Minor (MN) severity alarms. Service-Affecting (SA) alarms indicate service is affected.
Non-Service-Affecting (NSA) alarms always have a Minor (MN) default severity.

The Alarms or History tab State (ST) column indicate the disposition of the alarm or condition as
follows:

e A raised (R) event is one that is active.
e A cleared (C) event is one that is no longer active.

e A transient (T) event is one that is automatically raised and cleared in CTC during system changes
such as user login, logout, loss of connection to node view, etc. Transient events do not require user
action. These are listed in Chapter 3, “Transient Conditions.”

2.6 Safety Summary

A

This section covers safety considerations designed to ensure safe operation of the ONS 15454. Personnel
should not perform any procedures in this chapter unless they understand all safety precautions,
practices, and warnings for the system equipment. Some troubleshooting procedures require installation
or removal of cards; in these instances users should pay close attention to the following caution.

Caution

>

Warning

Hazardous voltage or energy could be present on the backplane when the system is operating. Use
caution when removing or installing cards.

Some troubleshooting procedures require installation or removal of OC-192 cards; in these instances
users should pay close attention to the following warnings.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293
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>

Warning

A

Warning

A

Warning

A

Warning

A

Warning

27 Alarm Procedures Il

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Class 1 laser product. Statement 1008

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

2.7 Alarm Procedures

Note

Note

This section list alarms alphabetically and includes some conditions commonly encountered when
troubleshooting alarms. The severity, description, and troubleshooting procedure accompany each alarm
and condition.

When you check the status of alarms for cards, ensure that the alarm filter icon in the lower right corner
of the GUI is not indented. If it is, click it to turn it off. When you are done checking for alarms, you can
click the alarm filter icon again to turn filtering back on. For more information about alarm filtering,
refer to the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

When checking alarms, ensure that alarm suppression is not enabled on the card or port. For more
information about alarm suppression, refer to the “Manage Alarms” chapter in the Cisco ONS 15454
Procedure Guide.

When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity and alarms and events appear on the Conditions tab. You can change this behavior for the
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the
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2.1.1 AIS

NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT value to TRUE on the NE Defaults tab.
For more information about changing NE defaults, refer to the “Maintain the Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, DS3, E1, FUDC, MSUDC
DWDM Logical Object: TRUNK

The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication
signal in the incoming signal SONET overhead.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Note  ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.
Clear the AIS Condition

Step 1 Determine whether there are alarms on the upstream nodes and equipment, especially the “LOS (OCN)”
alarm on page 2-152, or if there are out-of-service (OOS,MT or OOS,DSBLD) ports.

Step2  Clear the upstream alarms using the applicable procedures in this chapter.

Step3  If the condition does not clear, log into the Technical Support Website at

2.1.2 AIS-L

http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN
DWDM Logical Object: TRUNK

The AIS Line condition indicates that this node is detecting line-level AIS in the incoming signal. This
alarm is secondary to another alarm occurring simultaneously in an upstream node.

This condition can also be raised in conjunction with the “TIM-S” alarm on page 2-224 if AIS-L is
enabled.
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>
Note  ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the

loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS-L Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.3 AIS-P

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The AIS Path condition means that this node is detecting AIS in the incoming path. This alarm is
secondary to another alarm occurring simultaneously in an upstream node.

Clear the AIS-P Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

214 AIS-V

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM
The AIS VT condition means that this node is detecting AIS in the incoming VT-level path.

See the “1.11.2 AIS-V on DS3XM-6 or DS3XM-12 Unused VT Circuits” section on page 1-129 for
more information.

Clear the AIS-V Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.1.5 ALS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.6 AMPLI-INIT

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.1 APC-CORRECTION-SKIPPED

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.8 APC-DISABLED

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.9 APC-END

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.10 APC-OUT-OF-RANGE

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.111 APSB

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an
invalid switching code in the incoming APS signal. Some older SONET not manufactured by Cisco send
invalid APS codes if they are configured in a 1+1 protection group with newer SONET nodes, such as
the ONS 15454. These invalid codes cause an APSB alarm on an ONS 15454.

Step1  Use an optical test set to examine the incoming SONET overhead to confirm inconsistent or invalid
K bytes. For specific procedures to use the test set equipment, consult the manufacturer. If corrupted
K bytes are confirmed and the upstream equipment is functioning properly, the upstream equipment
might not interoperate effectively with the ONS 15454.
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Step 3

2712 APScDFLTK H

If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you could need to
replace the upstream cards for protection switching to operate properly. Complete the “Physically
Replace a Traffic Card” procedure on page 2-250.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.12 APSCDFLTK

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Default K Byte Received alarm occurs during bidirectional line switched ring (BLSR)
provisioning or when a BLSR is not properly configured, for example, when a four-node BLSR has one
node configured as a path protection. When this misconfiguration occurs, a node in a path protection or
1+1 configuration does not send the two valid K1/K2 APS bytes anticipated by a system configured for
BLSR. One of the bytes sent is considered invalid by the BLSR configuration. The K1/K2 byte is
monitored by receiving equipment for link-recovery information.

Troubleshooting for APSCDFLTK is often similar to troubleshooting for the “BLSROSYNC” alarm on
page 2-53.

Clear the APSCDFLTK Alarm

Step 1 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-238 to verify that
each node has a unique node ID number.

Step2  Repeat Step 1 for all nodes in the ring.

Step3  If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure
on page 2-238 to change one node ID number so that each node ID is unique.

Step4  If the alarm does not clear, verify correct configuration of east port and west port optical fibers. (See the
“E-W-MISMATCH” alarm on page 2-85.) West port fibers must connect to east port fibers and east port
fibers must connect to west port fibers. The “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide provides procedures for fibering BLSRs.

Step 5 If the alarm does not clear and the network is a four-fiber BLSR, ensure that each protect fiber is
connected to another protect fiber and each working fiber is connected to another working fiber. The
software does not report any alarm if a working fiber is incorrectly attached to a protect fiber.

Step6  If the alarm does not clear, complete the “Verify Node Visibility for Other Nodes” procedure on
page 2-239.

Step7  If nodes are not visible, complete the “Verify or Create Node Section DCC Terminations” procedure on
page 2-252 to ensure that section data communications channel (SDCC) terminations exist on each node.

Step8  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.
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2.7.13 APSC-IMP

Warning

A

Warning

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
An Improper SONET APS Code alarm indicates three consecutive, identical frames containing:
¢ Unused code in bits 6 through 8 of byte K2.
¢ Codes that are irrelevant to the specific protection switching operation being requested.

e Requests that are irrelevant to the ring state of the ring (such as a span protection switch request in
a two-fiber ring NE).

e ET code in K2 bits 6 through 8 received on the incoming span, but not sourced from the outgoing
span.

This alarm can occur on a VT tunnel when it does not have VT circuits provisioned on it. It can also
occur when the exercise command or a lockout is applied to a span. An externally switched span does
not raise this alarm because traffic is preempted.

The APSC-IMP alarm may be raised on a BLSR or MS-SPRing when a drop connection is part of a
cross-connect loopback.

The APSC-IMP alarm may be momentarily raised on BLSR spans during PCA circuit creation or
deletion across multiple nodes using CTC.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the APSC-IMP Alarm

Step 1

A

Use an optical test set to determine the validity of the K byte signal by examining the received signal.
For specific procedures to use the test set equipment, consult the manufacturer.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step 3
Step 4

Step 5
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If the K byte is invalid, the problem lies with upstream equipment and not with the reporting ONS 15454.
Troubleshoot the upstream equipment using the procedures in this chapter, as applicable. If the upstream
nodes are not ONS 15454s, consult the appropriate user documentation.

If the K byte is valid, verify that each node has a ring name that matches the other node ring names.
Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-238.

Repeat Step 2 for all nodes in the ring.

If a node has a ring name that does not match the other nodes, make that node’s ring name identical to
the other nodes. Complete the “Change a BLSR Ring Name” procedure on page 2-238.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.14 APSCINCON

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

An APS Inconsistent alarm means that an inconsistent APS byte is present. The SONET overhead
contains K1/K2 APS bytes that notify receiving equipment, such as the ONS 15454, to switch the
SONET signal from a working to a protect path when necessary. An inconsistent APS code occurs when
three consecutive frames contain nonidentical APS bytes, which in turn give the receiving equipment
conflicting commands about switching.

Clear the APSCINCON Alarm

Step 1

Step 2

Look for other alarms, especially the “LOS (OCN)” alarm on page 2-152, the “LOF (OCN)” alarm on
page 2-139, or the “AIS” condition on page 2-34. Clearing these alarms clears the APSCINCON alarm.

If an APSINCON alarm occurs with no other alarms, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.15 APSCM

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The APS Channel Mismatch alarm occurs when the ONS 15454 expects a working channel but receives
a protect channel. In many cases, the working and protect channels are crossed and the protect channel
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM
alarm occurs only on the ONS 15454 when bidirectional protection is used on OC-N cards in a 1+1
protection group configuration. The APSCM alarm does not occur in an optimized 141 protection
configuration.
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A

Warning On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

>

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

A

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the APSCM Alarm
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that the working-card channel fibers are physically connected directly to the adjoining node’s
working-card channel fibers.

Step2  If the fibers are correctly connected, verify that the protection-card channel fibers are physically
connected directly to the adjoining node’s protection-card channel fibers.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.16 APSCNMIS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The APS Node ID Mismatch alarm occurs when the source node ID contained in the incoming APS
channel K2 byte is not present in the ring map. The APSCNMIS alarm could occur and clear when a
BLSR is being provisioned. If so, you can disregard the temporary occurrence. If the APSCNMIS
remains, the alarm clears when a K byte with a valid source node ID is received.

Clear the APSCNMIS Alarm

Step 1 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-238 to verify that
each node has a unique node ID number.

Step2  If the Node ID column contains any two nodes with the same node ID listed, record the repeated node ID.
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Step 3
Step 4

Step 5

Step 6

Step 7
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Click Close in the Ring Map dialog box.

If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure
on page 2-238 to change one node ID number so that each node ID is unique.

N

Note  If the node names shown in the network view do not correlate with the node IDs, log into each
node and click the Provisioning > BLSR tabs. The BLSR window shows the node ID of the
login node.

~

Note  Applying and removing a lockout on a span causes the ONS node to generate a new K byte. The
APSCNMIS alarm clears when the node receives a K byte containing the correct node ID.

If the alarm does not clear, use the “Initiate a Lockout on a BLSR Protect Span” procedure on page 2-245
to lock out the span.

Complete the “Clear a BLSR External Switching Command” procedure on page 2-246 to clear the
lockout.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.17 APSIMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Invalid Code alarm occurs if a 1+1 protection group is not properly configured at both nodes
to send or receive the correct APS byte. A node that is either configured for no protection or is configured
for path protection or BLSR protection does not send the right K2 APS byte anticipated by a system
configured for 1+1 protection. The 1+1 protect port monitors the incoming K2 APS byte and raises this
alarm if it does not receive the byte.

The alarm is superseded by an APSCM or APSMM alarm, but not by an AIS condition. It clears when
the port receives a valid code for 10 ms.

Clear the APSIMP Alarm

Step 1

Check the configuration of the other node in the 1+1 protection group. If the far end is not configured
for 1+1 protection, create the group. For procedures, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step2  If the other end of the group is properly configured or the alarm does not clear after you have provisioned
the group correctly, verify that the working ports and protect ports are cabled correctly.
Step3  Ensure that both protect ports are configured for SONET.
Cisco ONS 15454 Troubleshooting Guide, R7.0
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Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.71.18 APS-INV-PRIM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The Optimized 1+1 APS Primary Facility condition occurs on OC-N cards in an optimized 1+1
protection system if the incoming primary section header does not indicate whether it is primary or
secondary.

Note  APS-INV-PRIM is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

2.1.19 APSMM

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

An APS Mode Mismatch failure alarm occurs on OC-N cards when there is a mismatch of the protection
switching schemes at the two ends of the span, such as being bidirectional at one end and unidirectional
at the other. Each end of a span must be provisioned the same way: bidirectional and bidirectional, or
unidirectional and unidirectional. APSMM can also occur if third-party equipment is provisioned as 1:N
and the ONS 15454 is provisioned as 1+1.

If one end is provisioned for 1+1 protection switching and the other is provisioned for path protection
switching, an APSMM alarm occurs in the ONS 15454 that is provisioned for 1+1 protection switching.

Clear the APSMM Alarm

Step 1 For the reporting ONS 15454, display node view and verify the protection scheme provisioning:
a. Click the Provisioning > Protection tabs.
b. Click the 1+1 protection group configured for the OC-N cards.

The chosen protection group is the protection group optically connected (with data communications
channel, or DCC, connectivity) to the far end.

c. Click Edit.
d. Record whether the Bidirectional Switching check box is checked.
Step2  Click OK in the Edit Protection Group dialog box.
Step3  Log into the far-end node and verify that the OC-N 1+1 protection group is provisioned.

Step4  Verify that the Bidirectional Switching check box matches the checked or unchecked condition of the
box recorded in Step 1. If not, change it to match.

Step5  Click Apply.
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Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.20 APS-PRIM-FAC

Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The Optimized 1+1 APS Invalid Primary Section condition occurs on OC-N cards in an optimized 1+1
protection system if there is an APS status switch between the primary and secondary facilities to
identify which port is primary.

Note  APS-PRIM-FAC is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

Clear the APS-PRIM-FAC Condition

Step 1 This condition clears when the card receives a valid primary section indication (1 or 2).

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.21 APS-PRIM-SEC-MISM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The Optimized 1+1 APS Primary Section Mismatch condition occurs on OC-N cards in an optimized
1+1 protection system if there is a mismatch between the primary section of the local node facility and
the primary section of the remote-node facility.

Clear the APS-PRIM-SEC-MISM Alarm

Step 1 Ensure that the local node and remote-node ports are correctly provisioned the same way. For more
information about optimized 1+1 configurations, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.
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2.1.22 AS-CMD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BPLANE, CE1000, CE100T, DS1, DS3, E1, E1000F, E100F, EC1, EQPT,
FCMR, G1000, GFP-FAC, ML1000, ML100T, MLFX, NE, OCN, PWR

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCH, OMS, OTS, PPM, SHELF,
TRUNK

The Alarms Suppressed by User Command condition applies to the network element (NE object),
backplane, a single card, or a port on a card. It occurs when alarms are suppressed for that object and its
subordinate objects. For example, suppressing alarms on a card also suppresses alarms on its ports.

Note  For more information about suppressing alarms, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the AS-CMD Condition

Step 1 For all nodes, in node view, click the Conditions tab.

Step2  Click Retrieve. If you have already retrieved conditions, look under the Object column and Eqpt Type
column and note what entity the condition is reported against, such as a port, slot, or shelf.

e If the condition is reported against a slot and card, alarms were either suppressed for the entire card
or for one of the ports. Note the slot number and continue with Step 3.

e If the condition is reported against the backplane, go to Step 7.
e If the condition is reported against the NE object, go to Step 8.

Step3  Determine whether alarms are suppressed for a port and if so, raise the suppressed alarms:
a. Double-click the card to open the card view.

b. Click the Provisioning > Alarm Profiles > Alarm Behavior tabs and complete one of the following
substeps:

e If the Suppress Alarms column check box is checked for a port row, deselect it and click Apply.

e If the Suppress Alarms column check box is not checked for a port row, from the View menu
choose Go to Previous View.

Step4  If the AS-CMD condition is reported for a card and not an individual port, in node view click the
Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step5  Locate the row number for the reported card slot.
Step6  Click the Suppress Alarms column check box to deselect the option for the card row.

Step7  If the condition is reported for the backplane, the alarms are suppressed for cards such as the ONS 15454
AIP that are not in the optical or electrical slots. To clear the alarm, complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.
b. In the backplane row, uncheck the Suppress Alarms column check box.
¢. Click Apply.
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Step8  If the condition is reported for the shelf, cards and other equipment are affected. To clear the alarm,
complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs if you have not
already done so.

b. Click the Suppress Alarms check box located at the bottom of the window to deselect the option.
c¢. Click Apply.

Step9  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.23 AS-MT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: CE1000, CE100T, DS1, DS3, E1, EC1, EQPT, FCMR, G1000, GFP-FAC,
ML1000, ML100T, MLFX, OCN

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCH, OMS, OTS, PPM, SHELF,
TRUNK

The Alarms Suppressed for Maintenance Command condition applies to OC-N and electrical cards and
occurs when a port is placed in the Out-of-Service and Management, Maintenance (OOS-MA,MT)
service state for loopback testing operations.

Clear the AS-MT Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-253.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.24 AS-MT-00G

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The Alarms Suppressed on an Out-Of-Group VCAT Member condition is raised on an STS or VT
member of a VCAT group whenever the member is in the IDLE (AS-MT-OOG) admin state. This
condition can be raised when a member is initially added to a group. In the IDLE (AS-MT-OOG) state,
all other alarms for the STS or VT are suppressed.

The AS-MT-OOG condition clears when an STS or VT member transitions to a different state from IDLE
(AS-MT-OO0G) or when the member is removed completely from the VCAT group. The condition does
not require troubleshooting unless it does not clear.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.1.25 AUD-LOG-LOSS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Audit Trail Log Loss condition occurs when the log is 100 percent full and the oldest entries are
being replaced while new entries are generated. The log capacity is 640 entries. The log must be
off-loaded using the following procedure to make room for more entries.

Clear the AUD-LOG-LOSS Condition

Step 1 In node view, click the Maintenance > Audit tabs.
Step2  Click Retrieve.
Step3  Click Archive.

Step4  In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to
save the file.

Step5  Enter a name in the File Name field.

You do not have to assign an extension to the file. It is readable in any application that supports text files,
such as WordPad, Microsoft Word (imported), etc.

Step6  Click Save.

The 640 entries are saved in this file. New entries continue with the next number in the sequence, rather
than starting over.

Step7  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.26 AUD-LOG-LOW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE
The Audit Trail Log Low condition occurs when the audit trail log is 80 percent full.

~

Note  AUD-LOG-LOW is an informational condition and does not require troubleshooting.

2.1.2]7 AUTOLSROFF

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN

The Auto Laser Shutdown alarm occurs when the OC-192 card temperature exceeds 194 degrees F
(90 degrees C). The internal equipment automatically shuts down the OC-192 laser when the card
temperature rises to prevent the card from self-destructing.
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On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the AUTOLSROFF Alarm

Step 1

Step 2

Step 3

Step 4

View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-1).

Figure 2-1 Shelf LCD Panel

o
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If the temperature of the shelf exceeds 194 degrees F (90 degrees C), the alarm should clear if you solve
the ONS 15454 temperature problem. Complete the “Clear the HITEMP Alarm” procedure on
page 2-118.

If the temperature of the shelf is under 194 degrees F (90 degrees C), the HITEMP alarm is not the cause
of the AUTOLSROFF alarm. Complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the OC-192 card.

If card replacement does not clear the alarm, call Cisco TAC 1 800 553-2447 to discuss the case and if
necessary open a returned materials authorization (RMA) on the original OC-192 card.

2.7.28 AUTORESET

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Automatic System Reset alarm occurs when you change an IP address or perform any other
operation that causes an automatic card-level reboot.

AUTORESET typically clears after a card reboots (up to ten minutes). If the alarm does not clear,
complete the following procedure.
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Clear the AUTORESET Alarm

Step1  Determine whether there are additional alarms that could have triggered an automatic reset. If there are,
troubleshoot these alarms using the applicable section of this chapter.

Step2  If the card automatically resets more than once a month with no apparent cause, complete the “Physically
Replace a Traffic Card” procedure on page 2-250.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.29 AUTOSW-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, VI-MON

The Automatic UPSR Switch Caused by an AIS condition indicates that automatic path protection
switching occurred because of an AIS condition. If the path protection is configured for revertive
switching, it reverts to the working path after the fault clears. The AIS also clears when the upstream
trouble is cleared.

Note  This condition is only reported if the path protection is set up for revertive switching.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.30 AUTOSW-LOP (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic UPSR Switch Caused by LOP condition for the STS monitor (STSMON) indicates that
automatic path protection switching occurred because of the “LOP-P” alarm on page 2-142. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.

Cisco ONS 15454 Troubleshooting Guide, R7.0
m. November 2009 |



| Chapter2 Alarm Troubleshooting

2731 AUTOSW-LOP (vT-moN) W

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-LOP (STSMON) Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-143.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.31 AUTOSW-LOP (VT-MON)

Default Severity: Not Alarmed (NA), Service-Affecting (SA)
SONET Logical Object: VI-MON

The AUTOSW-LOP alarm for the VT monitor (VIT-MON) indicates that automatic path protection
switching occurred because of the “LOP-V” alarm on page 2-143. If the path protection is configured
for revertive switching, it reverts to the working path after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-LOP (VT-MON) Condition

Step 1 Complete the “Clear the LOP-V Alarm” procedure on page 2-144.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.32 AUTOSW-PDI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic UPSR Switch Caused by Payload Defect Indication (PDI) condition indicates that
automatic path protection switching occurred because of a “PDI-P” alarm on page 2-179. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.

Note  This condition is only reported if the path protection is set up for revertive switching.
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Clear the AUTOSW-PDI Condition

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-180.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.33 AUTOSW-SDBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON

The Automatic UPSR Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition indicates
that a “SD-P” condition on page 2-199 caused automatic path protection switching to occur. If the path
protection is configured for revertive switching, the path protection reverts to the working path when the
SD-P is resolved.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SDBER Condition

Step 1 Complete the “Clear the SD-P Condition” procedure on page 2-200.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.34 AUTOSW-SFBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON

The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a
“SF-P” condition on page 2-203 caused automatic path protection switching to occur. If the path
protection is configured for revertive switching, the path protection reverts to the working path when the
SF-P is resolved.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SFBER Condition

Step 1 Complete the “Clear the SF-P Condition” procedure on page 2-203.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.35 AUTOSW-UNEQ (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic UPSR Switch Caused by Unequipped condition indicates that a UNEQ alarm caused
automatic path protection switching to occur. If the path protection is configured for revertive switching,
it reverts to the working path after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-UNEQ (STSMON) Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-230.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.36 AUTOSW-UNEQ (VT-MON)

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: VTI-MON

AUTOSW-UNEQ (VT-MON) indicates that the “UNEQ-V” alarm on page 2-232 caused automatic path
protection switching to occur. If the path protection is configured for revertive switching, it reverts to the
working path after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-UNEQ (VT-MON) Condition

Step 1 Complete the “Clear the UNEQ-V Alarm” alarm on page 2-232 procedure.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a service-affecting problem.
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2.1.371 AWG-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.38 AWG-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.39 AWG-OVERTEMP

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.40 AWG-WARM-UP

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.41 BAT-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Battery Fail alarm occurs when one of the two power supplies (A or B) is not detected. This could
be because the supply is removed or is not operational. The alarm does not distinguish between the
individual power supplies, so onsite information about the conditions is necessary for troubleshooting.

Clear the BAT-FAIL Alarm

Step1 At the site, determine which battery is not present or operational.

Step2 Remove the power cable from the faulty supply. For procedures, refer to the “Install the Shelf and
Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide. Reverse the power cable
installation procedure.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.42 BKUPMEMP

Default Severity: Critical (CR), Service-Affecting (SA)
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SONET Logical Object: EQPT

The Primary Nonvolatile Backup Memory Failure alarm refers to a problem with the TCC2/TCC2P flash
memory. The alarm occurs when the TCC2/TCC2P is in use and has one of four problems:

e Flash manager fails to format a flash partition.
¢ Flash manager fails to write a file to a flash partition.
¢ Problem at the driver level.

¢ Code volume fails cyclic redundancy checking (CRC, a method to verify for errors in data
transmitted to the TCC2/TCC2P).

The BKUPMEMP alarm can also cause the “EQPT” alarm on page 2-80. If the EQPT alarm is caused
by BKUPMEMP, complete the following procedure to clear the BKUPMEMP and the EQPT alarm.

Caution

A software update on a standby TCC2/TCC2P can take up to 30 minutes.

Clear the BKUPMEMP Alarm

Step 1

Step 2
Step 3

Step 4

Verify that both TCC2/TCC2Ps are powered and enabled by confirming lighted ACT/SBY LEDs on the
TCC2/TCC2Ps.

Determine whether the active or standbyTCC2/TCC2P has the alarm.

If both TCC2/TCC2Ps are powered and enabled, reset the TCC2/TCC2P where the alarm is raised. If the
card is the active TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-247. If the card is the standby TCC2/TCC2P:

a. Right-click the standby TCC2/TCC2P in CTC.

b. Choose Reset Card from the shortcut menu.

c. Click Yes in the Are You Sure dialog box. The card resets, the FAIL LED blinks on the physical card.
d. Wait ten minutes to verify that the card you reset completely reboots.

If the TCC2/TCC2P you reset does not reboot successfully, or the alarm has not cleared, call Cisco TAC
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.

2.7.43 BLSROSYNC

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The BLSR Out Of Synchronization alarm occurs is raised temporarily during a span upgrade,
downgrade, or two-fiber to four-fiber mode upgrade and clears when the procedure is complete for all
nodes on the ring. If the alarm does not clear, ensure that all maintenance procedures have completed for
all nodes on the ring. If the alarm still does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to
report a Service-Affecting (SA) problem.
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2.7.44 BLSR-SW-VER-MISM

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The BLSR Software Version Mismatch alarm is raised by the TCC2/TCC2P when it checks all software
versions for all nodes in a ring and discovers a mismatch in versions.

Clear the BLSR-SW-VER-MISM Alarm

Step1  Clear the alarm by loading the correct software version on the TCC2/TCC2P with the incorrect load. To
download software, refer to the release-specific software download document.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) condition.

2.1.45 BPV

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The 64K Clock Bipolar Density Violation alarm is raised on the TCC2P card if there is a frequency
variation in the 8K BITS clock.

The TCC2P card contains an 8K clock and a 64K clock. Each has some bipolar variation, which is
normal. This alarm is raised on the 8K clock if that variation discontinues. The BPV alarm is demoted
by an LOF or LOS against the BITS clock.

~

Note This alarm is not raised on the TCC2 card.

Clear the BPV Alarm

Step 1 Reestablishing a normal BITS input signal clears the alarm. Clear any alarms on the incoming signal or
against the BITS timing sources.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.46 CARLOSS (CE1000, CE100T)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE1000, CE100T
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2.7.47 CARLOSS (E1000F, E100T) W

The Carrier Loss alarm is raised on CE-Series cards in Mapper mode when the port is In-Service (IS) state
and if there is no carrier signal. Circuit need not be present to raise the alarm. In releases prior to 6.01 the
Carrier Loss alarm is raised on CE-100T-8 cards in Mapper mode when there is a circuit failure due to link
integrity. It does not get raised when a user simply puts the port in the In-Service and Normal (IS-NR) service
state.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (CE100T) Alarm

Step 1

Step 2

Complete the “Clear the CARLOSS (G1000) Alarm” procedure on page 2-59. However, rather than
checking for a TPTFAIL (G1000) at the end of the procedure, check for a “TPTFAIL (CE100T,
CE1000)” alarm on page 2-225.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.47 CARLOSS (E1000F, E100T)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: E1000F, E100T

A Carrier Loss alarm on the LAN E-Series Ethernet card is the data equivalent of the “LOS (OCN)”
alarm on page 2-152. The Ethernet card has lost its link and is not receiving a valid signal. The most
common causes of the CARLOSS alarm are a disconnected cable, an Ethernet Gigabit Interface
Converter (GBIC) fiber connected to an optical card rather than an Ethernet device, or an improperly
installed Ethernet card. Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is
declared after no signal is received for approximately 2.5 seconds.

The CARLOSS alarm also occurs after a node database is restored. After restoration, the alarm clears in
approximately 30 seconds after the node reestablishes Spanning Tree Protocol (STP).

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (E1000F, E100T) Alarm

Step 1

A

Verify that the fiber cable is properly connected and attached to the correct port. For more information
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in
the Cisco ONS 15454 Procedure Guide.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N card. For more information about fiber
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the

Cisco ONS 15454 Procedure Guide.

If no misconnection to an OC-N card exists, verify that the transmitting device is operational. If not,
troubleshoot the device.

If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.

If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-250 for the Ethernet card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the Ethernet card.

If a CARLOSS alarm repeatedly appears and clears, use the following steps to examine the layout of
your network to determine whether the Ethernet circuit is part of an Ethernet manual cross-connect.

An Ethernet manual cross-connect is used when another vendor’s equipment sits between ONS 15454
nodes, and the open systems interconnect/target identifier address resolution protocol
(OSI/TARP)-based equipment does not allow tunneling of the ONS 15454 TCP/IP-based DCC. To
circumvent a lack of continuous DCC, the Ethernet circuit is manually cross connected to an STS
channel riding through the non-ONS network.

If the reporting Ethernet circuit is part of an Ethernet manual cross-connect, complete the following
steps. The reappearing alarm could be a result of mismatched STS circuit sizes in the set up of the manual
cross-connect. If the Ethernet circuit is not part of a manual cross-connect, the following steps do not

apply.

a. Right-click anywhere in the row of the CARLOSS alarm.

b. Click Select Affected Circuits in the shortcut menu that appears.

c. Record the information in the type and size columns of the highlighted circuit.

d. From the examination of the layout of your network, determine which ONS 15454 and card and card
are hosting the Ethernet circuit at the other end of the Ethernet manual cross-connect and complete
the following substeps:

e Log into the ONS 15454 at the other end of the Ethernet manual cross-connect.
e Double-click the Ethernet card that is part of the Ethernet manual cross-connect.
¢ Click the Circuits tab.

e Record the information in the type and size columns of the circuit that is part of the Ethernet
manual cross-connect. The Ethernet manual cross-connect circuit connects the Ethernet card to
an OC-N card at the same node.

e. Use the information you recorded to determine whether the two Ethernet circuits on each side of the
Ethernet manual cross-connect have the same circuit size.

If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-252 and
reconfigure the circuit with the correct circuit size. For more information, refer to the “Create
Circuits and VT Tunnels” chapter in the Cisco ONS 15454 Procedure Guide.
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2748 CARLOSS (EPT) H

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.48 CARLOSS (EQPT)

>

Warning

>

Warning

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: EQPT

A Carrier Loss on the LAN Equipment alarm generally occurs on OC-N cards when the ONS 15454 and
the workstation hosting CTC do not have a TCP/IP connection. The problem involves the LAN or data
circuit used by the RJ-45 (LAN) connector on the TCC2/TCC2P or the LAN backplane pin connection.
This CARLOSS alarm does not involve an Ethernet circuit connected to an Ethernet port. The problem
is in the connection and not CTC or the node.

On TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G or MXP_2.5G_10G cards, CARLOSS is also
raised against trunk ports when ITU-T G.709 monitoring is turned off.

A TXP_MR_2.5G card can raise a CARLOSS alarm when the payload is incorrectly configured for the
10 Gigabit Ethernet or 1 Gigabit Ethernet payload data types.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. For more information
about MRC-12 and OC192-XFP/STM64-XFP cards, refer to the “Change Card Settings” chapter of the
Cisco ONS 15454 Procedure Guide. For more information about Ethernet cards, refer to the Ethernet
Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the CARLOSS (EQPT) Alarm

Step 1 If the reporting card is an MXP or TXP card in an ONS 15454 node, verify the data rate configured on
the pluggable port module (PPM):
a. Double-click the reporting MXP or TXP card.
b. Click the Provisioning > Pluggable Port Modules tabs.
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Step 2

Step 3

Step 4

A

¢. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the contents of the Selected PPM area Rate column for the MXP or TXP multirate
port.

d. If the rate does not match the actual equipment, you must delete and recreate the selected PPM.
Select the PPM, click Delete, then click Create and choose the correct rate for the port rate.

If the reporting card is an OC-N card, verify connectivity by pinging the ONS 15454 that is reporting
the alarm by completing the procedure in the “1.9.8 Verify PC Connection to the ONS 15454 (ping)”
procedure on page 1-112.

If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC:
a. Exit from CTC.

b. Reopen the browser.

c¢. Log into CTC.

Using optical test equipment, verify that proper receive levels are achieved. (For instructions to use
optical test equipment, refer to the manufacturer documentation.)

Caution

Step 5

Step 6

Step 7

Step 8

Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that the optical LAN cable is properly connected and attached to the correct port. For more
information about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable”
chapter in the Cisco ONS 15454 Procedure Guide.

If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N card.

If you are unable to establish connectivity, replace the fiber cable with a new known-good cable. To do
this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure
Guide.

If you are unable to establish connectivity, perform standard network or LAN diagnostics. For example,
trace the IP route, verify cable continuity, and troubleshoot any routers between the node and CTC. To
verify cable continuity, follow site practices.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.49 CARLOSS (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.50 CARLOSS (G1000)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: G1000
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2750 CARLOSS (G1000) M

A Carrier Loss alarm on the LAN G-Series Ethernet card is the data equivalent of the “LOS (OCN)”
alarm on page 2-152. The Ethernet card has lost its link and is not receiving a valid signal.

CARLOSS on the G1000-4 card is caused by one of two situations:

e The G1000-4 port reporting the alarm is not receiving a valid signal from the attached Ethernet
device. The CARLOSS can be caused by an improperly connected Ethernet cable or a problem with
the signal between the Ethernet device and the G1000-4 port.

e If a problem exists in the end-to-end path (including possibly the far-end G1000-4 card), it causes
the reporting card to turn off the Gigabit Ethernet transmitter. Turning off the transmitter typically
causes the attached device to turn off its link laser, which results in a CARLOSS on the reporting
G1000-4 card. The root cause is the problem in the end-to-end path. When the root cause is cleared,
the far-end G1000-4 port turns the transmitter laser back on and clears the CARLOSS on the
reporting card. If a turned-off transmitter causes the CARLOSS alarm, other alarms such as the
“TPTFAIL (G1000)” alarm on page 2-226 or OC-N alarms or conditions on the end-to-end path
normally accompany the CARLOSS (G1000s) alarm.

Refer to the Cisco ONS 15454 Reference Manual for a description of the G1000-4 card’s end-to-end
Ethernet link integrity capability. Also see the “TRMT” alarm on page 2-228 for more information about
alarms that occur when a point-to-point circuit exists between two cards.

Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is declared after no signal is
received for approximately 2.5 seconds.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (G1000) Alarm

Step 1

A

Verify that the fiber cable is properly connected and attached to the correct port. For more information
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in
the Cisco ONS 15454 Procedure Guide.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step2  If the fiber cable is correctly connected and attached, verify that the cable connects the card to another
Ethernet device and is not misconnected to an OC-N card.
Step3  If no misconnection to the OC-N card exists, verify that the attached transmitting Ethernet device is
operational. If not, troubleshoot the device.
Stepd  Verify that optical receive levels are within the normal range. The correct specifications are listed in the
“1.12.3 OC-N Card Transmit and Receive Levels” section on page 1-141.
Step5  If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.
Step6  If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.
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Step7  Ifthe alarm does not clear, and link autonegotiation is enabled on the port but the autonegotiation process
fails, the card turns off its transmitter laser and reports a CARLOSS alarm. If link autonegotiation has

been enabled for the port, determine whether there are conditions that could cause autonegotiation to
fail:

a. Confirm that the attached Ethernet device has autonegotiation enabled and is configured for
compatibility with the asymmetric flow control on the card.

b. Confirm that the attached Ethernet device configuration allows reception of flow control frames.

Step8  If the alarm does not clear, disable and reenable the Ethernet port to attempt to remove the CARLOSS
condition. (The autonegotiation process restarts.)

Step9  If the alarm does not clear and the “TPTFAIL (G1000)” alarm on page 2-226 is also reported, complete
the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-226. If the TPTFAIL alarm is not raised,
continue to the next step.

)

Note  When the CARLOSS and the TPTFAIL alarms are reported, the reason for the condition could
be the G1000-4 card's end-to-end link integrity feature taking action on a remote failure
indicated by the TPTFAIL alarm.

Step10 If the TPTFAIL alarm was not raised, determine whether a terminal (inward) loopback has been
provisioned on the port:

a. In node view, click the card to go to card view.
b. Click the Maintenance > Loopback tabs.
c. If the service state is listed as OOS-MA,LPBK&MT, a loopback is provisioned. Go to Step 11.

Step11  If a loopback was provisioned, complete the “Clear Other Electrical Card or Ethernet Card Loopbacks”
procedure on page 2-254.

On the G1000-4, provisioning a terminal (inward) loopback causes the transmit laser to turn off. If an
attached Ethernet device detects the loopback as a loss of carrier, the attached Ethernet device shuts off
the transmit laser to the G1000-4 card. Terminating the transmit laser could raise the CARLOSS alarm
because the loopbacked G1000-4 port detects the termination.

If the does not have a loopback condition, continue to Step 12.

Step12 If a CARLOSS alarm repeatedly appears and clears, the reappearing alarm could be a result of
mismatched STS circuit sizes in the setup of the manual cross-connect. Perform the following steps if
the Ethernet circuit is part of a manual cross-connect:

~

Note  An ONS 15454 Ethernet manual cross-connect is used when another vendor’s equipment sits
between ONS nodes, and the OSI/TARP-based equipment does not allow tunneling of the
ONS 15454 TCP/IP-based DCC. To circumvent a lack of continuous DCC, the Ethernet circuit
is manually cross connected to an STS channel riding through the non-ONS network.

a. Right-click anywhere in the row of the CARLOSS alarm.
b. Right-click or left-click Select Affected Circuits in the shortcut menu that appears.
c. Record the information in the type and size columns of the highlighted circuit.

d. Examine the layout of your network and determine which ONS 15454 and card are hosting the
Ethernet circuit at the other end of the Ethernet manual cross-connect and complete the following
substeps:

¢ Log into the node at the other end of the Ethernet manual cross-connect.
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Step 13

Step 14

Step 15

2151 CARLOSS (GE) W

e Double-click the Ethernet card that is part of the Ethernet manual cross-connect.
e Click the Circuits tab.

e Record the information in the type and size columns of the circuit that is part of the Ethernet
manual cross-connect. The cross-connect circuit connects the Ethernet card to an OC-N card at
the same node.

e. Determine whether the two Ethernet circuits on each side of the Ethernet manual cross-connect have
the same circuit size from the circuit size information you recorded.

f. If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-252 and
reconfigure the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-250.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the Ethernet card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.51 CARLOSS (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.52 CARLOSS (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.53 CARLOSS (ML1000, ML100T, MLFX)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: ML1000, ML100T, MLFX

A Carrier Loss alarm on an ML-Series Ethernet card is the data equivalent of the “LOS (OCN)” alarm
on page 2-152. The Ethernet port has lost its link and is not receiving a valid signal.

A CARLOSS alarm occurs when the Ethernet port has been configured from the Cisco IOS command
line interface (CLI) as a no-shutdown port and one of the following problems also occurs:

e The cable is not properly connected to the near or far port.
e Autonegotiation is failing.

e The speed (10/100 ports only) is set incorrectly.

| November 2009
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>

Note  For information about provisioning ML-Series Ethernet cards from the Cisco IOS interface, refer to the
Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH,
and Cisco ONS 15327.

Clear the CARLOSS (ML1000, ML100T, MLFX) Alarm

Step 1 Verify that the LAN cable is properly connected and attached to the correct port on the ML-Series card
and on the peer Ethernet port. For more information about fiber connections and terminations, refer to
the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, verify that autonegotiation is set properly on the ML-Series card port and the
peer Ethernet port.

Step3  If the alarm does not clear, verify that the speed is set properly on the ML-Series card port and the peer
Ethernet port if you are using 10/100 ports.

Step 4 If the alarm does not clear, the Ethernet signal is not valid, but the transmitting device is operational,
replace the LAN cable connecting the transmitting device to the Ethernet port.

Step5  If the alarm does not clear, disable and reenable the Ethernet port by performing a “shutdown” and then
a “no shutdown” on the Cisco IOS CLI. Autonegotiation restarts.

Step6  If the alarm does not clear, complete the “Create the Facility Loopback on the Source DS-1, DS-3,
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-11 and test the loopback.

Step7  If the problem persists with the loopback installed, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-250.

Step8  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.54 CARLOSS (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.55 CASETEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.71.56 CLDRESTART

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The Cold Restart condition occurs when a card is physically removed and inserted, replaced, or when
the ONS 15454 power is initialized.

Clear the CLDRESTART Condition

Step 1

Step 2

Step 3

Step 4

Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-249.

If the condition fails to clear after the card reboots, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-250.

If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on
page 2-250 for the card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.57 COMIOXC

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Input/Output Slot To Cross-Connect Communication Failure alarm is caused by the XC10G or
XC-VXC-10G cross-connect card when there is a communication failure for a traffic slot.

Clear the COMIOXC Alarm

Step 1

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 on the card in which the alarm is
reported. For the LED behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section
on page 2-237.

Step2  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step3  If the CTC reset does not clear the alarm, move traffic off the reporting cross-connect card. Complete
the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-248.

Step4d  Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-250 on the card in which
the alarm is reported.

Step5  If the alarm does not clear, complete the “Physically Replace an In-Service Cross-Connect Card”
procedure on page 2-251 for the reporting cross-connect card or complete the “Physically Replace a
Traffic Card” procedure on page 2-250 on the card in which the alarm is reported.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.
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2.7.58 COMM-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Plug-In Module (card) Communication Failure indicates that there is a communication failure
between the TCC2/TCC2P and the traffic card. The failure could indicate a broken card interface.

Clear the COMM-FAIL Alarm

Step 1
Step 2

Step 3

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.71.59 CONTBUS-A-18

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the first slot (TCC A) loses
communication with the coprocessor on the same card. This applies to the TCC2/TCC2P in Slot 7.

Clear the CONTBUS-A-18 Alarm

Step 1

Step 2

Step 3

Step 4

Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249
to make the TCC2/TCC2P in Slot 11 active.

Wait approximately 10 minutes for the TCC2/TCC2P in Slot 7 to reset as the standby TCC2/TCC2P.
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Position the cursor over the TCC2/TCC2P in Slot 11 and complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-247 to return the card to the active state.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-247. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.
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2.7.60 CONTBUS-B-18

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the second slot (TCC B)
loses communication with the coprocessor on the same card. This applies to the Slot 11 TCC2/TCC2P.

Clear the CONTBUS-B-18 Alarm

Step 1

Step 2

Step 3

Step 4

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-247 to make the Slot 7 TCC2/TCC2P active.

Wait approximately 10 minutes for the Slot 11 TCC2/TCC2P to reset as the standby TCC2/TCC2P.
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Position the cursor over the Slot 7 TCC2/TCC2P and complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-247 to return the Slot 11 TCC2/TCC2P to the active
state.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.

2.7.61 CONTBUS-DISABLED

A

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The CONTBUS-DISABLED alarm is a function of the enhanced cell bus verification feature. This alarm
occurs when a defective card is installed in the shelf assembly or when a card already installed in the
shelf assembly becomes defective (that is, the card fails the enhanced cell bus verification test). The
alarm persists as long as the defective card remains in the chassis. When the card is removed,
CONTBUS-DISABLED will remain raised for a one-minute wait time. This wait time is designed as a
guard period so that the system can distinguish this outage from a briefer card reset communication
outage.

If no card is reinserted into the original slot during the wait time, the alarm clears. After this time, a
different, nondefective card (not the original card) should be inserted.

When CONTBUS-DISABLED is raised, no message-oriented communication is allowed to or from this
slot to the TCC2/TCC2P (thus avoiding node communication failure).

Caution = CONTBUS-DISABLED clears only when the faulty card is removed for one minute. If any card at all is
reinserted before the one-minute guard period expires, the alarm does not clear.
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CONTBUS-DISABLED overrides the IMPROPRMVL alarm during the one-minute wait period, but
afterward IMPROPRMVL can be raised because it is no longer suppressed. IMPROPRMYVL is raised
after CONTBUS-DISABLED clears if the card is in the node database. If CONTBUS-DISABLED has
cleared but IMPROPRMVL is still active, inserting a card will clear the IMPROPRMVL alarm.

Clear the CONTBUS-DISABLED Alarm

Step1  If the IMPROPRMVL alarm is raised, complete the “Physically Replace a Traffic Card” procedure on
page 2-250. (For general information about card installation, refer to the “Install Cards and Fiber-Optic
Cable” chapter in the Cisco ONS 15454 Procedure Guide.)

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.62 CONTBUS-I0-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A TCCA to Shelf A Slot Communication Failure alarm occurs when the active Slot 7 TCC2/TCC2P
(TCC A) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.

The CONTBUS-IO-A alarm can appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-10-A Alarm

Step1  Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on
page 2-170 for the reporting card.

Step2  If the alarm object is any single card slot other than the standby Slot 11 TCC2/TCC2P, perform a CTC
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-247. For the
LED behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Step3  If the alarm object is the standby Slot 11 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC”
procedure on page 2-247 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-A is raised on several cards at the same time, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-247.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
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Step 5

Step 6

2763 CONTBUS-I0-B M

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-250 for the reporting card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.

2.7.63 CONTBUS-10-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A TCC B to Shelf Communication Failure alarm occurs when the active Slot 11 TCC2/TCC2P (TCC B)
has lost communication with another card in the shelf. The other card is identified by the Object column
in the CTC alarm window.

The CONTBUS-IO-B alarm could appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-10-B Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on
page 2-170 for the reporting card.

If the alarm object is any single card slot other than the standby Slot 7 TCC2/TCC2P, perform a CTC
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-247. For the
LED behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

If the alarm object is the standby Slot 7 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC”
procedure on page 2-247 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-B is raised on several cards at the same time, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-247.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-250 for the reporting card.
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Step 7

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.

2.7.64 CTNEQPT-MISMATCH

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Connection Equipment Mismatch condition is raised when there is a mismatch between the
cross-connect card preprovisioned in the slot and the card actually installed in the shelf. For example,
one type of cross-connect card could be preprovisioned in Slot 10, but another could be physically
installed. It can also be caused by a card that is mismatched with the card. For example,
CTNEQPT-MISMATCH is raised when an XCVT card is replaced with a XC10G card.

Cisco does not support configurations of unmatched cross-connect cards in Slot 8 and Slot 10, although
this situation could briefly occur during the upgrade process.

The cross-connect card you are replacing should not be the active card. (It can be in SBY state or
otherwise not in use.)

During an upgrade, this condition occurs and is raised as its default severity, Not Alarmed (NA).
However, after the upgrade has occurred, if you wish to change the condition’s severity so that it is
Not Reported (NR), you can do this by modifying the alarm profile used at the node. For more
information about modifying alarm severities, refer to the “Manage Alarms” chapter in the

Cisco ONS 15454 Procedure Guide.

Clear the CTNEQPT-MISMATCH Condition

Step 1

Step 2
Step 3

Determine what kind of card is preprovisioned in the slot:
a. In node view, click the Inventory tab.
b. View the information for the slot in the Eqpt Type and Actual Eqpt Type columns.

The Eqpt Type column contains the equipment that is provisioned in the slot. The Actual Eqpt Type
contains the equipment that is physically present in the slot. For example, Slot 8 could be
provisioned for an XCVT card, which is shown in the Eqpt Type column, but an XC10G XC10G
card could be physically present in the slot. The XC10G would be shown in the Actual Eqpt Type
column.

Complete the “Physically Replace a Traffic Card” procedure on page 2-250 for the mismatched card.

If the condition does not clear, log onto http://www.cisco.com/techsupport for more information or call
Cisco TAC 1 800 553-2447.
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2.7.65 CTNEQPT-PBPROT

~

Note

A

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Interconnection Equipment Failure Protect Cross-Connect Card Payload Bus Alarm indicates a
failure of the main payload between the protect ONS 15454 Slot 10 XC10G card and the reporting traffic
card. The cross-connect card and the reporting card are no longer communicating through the backplane.
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the
backplane.

This alarm automatically raises and clears when the Slot 8§ XC10G card is reseated.

Caution

A software update on a standby TCC2/TCC2P can take up to 30 minutes.

Clear the CTNEQPT-PBPROT Alarm

Step 1

A

If all traffic cards show CTNEQPT-PBPROT alarm, complete the following steps:

a. Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-249 for the standby TCC2/TCC2P.

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on
page 2-250 for the standby TCC2/TCC2P.

Caution Do not physically reseat an active TCC2/TCC2P. Doing so disrupts traffic.

Step2  If not all cards show the alarm, perform a CTC reset on the standby XC10G card. Complete the “Reset
a Traffic Card in CTC” procedure on page 2-247. For the LED behavior, see the “2.8.2 Typical Traffic
Card LED Activity During Reset” section on page 2-237.

Step3  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the cross-connect reset is not complete and error-free or if the TCC2/TCC2P reboots automatically,
call Cisco TAC 1 800 553-2447.

Step4  If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the standby OC-192 card.

Step5  Determine whether the card is an active card or standby card in a protection group. Click the node view
Maintenance > Protection tabs, then click the protection group. The cards and their status are displayed
in the list.

Step6  If the reporting traffic card is the active card in the protection group, complete the “Initiate a 1:1 Card
Switch Command” procedure on page 2-242. After you move traffic off the active card, or if the
reporting card is standby, continue with the following steps.

Step7  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 on the reporting card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Step8  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
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Step 9

Step 10
Step 11

Step 12

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the reporting card.

Complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-242 to switch traffic back.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting traffic card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.66 CTNEQPT-PBWORK

~

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Interconnection Equipment Failure Working Cross-Connect Card Payload Bus alarm indicates a
failure in the main payload bus between the ONS 15454 Slot 8 XC10G card and the reporting traffic
card. The cross-connect card and the reporting card are no longer communicating through the backplane.
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the
backplane.

This alarm automatically raises and clears when the ONS 15454 Slot 10 XC10G card is reseated.

Clear the CTNEQPT-PBWORK Alarm

Step 1

A

If all traffic cards show CTNEQPT-PBWORK alarm, complete the following steps:

a. Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-247 for the active TCC2/TCC2P and then complete the “Remove and Reinsert (Reseat) the
Standby TCC2/TCC2P Card” procedure on page 2-249.

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on
page 2-250 for the TCC2/TCC2P.

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Step 2

Step 3

Step 4

Do not physically reseat an active TCC2/TCC2P; it disrupts traffic.

If all cards do not show the alarm, complete the “Side Switch the Active and Standby Cross-Connect
Cards” procedure on page 2-248 for the active XC10G card.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
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Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

2767 DATAFLT W

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the standby cross-connect card.

If the alarm does not clear and the reporting traffic card is the active card in the protection group,
complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-242. If the card is standby, or
if you have moved traffic off the active card, proceed with the following steps.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-250 for the reporting card.

If you switched traffic, complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-242 to
revert the traffic.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the OC-192 card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting traffic card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.67 DATAFLT

A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Software Data Integrity Fault alarm occurs when the TCC2/TCC2P exceeds its flash memory
capacity.

Caution  When the system reboots, the last configuration entered is not saved.
Clear the DATAFLT Alarm
Step1  Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-247.
Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC 1 800 553-2447.

2.7.68 DBOSYNC

Default Severity: Major (MJ), Service-Affecting (SA)
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SONET Logical Object: NE

The Standby Database Out Of Synchronization alarm occurs when the standby TCC2/TCC2P database
does not synchronize with the active database on the active TCC2/TCC2P.

A

Caution  If you reset the active TCC2/TCC2P while this alarm is raised, you lose current provisioning.

Clear the DBOSYNC Alarm

Step 1 Save a backup copy of the active TCC2/TCC2P database. Refer to the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide for procedures.

Step2  Make a minor provisioning change to the active database to see if applying a provisioning change clears
the alarm:

a. Innode view, click the Provisioning > General > General tabs.
b. In the Description field, make a small change such as adding a period to the existing entry.

The change causes a database write but does not affect the node state. The write could take up to a
minute.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.69 DISCONNECTED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The Disconnected alarm is raised when CTC has been disconnected from the node. The alarm clears
when CTC reconnects to the node.

Clear the DISCONNECTED Alarm

Step 1 Restart CTC.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.1.10 DS3-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3
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The DS-3 Frame Format Mismatch condition indicates a frame format mismatch on a signal transiting
the ONS 15454 DS3XM-6, DS3XM-12, or DS3/EC1-48 card. The condition occurs when the
provisioned line type and incoming signal frame format type do no match. For example, if the line type
for a DS3XM-6 card is set to C Bit and the incoming signal frame format is detected as M 13, then the
ONS 15454 reports a DS3-MISM condition.

Clear the DS3-MISM Condition

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Step 7

Display the CTC card view for the reporting DS3XM-6, DS3XM-12, or DS3/EC1-48 card.
Click the Provisioning > Line tabs.

For the row on the appropriate port, verify that the Line Type column is set to match the expected
incoming signal (C Bit or M13).

If the Line Type field does not match the expected incoming signal, select the correct Line Type in the
drop-down list.

Click Apply.

If the condition does not clear after the user verifies that the provisioned line type matches the expected
incoming signal, use an optical test set to verify that the actual signal coming into the ONS 15454
matches the expected incoming signal. For specific procedures to use the test set equipment, consult the
manufacturer.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.711 DSP-COMM-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.72 DSP-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.13 DUP-IPADDR

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: NE

The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the
same DCC area. When this happens, CTC no longer reliably connects to either node. Depending on how
the packets are routed, CTC could connect to either node (having the same IP address). If CTC has
connected to both nodes before they shared the same address, it has two distinct NodeModel instances
(keyed by the node ID portion of the MAC address).
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Clear the DUP-IPADDR Alarm

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

Isolate the alarmed node from the other node having the same address:

a. Connect to the alarmed node using the Craft port on the TCC2/TCC2P card.
b. Begin a CTC session.

c. In the login dialog window, uncheck the Network Discovery check box.

In node view, click the Provisioning > Network > General tabs.

In the IP Address field, change the IP address to a unique number.

Click Apply.

Restart any CTC sessions that are logged into either of the duplicate IP addresses. (For procedures to log
in or log out, refer to the “Connect the PC and Log Into the GUI” chapter in the Cisco ONS 15454
Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.74 DUP-NODENAME

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being
used within the same DCC area.

Clear the DUP-NODENAME Alarm

Step 1
Step 2
Step 3
Step 4

In node view, click the Provisioning > General > General tabs.
In the Node Name/TID field, enter a unique name for the node.
Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.75 DUP-SHELF-ID

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.76 EHIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
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SONET Logical Object: PWR

The Extreme High Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input
voltage exceeds the extreme high power threshold. This threshold, with a default value of -56.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds.

Clear the EHIBATVG Alarm

Step 1
Step 2

The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.77 ELWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Extreme Low Voltage Battery alarm occurs in a —-48 VDC environment when a battery lead input
voltage falls below the extreme low power threshold. This threshold, with a default value of -40.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for

120 seconds.

Clear the ELWBATVG Alarm

Step 1
Step 2

The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.18 ENCAP-MISMATCH-P

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: STSTRM

The Encapsulation C2 Byte Mismatch Path alarm applies to ML-Series Ethernet cards and the CE-1000
card. It occurs when the first three following conditions are met and one of the last two is false:

e The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped unspecified).
e The received C2 byte is not 0x01 (equipped unspecified).
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Note

(This is in contrast to the “PLM-P” alarm on page 2-182, which must meet all five criteria.) For an
ENCAP-MISMATCH-P to be raised, there is a mismatch between the received and expected C2 byte,
with either the expected byte or received byte value being 0x01.

For example, an ENCAP-MISMATCH-P alarm is raised if a circuit created between two ML-Series or
between two CE-1000 cards has generic framing procedure (GFP) framing provisioned on one end and
high-level data link control (HDLC) framing with LEX encapsulation provisioned on the other. The GFP
framing card transmits and expects a C2 byte of 0x1B, while the HDLC framing card transmits and
expects a C2 byte of 0x01.

A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:

¢ Mode (HDLC, GFP-F)

¢ Encapsulation (LEX, HDLC, PPP)
e CRCssize (16 or 32)

e Scrambling state (on or off)

This alarm is demoted by a PLM-P or PLM-V condition.

By default, an ENCAP-MISMATCH-P alarm causes an ML-Series card or CE-1000 card data link to go
down. This behavior can be modified using the command line interface (CLI) command no pos trigger
defect encap.

For more information about the ML-Series Ethernet or CE-1000 cards, refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the ENCAP-MISMATCH-P Alarm

Step 1

Step 2

Step 3

Ensure that the correct framing mode is in use on the receive card:
a. In node view, double-click the receive ML-Series or CE-1000 card to open the card view.
b. Click the Provisioning > Card tabs.

c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the receiving
card:

a. Innode view, double-click the transmit ML-Series or CE-1000 card to open the card view.
b. Click the Provisioning > Card tabs.

c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

If the alarm does not clear, use the CLI to ensure that the remaining settings are correctly configured on
the ML-Series or CE-1000 card:

e Encapsulation

e CRC size

Cisco ONS 15454 Troubleshooting Guide, R7.0
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2.1.19 EOC

>

Warning

>

Warning

>

Warning

2279 eoc W

e Scrambling state

To open the interface, click the IOS tab and click Open IOS Command Line Interface (CLI). Refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full configuration command
sequences.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The SONET DCC Termination Failure alarm occurs when the ONS 15454 loses its DCC. Although this
alarm is primarily SONET, it can apply to DWDM. For example, the OSCM card can raise this alarm on
its OC-3 section overhead.

The SDCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS 15454
uses the DCC on the SONET section layer to communicate network management information.

On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note  If a circuit shows a partial state when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the EOC Alarm
Step 1 If the “LOS (DS1)” alarm on page 2-146 is also reported, complete the “Clear the LOS (OCN) Alarm”
procedure on page 2-153.
Cisco ONS 15454 Troubleshooting Guide, R7.0
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A

Caution

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the “SF-L” condition on page 2-202 is reported, complete the “Clear the SF-L Condition” procedure
on page 2-202.

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry SDCC traffic. For more information about fiber
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the

Cisco ONS 15454 Procedure Guide.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have in-service (IS-NR) ports. Verify that the ACT/SBY LED on each OC-N card is green.

When the LEDs on the OC-N cards are correctly illuminated, complete the “Verify or Create Node
Section DCC Terminations” procedure on page 2-252 to verify that the DCC is provisioned for the ports
at both ends of the fiber span.

Repeat Step 4 at the adjacent nodes.
If DCC is provisioned for the ends of the span, verify that the port is active and in service:
a. Confirm that the OC-N card shows a green LED in CTC or on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to open the card view.
c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and click IS
in the drop-down list. Click Apply.

~

Note If a portin the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

Caution

Step 8

Step 9

Step 10

Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for commonly used switching procedures.

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver. See the “1.12.3 OC-N Card Transmit and Receive Levels” section on
page 1-141 for non-DWDM card levels and refer to the Cisco ONS 15454 DWDM Reference Manual for
DWDM card levels.

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-247.
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Step 11

Step 12

Step 13
Step 14

2.7.80 EOC-L

>

Warning

>
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Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TCC2/TCC2P switches control to the standby TCC2/TCC2P. If the alarm clears
when the ONS 15454 node switches to the standby TCC2/TCC2P, the user can assume that the
previously active card is the cause of the alarm.

If the TCC2/TCC2P reset does not clear the alarm, delete the problematic SDCC termination:

a. From the View menu in card view, choose Go to Previous View if you have not already done so.
b. Click the Provisioning > Comm Channels > SDCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.

Recreate the SDCC termination. Refer to the “Turn Up Network™ chapter in the Cisco ONS 15454
Procedure Guide for procedures.

Verify that both ends of the DCC have been recreated at the optical ports.

If the alarm has not cleared, call Cisco TAC 1 800 553-2447. If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-249. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Traffic Card” procedure on page 2-250.

Default Severity: Minor (MN), Non-Service-Affecting (NSA) for OCN
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The Line DCC (LDCC) Termination Failure alarm occurs when the ONS 15454 loses its line data
communications channel (LDCC) termination. For example, the OSCM card can raise this alarm on its
OC-3 line overhead.

The LDCC consists of nine bytes, D4 through D12, in the SONET overhead. The bytes convey
information about OAM&P. The ONS 15454 uses the LDCCs on the SONET line layer to communicate
network management information.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning  Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
Cisco ONS 15454 Troubleshooting Guide, R7.0
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A

Warning

~

Note

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial status when the EOC or EOC-L alarm is raised, it occurs when the logical
circuit is in place. The circuit is able to carry traffic when the DCC termination issue is resolved. You
do not need to delete the circuit when troubleshooting this alarm.

Clear the EOC-L Alarm

Step 1
Step 2

2.1.81 EQPT

Complete the “Clear the EOC Alarm” procedure on page 2-77.

If the alarm has not cleared, call Cisco TAC 1 800 553-2447. If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-249. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Traffic Card” procedure on page 2-250.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: AICI-AEP, AICI-AIE, EQPT
DWDM Logical Object: PPM

An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the
EQPT alarm occurs with a BKUPMEMP alarm, refer to the “2.7.42 BKUPMEMP” section on
page 2-52. The BKUPMEMP procedure also clears the EQPT alarm.

This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is
the protect card, switching is inhibited and a“PROTNA” alarm on page 2-185 is raised. The standby path
generates a path-type alarm.

Clear the EQPT Alarm

Step 1

Step 2

Step 3

Step 4

If traffic is active on the alarmed port, you could need to switch traffic away from it. See the
“2.9.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-239 for commonly used
traffic-switching procedures.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card. For LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED status. A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a
standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-250 for the reporting card.
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Step5  If the physical reseat of the card fails to clear the alarm, complete the “Physically Replace a Traffic Card”
procedure on page 2-250 for the reporting card.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.82 EQPT-DIAG

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

An Equipment-Diagnostic Failure alarm indicates that a software or hardware failure has occurred on
the reporting card. This alarm can be raised against a traffic card or a cross-connect card.

Clear the EQPT-DIAG Alarm

Step 1 If traffic is active on the alarmed card, you could need to switch traffic away from it. Refer to the
“2.9.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-239 for procedures.

Step2  Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-250 for the alarmed card

Step3  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
if it is raised against a traffic card, or complete the “Physically Replace an In-Service Cross-Connect
Card” procedure on page 2-251 if the alarm is raised against the cross-connect card.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.83 EQPT-MISS

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN

The Replaceable Equipment or Unit Missing alarm is reported against the fan-tray assembly unit. It
indicates that the replaceable fan-tray assembly is missing or not fully inserted. It could also indicate
that the ribbon cable connecting the AIP to the system board is bad.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the EQPT-MISS Alarm

Step 1 If the alarm is reported against the fan, verify that the fan-tray assembly is present.

Step2  If the fan-tray assembly is present, complete the “Replace the Fan-Tray Assembly” procedure on
page 2-257.
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Step3  If no fan-tray assembly is present, obtain a fan-tray assembly and refer to the “Install the Fan-Tray
Assembly,” procedure in the Cisco ONS 15454 Procedure Guide.

Step4  If the alarm does not clear, replace the ribbon cable from the AIP to the system board with a known-good
ribbon cable.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.84 ERFI-P-CONN

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Three-Bit (Enhanced) Remote Failure Indication (ERFI) Path Connectivity condition is triggered on
DS-1, DS-3, or VT circuits when the “UNEQ-P” alarm on page 2-230 and the “TIM-P” alarm on
page 2-223 are raised on the transmission signal.

Clear the ERFI-P-CONN Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-230. This should clear the ERFI
condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.85 ERFI-P-PAYLD

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Three-Bit ERFI Path Payload condition is triggered on DS-1, DS-3, or VT circuits when the
“PLM-P” alarm on page 2-182 is raised on the transmission signal.

Clear the ERFI-P-PAYLD Condition

Step 1 Complete the “Clear the PLM-P Alarm” procedure on page 2-182. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.86 ERFI-P-SRVR

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Three-Bit ERFI Path Server condition is triggered on DS-1, DS-3, or VT circuits when the “AIS-P”
condition on page 2-35 or the “LOP-P” alarm on page 2-142 is raised on the transmission signal.

Clear the ERFI-P-SRVR Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-143. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.87 ERROR-CONFIG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Error in Startup Configuration alarm applies to the ML-Series Ethernet cards. These cards process
startup configuration files line by line. If one or more lines cannot be executed, the error causes the
ERROR-CONFIG alarm. ERROR-CONFIG is not caused by hardware failure.

The typical reasons for an errored startup file are:

e The user stored the configuration for one type of ML-Series card in the database and then installed
another type in its slot.

e The configuration file contained a syntax error on one of the lines.

Note  For information about provisioning the ML-Series Ethernet cards from the Cisco IOS interface, refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327.

Clear the ERROR-CONFIG Alarm

Step1  If you have a different type of ML-Series card specified in the startup configuration file than what you
have installed, create the correct startup configuration.

Follow the card provisioning instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Step2  Upload the configuration file to the TCC2/TCC2P:

a. In node view, right-click the ML-Series card graphic.

b. Choose I0OS Startup Config from the shortcut menu.

c. Click Local > TCC and navigate to the file location in the Open dialog box.
Step3  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247.
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Step 4

Step 5

Step 6

If the alarm does not clear or if your configuration file was correct according to the installed card, start
a Cisco IOS CLI for the card:

a. Right click the ML-Series card graphic in node view.
b. Choose Open IOS Connection from the shortcut menu.
A

Note  Open IOS Connection is not available unless the ML-Series card is physically installed in
the shelf.

Follow the card provisioning instructions in the Ethernet Card Sofiware Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 to correct the errored
configuration file line.

Execute the CLI command:

copy run start

The command copies the new card configuration into the database and clears the alarm.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.88 ETH-LINKLOSS

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Rear Panel Ethernet Link Removed condition, if enabled in the network defaults, is raised under the
following conditions:

¢ The node.network.general. AlarmMissingBackplaneLAN field in NE default is enabled.
¢ The node is configured as a gateway network element (GNE).

e The backplane LAN cable is removed.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the ETH-LINKLOSS Condition

Step 1

Step 2

To clear this condition, reconnect the backplane LAN cable. Refer to the “Install the Shelf and Backplane
Cable” chapter in the Cisco ONS 15454 Procedure Guide for procedures to install this cable.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.1.89 E-W-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

A Procedural Error Misconnect East/West Direction alarm occurs during BLSR setup, or when nodes in
a ring have slots misconnected. An east slot can be misconnected to another east slot, or a west slot can
be misconnected to another west slot. In most cases, the user did not connect the fibers correctly or the
ring provisioning plan was flawed. You can physically reconnect the cable to the correct slots to clear
the E-W-MISMATCH alarm. Alternately, you can delete and recreate the span in CTC to change the west
line and east line designations. The CTC method clears the alarm, but could change the traditional
east-west node connection pattern of the ring.

The E-W-MISMATCH alarm also appears during the initial set up of a ring with its east-west slots
configured correctly. If the alarm appears during the initial setup, the alarm clears itself shortly after the
ring setup is complete.

The lower-numbered slot at a node is traditionally labeled the west slot and the higher numbered slot is
labeled the east slot. For example, Slot 6 is west and Slot 12 is east.

The physical switch procedure is the recommend method of clearing the E-W-MISMATCH alarm. The
physical switch method reestablishes the logical pattern of connection in the ring. However, you can also
use CTC to recreate the span and identify the misconnected slots as east and west. The CTC method is
useful when the misconnected node is not geographically near the troubleshooter.

Clear the E-W-MISMATCH Alarm with a Physical Switch

Step 1 Diagram the ring setup, including nodes and spans, on a piece of paper or white board.

Step 2 In node view, click View > Go to Network View.

Step3  Click the circuit and click Edit. The network map detailed view window appears. This window contains
the node name, slot, and port for each end of each span.

Step4  Label each of the nodes on the diagram with the same name that appears on the network map.

Step5  Label the span ends on the diagram with the same information. For example, with
Node 1/Slot 12/Port 1—Node 2/Slot 6/Port 1 (2F BLSR OC48, ring name=0), label the end of the span
that connects Node 1 and Node 2 at the Node 1 end as Slot 12/Port 1. Label the Node 2 end of that same
span Slot 6/Port 1.

Step6  Repeat Steps 4 and 5 for each span on your diagram.

Step7  Label the highest slot at each node east and the lowest slot at each node west.

Step8 Examine the diagram. You should see a clockwise pattern of west slots connecting to east slots for each
span. Refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure
Guide for more information about cabling the system.

Step9  If any span has an east-to-east or west-to-west connection, physically switching the fiber connectors
from the card that does not fit the pattern to the card that continues the pattern should clear the alarm.
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A

Warning

>

Warning

>

Warning

Step 10

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

Clear the E-W-MISMATCH Alarm in CTC

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10

Log into the misconnected node. A misconnected node has both ring fibers connecting it to its neighbor
nodes misconnected.

Click the Maintenance > BLSR tabs.

From the row of information for the fiber span, complete the “Identify a BLSR Ring Name or Node ID
Number” procedure on page 2-238 to identify the node ID, ring name, and the slot and port in the
East Line column and West Line column. Record the above information.

Click View > Go to Network View.

Delete and recreate the BLSR:

a. Click the Provisioning > BLSR tabs.

b. Click the row from Step 3 to select it and click Delete.

c. Click Create.

d. Fill in the ring name and node ID from the information collected in Step 3.
e. Click Finish.

Display node view and click the Maintenance > BLSR tabs.

Change the West Line field to the slot you recorded for the East Line in Step 3.
Change the East Line field to the slot you recorded for the West Line in Step 3.
Click OK.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.
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2.7.90 EXCCOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Excess Collisions on the LAN alarm indicates that too many collisions are occurring between data
packets on the network management LAN, and communications between the ONS 15454 and CTC could
be affected. The network management LAN is the data network connecting the workstation running the
CTC software to the TCC2/TCC2P. The problem causing the alarm is external to the ONS 15454.

Troubleshoot the network management LAN connected to the TCC2/TCC2P for excess collisions. You
might need to contact the system administrator of the network management LAN to accomplish the
following steps.

Clear the EXCCOL Alarm

Step 1 Verify that the network device port connected to the TCC2/TCC2P has a flow rate set to 10 Mb,
half-duplex.

Step2  If the port has the correct flow rate and duplex setting, troubleshoot the network device connected to the
TCC2/TCC2P and the network management LAN.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.91 EXERCISE-RING-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Exercise Ring command issues ring protection switching of the requested channel without
completing the actual bridge and switch. The EXERCISE-RING-FAIL condition is raised if the
command was issued and accepted but the exercise did not take place.

Note  If the exercise command gets rejected due to the existence of a higher-priority condition in the ring,
EXERCISE-RING-FAIL is Not Reported (NR).

Clear the EXERCISE-RING-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-139, the “LOS (OCN)” alarm on
page 2-152, or a BLSR alarm.

Step2  Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-246.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.92 EXERCISE-SPAN-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Exercise Span command issues span switching of the requested channel without completing the
actual bridge and switch. The EXERCISE-SPAN-FAIL condition is raised if the command was issued
and accepted but the exercise did not take place.

Note If the exercise command gets rejected due to the existence of a higher-priority condition in the span or
ring, EXERCISE-SPAN-FAIL is Not Reported (NR).

Clear the EXERCISE-SPAN-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-139, the “LOS (OCN)” alarm on
page 2-152, or a BLSR alarm.

Step2  Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-246.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.93 EXT

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: ENVALRM

A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For
example, a door could be open or flooding could have occurred.

Clear the EXT Alarm

Step 1 In node view double-click the AIC-I card to open the card view.
Step2  Double-click the Maintenance > External Alarms tab.

Step3  Follow your standard operating procedure to remedy environmental conditions that cause alarms. The
alarm clears when the situation is remedied.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.94 EXTRA-TRAF-PREEMPT

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN
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An Extra Traffic Preempted alarm occurs on OC-N cards in two-fiber and four-fiber BLSRs when
low-priority traffic directed to the protect system has been preempted by a working system protection
switch.

Clear the EXTRA-TRAF-PREEMPT Alarm

Step 1
Step 2

Step 3

Step 4

Verify that the protection switch has occurred by checking the Conditions tab.

If a ring switch has occurred, clear the ring switch on the working system by following the appropriate
alarm in this chapter. For more information about protection switches, refer to the “2.9.2 Protection
Switching, Lock Initiation, and Clearing” section on page 2-239 or the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide.

If the alarm occurred on a four-fiber BLSR and the span switch occurred on this OC-N, clear the span
switch on the working system.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.95 FAILTOSW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Failure to Switch to Protection Facility condition occurs when a working or protect electrical or
optical facility switches to its companion port by using a MANUAL command. For example, if you
attempt to manually switch traffic from an unused protect port to an in-service working port, the switch
will fail (because traffic is already present on the working port) and you will see the FAILTOSW
condition.

Clear the FAILTOSW Condition

Step 1

Step 2

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

>
Note A higher-priority alarm is an alarm raised on the working DS-N card using the 1:N card

protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.

If the condition does not clear, replace the working electrical or optical card that is reporting the
higher-priority alarm by following the “Physically Replace a Traffic Card” procedure on page 2-250.
This card is the working electrical or optical card using the protect card and not reporting FAILTOSW.

Replacing the working electrical or optical card that is reporting the higher-priority alarm allows traffic
to revert to the working slot and the card reporting the FAILTOSW to switch to the protect card.
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Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.96 FAILTOSW-PATH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, VI-MON

The Fail to Switch to Protection Path condition occurs when the working circuit does not switch to the
protection circuit on a path protection. Common causes of the FAILTOSW-PATH alarm include a
missing or defective protect port, a lockout set on one of the path protection nodes, or path-level alarms
that would cause a path protection switch to fail including the “AIS-P” condition on page 2-35, the
“LOP-P” alarm on page 2-142, the “SD-P” condition on page 2-199, the “SF-P” condition on

page 2-203, and the “UNEQ-P” alarm on page 2-230.

The “LOF (OCN)” alarm on page 2-139, the “LOS (OCN)” alarm on page 2-152, the “SD-L” condition
on page 2-199, or the “SF-L” condition on page 2-202 can also occur on the failed path.

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

Step 1

Step 2

Step 3

Look up and clear the higher-priority alarm. Clearing this alarm frees the standby card and clears the
FAILTOSW-PATH condition. If the “AIS-P” condition on page 2-35, the “LOP-P” alarm on page 2-142,
the “UNEQ-P” alarm on page 2-230, the “SF-P” condition on page 2-203, the “SD-P” condition on
page 2-199, the “LOF (OCN)” alarm on page 2-139, the “LOS (OCN)” alarm on page 2-152, the “SD-L”
condition on page 2-199, or the “SF-L” condition on page 2-202 are also occurring on the reporting port,
complete the applicable alarm clearing procedure.

~

Note A higher-priority alarm is an alarm raised on the working electrical card using the 1:N card
protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.

If the condition does not clear, replace the active OC-N card that is reporting the higher-priority alarm.
Complete the “Physically Replace a Traffic Card” procedure on page 2-250. Replacing the active OC-N
card that is reporting the higher-priority alarm allows traffic to revert to the active slot. Reverting frees
the standby card, which can then take over traffic from the card reporting the lower-priority alarm and
the FAILTOSW-PATH condition.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.97 FAILTOSWR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
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The Fail to Switch to Protection Ring condition occurs when a ring switch did not complete because of
internal APS problems.

FAILTOSWR clears in any of the following situations:
e A physical card pull of the active TCC2/TCC2P (done under Cisco TAC supervision).
¢ A node power cycle.
¢ A higher-priority event such as an external switch command.
¢ The next ring switch succeeds.

e The cause of the APS switch (such as the “SD (DS1, DS3)” condition on page 2-196 or the “SF
(DS1, DS3)” condition on page 2-200) clears.

>

Warning  On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

>

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

A

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the FAILTOSWR Condition in a BLSR Configuration

Step 1 Perform the Exercise Ring command on the reporting card:

a. Click the Maintenance > BLSR tabs.

b. Click the row of the affected ring under the West Switch column.

c. Select Exercise Ring in the drop-down list.
Step 2 If the condition does not clear, from the view menu, choose Go to Network View.
Step3  Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.
Step4  If clearing other alarms does not clear the FAILTOSWR condition, log into the near-end node.
Step5  Click the Maintenance > BLSR tabs.

Step6  Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards and ports
are active and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED
indicates a standby card.

b. Double-click the card in CTC to open the card view.
c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.
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Step 7

Step 8

A

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

~

Note If a portin the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To
verify fiber continuity, follow site practices.

If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close
to the receiving card as possible.

Caution

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for commonly used switching procedures.

If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within
the OC-N card receiver specifications. The “1.12.3 OC-N Card Transmit and Receive Levels” section
on page 1-141 lists these specifications.

Repeat Steps 7 through 10 for any other ports on the card.

If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace
a Traffic Card” procedure on page 2-250 for the protect standby OC-N card.

If the condition does not clear after you replace the BLSR cards on the node one by one, repeat
Steps 4 through 12 for each of the nodes in the ring.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.98 FAILTOSWS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Failure to Switch to Protection Span condition signals an APS span switch failure. For a four-fiber
BLSR, a failed span switch initiates a ring switch. If the ring switch occurs, the FAILTOSWS condition
does not appear. If the ring switch does not occur, the FAILTOSWS condition appears. FAILTOSWS
clears when one of the following situations occurs:

¢ A physical card pull of the active TCC2/TCC2P done under Cisco TAC supervision.
e A node power cycle.
¢ A higher-priority event such as an external switch command occurs.

e The next span switch succeeds.
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e The cause of the APS switch (such as the “SD (DS1, DS3)” condition on page 2-196 or the “SF
(DS1, DS3)” condition on page 2-200) clears.

Clear the FAILTOSWS Condition

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Step 8

A

Perform the Exercise Span command on the reporting card:

a. Click the Maintenance > BLSR tabs.

b. Determine whether the card you would like to exercise is the west card or the east card.
c. Click the row of the affected span under the East Switch or West Switch column.

d. Select Exercise Span in the drop-down list.

If the condition does not clear, from the view menu, choose Go to Network View.

Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.
If clearing other alarms does not clear the FAILTOSWS condition, log into the near-end node.
Click the Maintenance > BLSR tabs.

Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards are active
and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED
indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

S,
Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To
verify fiber continuity, follow site practices.

If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close
to the receiving card as possible.

Caution  Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for commonly used switching procedures.

Step9  If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 10 If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within
the OC-N card receiver specifications. The “1.12.3 OC-N Card Transmit and Receive Levels” section
on page 1-141 lists these specifications.
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Step11  Repeat Steps 7 through 10 for any other ports on the card.

Step12  If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace
a Traffic Card” procedure on page 2-250 for the protect standby OC-N card.

Step13  If the condition does not clear after you replace the BLSR cards on the node one by one, follow
Steps 4 through 12 for each of the nodes in the ring.

Step 14  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.99 FAN

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN

The Fan Failure alarm indicates a problem with the fan-tray assembly. When the fan-tray assembly is not
fully functional, the temperature of the ONS 15454 can rise above its normal operating range.

The fan-tray assembly contains six fans and needs a minimum of five working fans to properly cool the
shelf. However, even with five working fans, the fan-tray assembly could need replacement because a
sixth working fan is required for extra protection against overheating.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the FAN Alarm

Step 1 Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-255.

Step2  If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-257.

Step3  If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-257. The fan should run immediately when correctly inserted.

Step4  If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem 1 800 553-2447.

2.7.100 FC-NO-CREDITS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, TRUNK
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The Fibre Channel Distance Extension Credit Starvation alarm occurs on storage access networking
(SAN) Fibre Channel/Fiber Connectivity (FICON) FC_MR-4 cards when the congestion prevents the
GFP transmitter from sending frames to the FC_MR-4 card port. For example, the alarm can be raised
when an operator configures a card to autodetect framing credits but the card is not connected to an
interoperable FC-SW-standards-based Fibre Channel/FICON port.

FC-NO-CREDITS is raised only if transmission is completely prevented. (If traffic is slowed but still
passing, this alarm is not raised.) The alarm is raised in conjunction with the GFP-NO-BUFFERS alarm.
For example, if the FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a
GFP-NO-BUFFERS alarm could be raised at the upstream remote FC_MR-4 data port.

Clear the FC-NO-CREDITS Alarm

Step1  If the port is connected to a Fibre Channel/FICON switch, make sure it is configured for interoperation
mode using the manufacturer’s instructions.

Step 2 If the port is not connected to a switch, turn off Autodetect Credits:
a. Double-click the FC_MR-4 card.
b. Click Provisioning > Port > General.
¢. Under Admin State, click the cell and choose OOS,MT.
d. Click Apply.
e. Click the Provisioning > Port > Distance Extension tabs.
f. Uncheck the Autodetect Credits column check box.
g. Click Apply.
h. Click Provisioning > Port > General.
i. Under Admin State, click the cell and choose IS.
j. Click Apply.

~

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

Step3  Program the Credits Available value based on the buffers available on the connected equipment:

~

Note  The NumCredits must be provisioned to a value smaller than or equal to the receive buffers or
credits available on the connected equipment.

a. Double-click the FC_MR-4 card.

b. Click the Provisioning > Port > Distance Extension tabs.
c. Enter a new value in the Credits Available column.

d. Click Apply.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.
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2.1.101 FDI

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.102 FE-AIS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End AIS condition occurs when an AIS has occurred at the far-end node. FE-AIS usually occurs
in conjunction with a downstream LOS alarm (see the “LOS (OCN)” alarm on page 2-152).

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the FE-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.103 FEC-MISM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.104 FE-DS1-MULTLOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End Multiple DS-1 LOS Detected condition occurs when multiple DS-1 signals are lost on a
far-end DS-1 card.

The prefix FE means the main alarm is occurring at the far-end node and not at the node reporting the
FE-DS1-MULTLOS condition. Troubleshoot the FE alarm or condition by troubleshooting the main
alarm at its source. The secondary alarms or conditions clear when the main alarm clears.
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Clear the FE-DS1-MULTLOS Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an ONS 15454 FE condition on a card in Slot 12 of Node 1 could relate to a
main alarm from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.105 FE-DS1-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end
DS-1 equipment failure occurs, but does not affect service because the port is protected and traffic is able
to switch to the protect port.

Clear the FE-DS1-NSA Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in an ONS 15454 Slot 12 of Node 1 could link to an alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.71.106 FE-DS1-SA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Service Affecting condition occurs when there is a far-end
equipment failure on a DS-1 card that affects service because traffic is unable to switch to the protect
port.
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Clear the FE-DS1-SA Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.107 FE-DS1-SNGLLOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End Single DS-1 LOS condition occurs when a single DS-1 signal is lost on far-end DS-1
equipment (within a DS3). Signal loss also causes the “LOS (OCN)” alarm on page 2-152.

Clear the FE-DS1-SNGLLOS Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could link to an alarm from
a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.108 FE-DS3-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end
ONS 15454 DS-3 equipment failure occurs in C-bit framing mode, but does not affect service because
the port is protected and traffic is able to switch to the protect port.
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Clear the FE-DS3-NSA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.109 FE-DS3-SA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Service Affecting condition occurs when there is a far-end
equipment failure on an ONS 15454 DS-3 card in C-bit framing mode that affects service because traffic
is unable to switch to the protect port.

Clear the FE-DS3-SA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.110 FE-EQPT-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End Common Equipment Failure condition occurs when a Non-Service-Affecting (NSA)
equipment failure is detected on far-end DS-3 equipment.
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Clear the FE-EQPT-NSA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.111 FE-FRCDWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Forced Switch Back to Working—Span condition is raised on a far-end 1+1 working port
when it is Force switched to the working port.

~

Note @ WKSWBK-type conditions apply only to revertive circuits.

Clear the FE-FRCDWKSWBK-SPAN Condition

Step 1 Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-240 for the far-end
port.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.112 FE-FRCDWKSWPR-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Ring Working Facility Forced to Switch to Protection condition occurs from a far-end node
when a BLSR is forced from working to protect using the Force Ring command. This condition is only
visible on the network view Conditions tab.
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Clear the FE-FRCDWKSWPR-RING Condition

Step 1

Step 2
Step 3
Step 4

Step 5

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Clear the main alarm.

If the FE-FRCDWKSWPR-RING condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.113 FE-FRCDWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Working Facility Forced to Switch to Protection Span condition occurs from a far-end node
when a span on a four-fiber BLSR is forced from working to protect using the Force Span command.
This condition is only visible on the network view Conditions tab. The port where the Force Switch
occurred is indicated by an “F” on the network view detailed circuit map. This condition is accompanied
by WKSWPR.

Clear the FE-FRCDWKSWPR-SPAN Condition

Step 1

Step 2
Step 3
Step 4

Step 5

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Clear the main alarm.

If the FE-FRCDWKSWPR-SPAN condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.114 FE-IDLE

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End Idle condition occurs when a far-end node detects an idle DS-3 signal in C-bit framing
mode.
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Clear the FE-IDLE Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm by clearing the protection switch. See the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for commonly used traffic-switching procedures.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.71.115 FE-LOCKOUTOFPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far-End Lock Out of Protection Span condition occurs when a BSLR span is locked out of the
protection system from a far-end node using the Lockout Protect Span command. This condition is only
seen on the network view Conditions tab and is accompanied by LKOUTPR-S. The port where the
lockout originated is marked by an “L” on the network view detailed circuit map.

Clear the FE-LOCKOUTOFPR-SPAN Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Ensure there is no lockout set. Complete the “Clear a BLSR External Switching Command” procedure
on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.116 FE-LOF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End LOF condition occurs when a far-end node reports the “LOF (DS3)” alarm on page 2-137
in C-bit framing mode.
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Clear the FE-LOF Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-136. It also applies to FE-LOF.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.117 FE-LOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End LOS condition occurs in C-bit framing mode when a far-end node reports the “LOS (DS3)”
alarm on page 2-147.

Clear the FE-LOS Condition

Step1  To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2 Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear the LOS (DS1) Alarm” procedure on page 2-146.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.118 FE-MANWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Manual Switch Back to Working—Span condition occurs when a far-end span with a
Manual switch reverts to working.

~

Note  WKSWBK-type conditions apply only to nonrevertive circuits.
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Clear the FE-EMANWKSWBK-SPAN Condition

Step 1

Step 2
Step 3
Step 4

To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.119 FE-MANWKSWPR-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Ring Manual Switch of Working Facility to Protect condition occurs when a BLSR working
ring is switched from working to protect at a far-end node using the Manual Ring command.

Clear the FEEMANWKSWPR-RING Condition

Step 1

Step 2
Step 3
Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.120 FE-MANWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far-End Span Manual Switch Working Facility to Protect condition occurs when a four-fiber BLSR
span is switched from working to protect at the far-end node using the Manual Span command. This
condition is only visible on the network view Conditions tab and is accompanied by WKSWPR. The port
where the Manual Switch occurred is indicated by an “M” on the network view detailed circuit map.
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Clear the FE-FMANWKSWPR-SPAN Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear a BLSR External Switching Command” alarm on page 2-246.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.121 FEPRLF

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Protection Line Failure alarm occurs when an APS channel “SF-L” condition on page 2-202
occurs on the protect card coming into the node.

Note  The FEPRLF alarm occurs when bidirectional protection is used on optical cards in a 1+1 protection
group configuration or four-fiber BLSR configuration.

Clear the FEPRLF Alarm on a Four-Fiber BLSR

Step1  To troubleshoot the FE alarm, determine which node and card link directly to the card reporting the FE
alarm. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm from a
card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter in this chapter for procedures.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.122 FIBERTEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.123 FORCED-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, STSMON, VI-MON
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The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a
port to force traffic from a working port to a protect port or protection span (or from a protect port to a
working port or span). You do not need to clear the condition if you want the Force switch to remain.

Clear the FORCED-REQ Condition

Step 1 Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-240.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.71.124 FORCED-REQ-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Force Switch Request Ring condition applies to optical trunk cards when the Force Ring command
is applied to BLSRs to move traffic from working to protect. This condition is visible on the network
view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where the
FORCE RING command originated is marked with an “F” on the network view detailed circuit map.

Clear the FORCED-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.71.125 FORCED-REQ-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Force Switch Request Span condition applies to optical trunk cards in two-fiber or four-fiber BLSRs
when the Force Span command is applied to a BLSR SPAN to force traffic from working to protect or
from protect to working. This condition appears on the network view Alarms, Conditions, and History
tabs. The port where the FORCE SPAN command was applied is marked with an “F” on the network
view detailed circuit map.

This condition can also be raised in 1+1 facility protection groups. If traffic is present on a working port
and you use the FORCE command to prevent it from switching to the protect port (indicated by
“FORCED TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this case, the force
is affecting not only the facility, but the span.
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Clear the FORCED-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.126 FRCDSWTOINT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Force Switch to Internal Timing condition occurs when the user issues a Force command to switch
to an internal timing source.

~

Note FRCDSWTOINT is an informational condition and does not require troubleshooting.

2.7.127 FRCDSWTOPRI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Primary Timing Source condition occurs when the user issues a Force command to
switch to the primary timing source.

~

Note FRCDSWTOPRI is an informational condition and does not require troubleshooting.

2.7.128 FRCDSWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Second Timing Source condition occurs when the user issues a Force command to
switch to the second timing source.

~

Note FRCDSWTOSEC is an informational condition and does not require troubleshooting.

2.7.129 FRCDSWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF
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The Force Switch to Third Timing Source condition occurs when the user issues a Force command to
switch to a third timing source.

S

Note FRCDSWTOTHIRD is an informational condition and does not require troubleshooting.

2.7.130 FRNGSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Free Running Synchronization Mode condition occurs when the reporting ONS 15454 is in free-run
synchronization mode. External timing sources have been disabled and the node is using its internal
clock, or the node has lost its designated building integrated timing supply (BITS) timing source. After
the 24-hour holdover period expires, timing slips could begin to occur on an ONS 15454 node relying
on an internal clock.

~

Note  If the ONS 15454 is configured to operate from its internal clock, disregard the FRNGSYNC condition.

Clear the FRNGSYNC Condition

Step 1 If the ONS 15454 is configured to operate from an external timing source, verify that the BITS timing
source is valid. Common problems with a BITS timing source include reversed wiring and bad timing
cards. Refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step2  If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference
sources, such as the “SYNCPRI” alarm on page 2-219 and the “SYNCSEC” alarm on page 2-220.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.131 FSTSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

A Fast Start Synchronization Mode condition occurs when the node is choosing a new timing reference.
The previous timing reference has failed.

The FSTSYNC alarm disappears after approximately 30 seconds. If the condition does not clear, log into
the Technical Support Website at http://www.cisco.com/techsupport for more information or call
Cisco TAC 1 800 553-2447.

Note FSTSYNC is an informational condition. It does not require troubleshooting.
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2.7.132 FULLPASSTHR-BI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Bidirectional Full Pass-Through Active condition occurs on a nonswitching node in a BLSR when
the protect channels on the node are active and carrying traffic and there is a change in the receive K byte
from No Request.

Clear the FULLPASSTHR-BI Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.133 GAIN-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.134 GAIN-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.135 GAIN-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.136 GAIN-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.71.137 GCC-EOC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.138 GE-O0SYNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.139 GFP-CSF

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP Client Signal Fail Detected alarm is a secondary alarm raised on local GFP data ports when a
remote Service-Affecting (SA) alarm causes invalid data transmission. The alarm is raised locally on
FC_MR-4, ML100T, ML1000, ML100X-8, MXP_MR_25G, and MXPP_MR_25G GFP data ports and
does not indicate that a Service-Affecting (SA) failure is occurring at the local site, but that a CARLOSS,
LOS, or SYNCLOSS alarm caused by an event such as a pulled receive cable is affecting a remote data
port's transmission capability. This alarm can be demoted when a facility loopback is placed on the
FC_MR-4 port.

For more information about provisioning MXP or TXP cards, refer to the Cisco ONS 15454 DWDM
Reference Manual. For more information about Ethernet cards, refer to the Ethernet Card Software
Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and

Cisco ONS 15327.

Clear the GFP-CSF Alarm

Step 1
Step 2

Clear the Service-Affecting (SA) alarm at the remote data port.

If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.

2.7.140 GFP-DE-MISMATCH

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Mismatch alarm indicates that a port configured for
Distance Extension is connected to a port that is not operating in Cisco's proprietary Distance Extension
mode. It is raised on Fibre Channel and FICON card GFP ports supporting distance extension. The alarm
occurs when distance extension is enabled on one side of the transport but not on the other. To clear,
distance extension must be enabled on both ports connected by a circuit.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the GFP-DE-MISMATCH Alarm

Step1  Ensure that the distance extension protocol is configured correctly on both sides:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > General tabs.

¢. Under Admin State, click the cell and choose OOS,MT.
d. Click Apply.

e. Click the Provisioning > Port > Distance Extension tabs.

f. Check the check box in the Enable Distance Extension column.
g. Click Apply.

h. Click the Provisioning > Port > General tabs.

i. Under Admin State, click the cell and choose IS.

j. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

Step2  If the GFP-DE-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.

2.1.141 GFP-EX-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE1000, FCMR, GFP-FAC

The GFP Extension Header Mismatch alarm is raised on Fibre Channel/FICON cards when it receives
frames with an extension header that is not null. The alarm occurs when a provisioning error causes all
GFP frames to be dropped for 2.5 seconds.

Ensure that both end ports are sending a null extension header for a GFP frame. The FC_MR-4 card
always sends a null extension header, so if the equipment is connected to other vendors’ equipment,
those need to be provisioned appropriately.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-EX-MISMATCH Alarm

Step1  Ensure that the vendor equipment is provisioned to send a null extension header in order to interoperate
with the FC_MR-4 card. (The FC_MR-4 card always sends a null extension header.)
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Step2  If the GFP-EX-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.

2.7.142 GFP-LFD

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP Loss of Frame Delineation alarm applies to Fibre Channel, FICON GFP, and Ethernet ports.
This alarm occurs if there is a faulty SONET connection, if SONET path errors cause GFP header errors
in the check sum calculated over payload length (PLI/cHEC) combination, or if the GFP source port
sends an invalid PLI/cHEC combination. This loss causes traffic stoppage.

Note  For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-LFD Alarm

Step 1 Look for and clear any associated SONET path errors such as LOS or AIS-L originating at the transmit
node.

Step2  If the GFP-LFD alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.

2.7.143 GFP-NO-BUFFERS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Buffer Starvation alarm is raised on Fibre Channel/FICON
card ports supporting GFP and the distance extension protocol when the GFP transmitter cannot send
GFP frames due to lack of remote GFP receiver buffers. This occurs when the remote GFP-T receiver
experiences congestion and is unable to send frames over the Fibre Channel/FICON link.

This alarm could be raised in conjunction with the FC-NO-CREDITS alarm. For example, if the
FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a GFP-NO-BUFFERS alarm could be
raised at the upstream remote FC_MR-4 data port.

Note  For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the GFP-NO-BUFFERS Alarm

Step 1 Complete the “Clear the FC-NO-CREDITS Alarm” procedure on page 2-95.

Step2  If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.71.144 GFP-UP-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP User Payload Mismatch is raised against Fibre Channel/FICON ports supporting GFP. It occurs
when the received frame user payload identifier (UPI) does not match the transmitted UPI and all frames
are dropped. The alarm is caused by a provisioning error, such as the port media type not matching the
remote port media type. For example, the local port media type could be set to Fibre Channel—1 Gbps
ISL or Fibre Channel—2 Gbps ISL and the remote port media type could be set to FICON—1 Gbps ISL
or FICON—2 Gbps ISL.

Fte For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-UP-MISMATCH Alarm

Step1  Ensure that the transmit port and receive port are identically provisioned for distance extension by
completing the following steps:

a. Double-click the card to open the card view.
b. Click the Provisioning > Port > Distance Extension tabs.
c. Check the check box in the Enable Distance Extension column.
d. Click Apply.
Step2  Ensure that both ports are set for the correct media type. For each port, complete the following steps:
a. Double-click the card to open the card view (if you are not already in card view).
b. Click the Provisioning > Port > General tabs.

c. Choose the correct media type (Fibre Channel - 1Gbps ISL, Fibre Channel - 2 Gbps ISL,
FICON - 1 Gbps ISL, or FICON - 2 Gbps ISL) from the drop-down list.

d. Click Apply.

Step3  If the GFP-UP-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a
Service-Affecting (SA) problem.
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2.7.145 HELLO

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Open Shortest Path First (OSPF) Hello alarm is raised when the two end nodes cannot bring an
OSPF neighbor up to the full state. Typically, this problem is caused by an area ID mismatch, and/or an
OSPF HELLO packet loss over the DCC.

Clear the HELLO Alarm

Step 1 Ensure that the area ID is correct on the missing neighbor:
a. Innode view, click the Provisioning > Network > OSPF tabs.
b. Ensure that the IP address in the Area ID column matches the other nodes.
c. If the address does not match, click the incorrect cell and correct it.
d. Click Apply.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.146 HIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The High Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input voltage
exceeds the high power threshold. This threshold, with a default value of —-52 VDC, is
user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the HIBATVG Alarm

Step1  The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.147 HI-CCVOLT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: BITS
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The 64K Composite Clock High NE Voltage alarm occurs when the 64K signal peak voltage exceeds
1.1 VDC.

Clear the HI-CCVOLT Condition

Step 1

Step 2

Step 3

Lower the source voltage to the clock.
If the condition does not clear, add more cable length or add a 5 dBm attenuator to the cable.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.148 HI-LASERBIAS

Note

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM

The Equipment High Transmit Laser Bias Current alarm is raised against TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, OC192-XFP, OC3 IR/STM1 SH
1310-8, OC192 SR/STM64 10 1310, OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xX.XX,
or MRC-12 card laser performance. The alarm indicates that the card laser has reached the maximum
laser bias tolerance.

Laser bias typically starts at about 30 percent of the manufacturer maximum laser bias specification and
increases as the laser ages. If the HI-ILASERBIAS alarm threshold is set at 100 percent of the maximum,
the laser usability has ended. If the threshold is set at 90 percent of the maximum, the card is still usable
for several weeks or months before it needs to be replaced.

When there is a HI-LASERBIAS alarm on the OC3 IR/STM1 SH 1310-8, OC192 SR/STM64 10 1310,
OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xx.x, or MRC-12 cards, the alarm is reported
at the card equipment level, not the port equipment level. However, on cards with PPMs, the alarms are
reported at the port level. So the end result is that the alarms are reported at different levels (port or card
equipment), depending on if the port has a replaceable PPM or is a fixed-rate port with no PPM. Because
the alarm cannot be isolated to a specific port from the alarm indication on the four cards mentioned,
when the HI-LASERBIAS alarm occurs and cannot be cleared, it is recommended to change out the
entire card (see the procedure in this section).

To see which port on a card is having possible performance problems that may be causing the alarm, see
DLP-A507 in the DLPs A500 to A599 chapter of the Cisco ONS 15454 Procedure Guide, R7.0. To
change how the performance monitoring (PM) parameters are displayed, see NTP-A253 in the Monitor
Performance chapter of the Cisco ONS 15454 Procedure Guide, R7.0.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.
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Clear the HI-LASERBIAS Alarm

Step1  Complete the “Clear the LASEREOL Alarm” procedure on page 2-130, which can include replacing the
card. Replacement is not urgent and can be scheduled during a maintenance window.

Caution Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.9.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-239 for commonly used traffic-switching procedures.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.149 HI-LASERTEMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM

The Equipment High Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
HI-LASERTEMP occurs when the internally measured transceiver temperature exceeds the card setting
by 35.6 degrees F (2 degrees C). A laser temperature change affects the transmitted wavelength.

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)”
alarm on page 2-152 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-73 is raised
at the near end.

Note  For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the HI-LASERTEMP Alarm

Step 1 In node view, double-click the TXP or MXP card to open the card view.
Step2  Click the Performance > Optics PM > Current Values tabs.

Step3  Verify the card laser temperature levels. Maximum, minimum, and average laser temperatures are shown
in the Current column entries in the Laser Temp rows.

Step4d  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the MXP or TXP card.

Step5  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting MXP or TXP card.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.
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2.7.150 HI-RXPOWER

Note

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC

The Equipment High Receive Power alarm is an indicator of the optical signal power that is transmitted
to the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, or
0OC192-XFP card. HI-RXPOWER occurs when the measured optical power of the received signal
exceeds the threshold. The threshold value is user-provisionable.

When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted
optical power (OPRO) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn
Up aNode” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC
uses the new OPRO value to calculate PM percentage values. If you do not change the nominal value, the
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the HI-RXPOWER Alarm

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Find out whether gain (the amplification power) of any amplifiers has been changed. This change also
causes channel power to need adjustment.

Find out whether channels have been dropped from the fiber. Increasing or decreasing channels can
affect power. If channels have been dropped, the power levels of all channels have to be adjusted.

~

Note  If the card is part of an amplified DWDM system, dropping channels on the fiber affects the
transmission power of each channel more than it would in an unamplified system.

At the transmit end of the errored circuit, decrease the transmit power level within safe limits.

If neither of these problems cause the HI-RXPOWER alarm, there is a slight possibility that another
wavelength is drifting on top of the alarmed signal. In this case, the receiver gets signals from two
transmitters at the same time and data alarms would be present. If wavelengths are drifting, the data is
garbled and receive power increases by about +3 dBm.

If the alarm does not clear, add fiber attenuators to the receive ports. Start with low-resistance attenuators
and use stronger ones as needed, depending on factors such as the transmission distance, according to
standard practice.

If the alarm does not clear and no faults are present on the other port(s) of the transmit or receive card,
use a known-good loopback cable to complete the “1.6.1 Perform a Facility Loopback on a
Source-Node FC_MR Port” procedure on page 1-87 and test the loopback.
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Step 7

Step 8

If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic
Card” procedure on page 2-250. If the port is bad but you can move the traffic to another port, replace
the card at the next available maintenance window.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.151 HITEMP

Default Severity: Critical (CR), Service-Affecting (SA) for NE; Default Severity: Minor (MN),
Non-Service-Affecting (NSA) for EQPT

SONET Logical Objects: EQPT, NE

The High Temperature alarm occurs when the temperature of the ONS 15454 is above 122 degrees F
(50 degrees C).

Clear the HITEMP Alarm

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-2).

Figure 2-2 Shelf LCD Panel
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Verify that the environmental temperature of the room is not abnormally high.

If the room temperature is not abnormal, physically ensure that nothing prevents the fan-tray assembly
from passing air through the ONS 15454 shelf.

If airflow is not blocked, physically ensure that blank faceplates fill the ONS 15454 shelf empty slots.
Blank faceplates help airflow.

If faceplates fill the empty slots, determine whether the air filter needs replacement. Refer to the
“Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-255.

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-257.

~

Note  The fan should run immediately when correctly inserted.

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem 1 800 553-2447 if it applies to the NE, or a

Non-Service-Affecting (NSA) problem if it applies to equipment.
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2.7.152 HI-TXPOWER

Note

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM

The Equipment High Transmit Power alarm is an indicator on the TXP_MR_E, TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, OC192-XFP, OC3 IR/STM1 SH 1310-8, OC192
SR/STM64 10 1310, OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xx.xX, and MRC-12
card transmitted optical signal power. HI-TXPOWER occurs when the measured optical power of the
transmitted signal exceeds the threshold.

When there is a HI-TXPOWER alarm on the OC3 IR/STM1 SH 1310-8, OC192 SR/STM64 10 1310,
0OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xx.xx, or MRC-12 cards, the alarm is
reported at the card equipment level, not the port equipment level. However, on cards with PPMs, the
alarms are reported at the port level. So the end result is that the alarms are reported at different levels
(port or card equipment), depending on if the port has a replaceable PPM or is a fixed-rate port with no
PPM. Because the alarm cannot be isolated to a specific port from the alarm indication on the four cards
mentioned, when the HI-TXPOWER alarm occurs and cannot be cleared, it is recommended to change
out the entire card (see the procedure in this section).

To see which port on a card is having possible performance problems that may be causing the alarm, see
DLP-A507 in the DLPs A500 to A599 chapter of the Cisco ONS 15454 Procedure Guide, R7.0. To
change how the performance monitoring (PM) parameters are displayed, see NTP-A253 in the Monitor
Performance chapter of the Cisco ONS 15454 Procedure Guide, R7.0.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the HI-TXPOWER Alarm

Step 1

Step 2
Step 3
Step 4

Step 5

In node view, double-click the card view for the TXP_MR_10E, TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, or OC192-XFP card.

Click the Provisioning > Optics Thresholds > Current Values tabs.
Decrease (change toward the negative direction) the OPT-HIGH column value by 0.5 dBm.

If the card transmit power setting cannot be lowered without disrupting the signal, complete the
“Physically Replace a Traffic Card” section on page 2-250.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.153 HLDOVRSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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SONET Logical Object: NE-SREF

The Holdover Synchronization Mode condition is caused by loss of the primary and second timing
references in the node. Timing reference loss occurs when line coding on the timing input is different
from the configuration on the node, and it often occurs during the selection of a new node reference
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover
period expires, timing slips could begin to occur on an ONS 15454 relying on an internal clock.

Clear the HLDOVRSYNC Condition

Step 1

Step 2

Step 3

Clear additional alarms that relate to timing, such as:
e 2.7.130 FRNGSYNC, page 2-108
e 2.7.131 FSTSYNC, page 2-108
e 2.7.180 LOF (BITS), page 2-135
e 2.7.197 LOS (BITS), page 2-145
e 2.7.245 MANSWTOINT, page 2-167
e 2.7.246 MANSWTOPRI, page 2-167
e 2.7.247 MANSWTOSEC, page 2-167
e 2.7.248 MANSWTOTHIRD, page 2-168
e 2.7.371 SWTOPRI, page 2-217
e 2.7.372 SWTOSEC, page 2-217
e 2.7.373 SWTOTHIRD, page 2-217
e 2.7.374 SYNC-FREQ, page 2-218
e 2.7.376 SYNCPRI, page 2-219
e 2.7.377 SYNCSEC, page 2-220
e 2.7.378 SYNCTHIRD, page 2-220

Reestablish a primary and secondary timing source according to local site practice. If none exists, refer
to the “Change Node Settings” chapter in the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to
report a Service-Affecting (SA) problem.

2.1.154 1-HITEMP

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: NE

The Industrial High Temperature alarm occurs when the temperature of the ONS 15454 is above 149
degrees F (65 degrees C) or below —40 degrees F (—40 degrees C). This alarm is similar to the HITEMP
alarm but is used for the industrial environment. If this alarm is used, you can customize your alarm
profile to ignore the lower-temperature HITEMP alarm.
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Clear the I-HITEMP Alarm

Step 1 Complete the “Clear the HITEMP Alarm” procedure on page 2-118.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.7.155 INCOMPATIBLE-SEND-PDIP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The Incompatible Software alarm is raised when the PDIP provisioning on CTC differs from the
provisioning on the host node.

Clear the INCOMPATIBLE-SEND-PDIP Alarm

Step1  Reconfigure the send-PDI-P-alarm capability in CTC to align with the host node settings.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.7.156 INCOMPATIBLE-SW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The Incompatible Software alarm is raised when CTC cannot connect to the NE due to incompatible
versions of software between CTC and the NE. The alarm is cleared by restarting CTC in order to
redownload the CTC jar files from the NE.

Clear the INCOMPATIBLE-SW Alarm

Step1  Restart the CTC application.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.7.157 IMPROPRMVL

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT
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DWDM Logical Object: PPM
The Improper Removal equipment IMPROPRMVL) alarm occurs under the following conditions:

e A card is removed when the card was rebooting. It is recommended that after the card completely
reboots, delete the card in CTC and only then remove the card physically. When you delete the card,
CTC loses connection with the node view (single-shelf mode) or shelf view (multishelf mode), and
goes to network view.

e When a card is physically removed from its slot before it is deleted from CTC. It is recommended
that any card be deleted in CTC before physically removing the card from the chassis.

~

Note  CTC provides the user approximately 15 seconds to physically remove the card before it begins
rebooting the card.
It can take up to 30 minutes for software to be updated on a standby TCC2/TCC2P card.

e A card is inserted into a slot but is not fully plugged into the backplane.
e A PPM (SFP) is provisioned but the physical module is not inserted into the port.

e Electrical issues such as short circuit or failure of DC-DC conversion.

Clear the IMPROPRMVL Alarm

Step 1
Step 2

Step 3

A

In node view, right-click the card reporting the IMPROPRMVL.
Choose Delete from the shortcut menu.

~

Note  CTC does not allow you to delete the reporting card if the card is in service, does have circuits
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing
reference.

If any ports on the card are in service, place them out of service (OOS,MT):

Caution

Step 4

A

Before placing a port out of service (OOS,MT or OOS,DSBLD), ensure that no live traffic is present.

a. In node view, double-click the reporting card to open the card view.
b. Click the Provisioning > Line tab.

c. Click the Admin State column of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-252.

Caution

Step 5

Before deleting the circuit, ensure that the circuit does not carry live traffic.

If the card is paired in a protection scheme, delete the protection group:
a. Click View > Go to Previous View to return to node view.
b. If you are already in node view, click the Provisioning > Protection tabs.

c. Click the protection group of the reporting card.

Cisco ONS 15454 Troubleshooting Guide, R7.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

Step 6

Step 7

Step 8

27158 INc-isD H

d. Click Delete.

If the card is provisioned for DCC, delete the DCC provisioning:

a. Click the ONS 15454 Provisioning > Comm Channels > SDCC tabs.
b. Click the slots and ports listed in DCC terminations.

c. Click Delete and click Yes in the dialog box that appears.

If the card is used as a timing reference, change the timing reference:

a. Click the Provisioning > Timing > General tabs.

b. Under NE Reference, click the drop-down arrow for Ref-1.

c. Change Ref-1 from the listed OC-N card to Internal Clock.

d. Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.158 INC-ISD

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The DS-3 Idle condition indicates that the DS-3 card is receiving an idle signal, meaning that the payload
of the signal contains a repeating pattern of bits. The INC-ISD condition occurs when the transmitting
port has an OOS-MA,MT service state. It is resolved when the OOS-MA,MT state ends.

INC-ISD is a condition and not an alarm. It is for information only and does not require troubleshooting.

2.7.159 INHSWPR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Inhibit Switch To Protect Request on Equipment condition occurs on traffic cards when the ability
to switch to protect has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the working system. If the card is part of a 1:N protection scheme, traffic can be
switched between working cards when the switch to protect is disabled.

Clear the INHSWPR Condition

Step 1 If the condition is raised against a 1+1 port, complete the “Initiate a 141 Manual Switch Command”
section on page 2-240.
Step2  If the condition is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command”
procedure on page 2-242 to switch it back.
Cisco ONS 15454 Troubleshooting Guide, R7.0
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Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.160 INHSWWKG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Inhibit Switch To Working Request on Equipment condition occurs on traffic cards when the ability
to switch to working has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the protect system. If the card is part of a 1:N protection scheme, traffic can be
switched between protect cards when the switch to working is disabled.

Clear the INHSWWHKG Condition

Step 1 If the condition is raised against a 1+1 port, complete the “Initiate a 14+1 Manual Switch Command”
section on page 2-240.

Step2  Ifitis raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-242 to switch traffic back.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.161 INTRUSION-PSWD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is
only shown in Superuser login sessions, not in login sessions for lower-level users. The
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires,
or it can be manually cleared in CTC by the Superuser if the lockout is permanent.

Clear the INTRUSION-PSWD Condition

Step 1 Click the Provisioning > Security > Users tabs.
Step2  Click Clear Security Intrusion Alarm.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.162 INVMACADR

Default Severity: Major (MJ), Non-Service Affecting (NSA)
SONET Logical Object: AIP

The Equipment Failure Invalid MAC Address alarm occurs when the ONS 15454 MAC address is
invalid. Each ONS 15454 has a unique, permanently assigned MAC address. The address resides on an
AIP EEPROM. The TCC2/TCC2P reads the address value from the AIP chip during boot-up and keeps
this value in its synchronous dynamic RAM (SDRAM).

Under normal circumstances, the read-only MAC address can be viewed in the Provisioning/Network
tab in CTC.

The ONS 15454 uses both IP and MAC addresses for circuit routing. When an INVMACADR alarm
exists on a node, you see a PARTIAL circuit in the CTC circuit status column. The circuit works and is
able to carry traffic, but CTC cannot logically display the circuit end-to-end information.

An invalid MAC address can be caused when:

e There is a read error from the AIP during bootup; in this case, the reading TCC2/TCC2P uses the
default MAC address (00-10-cf-ff-ff-ff).

e There is a read error occurring on one of the redundant TCC2/TCC2Ps that read the address from
the AIP; these cards read the address independently and could therefore each read different address
values.

e An AIP component failure causes a read error.

e The ribbon cable connecting the AIP card to the backplane is bad.

Clear the INVMACADR Alarm

Step 1 Check for any outstanding alarms that were raised against the active and standby TCC2/TCC2P and
resolve them.
Step2  If the alarm does not clear, determine whether the LCD display on the fan tray (Figure 2-2 on
page 2-118) is blank or if the text is garbled. If so, proceed to Step 8. If not, continue with Step 3.
Step3 At the earliest maintenance window, reset the standby TCC2/TCC2P:
)
Note  The reset requires approximately five minutes. Do not perform any other step until the reset is
complete.
a. Log into a node on the network. If you are already logged in, continue with Step b.
b. Identify the active TCC2/TCC2P.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
c. Right-click the standby TCC2/TCC2P in CTC.
d. Choose Reset Card from the shortcut menu.
e. Click Yes in the Are You Sure dialog box.
The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.
f. Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
[ November 2009
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Step 4

Step 5
Step 6

Step 7

Step 8

Step 9
Step 10
Step 11

g. Double-click the node and ensure that the reset TCC2/TCC2P is still in standby mode and that the
other TCC2/TCC2P is active.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
h. Ensure that no new alarms associated with this reset appear in the CTC Alarms window.

If the standby TCC2/TCC2P fails to boot into standby mode and reloads continuously, the AIP is
probably defective. In this case, the standby TCC2/TCC2P is unsuccessfully attempting to read the
EEPROM located on the AIP. The TCC2/TCC2P reloads until it reads the EEPROM. Proceed to Step 8.

If the standby TCC2/TCC2P rebooted successfully into standby mode, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249.

Resetting the active TCC2/TCC2P causes the standby TCC2/TCC2P to become active. The standby
TCC2/TCC2P keeps a copy of the chassis MAC address. If its stored MAC address is valid, the alarm
should clear.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present.

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-247 again to place the standby TCC2/TCC2P back into active mode.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the
INVMACADR alarm remains standing through both TCC2/TCC2P resets, this indicates that the AIP is
probably defective. Proceed to Step 8.

If the INVMACADR was raised during one TCC2/TCC2P reset and cleared during the other, the
TCC2/TCC2P that was active while the alarm was raised needs to be replaced. Continue with Step 7.

If the faulty TCC2/TCC2P is currently in standby mode, complete the “Physically Replace a Traffic
Card” procedure on page 2-250 for this card. If the faulty TCC2/TCC2P is currently active, during the
next available maintenance window complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-247 and then complete the “Physically Replace a Traffic Card”
procedure on page 2-250.

~

Note  If the replacement TCC2/TCC2P is loaded with a different software version from the current
TCC2/TCC2P, the card bootup could take up to 30 minutes. During this time, the card LEDs
flicker between Fail and Act/Sby as the active TCC2/TCC2P version software is copied to the
new standby card.

Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node’s previous MAC
address.

Replace the ribbon cable between the system board and the AIP with a known-good cable.
If the alarm persists, complete the “Replace the Alarm Interface Panel” procedure on page 2-259.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.163 10SCFGCOPY

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The IOS Configuration Copy in Progress condition occurs on ML-Series Ethernet cards when a
Cisco IOS startup configuration file is being uploaded or downloaded to or from an ML-Series card.
(This condition is very similar to the “SFTWDOWN” condition on page 2-203 but it applies to
ML-Series Ethernet cards rather than to the TCC2/TCC2P.)

The condition clears after the copy operation is complete. (If it does not complete correctly, the
“NO-CONFIG” condition on page 2-174 could be raised.)

IOSCFGCOPY is an informational condition.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.7.164 ISIS-ADJ-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.

The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network
Connectivity” chapter in the Cisco ONS 15454 Reference Manual. For more information about
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 Procedure Guide.

Clear the ISIS-ADJ-FAIL Alarm

Step 1

Step 2

Step 3

Ensure that both ends of the communication channel are using the correct Layer 2 protocol and settings
(LAPD or PPP). To do this, complete the following steps:

a. At the local node, in node view, click the Provisioning > Comm Channels > SDCC tabs.

b. Click the row of the circuit. Click Edit.

c. Inthe Edit SDCC termination dialog box, view and record the following selections: Layer 2 protocol
(LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection (Network
or User); MTU value; T200 value, and T203 selections.

d. Click Cancel.

e. Login to the remote node and follow the same steps, also recording the same information for this
node.

If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node”
chapter in the Cisco ONS 15454 Procedure Guide for the procedure.

If the nodes use PPP Layer 2, complete the “Clear the EOC Alarm” procedure on page 2-77. If the alarm
does not clear, go to Step 7.
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Step4d  If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect
node’s entry by clicking the correct setting radio button in the Edit SDCC termination dialog box and
clicking OK.

Step5  If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one
by clicking the correct radio button in the Edit SDCC termination dialog box and clicking OK.

Step6  If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is
incorrect, choose the correct value in the Edit SDCC dialog box and click OK.

Step7  If all of the preceding settings are correct, ensure that OSI routers are enabled for the communications
channels at both ends:

a. Click Provisioning > OSI > Routers > Setup tabs.

b. View the router entry under the Status column. If the status is Enabled, check the other end.
c. If the Status is Disabled, click the router entry and click Edit.

d. Check the Enabled check box and click OK.

Step 8 If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the
communications channel have a common MAA:

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. Record the primary MAA and secondary MAAs, if configured.

Tip You can record long strings of information such as the MAA address by using the CTC export and print
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.

c¢. Log into the other node and record the primary MAA and secondary MAAs, if configured.

d. Compare this information. There should be at least one common primary or secondary MAA in
order to establish an adjacency.

e. If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up
Node” chapter in the Cisco ONS 15454 Procedure Guide for procedures.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.71.165 KB-PASSTHR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The K Bytes Pass Through Active condition occurs on a nonswitching node in a BLSR when the protect
channels on the node are not active and the node is in K Byte pass-through state. It also occurs when a
BLSR ring is being exercised using the Exercise Ring command.

Clear the KB-PASSTHR Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.
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If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.166 KBYTE-APS-CHANNEL-FAILURE

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The APS Channel Failure alarm is raised when a span is provisioned for different APS channels on each
side. For example, the alarm is raised if K3 is selected on one end and F1, E2, or Z2 is selected on the
other end.

This alarm is also raised during checksum failure if the K1 and K2 bytes are overwritten by test
equipment. It is not raised in bidirectional full pass-through or K-byte pass-through states. The alarm is
overridden by the “AIS-P” alarm on page 2-35, the “LOF (OCN)” alarm on page 2-139, the “LOS
(OCN)” alarm on page 2-152 or the “SF-P” alarm on page 2-203.

Clear the KBYTE-APS-CHANNEL-FAILURE Alarm

Step 1

Step 2

Step 3

Step 4

The alarm is most frequently raised due to mismatched span provisioning. In this case, reprovision one
side of the span with the same parameters. To do this, refer to the “Turn Up Network” chapter in the
Cisco ONS 15454 Procedure Guide.

If the error is not caused by misprovisioning, it is due to checksum errors within an OC-N, cross-connect,
or TCC2/TCC2P. In this case, complete the “Side Switch the Active and Standby Cross-Connect Cards”
procedure on page 2-248 to allow CTC to resolve the issue.

If third-party equipment is involved, ensure that it is configured for the same APS channel as the
Cisco ONS equipment.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.167 LAN-POL-REV

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The LAN Connection Polarity Reversed condition is not raised in shelves that contain TCC2 cards. It is
raised during a software upgrade when the card detects that a connected Ethernet cable has reversed
receive wire pairs. The card automatically compensates for this reversal, but LAN-POL-REV stays
active.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the LAN-POL-REV Condition

Step 1 Replace the connected Ethernet cable with a cable that has the correct pinout. For correct pin mapping,
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.168 LASER-APR

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.169 LASERBIAS-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.170 LASERBIAS-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.171 LASEREOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Laser Approaching End of Life alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_I10E, and MXP_2.5G_10G cards. It is typically accompanied by the “HI-LASERBIAS” alarm
on page 2-115. It is an indicator that the laser in the card must be replaced. How soon the replacement
must happen depends upon the HI-LASERBIAS threshold. If the threshold is set under 100 percent, the
laser replacement can usually be done during a maintenance window. But if the HI-ILASERBIAS
threshold is set at 100 percent and is accompanied by data errors, the card must be replaced sooner.

Note  For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM
Troubleshooting Guide.

Clear the LASEREOL Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-250.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.71.172 LASERTEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.173 LCAS-CRC

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The Link Capacity Adjustment Scheme (LCAS) Control Word CRC Failure condition is raised against
ML-Series Ethernet cards and CE-series cards. It occurs when there is an equipment, path, or
provisioning error on the virtual concatenation group (VCG) that causes consecutive 2.5 second CRC
failures in the LCAS control word.

Transmission errors would be reflected in CV-P, ES-P, or SES-P performance monitoring statistics. If
these errors do not exist, an equipment failure is indicated.

If LCAS is not supported on the peer node, the condition does not clear.

LCAS-CRC can also occur if the VCG source node is not LCAS-enabled, but the receiving node does
have the capability enabled. Both source and destination nodes must have LCAS enabled. Otherwise, the
LCAS-CRC condition persists on the VCG.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LCAS-CRC Condition

Step 1

Step 2
Step 3

Step 4

Look for and clear any associated equipment failures, such as the EQPT alarm, on the receive node or
transmit node.

Look for and clear any bit error rate alarms at the transmit node.

If no equipment or SONET path errors exist, ensure that the remote node has LCAS enabled on the
circuit:

a. In node view, click the Circuits tab.

b. Choose the VCAT circuit and click Edit.

c. In the Edit Circuit window, click the General tab.
d. Verify that the Mode column says LCAS.

If the column does not say LCAS, complete the “Delete a Circuit” procedure on page 2-252 and recreate
it in LCAS mode using the instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R7.0 g



Chapter2  Alarm Troubleshooting |

W 27174 LCAS-RX-FAIL

Step 5

2.1.174 LCAS-

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

RX-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The LCAS VCG Member Receive-Side-In Fail condition is raised against CE-series cards, FC_MR-4
cards, and ML-Series Ethernet cards with LCAS-enabled VCG. ML-Series Ethernet cards with
LCAS-enabled VCG.

LCAS VCGs treat failures unidirectionally, meaning that failures of the transmit or receive points occur
independently of each other. The LCAS-RX-FAIL condition can occur on the receive side of an LCAS
VCG member for the following reasons:

¢ SONET path failure (a unidirectional failure as seen by the receive side)
e VCAT member is set out of group at the transmit side, but is set in group at the receive side
e VCAT member does not exist at the transmit side but does exist and is in group at the receive side

The condition can be raised during provisioning operations on LCAS VCGs but should clear when the
provisioning is completed.

Software-enabled LCAS VCGs treat failure bidirectionally, meaning that both directions of a VCG
member are considered failed if either transmit or receive fails. The LCAS-RX-FAIL condition is raised
on these VCG members when a member receive side fails due to a SONET path failure.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

ML-Series cards are LCAS-enabled. ML-Series and FC_MR-4 cards are SW-LCAS enabled.

Clear the LCAS-RX-FAIL Condition

Step 1
Step 2

2.1.175 LCAS-

Check for and clear any line or path alarms.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

TX-ADD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM
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The LCAS VCG Member Transmit-Side-In Add State condition is raised against ML-Series Ethernet
and CE-series cards when the transmit side of an LCAS VCG member is in the add state. The condition
clears after provisioning is completed. The remote likely reports a path condition such as the “AIS-P”
condition on page 2-35 or the “UNEQ-P” alarm on page 2-230

LCAS-TX-ADD is an informational condition and does not require troubleshooting.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.71.176 LCAS-TX-DNU

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The LCAS VCG Member Transmit-Side-In Do Not Use condition is raised on FC_MR-4 cards and
ML-Series Ethernet cards, and CE-series cards when the transmit side of an LCAS VCG member is in
the do-not use state. For a unidirectional failure, this condition is only raised at the source node. The
LCAS-TX-DNU condition is raised when the cable is unplugged.

The node reporting this condition likely reports an “RFI-P” alarm on page 2-190, and the remote node
likely reports a path alarm such as the “AIS-P” alarm on page 2-35 or the “UNEQ-P” alarm on
page 2-230.

LCAS-TX-DNU is an informational condition and does not require troubleshooting.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.1.177 LKOUTPR-S

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Lockout of Protection Span condition occurs when span traffic is locked out of a protect span using
the Lockout of Protect command. This condition is visible on the network view Alarms, Conditions, and
History tabs after the lockout has occurred and accompanies the FE-LOCKOUTPR-SPAN condition.
The port where the lockout originated is marked by an “L” on the network view detailed circuit map.

Clear the LKOUTPR-S Condition

Step 1

Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.
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Step 2

2.7.178 LOA

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: VCG

The Loss of Alignment on a VCG is a VCAT member alarm. (VCAT member circuits are independent
circuits that are concatenated from different time slots into a higher-rate signal.) The alarm occurs when
members of a VCG travel over different paths in the network (due to initial operator provisioning or to
protection or restoration events) and the differential delays between the paths cannot be recovered by
terminating hardware buffers.

Clear the LOA Alarm

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

In network view, click the Circuits tab.
Click the alarmed VCG and then click Edit.
In the Edit Circuit window, view the source and destination circuit slots, ports, and STSs.

Identify whether the STS travels across different fibers. If it does, complete the “Delete a Circuit”
procedure on page 2-252.

Recreate the circuit using the procedure in the “Create Circuits and VT Tunnels” chapter in the
Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.179 LOCKOUT-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VI-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout
switch request for an OC-N port in a 1+1 facility protection group. This can be accomplished by locking
traffic onto the working port with the LOCK ON command (thus locking it off the protect port), or
locking it off the protect port with the LOCK OUT command. In either case, the protect port will show
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.
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Clear the LOCKOUT-REQ Condition

Step 1

Step 2

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-241.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.180 LOF (BITS)

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The Loss of Frame (LOF) BITS alarm occurs when a port on theTCC2/TCC2P BITS input detects an
LOF on the incoming BITS timing reference signal. LOF indicates that the receiving ONS 15454 has
lost frame delineation in the incoming data.

The procedure assumes that the BITS timing reference signal is functioning properly. It also assumes the
alarm is not appearing during node turn-up.

Clear the LOF (BITS) Alarm

Step1  Verify that the line framing and line coding match between the BITS input and the TCC2/TCC2P:

a. Innode or card view, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the external BITS timing source. The formats should be in
the user documentation for the external BITS timing source or on the timing source itself.

c. Click the Provisioning > Timing > BITS Facilities tabs.

d. Verify that the Coding setting matches the coding of the BITS timing source, either B§ZS or AMI.

e. If the coding does not match, click Coding and choose the appropriate coding from the drop-down
list.

f. Verify that Framing matches the framing of the BITS timing source, either ESF or SF (D4).

g. If the framing does not match, click Framing and choose the appropriate framing from the
drop-down list.
A
Note  On the timing subtab, the B8ZS coding field is normally paired with ESF in the Framing

field and the AMI coding field is normally paired with SF (D4) in the Framing field.

Step2  If the alarm does not clear when the line framing and line coding match between the BITS input and the
TCC2/TCC2P, complete the “Physically Replace a Traffic Card” procedure on page 2-250 for the
TCC2/TCC2P.
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Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.181 LOF (DS1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: DS1

The DS-1 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in an incoming
DS-1 data stream.

Clear the LOF (DS1) Alarm

Step1  Verify that the line framing and line coding match between the DS1 port and the signal source:

b.

In CTC, note the slot and port reporting the alarm.

Find the coding and framing formats of the signal source for the card reporting the alarm. You could
need to contact your network administrator for the format information.

Display the card view of the reporting card.
Click the Provisioning > Line tabs.

Verify that the line type of the reporting port matches the line type of the signal source (DS4 and
DS4, unframed and unframed, or ESF and ESF). If the signal source line type does not match the
reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

Verify that the reporting Line Coding matches the signal source line coding (AMI and AMI or B8ZS
and B8ZS). If the signal source line coding does not match the reporting port, click the Line Coding
cell and choose the correct type from the drop-down list.

Click Apply.

~

Note  On the Line tab, the B8ZS coding field is normally paired with ESF in the Framing field.
AMI coding is normally paired with SF (D4) in the Framing field.

~

Note  When you replace a card with the identical type of card, you do not need to make any
changes to the database.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.
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2.7.182 LOF (DS3)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: DS3

The DS-3 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in the incoming
DS-3 data stream on DS3XM-6, DS3XM-12, or add DS3/EC1-48 cards. The framing of the transmitting
equipment could be set to a format that differs from the receiving system. On DS3XM-6 cards, the alarm
occurs only on cards with the provisionable framing format set to C Bit or M13 and not on cards with
the provisionable framing format is set to unframed.

Clear the LOF (DS3) Alarm

Step 1 Change the line type of the non-ONS equipment attached to the reporting card to C Bit:
a. Display the card view of the reporting card.
b. Click the Provisioning > Line tabs.
c. Verify that the line type of the reporting port matches the line type of the signal source.

d. If the signal source line type does not match the reporting port, click Line Type and choose C Bit
from the drop-down list.

e. Click Apply.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.183 LOF (E1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: El

The E1 LOF alarm appears on the DS1/E1-56 card when the card is placed in All E1 mode. It indicates
that the receiving ONS 15454 has lost frame delineation in an incoming E1 data stream. The transmitting
equipment could possibly have its framing set to a format that differs from the receiving node. For more
information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the Cisco ONS 15454
Reference Manual.

~

Note  The DS1/E1-56 card only carries an E1 signal within an STS-3¢/VT2 circuit.

Clear the LOF (E1) Alarm

Step1  Verify that the line framing and line coding match between the DS1/E1-56 port and the signal source:
a. In CTC, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the signal source for the card reporting the alarm. You could
need to contact your network administrator for this information.
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Step 2

¢. Double-click the DS1/E1-56 card to open the card view.
d. Click the Provisioning > Line tabs.

e. Verify that the line type of the reporting port matches the line type (E1_MF, E1_CRCMEF,
AUTOFRAMED, UNFRAMED) of the signal source. If the signal source line type does not match
the reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

f. Verify that the reporting Line Coding matches the signal source line coding. If the signal source line
coding does not match the reporting port, click the Line Coding cell and choose the correct type
from the drop-down list.

g. Click Apply.

~

Note  When you replace a card with the identical type of card, you do not need to make any
changes to the database.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.184 LOF (EC1)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EC1

The EC1/EC1-12 LOF alarm occurs when a port on the reporting EC1/EC1-12 or DS3/EC1-48 card has
an LOF condition. LOF indicates that the receiving ONS 15454 has lost frame delineation in the
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds.
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

Clear the LOF (EC1) Alarm

Step 1

A

Verify cabling continuity to the port reporting the alarm. To verify cable continuity, follow site practices.

Caution

Step 2

Step 3

Step 4

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete
the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to
isolate the fault causing the LOF alarm.

If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem 1 800 553-2447.
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2.7.185 LOF (OCN)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN

The LOF alarm occurs when a port on the reporting card has an LOF condition. It can also occur on
ONS 15454 MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G,TXP_MR_10E, or TXPP_MR_2.5G
cards reporting LOF. The alarm indicates that the receiving ONS 15454 has lost frame delineation in the
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds.
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

When the alarm is raised on an OC-N card, it is sometimes an indication that the OC-N card expects a
specific line rate and the input line rate source does not match the input line rate of the optical receiver.

~

m For information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the LOF (OCN) Alarm

Step 1 Verify cabling continuity to the port reporting the alarm.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

Step2  If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete
the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step3  If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to
isolate the fault causing the LOF alarm.

Step4  If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem 1 800 553-2447.

2.7.186 LOF (STSTRM)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: STSTRM

A Loss of Frame alarm for an STS circuit termination indicates that the LOF has occurred at the
terminating point of the circuit (such as an OC-N port). It is similar to the “LOF (OCN)” alarm on
page 2-139.

Clear the LOF (STSTRM) Alarm

Step 1 Complete the “Clear the LOF (OCN) Alarm” alarm on page 2-139.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.187 LOF (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.188 LOGBUFR90

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The Log Buffer Over 90 alarm indicates that the per-NE queue of incoming alarm, event, or update
capacity of 5000 entries is over 90% full. LOGBUFR90 will clear if CTC recovers. If it does not clear,
the LOGBUFROVFL alarm occurs.

S

Note LOGBUFRYO0 is an informational alarm and does not require troubleshooting.

2.7.189 LOGBUFROVFL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The Log Buffer Overflow alarm indicates that the CTC per-NE queue of incoming alarm, event, or
updates, which has a capacity of 5000 entries, has overflowed. This happens only very rarely; if the
alarm does occur, you must restart the CTC session. If this alarm occurs, it is likely that some updates
are missing.

Clear the LOGBUFROVFL Alarm

Step 1 Restart the CTC session.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.7.190 LO-LASERBIAS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM
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The Equipment Low Transmit Laser Bias Current alarm is raised against the TXP, MXP, OC3 IR/STM1
SH 1310-8, OC192 SR/STM64 10 1310, OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU
15xx.xx, or MRC-12 card laser performance. The alarm indicates that the card laser has reached the
minimum laser bias tolerance.

If the LO-LASERBIAS alarm threshold is set at O percent (the default), the laser's usability has ended.
If the threshold is set at 5 percent to10 percent, the card is still usable for several weeks or months before
you need to replace it.

When there is a LO-LASERBIAS alarm on the OC3 IR/STM1 SH 1310-8, OC192 SR/STM64 10 1310,
0OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xx.xx, or MRC-12 cards, the alarm is
reported at the card equipment level, not the port equipment level. However, on cards with PPMs, the
alarms are reported at the port level. So the end result is that the alarms are reported at different levels
(port or card equipment), depending on if the port has a replaceable PPM or is a fixed-rate port with no
PPM. Because the alarm cannot be isolated to a specific port from the alarm indication on the four cards
mentioned, when the LO-LASERBIAS alarm occurs and cannot be cleared, it is recommended to change
out the entire card (see the procedure in this section).

To see which port on a card is having possible performance problems that may be causing the alarm, see
DLP-A507 in the DLPs A500 to A599 chapter of the Cisco ONS 15454 Procedure Guide, R7.0. To
change how the performance monitoring (PM) parameters are displayed, see NTP-A253 in the Monitor
Performance chapter of the Cisco ONS 15454 Procedure Guide, R7.0.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the LO-LASERBIAS Alarm

Step 1

Step 2

Complete the “Physically Replace a Traffic Card” procedure on page 2-250.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.191 LO-LASERTEMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM

The Equipment Low Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
LO-LASERTEMP occurs when the internally measured transceiver temperature falls below the card
setting by35.6 degrees F or 2 degrees C. A laser temperature change affects the transmitted wavelength.
(Two degrees Celsius is equivalent to about 200 picometers in the wavelength.)
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Note

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)”
alarm on page 2-152 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-73 is raised
at the near end. To verify the card laser temperature level, double-click the card in node view and click
the Performance > Optics PM > Current Values tabs. Maximum, minimum, and average laser
temperatures are shown in the Current column entries in the Laser Temp rows.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the LO-LASERTEMP Alarm

Step 1
Step 2

Step 3

2.7.192 LOM

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting MXP or TXP
card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting MXP or TXP card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

Default Severity: Critical (CR), Service-Affecting (SA) for STSMON, STSTRM, TRUNK;
Major (MJ) for VI-TERM

SONET Logical Objects: STSMON, STSTRM, VT-TERM
DWDM Logical Object: TRUNK

The Optical Transport Unit (OTU) Loss of Multiframe is a VCAT member alarm. (VCAT member
circuits are independent circuits that are concatenated from different time slots into a higher-rate signal.)
The alarm applies to OCN ports when the Multi Frame Alignment Signal (MFAS) overhead field is
errored for more than five frames and persists for more than 3 milliseconds.

Note  Optical cards do not recognize the LOM. The system redirects the LOM alarm to the incoming side so
that any optical card can display this alarm as a TERM alarm.
Clear the LOM Alarm

2.7.193 LOP-P

To clear the alarm, log into the Technical Support Website at http://www.cisco.com/techsupport for more
information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) problem.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM
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A Loss of Pointer Path alarm indicates that the SONET path pointer in the overhead has been lost. LOP
occurs when valid H1/H2 pointer bytes are missing from the overhead. Receiving equipment monitors
the H1/H2 pointer bytes to locate the SONET payload. An LOP-P alarm occurs when eight, nine, or ten
consecutive frames do not have valid pointer values. The alarm clears when three consecutive valid
pointers are received.

The LOP-P alarm can occur when the received payload does not match the provisioned payload. The
alarm is caused by a circuit type mismatch on the concatenation facility. For example, if an STS-1 is sent
across a circuit provisioned for STS-3c, an LOP-P alarm occurs.

For the FC_MR-4 card, an LOP-P is raised if a port is configured for a SONET signal but receives an
SONET signal instead. (This information is contained in the H1 byte bits 5 and 6.)

Clear the LOP-P Alarm

A

Caution

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

2.7.194 LOP-V

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

In node view, click the Circuits tab and view the alarmed circuit.

Verify the circuit size listed in the Size column. If the size is different from what is expected, such as an
STS3c instead of an STS1, this causes the alarm.

If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. For specific procedures to use the
test set equipment, consult the manufacturer. Ensure that the test set monitoring is set up for the same
size as the circuit provisioning.

Refer to the manufacturer’s instructions for test-set use.

If the error is not due to an incorrectly configured test set, the error is in the provisioned CTC circuit
size. Complete the “Delete a Circuit” procedure on page 2-252.

Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: VI-MON, VI-TERM
The LOP VT alarm indicates a loss of pointer at the VT level.

The LOP-V alarm can occur when the received payload does not match the provisioned payload. LOP-V
is caused by a circuit size mismatch on the concatenation facility.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R7.0 g



Chapter2  Alarm Troubleshooting |

W 27195 LO-RXPOWER

Clear the LOP-V Alarm

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-143.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.195 LO-RXPOWER

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC

The Equipment Low Receive Power alarm is an indicator for TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, MRC-12, MRC-4, and OC192-XFP card received
optical signal power. LO-RXPOWER occurs when the measured optical power of the received signal
falls below the threshold value, which is user-provisionable.

Note  When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted
optical power (OPRO) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn
Up a Node” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC
uses the new OPRO value to calculate PM percentage values. If you do not change the nominal value, the
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the LO-RXPOWER Alarm

Step 1 At the transmit end of the errored circuit, increase the transmit power level within safe limits.

Step2  Find out whether new channels have been added to the fiber. Up to 32 channels can be transmitted on
the same fiber, but the number of channels affects power. If channels have been added, power levels of
all channels need to be adjusted.

~

Note If the card is part of an amplified DWDM system, adding channels on the fiber affects the
transmission power of each channel more than it would in an unamplified system.

Cisco ONS 15454 Troubleshooting Guide, R7.0
m. November 2009 |



| Chapter2  Alarm Troubleshooting

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

2719% LoS(2rR) M

Find out whether gain (the amplification power) of any amplifiers has been changed. Changing
amplification also causes channel power to need adjustment.

If the alarm does not clear, remove any receive fiber attenuators or replace them with lower-resistance
attenuators.

If the alarm does not clear, inspect and clean the receive and transmit node fiber connections according
to site practice. If no site practice exists, complete the procedure in the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, ensure that the fiber is not broken or damaged by testing it with an optical

test set. If no test set is available, use the fiber for a facility (line) loopback on a known-good port. The
error reading you get is not as precise, but you generally know whether the fiber is faulty. For specific
procedures to use the test set equipment, consult the manufacturer.

If the alarm does not clear, and no faults are present on the other port(s) of the transmit or receive card,
do a facility loopback on the transmit and receive ports with known-good loopback cable. Complete the
“1.4.1 Perform a Facility Loopback on a Source-Node Optical Port” procedure on page 1-48 or the
“1.4.4 Perform a Facility Loopback on an Intermediate-Node Optical Port” procedure on page 1-57 to
test the loopback.

If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic
Card” procedure on page 2-250. If the port is bad but you can move the traffic to another port, replace
the card at the next available maintenance window.

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.196 LOS (2R)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.197 LOS (BITS)

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The LOS (BITS) alarm indicates that the TCC2/TCC2P has an LOS from the BITS timing source. The
LOS (BITS) means the BITS clock or the connection to it failed.

Clear the LOS (BITS) Alarm

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step 1 Verify the wiring connection from the BITS clock pin fields on the ONS 15454 backplane to the timing
source.
Step2  If wiring is good, verify that the BITS clock is operating properly.
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Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.198 LOS (DS1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: DS1

A LOS (DS1) alarm for a DS-1 port occurs when the port on the card is in service but no signal is being
received. A cabling issue or a configuration issue could cause this alarm. If an upstream equipment
failure causes a transmission failure, the LOS (DS1) will likely be demoted by a card-level alarm (to the
DS1/E1-56).

Clear the LOS (DS1) Alarm
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step1  Verify that the fiber cable is properly connected and attached from the correct transmitting port to the
correct receiving port. For more information about fiber connections and terminations, refer to the
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step2  Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step3  If the alarm is raised on a DS1/E1-56 card, verify that the card is placed in the correct service mode by
completing the following steps:

a. Double-click the card to open the card view.
b. Click the Provisioning > Card tabs.
c. Verify that the Operating Mode column says All DS1 for your errored circuit.

Step4  For any other DS-1 or DS-3 card, consult site records to determine whether the port raising the alarm
has been assigned.

Step5  If the port is not currently assigned, place the port out of service using the following steps:
a. Double-click the card to open the card view.

b. For a DS-1 card, click the Maintenance > Loopback tabs. For a DS-1 line on a DS3XM-6 or
DS3XM-12 card, click the Maintenance > DS1 tabs.

¢. Under Admin State, click OOS,DSBLD.
d. Click Apply.
Step6  For any card, if the port is assigned, verify that the correct one is in service:
a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
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Step 7

Step 8

Step 9
Step 10

Step 11
Step 12
Step 13

Step 14
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b. To determine this virtually, double-click the card in CTC to open the card view and complete the
following substeps:

¢ Click the Provisioning > Line tabs.
e Verify that the Admin State column lists the port as IS.

e If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and
choose IS. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either
raised or remains, and the port service state transitions to OOS-AU,FLT.

Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card
as possible. For specific procedures to use the test set equipment, consult the manufacturer.

Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454.

If a valid electrical signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Repeat Steps 1 to 10 for any other port on the card that reports the LOS.
If the alarm does not clear, check for any card-level alarm that could affect this port.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.199 LOS (DS3)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: DS3

The LOS (DS3) for a DS-3 port occurs when the port on a DS3XM-6, DS3XM-12, or DS3/EC1-48 card
is in service but no signal is being received. The alarm is caused by incorrect or dirty cabling, a fiber
break, or upstream equipment failure.

If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.
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Clear the LOS (DS3) Alarm

Step1  Check for any upstream failures in the transmitting equipment.

Step2  Verify that the cable is properly connected from the transmitting port and attached to the correct
receiving port at the node with the LOS. For more information about fiber connections and terminations,
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step3  Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step4  Consult site records to determine whether the port raising the alarm has been assigned.
Step5  If the port is not currently assigned, place the port out of service using the following steps:
a. Double-click the card to open the card view.
b. Click the Maintenance > DS3 tabs.
¢. Under Admin State, click OOS,DSBLD.
d. Click Apply.
Step6  If the port is assigned, verify that the correct one is in service:
a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine this virtually, double-click the card in CTC to open the card view and complete the
following substeps:

¢ Click the Provisioning > Line tabs.
e Verify that the Admin State column lists the port as IS.

e If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and
choose IS. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either
raised or remains, and the port service state transitions to OOS-AU,FLT.

Step7  Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card
as possible. (For specific procedures to use the test set equipment, consult the manufacturer.)

Step8  Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step9  If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454.

Step 10  If the test set shows signal errors but the cabling is correctly installed and the transmitting device is
operational, the existing cabling could still be faulty. Use the test set to locate the bad cable and replace
it. To do this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454
Procedure Guide.

Step11  Repeat Steps 1 to 10 for any other port on the card that reports the LOS.
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Step 12

Step 13
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If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.200 LOS (E1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: E1l

An LOS (E1) alarm for a DS1/E1-56 card port occurs when the card is placed in All E1 mode and is in
service, but the alarmed port is not receiving a signal due to a physical or provisioning problem. The
physical causes for the alarm could be incorrectly connected or faulty cabling. The software causes could
be improperly configured card or circuit size.

For more information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the
Cisco ONS 15454 Reference Manual.

Clear the LOS (E1) Alarm

A

Caution

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that the cable is properly connected and attached to the correct port. For more information about
connecting cable, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454
Procedure Guide. Also refer to site records for your specific cabling scheme.

Ensure that the transmit and receive outputs from the patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Clean the cable using your site practices. If none exists, complete the procedure in the “Maintain the
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Confirm that the card is properly provisioned to carry the E1 payload:
a. Double-click the card to open the card view.
b. Click the Provisioning > Card tabs.

¢. Under the Operating Mode column, you should see “All E1.” If you see “All DS1,” click the
drop-down to change it and click Apply.

Use a test set to confirm that a valid E1 signal exists on the line. Test the line as close to the receiving
card as possible. (For specific procedures to use the test set equipment, consult the manufacturer.) If the
test set shows errors, the cabling could still be faulty despite being correctly installed. Use the tester to
isolate the bad section of cable and replace it. Refer to the “Install Cards and Fiber-Optic Cable” chapter
in the Cisco ONS 15454 Procedure Guide for procedures.

Repeat Steps 1 to 5 for any other port on the card that reports the LOS (E1).

If the alarm does not clear, look for any card-level alarm that could cause this alarm.
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Step 8

Step 9

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.201 LOS (EC1)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EC1

LOS on an EC1/EC1-12 or DS3/EC1-48 port occurs when a SONET receiver detects an all-zero pattern
for 10 microseconds or longer. An LOS (EC1) most likely means that the upstream transmitter has failed.
If an EC1 LOS alarm is not accompanied by additional alarms, a cabling problem (such as an incorrect
attachment, fiber cut, or other fiber error) usually causes this alarm. The condition clears when the
problem is corrected, allowing two consecutive valid frames to be received.

If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the LOS (EC1) Alarm

A

Caution

Step 1
Step 2

Step 3

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Check for any upstream equipment failures that could cause the LOS (EC1) in this node.

If there is no cause upstream, verify cabling continuity from the transmitting port to the receiving port
reporting LOS (EC1) To verify cable continuity, follow site practices.

If the continuity is good, clean the fiber according to site practice. If none exists, complete the procedure
in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If the cabling is good, verify that the correct EC1-12 port is in service:
a. Confirm that the LED is correctly lit on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to open the card view.
c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.
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S

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

Stepd4  If the correct port is in service, use an optical test set to confirm that a valid signal exists on the line. For
specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to the
receiving card as possible.

Step5  If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected. For more information about fiber connections and terminations, refer to the
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step6  If a valid signal exists but the alarm does not clear, replace the cable connector on the ONS 15454.
Step7  Repeat Steps 2 through 6 for any other port on the card that reports the LOS (EC1).

Step8  If the alarm does not clear, the cabling could still be faulty despite correct attachments. Use the test set
to locate the bad cable and replace it using the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

Step9  If the alarm does not clear, look for any card-level alarm that could cause this port alarm.

Step10  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting card.

Step 11 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.202 LOS (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.203 LOS (FUDC)

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: FUDC

The LOS (FUDC) alarm is raised if there is a UDC circuit created on an AIC-I UDC port but the port is
not receiving signal input. The downstream node has an AIS condition raised against the AIC-I port
transmitting the UDC. FUDC refers to the 64-kb user data channel using the F1 byte.

Clear the LOS (FUDC) Alarm

Step1  Verify cable continuity to the AIC-I UDC port. To verify cable continuity, follow site practices.

Step2  Verify that there is a valid input signal using a test set. For specific procedures to use the test set
equipment, consult the manufacturer.

Step3  If there is a valid signal, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.
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Step 4

Step 5

Step 6

Step 7

If the alarm does not clear, verify that the UDC is provisioned:
a. At the network view, click the Provisioning > Overhead Circuits tabs.

b. If no UDC circuit exists, create one. Refer to the “Create Circuits and VT Tunnels” chapter in the
Cisco ONS 15454 Procedure Guide.

c. If a user data circuit exists (shown as User Data F1 under the Type column), check the source and
destination ports. These must be located on AIC-I cards to function.

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

If no other alarms exist that could be the source of the LOS (FUDC), or if clearing another alarm did not
clear the LOS, complete the “Physically Replace a Traffic Card” procedure on page 2-250 for the
reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.204 LOS (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.205 LOS (MSUDC)

The LOS (MSUDC) alarm is not used in this platform in this release. It is reserved for future
development.

2.7.206 LOS (OCN)

>

Warning

>

Warning

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN

An LOS alarm on an OC-N port occurs when a SONET receiver detects an all-zero pattern for

10 microseconds or longer. An LOS alarm means the upstream transmitter has failed. If an OC-N LOS
alarm is not accompanied by additional alarms, a fiber break is usually the cause of the alarm. It clears
when two consecutive valid frames are received.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the LOS (OCN) Alarm

A

Caution

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Using site practices, verify fiber continuity to the port.
If the cabling is good, verify that the correct port is in service:
a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS.

f. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

If the correct port is in service, clean the fiber according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, verify that the power level of the optical signal is within the OC-N card
receiver specifications. The “1.12.3 OC-N Card Transmit and Receive Levels” section on page 1-141
lists these specifications for each OC-N card. For DWDM cards, refer to the Cisco ONS 15454 DWDM
Reference Manual for levels.

If the optical power level is within specifications, use an optical test set to verify that a valid signal exists
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line
as close to the receiving card as possible.

If a valid signal exists, replace the connector on the backplane.
Repeat Steps 1 to 6 for any other port on the card reporting the LOS (OC-N).

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.
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Step9  If no other alarms exist that could be the source of the LOS, or if clearing an alarm did not clear the LOS,
complete the “Physically Replace a Traffic Card” procedure on page 2-250 for the reporting card.

Step10  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.207 LOS (OTS)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.208 LOS (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.209 LOS-0

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.210 LOS-P (OCH)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.211 LOS-P (OMS, OTS)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.212 LOS-P (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.213 LO-TXPOWER

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM
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The Equipment Low Transmit Power alarm is an indicator for the TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, OC192-XFP, OC3 IR/STM1 SH 1310-8, OC192
SR/STM64 10 1310, 0C192 IR/STM64 SH 155, OC192 LR/STM64 LH ITU 15xx.xx, and MRC-12 card
transmitted optical signal power. LO-TXPOWER occurs when the measured optical power of the
transmitted signal falls under the threshold. The threshold value is user-provisionable.

When there is a LO-TXPOWER alarm on the OC3 IR/STM1 SH 1310-8, OC192 SR/STM64 10 1310,
0OC192 IR/STM64 SH 1550, OC192 LR/STM64 LH ITU 15xx.xx, or MRC-12 cards, the alarm is
reported at the card equipment level, not the port equipment level. However, on cards with PPMs, the
alarms are reported at the port level. So the end result is that the alarms are reported at different levels
(port or card equipment), depending on if the port has a replaceable PPM or is a fixed-rate port with no
PPM. Because the alarm cannot be isolated to a specific port from the alarm indication on the four cards
mentioned, when the LO-TXPOWER alarm occurs and cannot be cleared, it is recommended to change
out the entire card (see the procedure in this section).

To see which port on a card is having possible performance problems that may be causing the alarm, see
DLP-A507 in the DLPs A500 to A599 chapter of the Cisco ONS 15454 Procedure Guide, R7.0. To
change how the performance monitoring (PM) parameters are displayed, see NTP-A253 in the Monitor
Performance chapter of the Cisco ONS 15454 Procedure Guide, R7.0.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the LO-TXPOWER Alarm

Step 1

Step 2
Step 3
Step 4

Step 5

Display the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, or
OC192-XFP card view.

Click the Provisioning > Optics Thresholds > Current Values tabs.
Increase the TX Power Low column value by 0.5 dBm.

If the card transmit power setting cannot be increased without affecting the signal, complete the
“Physically Replace a Traffic Card” procedure on page 2-250.

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.214 LPBKCRS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Loopback Cross-Connect condition indicates that there is a software cross-connect loopback active
between an optical card and an OC-192 card. A cross-connect loopback test occurs below line speed and
does not affect traffic.
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For more information on loopbacks, see the “1.4 Troubleshooting Optical Circuit Paths With
Loopbacks” section on page 1-47.

~

Note  Cross-connect loopbacks occur below line speed. They do not affect traffic.

Clear the LPBKCRS Condition

Step1  To remove the loopback cross-connect condition, double-click the optical card in CTC to open the card
view.

Step2  Complete the “Clear an OC-N Card Cross-Connect (XC) Loopback Circuit” procedure on page 2-253.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.215 LPBKDS1FEAC-CMD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS1

The DS-1 Loopback Command Sent To Far End condition occurs on the near-end node when you send
a DS-1 FEAC loopback on DS3XM-6, DS3XM-12, or DS3/EC1-48 cards. For more information about
FEAC loopbacks, see the “1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With
FEAC Loopbacks” section on page 1-45.

Note LPBKDSIFEAC-CMD is an informational condition and does not require troubleshooting.

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

2.1.216 LPBKDS3FEAC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

A Loopback Due to FEAC Command DS-3 condition occurs when a DS3XM-6, DS3XM-12, DS3-12E,
or DS3/EC1-48 port loopback signal is received in C-bit framing mode from the far-end node because
of an FEAC command. An FEAC command is often used with loopbacks. LPBKDS3FEAC is only
reported by these DS cards. DS3XM-6, DS3XM-12, and DS3/EC1-48 cards generate and report FEAC
alarms or conditions, but a DS3-12E card only reports FEAC alarms or conditions.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).
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LPBKDS3FEAC is an informational condition and does not require troubleshooting.

Clear the LPBKDS3FEAC Condition

Step 1
Step 2
Step 3
Step 4

In node view, double-click the DS-3 card to open the card view.
Click the Maintenance > DS3 tabs.
Click the cell for the port in the Send Code column and click No Code from the drop-down list.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.217 LPBKDS3FEAC-CMD

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The DS-3 Loopback Command Sent To Far End condition occurs on the near-end node when you send
a DS-3 FEAC loopback on DS3XM-6, DS3XM-12, or DS3/EC1-48 cards. For more information about
FEAC loopbacks, see the “1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With
FEAC Loopbacks” section on page 1-45.

LPBKDS3FEAC-CMD is an informational condition and does not require troubleshooting.

2.7.218 LPBKFACILITY (CE1000, CE100T)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: CE1000, CE100T

A Loopback Facility condition on a CE-100T-8 port occurs when a software facility (line) loopback is
active for a port on the card.

For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.5 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKFACILITY (CE1000, CE100T) Condition

Step 1

Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.219 LPBKFACILITY (DS1, DS3)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Loopback Facility condition on a DS-1 or DS-3 port occurs when a software facility (line) loopback
is active for the reporting DS3XM-6 card, DS3XM-12 card, a DS1/E1-56 card operating in All DS1
mode, or a DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the
LPBKFACILITY condition can be accompanied by a more serious alarms such as LOS.

ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback if desired.

Clear the LPBKFACILITY (DS1, DS3) Condition

Step 1

Step 2

Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-253.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.220 LPBKFACILITY (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: El

A Loopback Facility on an E1 port condition occurs when a software facility (line) loopback is active
for a DS1/E1-56 card port operating in All E1 mode.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.
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Note CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the
LPBKFACILITY condition can be accompanied by a more serious alarms such as LOS.

Note El facility (line) loopbacks transmit an AIS in the direction away from the loopback, but this is
provisionable.

Clear the LPBKFACILITY (E1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.221 LPBKFACILITY (EC1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EC1

A Loopback Facility condition on an EC-1 port occurs when a software facility (line) loopback is active
for a port on the reporting ECI/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Clear the LPBKFACILITY (EC1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.222 LPBKFACILITY (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.223 LPBKFACILITY (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.224 LPBKFACILITY (FCMR)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: FCMR

A Loopback Facility for FCMR condition occurs when a facility loopback is provisioned on an
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.6 Troubleshooting
FC_MR Circuit Paths With Loopbacks” section on page 1-86.

Clear the LPBKFACILITY (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.225 LPBKFACILITY (G1000)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: G1000

A Loopback Facility condition for the G1000 object occurs when a software facility (line) loopback is
active for a port on the reporting G-Series Ethernet card.

For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.5 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

S

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKFACILITY (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.226 LPBKFACILITY (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.227 LPBKFACILITY (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.228 LPBKFACILITY (OCN)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

A Loopback Facility condition for an OC-N port occurs when a software facility (line) loopback is active
for a port on the reporting OC-N card.

For information about troubleshooting optical circuits with loopbacks, refer to the “1.4 Troubleshooting
Optical Circuit Paths With Loopbacks” section on page 1-47.

~

Note OC-3 facility loopbacks do not transmit an AIS in the direction away from the loopback. Instead of AIS,
a continuance of the signal transmitted to the loopback is provided.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

A

Caution  Before performing a facility (line) loopback on an OC-N card, ensure that the card contains at least two
DCC paths to the node where the card is installed. A second DCC path provides a nonlooped path to log
into the node after the loopback is applied, thus enabling you to remove the facility loopback. Ensuring
a second DCC is not necessary if you are directly connected to the ONS 15454 containing the loopback
OC-N.

Clear the LPBKFACILITY (OCN) Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-253.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.229 LPBKFACILITY (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.230 LPBKTERMINAL (CE1000, CE100T)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: CE1000, CE100T

A Loopback Terminal condition on a CE-100T-8 port occurs when a software terminal loopback is active
for a port on the card.

Note  For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.5 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKTERMINAL (CE1000, CE100T) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.231 LPBKTERMINAL (DS1, DS3)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Loopback Terminal condition for a DS-1 or DS-3 occurs when a software terminal (inward) loopback
is active for a DS1 or DS3 port on the reporting DS3XM-6, DS3XM-12, or DS3/EC1-48 card. DS-1 and
DS-3 terminal loopbacks do not typically return an AIS signal, but you can provision one for the
DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section
on page 1-45.

Clear the LPBKTERMINAL (DS1, DS3) Condition

Step1  Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-253.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.232 LPBKTERMINAL (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: El

A Loopback Terminal condition for an E-1 signal on a DS1/E1-56 card occurs when the card is operating
in All E1 mode and a software terminal (inward) loopback is active for a port.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section
on page 1-45.

Clear the LPBKTERMINAL (E1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.233 LPBKTERMINAL (EC1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EC1

A Loopback Terminal condition on an EC-1 signal occurs when a software terminal (inward) loopback
is active for a port on the reporting EC1/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Clear the LPBKTERMINAL (EC1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.234 LPBKTERMINAL (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.235 LPBKTERMINAL (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.236 LPBKTERMINAL (FCMR)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: FCMR

A Loopback Terminal for FCMR condition occurs when a terminal loopback is provisioned on an
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.6 Troubleshooting
FC_MR Circuit Paths With Loopbacks” section on page 1-86.

Clear the LPBKTERMINAL (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.237 LPBKTERMINAL (G1000)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: G1000

A Loopback Terminal condition for the G1000 occurs when a software terminal (inward) loopback is
active for a port on the reporting G-Series Ethernet card.

When a port in terminal (inward) loopback, its outgoing signal is redirected into the receive direction on
the same port, and the externally received signal is ignored. On the G1000-4 card, the outgoing signal is
not transmitted; it is only redirected in the receive direction.

For more information about troubleshooting Ethernet circuits, refer to the “1.5 Troubleshooting
Ethernet Circuit Paths With Loopbacks” section on page 1-68.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).
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~
Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKTERMINAL (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.238 LPBKTERMINAL (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.239 LPBKTERMINAL (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.240 LPBKTERMINAL (OCN)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

A Loopback Terminal condition for an OC-N port occurs when a software terminal (inward) loopback
is active for a port on the reporting card.

Note  OC-N terminal loopbacks do not typically return an AIS.

Note Performing a loopback on an in-service circuit is Service-Affecting (SA). If you did not perform a
lockout or Force switch to protect traffic, the LPBKTERMINAL condition can also be accompanied by

a more serious alarm such as LOS.

For information about troubleshooting circuits, refer to the loopback procedures in Chapter 1, “General

Troubleshooting.”

Clear the LPBKTERMINAL (OCN) Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-253.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.241 LPBKTERMINAL (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.242 LWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Low Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input voltage falls
below the low power threshold. This threshold, with a default value of —44 VDC, is user-provisionable.
The alarm remains raised until the voltage remains above the threshold for 120 seconds. (For
information about changing this threshold, refer to the “Turn Up Node” chapter in the Cisco ONS 15454
Procedure Guide.

Clear the LWBATVG Alarm

Step1  The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.243 MAN-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, STSMON, VI-MON

The Manual Switch Request condition occurs when a user initiates a Manual switch request on an OC-N
port. Clearing the Manual switch clears the MAN-REQ condition. You do not need to clear the switch if
you want the Manual switch to remain.

Clear the MAN-REQ Condition

Step1  Complete the “Initiate a 1+1 Manual Switch Command” procedure on page 2-240.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.244 MANRESET

~

Note MANRESET is an informational condition and does not require troubleshooting.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A User-Initiated Manual Reset condition occurs when you right-click a card in CTC and choose Reset.
Resets performed during a software upgrade also prompt the condition. The MANRESET condition
clears automatically when the card finishes resetting.

2.7.245 MANSWTOINT

~

Note MANSWTOINT is an informational condition and does not require troubleshooting.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Manual Switch To Internal Clock condition occurs when the NE timing source is manually switched
to an internal timing source.

2.7.246 MANSWTOPRI

~

Note MANSWTOPRI is an informational condition and does not require troubleshooting.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Primary Reference condition occurs when the NE timing source is manually
switched to the primary timing source.

2.7.247 MANSWTOSEC

~

Note MANSWTOSEC is an informational condition and does not require troubleshooting.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Second Reference condition occurs when the NE timing source is manually
switched to a second timing source.
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2.7.248 MANSWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Third Reference condition occurs when the NE timing source is manually
switched to a third timing source.

~

Note MANSWTOTHIRD is an informational condition and does not require troubleshooting.

2.7.249 MANUAL-REQ-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Manual Switch Request on Ring condition occurs when a user initiates a MANUAL RING command
on BLSR rings to switch from working to protect or protect to working. This condition is visible on the
network view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where
the MANUAL RING command originated is marked with an “M” on the network view detailed circuit
map.

Clear the MANUAL-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.250 MANUAL-REQ-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Manual Switch Request on Ring condition occurs on BLSRs when a user initiates a Manual Span
command to move BLSR traffic from a working span to a protect span. This condition appears on the
network view Alarms, Conditions, and History tabs. The port where the MANUAL SPAN command was
applied is marked with an “M” on the network view detailed circuit map.

Clear the MANUAL-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-246.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.251 MEA (AIP)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: AIP

If the Mismatch of Equipment Attributes (MEA) alarm is reported against the AIP, the fuse in the AIP
board blew or is missing. The MEA alarm also occurs when an old AIP board with a 2-A fuse is installed
in a newer ANSI 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD).

Clear the MEA (AIP) Alarm

Step 1 Complete the “Replace the Alarm Interface Panel” procedure on page 2-259.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.252 MEA (BIC)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: BIC

The Missing Equipment Attributes alarm for the backplane interface connector (BIC) indicates a
compatibility issue in using high-density DS-3 cards with universal backplane interface connectors
(UBIC) and an older shelf backplane. The backplane on the high-density shelf assembly, 15454-SA-HD,
is compatible with the UBIC with horizontal connectors (UBIC-H) and UBIC with vertical connectors
(UBIC-V) that the high-density EC-1, DS-1, and DS-3 electrical connections require. The MEA alarm
is raised if you attempt to install a high-density card in Slot 4, 5, 6, 12, 13, or 14 in a shelf assembly with
an older, incompatible backplane. The card is not usable in this case. It is also raised if you attempt to
use an older BIC (also known as electrical interface assemblies [EIAs]) with the newer shelf assembly.

Clear the MEA (BIC) Alarm

Step 1 Click the Provisioning > Inventory tabs to determine your backplane model. If the backplane is not a
15454-SA-HD, replace the backplane or do not attempt to use high-density DS-3 cards. The following
tables list the EIA Types that are compatible with various backplanes.

Table 2-13 EIA Types Compatible with the 15454-SA-ANSI Only

EIA Type A-Side Product Number B-Side Product Number

BNC 15454-EIA-BNC-A24= 15454-EIA-BNC-A24=

Cisco ONS 15454 Troubleshooting Guide, R7.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

W 27.253 MEA (EQPT)

Table 2-13

EIA Types Compatible with the 15454-SA-ANSI Only (continued)

EIA Type

A-Side Product Number

B-Side Product Number

High- Density BNC

15454-EIA-BNC-A48=

15454-EIA-BNC-B48=

SMB 15454-EIA-SMB-A84= 15454-EIA-SMB-B84=

AMP Champ 15454-EIA-AMP-A84= 15454-EIA-AMP-B84=
Table 2-14 EIA Types Compatible with the 15454-SA-ANSI and the 15454-SA-HD

EIA Type A-Side Product Number B-Side Product Number

BNC 15454-EIA-BNC-A24= 15454-EIA-BNC-B24=

High- Density BNC

15454-EIA-1BNCA48=

15454-EIA-1BNCB48=

Mini(BNC) 15454-EIA-BNC-A96= 15454-EIA-BNC-A96=
SMB 15454-EIA-1SMBA84= 15454-EIA-1SMBBg84=
AMP Champ 15454-EIA-1AMPA84= 15454-EIA-1AMPB84=
UBIC-V 15454-EIA-UBICV-A 15454-EIA-UBICV-B
UBIC-H 15454-EIA-UBICH-A 15454-EIA-UBICH-B

Step2  If you determine that your BIC type and backplane are compatible despite the MEA alarm, or if the alarm
does not clear after you resolve the incompatibilities, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to
report a Service-Affecting (SA) problem.

2.7.253 MEA (EQPT)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The MEA alarm for equipment is reported against a card slot when the physical card inserted into a slot
does not match the card type that is provisioned for that slot in CTC. The alarm also occurs when certain
cards introduced in Release 3.1 or later are inserted into an older shelf assembly or when older Ethernet
cards (E1000-2 and E100T-12) are used in a newer 10-Gbps-compatible shelf assembly.

Removing the incompatible cards clears the alarm.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

If an OC3-8 card is installed in Slot 5 to 6 and Slot 12 to 13, it does not appear in CTC and raises an
MEA.

[l Cisco ONS 15454 Troubleshooting Guide, R7.0

November 2009 |



| Chapter2  Alarm Troubleshooting

27253 MEA (EarT) W

Clear the MEA (EQPT) Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Physically verify the type of card that is installed in the slot reporting the MEA alarm. In node view,
click the Inventory tab and compare it to the actual installed card.

Determine whether the ONS 15454 shelf assembly is a newer 10-Gbps-compatible shelf assembly
(15454-SA-ANSI or 15454-SA-HD) or an earlier shelf assembly. Under the HW Part # column, if the
part number is 800-19857-XX or 800-19856-XX, then you have a 15454-SA-ANSI shelf. If the part
number is 800-24848-XX, then you have a 15454-SA-HD shelf. If the number is not one of those listed
above, then you are using an earlier shelf assembly.

~

Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

Verify the type of card that sits in the slot reported in the object column of the MEA row on the Alarms
window by reading the name at the top of the card faceplate.

e If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and
the card reporting the alarm is not an E1000-2 or E100T-12, proceed to Step 4.

e If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and
the card reporting the alarm is an E1000-2 or E100T-12, then that version of the Ethernet card is
incompatible and must be removed. Proceed to Step 4.

A

Note The E1000-2-G and E100T-G cards are compatible with the newer ANSI
10-Gbps-compatible shelf assembly and are the functional equivalent of the older,
noncompatible E1000-2 and E100T-12 cards. E1000-2-G and E100T-G cards can be used as
replacements for E1000-2 and E100T-12 cards in a 10-Gbps-compatible shelf assembly.

e If you have an older shelf assembly and the card reporting the alarm is not a card introduced in
Release 3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS),
proceed to Step 4.

e If you have an older shelf assembly and the card reporting the alarm is a card introduced in Release
3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS), the
reporting card is incompatible with the shelf assembly and must be removed Proceed to Step 4.

If you prefer the card type depicted by CTC, complete the “Physically Replace a Traffic Card” procedure
on page 2-250 for the reporting card.

If you prefer the card that physically occupies the slot but the card is not in service, does not have circuits
mapped to it, and is not part of a protection group, place the cursor over the provisioned card in CTC
and right-click to choose Delete Card.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

>
Note  Ifthe cardisin service, does have circuits mapped to it, is paired in a working protection scheme,

has DCC communications turned on, or is used as a timing reference, CTC does not allow you
to delete the card.

If any ports on the card are in service, place them out of service (OOS,MT):

| November 2009
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A

Caution  Before placing ports out of service, ensure that live traffic is not present.

a. Double-click the reporting card to open the card view.
b. Click the Provisioning tab.
¢. Click the admin state of any in-service ports.
d. Choose OOS,MT to take the ports out of service.
Step7  If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-252.

A

Caution  Before deleting the circuit, ensure that live traffic is not present.

Step8  If the card is paired in a protection scheme, delete the protection group:
a. Click the Provisioning > Protection tabs.
b. Choose the protection group of the reporting card.
c. Click Delete.

Step9  Right-click the card reporting the alarm.

Step10 Choose Delete.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

Step 11 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.254 MEA (FAN)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN

The MEA alarm is reported against the fan-tray assembly when a newer fan-tray assembly (15454-FTA3)
with a 5-A fuse is used with an older shelf assembly or when an older fan-tray assembly with a 2-A fuse
is used with a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) that
contains cards introduced in Release 3.1 or later. If a 10-Gbps-compatible shelf assembly contains only
cards introduced before Release 3.1, then an older fan-tray assembly (15454-FTA-2) can be used and
does not report an MEA alarm.

Clear the MEA (FAN) Alarm

Step 1 Determine whether the shelf assembly is a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI
or 15454-SA-HD) or an earlier shelf assembly. In node view, click the Inventory tab.

Under the HW Part # column, if the part number is 800-19857-XX or 800-19856-XX, then you have a
15454-SA-ANSI shelf. If the part number is 800-24848-XX, you have a 15454-SA-HD shelf.

Cisco ONS 15454 Troubleshooting Guide, R7.0
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Step 2

Step 3

Step 4

27.255 MEA (ppv) W

Under the HW Part # column, if the number is not one of those listed above, then you are using an earlier
shelf assembly.

If you have a 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD), the alarm
indicates that an older incompatible fan-tray assembly is installed in the shelf assembly. Obtain a newer
fan-tray assembly (15454-FTA3) with a 5-A fuse and complete the “Replace the Fan-Tray Assembly”
procedure on page 2-257.

If you are using an earlier shelf assembly, the alarm indicates that you are using a newer fan-tray
assembly (15454-FTA3), which is incompatible with the earlier version of the shelf assembly. Obtain an
earlier version of the fan-tray assembly (15454-FTA2) and complete the “Replace the Fan-Tray
Assembly” procedure on page 2-257.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.255 MEA (PPM)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.256 MEM-GONE

~

Note

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Memory Gone alarm occurs when data generated by software operations exceeds the memory
capacity of the TCC2/TCC2P. The TCC2/TCC2P cards which exceed the memory capacity reboot to
avoid failure of card operations.

The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE
alarm.

2.1.251 MEM-LOW

~

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is
close to exceeding the memory capacity of the TCC2/TCC2P. The alarm clears when additional memory
becomes available. If additional memory is not made available and the memory capacity of the card is
exceeded, CTC ceases to function.

The alarm does not require user intervention. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.1.258 MFGMEM

Tip

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: AICI-AEP, AICI-AIE, AIP, BPLANE, FAN
DWDM Logical Object: PPM

The Manufacturing Data Memory Failure alarm occurs when the EEPROM fails on a card or component,
or when the TCC2/TCC2P cannot read this memory. EEPROM stores manufacturing data that a system
TCC2/TCC2P uses to determine system compatibility and shelf inventory status. Unavailability of this
information can cause less-significant problems. The AIP EEPROM also stores the system MAC
address. If the MFGMEM alarm indicates EEPROM failure on these panels, IP connectivity could be
disrupted and the system icon is grayed out in CTC network view.

When you lose LAN connectivity with an ONS 15454 due to an MFGMEM alarm on the AIP, you can
reestablish node management by disconnecting the Ethernet cable from the panel and connecting it to
the active TCC2/TCC2P LAN port.

Clear the MFGMEM Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-247.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, complete the “Physically Replace a
Traffic Card” procedure on page 2-250.

If the MFGMEM alarm continues to report after replacing the TCC2/TCC2Ps, the problem lies with the
EEPROM.

If the MFGMEM is reported from the fan-tray assembly, obtain a fan-tray assembly and complete the
“Replace the Fan-Tray Assembly” procedure on page 2-257.

If the MFGMEM is reported from the AIP, the backplane, or the alarm persists after the fan-tray
assembly is replaced, log into the Technical Support Website at http://www.cisco.com/techsupport for
more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.259 NO-CONFIG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The No Startup Configuration condition applies to ML-Series Ethernet cards and occurs when no startup
configuration file has been downloaded to the TCC2/TCC2P, whether or not you preprovision the card
slot. This alarm can be expected during provisioning. When the startup configuration file is copied to the
active TCC2/TCC2P, the alarm clears.

Cisco ONS 15454 Troubleshooting Guide, R7.0
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~
Note For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the NO-CONFIG Condition

Step 1 Create a startup configuration for the card in Cisco IOS.

Follow the card provisioning instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Step2  Upload the configuration file to the TCC2/TCC2P:
a. Innode view, right-click the ML-Series card graphic.
b. Choose IOS Startup Config from the shortcut menu.
¢. Click Local > TCC and navigate to the file location.
Step3  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.260 NOT-AUTHENTICATED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when CTC fails to log into a node.
This alarm only appears in CTC where the login failure occurred. This alarm differs from the
“INTRUSION-PSWD” alarm on page 2-124 because INTRUSION-PSWD occurs when a user exceeds
the login failures threshold.

Note NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the
node.

2.7.261 OCHNC-INC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.262 OCHTERM-INC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

Cisco ONS 15454 Troubleshooting Guide, R7.0
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2.7.263 ODUK-1-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.264 ODUK-2-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.265 ODUK-3-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.266 ODUK-4-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.267 ODUK-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.268 ODUK-BDI-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.269 ODUK-LCK-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.270 ODUK-OCI-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.1.2711 ODUK-SD-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.272 ODUK-SF-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.273 ODUK-TIM-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.274 O0OU-TPT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The Out of Use Transport Failure alarm is a VCAT member alarm. (VCAT member circuits are
independent circuits that are concatenated from different time slots into a higher-rate signal.) This
condition is raised when a member circuit in a VCAT is unused, such as when it is removed by
SW-LCAS. It occurs in conjunction with the “VCG-DEG” condition on page 2-233.

Clear the OOT-TPT Condition

Step1  Complete the “Clear the VCG-DEG Condition” procedure on page 2-233. Clearing that condition clears
this condition as well.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.275 OPEN-SLOT

Default Severity: Not Alarmed (NA)
Logical Object: EQPT

The Open Slot condition indicates that there is an open slot in the system shelf. Slot covers assist with
airflow and cooling.

Cisco ONS 15454 Troubleshooting Guide, R7.0
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Clear the OPEN-SLOT Condition

Step 1

Step 2

To install a slot cover and clear this condition, refer to the procedures located in the “Install Cards and
Fiber-Optic Cable” chapter of the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.276 OPTNTWMIS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.277 OPWR-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.278 OPWR-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.2719 OPWR-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.280 OPWR-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.281 OSRION

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.282 OTUK-AIS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.283 OTUK-BDI

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.284 OTUK-IAE

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.285 OTUK-LOF

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.286 OTUK-SD

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.287 OTUK-SF

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.288 OTUK-TIM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.289 OUT-OF-SYNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.290 PARAM-MISM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.291 PDI-P

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Cisco ONS 15454 Troubleshooting Guide, R7.0
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>

Warning

>

Warning

>

Warning

Note

SONET Logical Objects: STSMON, STSTRM

PDI-P is a set of application-specific codes indicating a signal label mismatch failure (SLMF) in the
ONS 15454 STS path overhead. The condition indicates to downstream equipment that there is a defect
in one or more of the directly mapped payloads contained in that STS synchronous payload envelope
(SPE). For example, the mismatch could occur in the overhead to the path selector in a downstream node
configured as part of a path protection. The PDI-P codes appear in the STS Signal Label (C2 byte).

An SLMF often occurs when the payload (for example, ATM) does not match what the signal label is
reporting. The “AIS” condition on page 2-34 often accompanies a PDI-P condition. If the PDI-P is the
only condition reported with the AIS, clearing PDI-P clears the AIS. PDI-P can also occur during an
upgrade, but usually clears itself and is not a valid condition.

A PDI-P condition reported on an OC-N port supporting a G1000-4 card circuit could result from the
end-to-end Ethernet link integrity feature of the G1000-4 card. If the link integrity is the cause of the
path defect, it is typically accompanied by the “TPTFAIL (G1000)” alarm on page 2-226 or the
“CARLOSS (G1000)” alarm on page 2-58 reported against one or both Ethernet ports terminating the
circuit. If this is the case, clear the TPTFAIL and CARLOSS alarms to resolve the PDI-P condition.

A PDI-P condition reported on an OC-N port supporting an ML-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the ML-Series card. If the link integrity is the cause, it is
typically accompanied by the “TPTFAIL (ML100T, ML1000, MLFX)” alarm on page 2-227 reported
against one or both packet-over-SONET (POS) ports terminating the circuit. If TPTFAIL is reported
against one or both of the POS ports, troubleshooting the accompanying alarm clears the PDI-P
condition. Refer to the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454,
Cisco ONS 15454 SDH, and Cisco ONS 15327 for more information about ML-Series cards.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the PDI-P Condition

Step 1

Verify that all circuits terminating in the reporting card are DISCOVERED:
a. Click the Circuits tab.

b. Verify that the Status column lists the circuit as active.
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A

27292 PEER-NORESPONSE M

c. If the Status column lists the circuit as PARTIAL, wait 10 minutes for the ONS 15454 to initialize
fully. If the PARTIAL status does not change after full initialization, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem 1 800 553-2447.

After determining that the circuit is DISCOVERED, ensure that the signal source to the card reporting
the alarm is working.

Caution

Step 3

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If traffic is affected, complete the “Delete a Circuit” procedure on page 2-252.

Caution

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Deleting a circuit can affect existing traffic.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

If circuit deletion and re-creation does not clear the condition, verify that there is no problem stemming
from the far-end OC-N card providing STS payload to the reporting card.

If the condition does not clear, confirm the cross-connect between the OC-N card and the reporting card.

If the condition does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on
page 2-250 for the optical/electrical cards.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.292 PEER-NORESPONSE

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The switch agent raises a Peer Card Not Responding alarm if either traffic card in a protection group
does not receive a response to the peer status request message. PEER-NORESPONSE is a software
failure and occurs at the task level, as opposed to a communication failure, which is a hardware failure
between peer cards.

Clear the PEER-NORESPONSE Alarm

Step1  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.
Step2  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.
Cisco ONS 15454 Troubleshooting Guide, R7.0
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.293 PLM-P

>

Warning

A

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM

A Payload Label Mismatch Path alarm indicates that signal does not match its label. The condition is
indicated by a problematic C2 byte value in the SONET path overhead. The alarm is raised if all of the
following conditions are met:

¢ The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped, unspecified).
e The received C2 byte is not 0x01 (equipped, unspecified).

For example, on nodes equipped with CTC Software R4.1 and earlier, this alarm could occur when you
have a DS3XM-6 card connected to a DS-3 card instead of a DS-1 card. The DS3XM-6 card expects a
C2 label byte value of 01. A DS-1 card transmits this value, but a DS-3 card transmits a value of 04. The
mismatch between the sent and expected values causes the PLM-P alarm.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

Warning

A

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the PLM-P Alarm

Step 1

A

Complete the “Clear the PDI-P Condition” procedure on page 2-180.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.294 PLM-V

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: VI-TERM

A Payload Label Mismatch VT Layer alarm indicates that the content of the V5 byte in the SONET
overhead is inconsistent or invalid. PLM-V occurs when ONS 15454s interoperate with equipment that
performs bit-synchronous mapping for DS-1 signal. The ONS 15454 uses asynchronous mapping.

Clear the PLM-V Alarm

Step 1 Verify that your signal source matches the signal allowed by the traffic card. For example, the traffic card
does not allow VT6 or VT9 mapping.

Step2  If the signal source matches the card, verify that the SONET VT path originator is sending the correct
VT label value. You can find the SONET VT path originator using circuit provisioning steps.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.295 PMI

For more information about the PMI condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.296 PORT-ADD-PWR-DEG-HIGH

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.1.297 PORT-ADD-PWR-DEG-LOW

For more information about the PORT-ADD-PWR-DEG-LOW alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.
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2.7.298 PORT-ADD-PWR-FAIL-HIGH

For more information about the PORT-ADD-PWR-FAIL-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.299 PORT-ADD-PWR-FAIL-LOW

For more information about the PORT-ADD-PWR-FAIL-LOW alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.300 PORT-FAIL

For more information about the PORT-FAIL alarm, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.301 PORT-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE-MR-10, ML-MR-10, FC_MR-4

The Pluggable PORT-MISMATCH alarm applies to FC_MR-4, ML-MR-10, and CE-MR-10 Ethernet
cards.

For the ML-MR-10 and CE-MR-10 cards the alarm indicates either of the following:

e The provisioned payload, speed, or duplex configured on the port does not match that of the SFP
plugged into the port.

¢ A non-supported SFP is plugged into the port.
For the FC_MR-4 card the alarm indicates that a non-supported GBIC is plugged into the port.

Clear the PORT-MISMATCH Alarm

To clear the alarm on the CE-MR-10 card, either plug-in a supported SFP into the CE-MR-10 port or
follow these steps to provision the correct payload, speed, or duplex:

1. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the CE-MR-10
card to open the card view.

2. Click the Provisioning > Ether Ports tabs.

3. Specify correct values in the Expected Speed and Expected Duplex fields to match the SFP
configuration.

4. Click Apply.

To clear the alarm on the FC_MR-4 card, plug-in a supported GBIC into the FC_MR-4 port and follow
these steps to provision the media type:

1. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the FC_MR-4
card graphic to open the card.

2. Click the Provisioning > Port > General tabs.
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3. Specify proper payload value in the Media Type field.
4. Click Apply.

For the CE-MR-10 and FC_MR-10 card, the alarm can also be cleared using TL1 commands. For
detailed instructions, refer to the Cisco ONS 15454, Cisco ONS 15600, and Cisco ONS 15310-MA
SONET TL1 Command Guide.

For the ML-MR-10 card, the alarm can be cleared through Cisco IOS commands. For detailed
instructions, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature
and Configuration Guide.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.7.302 PRC-DUPID

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The Procedural Error Duplicate Node ID alarm indicates that two identical node IDs exist in the same
ring. The ONS 15454 requires each node in the ring to have a unique node ID.

Clear the PRC-DUPID Alarm

Step 1
Step 2

Step 3
Step 4

Step 5

Log into a node on the ring.

Find the node ID by completing the “Identify a BLSR Ring Name or Node ID Number” procedure on
page 2-238.
Repeat Step 2 for all the nodes on the ring.

If two nodes have an identical node ID number, complete the “Change a BLSR Node ID Number”
procedure on page 2-238 so that each node ID is unique.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.303 PROTNA

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Protection Unit Not Available alarm is caused by an OOS protection card when a TCC2/TCC2P or
XC10G card that has been provisioned as part of a protection group is not available. Unavailable
protection can occur when a card is reset, but the alarm clears as soon as the card is back in service. The
alarm clears if the device or facility is brought back in service.
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Clear the PROTNA Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

If the PROTNA alarm occurs and does not clear, and if it is raised against a controller or cross-connect
card, ensure that there is a redundant TCC2/TCC2P installed and provisioned in the chassis.

If the alarm is raised against a line card, verify that the ports have been taken out of service (OOS,MT):
a. In CTC, double-click the reporting card to open the card view (if the card is not an XC10G card).
b. Click the Provisioning tab.

¢. Click the admin state of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the reporting card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.304 PROV-MISMATCH

2.1.305 PTIM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.306 PWR-FAIL-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONETLogical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.
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The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-A Alarm

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

If a single card has reported the alarm, take the following actions depending on the reporting card:

e Ifthereporting card is an active traffic line portin a 1+1 protection group or part of a path protection,
ensure that an APS traffic switch has occurred to move traffic to the protect port.

~

Note Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To
avoid this, perform an external switch if a switch has not already occurred. See the
“2.9.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-239 for
commonly used traffic-switching procedures.

e If the alarm is reported against a TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-247.

e Ifthe alarm is reported against an OC-N card, complete the “Reset a Traffic Card in CTC” procedure
on page 2-247.

e If the alarm is reported against a cross-connect card, complete the “Reset a Traffic Card in CTC”
procedure on page 2-247 for the cross-connect card. (The process is similar.)

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the reporting card.

If the single card replacement does not clear the alarm, or if multiple cards report the alarm, verify the
office power. Refer to the “Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454
Procedure Guide for procedures. See the “1.13 Power Supply Problems” section on page 1-143 as
necessary.

If the alarm does not clear, reseat the power cable connection to the connector.
If the alarm does not clear, physically replace the power cable connection to the connector.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.307 PWR-FAIL-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The Equipment Power Failure at Connector B alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

>

Warning  The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-B Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-187.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.308 PWR-FAIL-RET-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-187.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.309 PWR-FAIL-RET-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-187.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.310 RAI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3, El

The Remote Alarm Indication condition signifies an end-to-end failure. The error condition is sent from
one end of the SONET path to the other. RAI on a DS3XM-6 card indicates that the far-end node is
receiving a DS-3 AIS.

Clear the RAI Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-34.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.311 RCVR-MISS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: DS1, E1

A Facility Termination Equipment Receiver Missing alarm occurs when the facility termination
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance
usually occurs when a receive cable is missing from a DS-1 port, or a possible mismatch of backplane
equipment occurs. For example, an SMB connector or a BNC connector could be misconnected to a
DS-1 card.

Note  DS-1s are four-wire circuits and need a positive (tip) and negative (ring) connection for both transmit
and receive.
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Clear the RCVR-MISS Alarm

Step1  Ensure that the device attached to the DS-1 port is operational.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the attachment is good, verify that the cabling is securely connected.
Step3  If the cabling is good, verify that the pinouts are correct.
Step4  If the pinouts are correct, replace the receive cable.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.312 RFl

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.313 RFI-L

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN
DWDM Logical Object: TRUNK

A RFI Line condition occurs when the ONS 15454 detects an RFI in OC-N card SONET overhead
because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-L condition
in the reporting node. RFI-L indicates that the condition is occurring at the line level.

Clear the RFI-L Condition

Step 1 Log into the node at the far-end node of the reporting ONS 15454.
Step2  Identify and clear any alarms, particularly the “LOS (OCN)” alarm on page 2-152.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.314 RFI-P

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM
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The RFI Path condition occurs when the ONS 15454 detects an RFI in the an STS-1 signal SONET
overhead because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-P
condition in the reporting node. RFI-P occurs in the terminating node in that path segment.

Clear the RFI-P Condition

Step1  Verify that the ports are enabled and in service (IS-NR) on the reporting ONS 15454:
a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

Step2  To find the path and node failure, verify the integrity of the SONET STS circuit path at each of the
intermediate SONET nodes.

Step3  Clear alarms in the node with the failure, especially the “UNEQ-P” alarm on page 2-230 or the
“UNEQ-V” alarm on page 2-232.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.315 RFI-V

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: VTMON, VI-TERM

An RFI VT Layer condition occurs when the ONS 15454 detects an RFI in the SONET overhead because
of a fault in another node. Resolving the fault in the adjoining node clears the RFI-V condition in the
reporting node. RFI-V indicates that an upstream failure has occurred at the VT layer.

Clear the RFI-V Condition

Step 1 Verify that the connectors are securely fastened and connected to the correct slot. For more information,
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step2  If connectors are correctly connected, verify that the DS-N
Step3  port is active and in service (IS-NR):
a. Confirm that the LED is correctly illuminated on the physical card:
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

Step4  If the ports are active and in service, use an optical test set to verify that the signal source does not have
errors. For specific procedures to use the test set equipment, consult the manufacturer.

Step5  If the signal is valid, log into the node at the far-end of the reporting ONS 15454.

Step6  Clear alarms in the far-end node, especially the “UNEQ-P” alarm on page 2-230 or the “UNEQ-V” alarm
on page 2-232.

Step7  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.316 RING-ID-MIS

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Object: OSC-RING

The Ring ID Mismatch condition refers to the ring ID in APC. It occurs when a ring name does not match
other detectable node ring names, and can cause problems with applications that require data exchange
with APC. This alarm is similar to BLSR RING-MISMATCH, but rather than apply to ring protection,
RING-ID-MIS applies to DWDM node discovery within the same network.

~

m For more information about APC, refer to the Cisco ONS 15454 DWDM Procedure Guide.

Clear the RING-ID-MIS Alarm

Step 1 Complete the “Clear the RING-MISMATCH Alarm” procedure on page 2-193.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.
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2.1.317 RING-MISMATCH

~

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

A Procedural Error Mismatch Ring alarm occurs when the ring name of the ONS 15454 node that is
reporting the alarm does not match the ring name of another node in the BLSR. Nodes connected in a
BLSR must have identical ring names to function. This alarm can occur during BLSR provisioning.

RING-MISMATCH is somewhat similar to RING-ID-MIS, but it applies to BLSR protection discovery
instead of DWDM node discovery.

For more information about DWDM cards, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the RING-MISMATCH Alarm

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

In node view, click the Provisioning > BLSR tabs.

Note the name in the Ring Name field.

Log into the next ONS 15454 node in the BLSR.

Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-238.

If the ring name matches the ring name in the reporting node, repeat Step 4 for the next ONS 15454 in
the BLSR.

Complete the “Change a BLSR Ring Name” procedure on page 2-238.
Verify that the ring map is correct.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.318 RING-SW-EAST

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Ring Switch Is Active East Side condition occurs when a ring switch occurs at the east side of a
BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-EAST
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was
applied shows an “F” on the network view detailed circuit map.

RING-SW-EAST is an informational condition and does not require troubleshooting.

2.7.319 RING-SW-WEST

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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SONET Logical Object: OCN

The Ring Switch Is Active West Side condition occurs when a ring switch occurs at the west side of a

BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-WEST
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was
applied shows an “F” on the network view detailed circuit map.

~

Note  RING-SW-WEST is an informational condition and does not require troubleshooting.

2.7.320 ROLL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM, VI-MON

The ROLL condition indicates that circuits are being rolled. This is typically carried out to move traffic
for a maintenance operation or to perform bandwidth grooming. The condition indicates that a good
signal has been received on the roll destination leg, but the roll origination leg has not yet been dropped.
The condition clears when the roll origination leg is dropped.

~

Note  ROLL is an informational condition and does not require troubleshooting.

2.7.321 ROLL-PEND

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM, VI-MON

ROLL-PEND indicates that a roll process has been started, but a good signal has not been received yet
by the roll destination leg. This condition can be raised individually by each path in a bulk circuit roll.

The condition clears when a good signal has been received on the roll destination leg.

S

Note ROLL-PEND is an informational condition and does not require troubleshooting.

2.1.322 RPRW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: LOGFAC, ML100T, ML1000, MLFX

The Resilient Packet Ring (RPR) Wrapped condition applies to ML-Series card and occurs when the
RPR protocol initiates a ring wrap due to a fiber cut, node failure, node restoration, new node insertion,
or other traffic problem. It can also be raised if the POS port has an Admin down condition. (In this case,
you will not see any SONET-level or TPTFAIL alarms.). The POS port can go down for one of the
following reasons: Deletion of circuit on the POS port, SPR KeepAlive failure when it is configured.

When the wrap occurs, traffic is redirected to the original destination by sending it in the opposite
direction around the ring after a link state change or after receiving any SONET path-level alarms.
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ML-Series card POS interfaces normally send the “PDI-P” alarm on page 2-179 to the far end when the
POS link goes down or when RPR wraps. ML-Series card POS interfaces do not send a PDI-P alarm to
the far end when this alarm is detected, when the alarm is being sent to the far end, or when the only
defects being detected are the “GFP-LFD” alarm on page 2-112, the “GFP-CSF” alarm on page 2-110,
the VCAT “LOM” alarm on page 2-142, or the VCAT “SQM” alarm on page 2-210.

For more information about CE-100T-8 and ML-Series Ethernet cards, refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the RPRW Condition

Step 1

Step 2

Step 3

Step 4

If a circuit on the POS port part of SPR interface had been deleted, recreate the circuit on the POS port
for this alarm to clear ring wrapping.

Look for and clear any service-affecting SONET path-level alarms on the affected circuit, such as the
“LOP-P” alarm on page 2-142, “LOS-P (TRUNK)” alarm on page 2-154, “PLM-P” alarm on
page 2-182, or the “TIM-P” alarm on page 2-223. Clearing this alarm can also clear RPRW.

If the condition does not clear, look for and clear any service alarms for the ML-Series card itself, such
as the “CARLOSS (CE1000, CE100T)” alarm on page 2-54, “CARLOSS (ML1000, ML100T, MLFX)”
alarm on page 2-61, “TPTFAIL (CE100T, CE1000)” alarm on page 2-225, or the “TPTFAIL (ML100T,
ML1000, MLFX)” alarm on page 2-227.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.7.323 RUNCFG-SAVENEED

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Run Configuration Save Needed condition occurs when you change the running configuration file
for ML-Series cards. It is a reminder that you must save the change to the startup configuration file for
it to be permanent.

The condition clears after you save the running configuration to the startup configuration, such as by
entering:

copy run start
at the privileged EXEC mode of the Cisco IOS CLI. If you do not save the change, the change is lost

after the card reboots. If the command “copy run start” is executed in configuration mode and not
privileged EXEC mode, the running configuration will be saved, but the alarm will not clear.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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2.7.324 SD (DS1, DS3)

>

Warning

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Signal Degrade (SD) condition for DS-1 or DS-3 occurs when the quality of an electrical signal on a
DS3XM-6, DS3XM-12, or DS3/EC1-48 card has exceeded the BER signal degrade threshold. Signal
degrade is defined by Telcordia as a soft failure condition. SD and signal fail (SF) both monitor the
incoming BER and are similar, but SD is triggered at a lower bit error rate than SF.

The BER threshold is user-provisionable and has a range for SD from 1E-9 dBm to 1E-5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance
(OOS-MA,MT), but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but
if it occurs on an AINS port, the alarm prevents the port from going into service.

The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Some levels of BER errors (such as 1E-9 dBm) take a long period to raise or clear, about 9,000 seconds,
or 150 minutes. If the SD threshold is provisioned at 1E-9 dBm rate, the SD alarm needs at least one
and one-half hours to raise and then another period at least as long to clear.

The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific
procedures to use the test set equipment, consult the manufacturer.

Clear the SD (DS1, DS3) Condition

Step 1

If the condition applies for a DS-3 line on a DS3XM-6, DS3XM-12, DS3E-12, or DS3/EC1-48 card,
complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-253. If the condition applies to any other DS-N card (DS3i-N-14, DS3-12, DS3i-N-14, or
DS1/E1-56) complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on
page 2-254.
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Caution

Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10

Step 11

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, verify that single-mode fiber is used.

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.
Verify that a single-mode laser is used at the far end.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.9.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-249.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.325 SD (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: E1l

An SD condition for an E1 occurs on a DS1/E1-56 card in E1 only mode when the quality of an electrical
signal has exceeded the BER signal degrade threshold.

SD is triggered at a lower bit error rate than SF. The SD BER threshold is user-provisionable and ranges
from 1E-9 dBm to 1E-5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance
(OOS-MA,MT) but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but
if it occurs on an AINS port, the alarm prevents the port from going into service.

The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.
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Warning

Note
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Note

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Some levels of BER errors (such as 1E-9 dBm) take a long period to raise or clear, about 9,000 seconds,
or 150 minutes. If the SD threshold is provisioned at 1E-9 dBm rate, the SD alarm needs at least one
and a half hours to raise and then another period at least as long to clear.

The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific
procedures to use the test set equipment, consult the manufacturer.

Clear the SD (E1) Condition

Step 1

A

Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-254.

Caution

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Step 10

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, verify that single-mode fiber is used.
If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.9.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-249.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.326 SD (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.327 SD-L

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

An SD Line condition is similar to the “SD (DS1, DS3)” condition on page 2-196. It applies to the line
level of the SONET signal and travels on the B2 byte of the SONET overhead.

An SD-L on an Ethernet or OC-N card does not cause a protection switch. If the alarm is reported on a
card that has also undergone a protection switch, the SD BER count continues to accumulate. The
condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-138, the
“LOF (OCN)” alarm on page 2-139, the “LOS (EC1)” alarm on page 2-150, and the “LOS (OCN)” alarm
on page 2-152.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the SD-L Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.328 SD-L (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.329 SD-P

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

An SD Path condition is similar to the “SD (DS1, DS3)” condition on page 2-196, but it applies to the
path (STS) layer of the SONET overhead. A path or STS-level SD alarm travels on the B3 byte of the
SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E-9 dBm to 1E-5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E-6 dBm.
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On path protection configurations, an SD-P condition causes a switch from the working card to the
protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-P condition does
not cause switching.

The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.
Clear the SD-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.330 SD-V

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM

An SD-V condition is similar to the “SD (DS1, DS3)” condition on page 2-196, but it applies to the VT
layer of the SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E-9 dBm to 1E-5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E-6 dBm.

On path protection configurations, an SD-V condition does not cause a switch from the working card to
the protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-V condition
does not cause switching.

The BER increase that causes the alarm is sometimes caused by a physical fiber problem such as a poor
fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD alarm clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.331 SF(DS1, DS3)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3
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A Signal Fail (SF) condition occurs when the quality of the signal has exceeded the BER signal failure
threshold. Signal failure is defined by Telcordia as a “hard failure” condition. The SD and SF conditions
both monitor the incoming BER error rate and are similar conditions, but SF is triggered at a higher BER
than SD.

The BER threshold is user-provisionable and has a range for SF from 1E-5 dBm to 1E-3 dBm.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the SF (DS1, DS3) Condition

Step 1

A

Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Caution

Step 2

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.332 SF(E1)

>

Warning

>

Warning

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: E1l

An SF condition for an E1 occurs on a DS1/IE1-56 card in E1 only mode when the quality of the signal
has exceeded the BER signal failure threshold.

SF monitors the incoming BER error rate just as SD does, but SF is triggered at a higher BER than SD.
The SF BER threshold is user-provisionable and has a range for SF from 1E-5 dBm to 1E-3 dBm.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
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Clear the SF (E1) Condition

Step 1 Complete the “Clear the SD (E1) Condition” procedure on page 2-198.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.333 SF(TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.334 SF-L

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

An SF Line condition is similar to the “SF (DS1, DS3)” condition on page 2-200, but it applies to the
line layer B2 overhead byte of the SONET signal. It can trigger a protection switch.

The SF-L condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-138,
the “LOS (EC1)” alarm on page 2-150, and the “LOS (OCN)” alarm on page 2-152.

Clear the SF-L Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.335 SF-L (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.1.336 SF-P

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

An SF Path condition is similar to the “SF (DS1, DS3)” condition on page 2-200, but it applies to the
path (STS) layer B3 byte of the SONET overhead. It can trigger a protection switch.

The SF-P condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the SF-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.337 SFTWDOWN

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Software Download in Progress alarm occurs when the TCC2/TCC2P is downloading or transferring
software.

If the active and standby TCC2/TCC2Ps have the same versions of software, it takes approximately three
minutes for software to be updated on a standby TCC2/TCC2P.

If the active and standby TCC2/TCC2Ps have different software versions, the transfer can take up to
30 minutes. Software transfers occur when different software versions exist on the two cards. After the
transfer completes, the active TCC2/TCC2P reboots and goes into standby mode after approximately
three minutes.

No action is necessary. Wait for the transfer or the software download to complete. If the alarm does not
clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more information
or call Cisco TAC 1 800 553-2447.

~

Note SFTWDOWN is an informational alarm.

2.1.338 SF-V

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM

An SF-V condition is similar to the “SF (DS1, DS3)” condition on page 2-200, but it applies to the VT
layer of the SONET overhead.
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Clear the SF-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-196.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.339 SHELF-COMM-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.340 SH-INS-LOSS-VAR-DEG-HIGH

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.341 SH-INS-LOSS-VAR-DEG-LOW

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.342 SHUTTER-OPEN

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.343 SIGLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, GE, ISC, TRUNK

The Signal Loss on Data Interface alarm is raised on FC_MR-4 card receive client ports and MXP card
FC and ISC client data ports when there is a loss of signal. (Loss of Gigabit Ethernet client signal results
in a CARLOSS [GE], not SIGLOSS.) SIGLOSS can also be raised on the MXP trunk port.

If the SYNCLOSS alarm was previously raised on the port, the SIGLOSS alarm will demote it.
Clear the SIGLOSS Alarm

Step1  Ensure that the data port connection at the near-end card’s port of the SONET link is operational.

Step2  Verify fiber continuity to the port. To verify fiber continuity, follow site practices.
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Step 4

2.7.344 SNTP-HOST W

Check the physical port LED on the card. The port LED looks clear (that is, not lit green) if the link is
not connected.

If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call
Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) problem.

2.7.344 SNTP-HOST

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS 15454 serving
as an IP proxy for the other ONS 15454 nodes in the ring is not forwarding SNTP information to the
other nodes in the network. The forwarding failure can result from two causes: either the IP network
attached to the ONS 15454 proxy node is experiencing problems, or the ONS 15454 proxy node itself is
not functioning properly.

Clear the SNTP-HOST Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible
within the subnet by completing the “1.9.8 Verify PC Connection to the ONS 15454 (ping)” procedure
on page 1-112.

If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP
information to the proxy and determine whether the network is experiencing problems, which could
affect the SNTP server/router connecting to the proxy ONS 15454 system.

If no network problems exist, ensure that the ONS system proxy is provisioned correctly:

a. In node view for the ONS 15454 serving as the proxy, click the Provisioning > General tabs.
b. Ensure that the Use NTP/SNTP Server check box is checked.

c. If the Use NTP/SNTP Server check box is not checked, click it.

d. Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

If proxy is correctly provisioned, refer to the “Timing” chapter in the Cisco ONS 15454 Reference
Manual for more information on SNTP Host.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.345 SPANLENGTH-OUT-OF-RANGE

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.346 SPAN-SW-EAST

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Span Switch Is Active East Side condition occurs when a span switch occurs at the east side of a
four-fiber BLSR span using a Force Span command. The condition clears when the switch is cleared.
SPAN-SW-EAST is visible on the network view Alarms, Conditions, and History tabs. The port where
the Force Span was applied shows an “F” on the network view detailed circuit map.

SPAN-SW-EAST is an informational condition and does not require troubleshooting.

2.1.347 SPAN-SW-WEST

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Span Switch Is Active West Side condition occurs when a span switch occurs at the west side of a
four-fiber BLSR span using a Force Span command. The condition clears when the switch is cleared.
SPAN-SW-WEST is visible on the network view Alarms, Conditions, and History tabs. The port where
the Force Span was applied shows an “F” on the network view detailed circuit map.

SPAN-SW-WEST is an informational condition and does not require troubleshooting.

2.7.348 SQUELCH

>

Warning

>

Warning

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Ring Squelching Traffic condition occurs in a BLSR when a node that originates or terminates STS
circuits fails or is isolated by multiple fiber cuts or maintenance Force Ring commands. The isolation or
failure of the node disables circuits that originate or terminate on the failed node. SQUELCH conditions
appear on one or both of the nodes on either side of the isolated or failed node. The “AIS-P” condition
on page 2-35 also appears on all nodes in the ring except the isolated node.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the SQUELCH Condition

A

Caution

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Determine the isolated node:
a. From the View menu, choose Go to Network View.
b. The grayed out node with red spans is the isolated node.
Verify fiber continuity to the ports on the isolated node. To verify cable continuity, follow site practices.
If fiber continuity is good, verify that the proper ports are in service:
a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.

If the correct ports are in service, use an optical test set to verify that a valid signal exists on the line.
For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to
the receiving card as possible.

If the signal is valid, verify that the power level of the optical signal is within the optical card receiver
specifications. Refer to the Cisco ONS 15454 Reference Manual for card specifications.

If the receiver levels are good, ensure that the optical transmit and receive fibers are connected properly.

If the connectors are good, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the OC-N card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.349 SQUELCHED

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Client Signal Squelched condition is raised by a TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, or MXPP_MR_2.5G card.

The condition can be raised in the following situations:

An MXP or TXP client facility detects that an upstream receive facility has experienced a loss of
signal (such as an Ethernet CARLOSS, DWDM SIGLOSS, or optical LOS). In response, the
facility’s transmit is turned off (SQUELCHED). The upstream receive facilities are the trunk receive
on the same card as the client, as well as the client receive on the card at the other end of the trunk
span.

The client will squelch if the upstream trunk receive (on the same card) experiences a SIGLOSS,
Ethernet CARLOSS, LOS, or LOS (TRUNK) alarm. In some transparent modes, the client is
squelched if the trunk detects an AIS condition or a TIM alarm.

The client will squelch if the upstream client receive (on the card at the other end of the DWDM
span) experiences CARLOSS, SIGLOSS, or LOS.

In an example situation, an upstream MXP_2.5G_10G client port receive experiences a “loss of light,”
and this port raises CARLOSS, SIGLOSS, or LOS (determined by the payload type) locally. The port
also sends client signal fail (GFP-CSF) to its downstream card. The downstream card raises a GFP-CSF
alarm, turns off the client transmit laser, and raises the SQUELCHED condition.

The local client raises SQUELCHED if it also raises one of the following alarms for the client, all of
which are signalled by the upstream node:

2.7.139 GFP-CSF, page 2-110

2.7.142 GFP-LFD, page 2-112

2.7.143 GFP-NO-BUFFERS, page 2-112
2.7.140 GFP-DE-MISMATCH, page 2-110
2.7.141 GFP-EX-MISMATCH, page 2-111
2.7.263 ODUK-1-AIS-PM, page 2-176
2.7.264 ODUK-2-AIS-PM, page 2-176
2.7.265 ODUK-3-AIS-PM, page 2-176
2.7.266 ODUK-4-AIS-PM, page 2-176

On the MXP_MR_10G, the local client raises a SQUELCHED condition if the upstream client detects
one of the following alarms. Note that no corresponding local alarm is raised to indicate which of these
conditions is present upstream.

LOS for the clients including the “LOS (2R)” alarm on page 2-145, the “LOS (ESCON)” alarm on
page 2-151, and the “LOS (ISC)” alarm on page 2-152

CARLOSS for the clients including the “CARLOSS (FC)” alarm on page 2-58, the “CARLOSS
(GE)” alarm on page 2-61, and the “CARLOSS (ISC)” alarm on page 2-61

The local client raises a SQUELCHED condition if the local trunk raises one of the following alarms:

2.7.282 OTUK-AIS, page 2-178
2.7.285 OTUK-LOF, page 2-179
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e 2.7.208 LOS (TRUNK), page 2-154

e 2.7.288 OTUK-TIM, page 2-179 (squelching enabled)

e 2.7.267 ODUK-AIS-PM, page 2-176

e 2.7.269 ODUK-LCK-PM, page 2-176

e 2.7.273 ODUK-TIM-PM, page 2-177 (squelching enabled)

e 2.7.381 TIM, page 2-222 (for the OC-N, squelching enabled)
e 2.7.185 LOF (OCN), page 2-139

e 2.7.206 LOS (OCN), page 2-152

e 2.7.54 CARLOSS (TRUNK), page 2-62

e 2.7.411 WVL-MISMATCH, page 2-236 (client or trunk)

When troubleshooting the SQUELCHED condition locally, look for failures progressing upstream in the
following order. (If you are troubleshooting this alarm remotely, reverse the order of progress.)

e Local client alarms, as above
e Local trunk alarms, as above

e Remote (upstream) client receive alarms, as above

If you see a SQUELCHED condition on the trunk, this can only be caused by a transponder (TXP) card.

For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the SQUELCHED Condition

Step 1

Step 2

Step 3

If the object is reported against any object besides ESCON, determine whether the remote node and local
node reports and LOF or the LOS alarm (for the client trunk, as listed above). If it does, turn to the
relevant section in this chapter and complete the troubleshooting procedure.

If no LOF or LOS is reported, determine whether any other listed remote node or local node conditions
as listed above has occurred. If so, turn to the relevant section of this chapter and complete the
troubleshooting procedure.

If none of these alarms is reported, determine whether the local port reporting the SQUELCHED
condition is in loopback. (You will see LPBKFACILITY OR LPBKTERMINAL in the condition window
for this port.) If it is in loopback, complete the following steps:

a. Double-click the client card to open the card view.
b. Click the Maintenance > Loopback > Port tabs.

c. If the port Admin State column says OOS,MT or OOS,DSBLD, click the cell to highlight it and
choose IS from the drop-down list. Changing the state to IS also clears any loopback provisioned on
the port.

~

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised
or remains, and the port service state transitions to OOS-AU,FLT.
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Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.350 SOM

Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Major (MJ),
Service-Affecting (SA) for VI-TERM

SONET Logical Objects: STSTRM, VI-TERM

The Sequence Mismatch alarm is a virtual concatenated (VCAT) member alarm. (VCAT member circuits
are independent circuits that are concatenated from different time slots into a higher-rate signal.) The
alarm occurs when the expected sequence numbers of VCAT members do not match the received
sequence numbers.

Clear the SQM Alarm

Step 1 For the errored circuit, complete the “Delete a Circuit” procedure on page 2-252.

Step2  Recreate the circuit using the “Create Circuits and VT Tunnels” chapter of the Cisco ONS 15454
Procedure Guide.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.351 SSM-DUS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The Synchronization Status (SSM) Message Quality Changed to Do Not Use (DUS) condition occurs
when the synchronization status message (SSM) quality level degrades to DUS or is manually changed
to DUS.

The signal is often manually changed to DUS to prevent timing loops from occurring. Sending a DUS
prevents the timing from being reused in a loop. The DUS signal can also be sent for line maintenance
testing.

S

Note  SSM-DUS is an informational condition and does not require troubleshooting.

2.1.352 SSM-FAIL

Single Failure Default Severity: Minor (MN), Non-Service-Affecting (NSA); Double Failure
Default Severity: Major (MJ), Service-Affecting (SA)
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SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The SSM Failed alarm occurs when the synchronization status messaging received by the ONS 15454
fails. The problem is external to the ONS 15454. This alarm indicates that although the ONS 15454 is
set up to receive SSM, the timing source is not delivering valid SSM messages.

Clear the SSM-FAIL Alarm

Step1  Verify that SSM is enabled on the external timing source.

Step2 Iftiming is enabled, use an optical test set to determine that the external timing source is delivering SSM.
For specific procedures to use the test set equipment, consult the manufacturer.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.353 SSM-LNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.354 SSM-OFF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The SSM Off condition applies to references used for timing the node. It occurs when the SSM for the
reference has been turned off. The node is set up to receive SSM, but the timing source is not delivering
SSM messages.

Clear the SSM-OFF Condition

Step 1 Complete the “Clear the SSM-FAIL Alarm” procedure on page 2-211.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.355 SSM-PRC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.1.356 SSM-PRS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Primary Reference Source (PRS) Traceable condition occurs when the SSM transmission level
is changed to Stratum 1 Traceable.

~

Note  SSM-PRS is an informational condition and does not require troubleshooting.

2.1.357 SSM-RES

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Reserved (RES) For Network Synchronization Use condition occurs when the synchronization
message quality level is changed to RES.

~

Note  SSM-RES is an informational condition and does not require troubleshooting.

2.7.358 SSM-SDN-TN

The SSM-SDN-TN condition is not used in this platform in this release. It is reserved for development.

2.1.359 SSM-SETS

The SSM-SETS condition is not used in this platform in this release. It is reserved for development.

2.7.360 SSM-SMC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM SONET Minimum Clock (SMC) Traceable condition occurs when the synchronization
message quality level changes to SMC. The login node does not use the clock because the node cannot
use any reference beneath its internal level, which is ST3.

Note  SSM-SMC is an informational condition and does not require troubleshooting.
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2.1.361 SSM-ST2

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 2 (ST2) Traceable condition occurs when the synchronization message quality level
is changed to ST2.

~

Note  SSM-ST?2 is an informational condition and does not require troubleshooting.

2.1.362 SSM-ST3

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 3 (ST3) Traceable condition occurs when the synchronization message quality level
is changed to ST3.

~

Note  SSM-ST3 is an informational condition and does not require troubleshooting.

2.7.363 SSM-ST3E

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 3E (ST3E) Traceable condition indicates that the synchronization message quality
level is changed to ST3E from a lower level of synchronization. SSM-ST3E is a Generation 2 SSM and
is used for Generation 1.

~

Note  SSM-ST3E is an informational condition and does not require troubleshooting.

2.1.364 SSM-ST4

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 4 (ST4) Traceable condition occurs when the synchronization message quality level
is lowered to ST4. The message quality is not used because it is below ST3.
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~

Note  SSM-ST4 is an informational condition and does not require troubleshooting.

2.7.365 SSM-STU

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Synchronization Traceability Unknown (STU) condition occurs when the reporting node is
timed to a reference that does not support SSM, but the ONS 15454 has SSM support enabled. SSM-STU
can also occur if the timing source is sending out SSM messages but SSM is not enabled on the

ONS 15454.

Clear the SSM-STU Condition

Step1  In node view, click the Provisioning > Timing > BITS Facilities tabs.
Step2  Complete one of the following depending upon the status of the Sync Messaging Enabled check box:
e If the Sync. Messaging Enabled check box for the BITS source is checked, uncheck the box.
e [f the Sync. Messaging Enabled check box for the BITS source is not checked, check the box.
Step3  Click Apply.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.366 SSM-TNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, NE-SREF
DWDM Logical Object: TRUNK

The SSM Transit Node Clock (TNC) Traceable condition occurs when the synchronization message
quality level is changed to TNC.

~

Note  SSM-TNC is an informational condition and does not require troubleshooting.

2.7.367 STS-SQUELCH-L

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
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The Ring is Squelching STS traffic condition is raised on an OC-N facility. If the node failure scenario
includes the source or destination node, then switching the nodes will squelch all the STSs that originate
from or destinate to the failure node. The condition resolves when the node is no longer failing.

This condition has an NA severity by default. However, the condition indicates that traffic is squelched
due to node failure, that is, traffic outage. Traffic outage can be caused by different problems, such as
multiple LOS alarms, AIS-L, or node power outage. STS-SQUELCH-L is symptomatic and indicates
that the user must investigate which node in a ring is being isolated and what is causing the node
isolation.

~

Note  STS-SQUELCH-L is an informational condition.

2.7.368 SW-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Software Mismatch condition occurs during software upgrade when there is a mismatch between
software versions. The card connecting to the TCC2/TCC2P is running an older version than the
TCC2/TCC2P is.

Clear the SW-MISMATCH Condition

Step1  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the errored card.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.369 SWMTXMOD-PROT

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Switching Matrix Module Failure on Protect Slot alarm is raised by the Slot 10 cross connect card
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are
given in the following paragraph.) SWMTXMOD-PROT occurs when a logic component internal to the
Slot 10 cross connect is out of frame (OOF) with a traffic card in the system. In this case, the alarm is
raised against the traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 10) whether it is ACT or standby (SBY). The XCVT
card can raise SWMTXMOD-PROT against itself if the cross-connect card is OOF with a second logic
component on the same cross connect card.

Clear the SWMTXMOD-PROT Alarm

Step1  Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the Slot 10 card. For the LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.
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Step 2

Step 3

Step 4

Step 5

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the Slot 10 cross-connect card.

Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-248.

~

Note  After the active cross-connect card goes into standby mode, the original standby slot becomes
active. The former standby card ACT/SBY LED becomes green.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.17.370 SWMTXMOD-WORK

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Switching Matrix Module Failure on Working Slot alarm is raised by the Slot 8 cross connect card
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are
given in the following paragraph.) SWMTXMOD-WORK occurs when a logic component internal to the
Slot 8 cross connect is OOF with a traffic card in the system. In this case, the alarm is raised against the
traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 8) whether it is ACT or standby (SBY). The XCVT
card can raise SWMTXMOD-WORK against itself if the cross-connect card is OOF with a second logic
component on the same cross connect card.

Clear the SWMTXMOD-WORK Alarm

Step 1

Step 2

Step 3

Step 4

Complete the “Reset a Traffic Card in CTC” procedure on page 2-247 for the Slot 8 card. For LED
behavior, see the “2.8.2 Typical Traffic Card LED Activity During Reset” section on page 2-237.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-250 for the Slot 8 cross-connect card.

Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-248.
>

Note  After the active cross-connect card goes into standby mode, the original standby slot becomes
active. The former standby card ACT/SBY LED becomes green.
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Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.3711 SWTOPRI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Primary Reference condition occurs when the ONS 15454 switches to
the primary timing source (reference 1). The ONS 15454 uses three ranked timing references. The timing
references are typically two BITS-level or line-level sources and an internal reference.

~

Note SWTOPRI is an informational condition and does not require troubleshooting.

2.1.372 SWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Secondary Reference condition occurs when the ONS 15454 has
switched to a secondary timing source (reference 2).

Clear the SWTOSEC Condition

Step1  To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-219.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.3713 SWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Third Reference condition occurs when the ONS 15454 has switched to
a third timing source (reference 3).

Clear the SWTOTHIRD Condition

Step1  To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-219 or the “SYNCSEC” alarm on page 2-220.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.374 SYNC-FREQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The Synchronization Reference Frequency Out of Bounds condition is reported against any reference
that is out of the bounds for valid references. The login node fails the reference and chooses another
internal or external reference to use.

Clear the SYNC-FREQ Condition

Step 1 Use an optical test set to verify the timing frequency of the line or BITS timing source and ensure that
it falls within the proper frequency. For specific procedures to use the test set equipment, consult the
manufacturer.

For BITS, the proper timing frequency range is approximately —15 PPM to 15 PPM. For optical line
timing, the proper frequency range is approximately —16 PPM to 16 PPM.

Step2  If the reference source frequency is not outside of bounds, complete the “Physically Replace a Traffic
Card” procedure on page 2-250 for the TCC2/TCC2P.

N

Note It takes up to 30 minutes for the TCC2/TCC2P to transfer the system software to the newly
installed TCC2/TCC2P. Software transfer occurs in instances where different software versions
exist on the two cards. When the transfer completes, the active TCC2/TCC2P reboots and goes
into standby mode after approximately three minutes.

Step3  If the SYNC-FREQ condition continues to report after replacing the TCC2/TCC2P, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
1 800 553-2447.

2.1.375 SYNCLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, GE, ISC, TRUNK

The Loss of Synchronization on Data Interface alarm is raised on FC_MR-4 client ports and MXP cards
client or trunk ports when there is a loss of signal synchronization on the port. This alarm is demoted by
the SIGLOSS alarm.
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Clear the SYNCLOSS Alarm

Step 1
Step 2
Step 3

Step 4

Ensure that the data port connection at the near-end card’s port of the SONET link is operational.
Verify fiber continuity to the port. To do this follow site practices.
View the physical port LED to determine whether the alarm has cleared:

e If the LED is green, the alarm has cleared.

e If the port LED is clear (that is, not illuminated green), the link is not connected and the alarm has
not cleared.

e If the LED is red, this indicates that the fiber is pulled.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 to report a service-affecting problem.

2.1.376 SYNCPRI

Default Severity: Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF;Major (MJ),
Service-Affecting (SA) for NE-SREF

SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Primary Reference alarm occurs when the ONS 15454 loses the primary timing
source (reference 1). The ONS 15454 uses three ranked timing references. The timing references are
typically two BITS-level or line-level sources and an internal reference. If SYNCPRI occurs, the
ONS 15454 should switch to its secondary timing source (reference 2). Switching to the secondary
timing source also triggers the “SWTOSEC” alarm on page 2-217.

A

Note The SYNCPRI alarm will be escalated to Major (MJ), Service-Affecting if no other valid
references (SYNCSEC, SYNCTHIRD) are available. If any other reference are available
then SYNCPRI gets raised as Minor (MN), non service affecting.

Clear the SYNCPRI Alarm

Step1  In node view, click the Provisioning > Timing > General tabs.

Step2  Verify the current configuration for REF-1 of the NE Reference.

Step3  If the primary timing reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure
on page 2-145.

Step4  If the primary reference clock is an incoming port on the ONS 15454, complete the “Clear the LOS
(OCN) Alarm” procedure on page 2-153.

Step5  If the condition does not clear, log into the Technical Support Website at

http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.1.377 SYNCSEC

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Secondary Reference alarm occurs when the ONS 15454 loses the secondary
timing source (reference 2). If SYNCSEC occurs, the ONS 15454 should switch to a third timing source
(reference 3) to obtain valid timing for the ONS 15454. Switching to a third timing source also triggers
the “SWTOTHIRD” alarm on page 2-217.

~

Note The severity of SYNCSEC alarm is dependent on the alarm profile it is associated with. If
the alarm profile it is associated with is Major (MJ), then this condition is raised as MJ,
service affecting, even if alternate source of references are available.

Clear the SYNCSEC Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.
Step2  Verify the current configuration of REF-2 for the NE Reference.

Step3  If the secondary reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-145.

Step4  Verify that the BITS clock is operating properly.

Step5  If the secondary timing source is an incoming port on the ONS 15454, complete the “Clear the LOS
(OCN) Alarm” procedure on page 2-153.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.378 SYNCTHIRD

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Third Reference alarm occurs when the ONS 15454 loses the third timing source
(reference 3). If SYNCTHIRD occurs and the ONS 15454 uses an internal reference for source three,
the TCC2/TCC2P could have failed. The ONS 15454 often reports either the “FRNGSYNC” condition
on page 2-108 or the “HLDOVRSYNC” condition on page 2-119 after a SYNCTHIRD alarm.

~

Note  The severity of SYNCTHIRD alarm is dependent on the alarm profile it is associated with.
If the alarm profile it is associated with is Major (MJ), then this condition is raised as MJ,
service affecting, even if alternate source of references are available.

Clear the SYNCTHIRD Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.
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Step 2
Step 3

Step 4

A
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Verify that the current configuration of REF-3 for the NE Reference. For more information about
references, refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual.

If the third timing source is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-145.

If the third timing source is an incoming port on the ONS 15454, complete the “Clear the LOS (OCN)
Alarm” procedure on page 2-153.

Caution

Step 5

Step 6

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the third timing source uses the internal ONS 15454 timing, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-247.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-249. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-250.

2.7.379 SYSBOOT

~

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: NE

The System Reboot alarm indicates that new software is booting on the TCC2/TCC2P. No action is
required. The alarm clears when all cards finish rebooting the new software. The reboot takes up to
30 minutes.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

SYSBOOT is an informational alarm. It only requires troubleshooting if it does not clear.

2.7.380 TEMP-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

Temperature Reading Mismatch Between Control Cards is raised when the temperature readings on the
two TCC2/TCC2Ps are out of range of each other by more than some predefined difference (such as 5
degrees C). A message containing power monitoring and temperature information is exchanged between
the two TCC2/TCC2Ps, allowing the values to be compared. The temperature of each TCC2/TCC2P is
read from a system variable.

This condition can be caused by a clogged fan filter or by fan tray stoppage.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R7.0 g



Chapter2  Alarm Troubleshooting |

W 27381 TIM

Clear the TEMP-MISM Condition

Step 1
Step 2

Step 3

2.1.381 TIM

Complete the “Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-255.

If the condition does not clear, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-257.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The Section TIM alarm occurs when the expected JO section trace string does not match the received
section trace string. This occurs because the data being received is not correct, and the receiving port
could not be connected to the correct transmitter port.

If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed due to
a fibering misconnection, a TL1 routing change, or to someone entering an incorrect value in the Current
Transmit String field.

TIM occurs on a port that has previously been operating without alarms if someone switches optical
fibers that connect the ports. TIM is usually accompanied by other alarms, such as the “LOS (OCN)”
alarm on page 2-152 or the “UNEQ-P” alarm on page 2-230. If these alarms accompany a TIM alarm,
reattach or replace the original cables/fibers to clear the alarms. If a Transmit or Expected String was
changed, restore the original string.

Clear the TIM Alarm

Step 1

Step 2

Ensure that the physical fibers are correctly configured and attached. To do this, consult site documents.
For more information about cabling the ONS 15454, refer to the “Install Cards and Fiber-Optic Cable”
chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, you can compare the JO expected and transmitted strings and, if necessary,
change them:

a. Log into the circuit source node and click the Circuits tab.
b. Select the circuit reporting the condition, then click Edit.
¢. In the Edit Circuit window, check the Show Detailed Circuit Map check box and click Apply.

d. On the detailed circuit map, right-click the source circuit port and choose Edit J0 Path Trace (port)
from the shortcut menu.

e. Compare the Current Transmit String and the Current Expected String entries in the Edit JO Path
Trace dialog box.

f. If the strings differ, correct the Transmit or Expected strings and click Apply.
g. Click Close.
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Step3  If the alarm does not clear, ensure that the signal has not been incorrectly routed. (Although the
ONS 15454 routes circuits automatically, the circuit route could have been changed using TL1.) If
necessary, manually correct the routing using TL1. For instructions, refer to the Cisco ONS SONET TL1
Reference Guide and the Cisco ONS SONET TL1 Command Guide .

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem if necessary.

2.7.382 TIM-MON

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The TIM Section Monitor TIM alarm is similar to the “TIM-P” alarm on page 2-223, but it applies to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, and MXP_2.5G_10G cards when
they are configured in transparent mode. (In transparent termination mode, all SONET overhead bytes
are passed through from client ports to the trunk ports or from trunk ports to client ports.)

Note For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the TIM-MON Alarm

Step 1 Complete the “Clear the TIM-P Alarm” procedure on page 2-224.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.1.383 TIM-P

Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Default Severity:
Minor (MN), Non-Service-Affecting (NSA) for STSMON

SONET Logical Objects: STSMON, STSTRM

The TIM Path alarm occurs when the expected path trace string does not match the received path trace
string. Path Trace Mode must be set to Manual or Auto for the TIM-P alarm to occur.

In manual mode at the Path Trace window, the user types the expected string into the Current Expected
String field for the receiving port. The string must match the string typed into the Transmit String field
for the sending port. If these fields do not match, the login node raises the TIM-P alarm. In Auto mode
on the receiving port, the card sets the expected string to the value of the received string. If the alarm
occurs on a port that has been operating with no alarms, the circuit path has changed or someone entered
a new incorrect value into the Current Transmit String field. Complete the following procedure to clear
either instance.
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Clear the TIM-P Alarm

Step 1

Step 2

2.7.384 TIM-S

Note

Complete the “Clear the TIM Alarm” procedure on page 2-222. (The option will say “Edit J1 Path Trace”
rather than “Edit JO Path Trace.”)

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447. If the alarm applies to the STSTRM object, it
is Service-Affecting (SA).

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: EC1, OCN

The TIM for Section Overhead alarm occurs when there is a mismatch between the expected and
received JO section overhead strings in either Manual or Auto mode.

In manual mode at the DS3/EC1-48 card Section Trace window, the user enters the expected string into
the Current Expected String field for the receiving port. The string must match the string typed into the
Transmit String field for the sending port. If these fields do not match, the login node raises the TIM-S
alarm.

In Auto mode on the receiving port, the card sets the expected string to the value of the received string.
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Complete the following
procedure to clear either problem.

TIM-S also occurs on a port that has previously been operating without alarms if someone switches the
cables or optical fibers that connect the ports. If TIM-S is enabled on the port, the “AIS-L” alarm on
page 2-34 can be raised downstream and the “RFI-L” alarm on page 2-190 can be raised upstream.

AIS-L and RFI-L are disabled or enabled in the Provisioning > EC1 > Section Trace tab Disable
AIS/RDI on TIM-S? check box.

Clear the TIM-S Alarm

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Double-click the DS3/EC1-48 card to open the card view.

Click the Provisioning > EC1 > Section Trace tabs.

Choose the port from the Port pull-down.

In the Expected area, enter the correct string into the Current Expected String field.
Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447. If the alarm applies to the STSTRM object, it
is Service-Affecting (SA).
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2.1.385 TIM-V

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: VI-TERM

The VT Path TIM alarm is raised on VT terminations when the J2 path trace is enabled and is
mismatched with the expected trace string.

Clear the TIM-V Alarm

Step1  Complete the “Clear the TIM Alarm” procedure on page 2-222.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 to report a service-affecting problem.

2.7.386 TPTFAIL (CE100T, CE1000)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE100T, CE1000, LOGFAC

The Transport (TPT) Layer Failure alarm for the CE-100T-8 card indicates a break in the end-to-end
Ethernet link integrity feature of the ONS 15454 CE-100T-8 card. TPTFAIL indicates a far-end
condition and not a problem with the port reporting TPTFAIL.

Note  For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (CE100T, CE1000) Alarm

Step 1 Complete the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-226.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.387 TPTFAIL (FCMR)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR

The Transport Fail alarm is raised against a local Fibre Channel (FC) port on an FC_MR-4 card when
the port receives another SONET error such as AIS-P, LOP-P, UNEQ-P, PLM-P, TIM-P, LOM (for VCAT
only), or SQM (for VCAT only).
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This TPTFAIL can be raised against Fibre Channel cards if the remote FC card port is down from
SIGLOSS or SYNCLOSS. In that case, the remote FC card port sends a PDI-P error code in the SONET
C2 byte and signals the local FC port transmitter to turn off (thus causing the local FC port to raise the
TPTFAIL alarm). A TPTFAIL can also be raised when a far-end receive fiber is pulled. This alarm can
be demoted when a facility loopback is placed on the FC_MR-4 port.

Clear the TPTFAIL (FCMR) Alarm

Step 1

Step 2

Find and clear any path alarms applying to the port. Refer to the correct section of this chapter for trouble
clearing instructions. Clearing the path alarm also clears the TPTFAIL.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.388 TPTFAIL (G1000)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: G1000

The Transport Layer Failure alarm for the G-Series Ethernet card indicates a break in the end-to-end
Ethernet link integrity feature of the ONS 15454 G1000-4 cards. TPTFAIL indicates a far-end condition
and not a problem with the port reporting TPTFAIL.

The TPTFAIL alarm indicates a problem on either the SONET path or the remote Ethernet port that
prevents the complete end-to-end Ethernet path from working. If any SONET path alarms such as the
“AIS-P” alarm on page 2-35, the “LOP-P” alarm on page 2-142, the “PDI-P” alarm on page 2-179, or
the “UNEQ-P” alarm on page 2-230 exist on the SONET path used by the Ethernet port, the affected port
causes a TPTFAIL alarm. Also, if the far-end G1000-4 port Ethernet port is administratively disabled or
it is reporting the “CARLOSS (G1000)” alarm on page 2-58, the C2 byte in the SONET path overhead
indicates the “PDI-P” alarm on page 2-179, which in turn causes a TPTFAIL to be reported against the
near-end port.

When a TPTFAIL alarm occurs, the near-end port is automatically disabled (transmit laser turned off).
In turn, the laser shutoff can also cause the external Ethernet device attached at the near end to detect a
link down and turn off its transmitter. This also causes a CARLOSS alarm to occur on the reporting port.
In all cases, the source problem is either in the SONET path being used by the G1000-4 port or the far-
end G1000-4 port to which it is mapped.

An occurrence of TPTFAIL on an ONS 15454 G1000-4 port indicates either a problem with the SONET
path that the port is using or with the far-end G1000-4 port that is mapped to the port.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (G1000) Alarm

Step 1

Clear any alarms being reported by the OC-N card on the G1000-4 circuit.
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Step 3

2.7.389 TPTFAIL (ML100T, ML1000, MLFX) T

If no alarms are reported by the OC-N card, or if the “PDI-P” condition on page 2-179 is reported, the
problem could be on the far-end G1000-4 port. Clear any alarms, such as CARLOSS, reported against
the far-end port or card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.389 TPTFAIL (ML100T, ML1000, MLFX)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: ML100T, ML1000, MLFX

The TPT Layer Failure alarm for the ML-Series Ethernet card indicates a break in the end-to-end
packet-over-SONET (POS) link integrity feature of the ML-Series POS cards. TPTFAIL indicates a
far-end condition or misconfiguration of the POS port.

The TPTFAIL alarm indicates a problem on the SONET path, a problem on the remote POS port, or a
misconfiguration of the POS port that prevents the complete end-to-end POS path from working. If any
SONET path alarms such as the “AIS-P” condition on page 2-35, the “LOP-P” alarm on page 2-142, the
“PDI-P” condition on page 2-179, or the “UNEQ-P” alarm on page 2-230 exist on the circuit used by the
POS port, the affected port could report a TPTFAIL alarm. If the far-end ML POS port is
administratively disabled, it inserts an “AIS-P” condition on page 2-35 that is detected by the near-end
port. The near-end port could report TPTFAIL in this event. If the POS port is misconfigured at the
Cisco IOS CLI level, the misconfiguration causes the port to go down and report TPTFAIL.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

Step 1

Step 2

Step 3

Step 4

If there are no SONET alarms reported against the POS port circuit, verify that both POS ports are
properly configured. Refer to the Ethernet Card Software Feature and Configuration Guide for the
Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 for configuration information.

If the “PLM-P” alarm on page 2-182 is the only one reported against the POS port circuit, verify that
both POS ports are properly configured. Refer to the Ethernet Card Software Feature and Configuration
Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 for configuration
information.

If the “PDI-P” condition on page 2-179 is the only one reported against the POS port circuit and the
circuit is terminated by a G-Series card, determine whether a “CARLOSS (G1000)” alarm on page 2-58
is reported against the G-Series card, and if so, complete the “Clear the CARLOSS (G1000) Alarm”
procedure on page 2-59.

If the “AIS-P” alarm on page 2-35, the “LOP-P” alarm on page 2-142, or the “UNEQ-P” alarm on
page 2-230 is present, clear those alarms using the procedures in those sections.
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Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.390 TRMT

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: DS1, E1

A Missing Transmitter alarm occurs when there is a transmit failure on the ONS 15454 DS-1 card
because of an internal hardware failure. The card must be replaced.

Clear the TRMT Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-250 for the reporting DS-1 card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.391 TRMT-MISS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: DS1, E1

A Facility Termination Equipment Transmitter Missing alarm occurs when the facility termination
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance is
detected when a transmit cable is missing on the DS-1 port or the backplane does not match the inserted
card. For example, an SMB connector or a BNC connector could be connected to a DS-1 card instead of
a DS-3 card.

~

Note  DS-Is are four-wire circuits and need a positive and negative connection for both transmit and receive.

Clear the TRMT-MISS Alarm

Step 1 Verify that the device attached to the DS-1 port is operational.
Step2  If the device is operational, verify that the cabling is securely connected.
Step3  If the cabling is secure, verify that the pinouts are correct.

Step4  If the pinouts are correct, replace the transmit cable.
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Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.392 TX-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3, El

The (TX) Transmit Direction AIS condition is raised by the ONS 15454 backplane when it receives a
far-end DS-1 LOS.

Clear the TX-AIS Condition

Step 1 Determine whether there are alarms on the downstream nodes and equipment, especially the “LOS
(OCN)” alarm on page 2-152, or OOS ports.

Step2  Clear the downstream alarms using the applicable procedures in this chapter.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.393 TX-LOF

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, E1
The Transmit Direction LOF condition is transmitted by the backplane when it receives a DS-1 TX-LOF.

This alarm is raised only at the transmit (egress) side.

Clear the TX-LOF Condition

Step 1 Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-136.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.1.394 TX-RAI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3, El
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The Transmit Direction RAI condition is transmitted by the backplane when it receives a DS-1 TX-AIS.
This alarm is raised only at the transmit side, but RAI is raised at both ends.

Note  The DS1-56 card operating in retiming mode reports a Transmit Condition remote alarm indication
(TX-RAI) alarm in the alarm log. However, the physical signal that is transmitted out does not have TX-
RAI in the frame. Hence, TX-RAI is not transmitted in the DS1 signal. This causes the client equipment
not to detect TX-RAI in the incoming signal.

Clear the TX-RAI Condition

Step 1 Complete the “Clear the TX-AIS Condition” procedure on page 2-229.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.395 UNC-WORD

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.396 UNEQ-P

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM

An SLMF UNEQ Path alarm occurs when the path does not have a valid sender. The UNEQ-P indicator
is carried in the C2 signal path byte in the SONET overhead. The source of the problem is the node that
is transmitting the signal into the node reporting the UNEQ-P.

The alarm could result from a PARTIAL circuit or an empty VT tunnel. UNEQ-P occurs in the node that
terminates a path.

Note  If a newly created circuit has no signal, a UNEQ-P alarm is reported on the OC-N cards and the “AIS-P”
condition on page 2-35 is reported on the terminating cards. These alarms clear when the circuit carries
a signal.

A

Caution  Deleting a circuit affects traffic.

Clear the UNEQ-P Alarm

Step 1 In node view, choose Go to Network View from the View menu.
Step2  Right-click the alarm to display the Select Affected Circuits shortcut menu.
Step3  Click Select Affected Circuits.
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Warning

>

Warning

>

Warning

273% UNEa-P H

When the affected circuits appear, look in the Type column for VTT, which indicates a VT tunnel circuit.
A VT tunnel with no VTs assigned could be the cause of an UNEQ-P alarm.

If the Type column does not contain VTT, there are no VT tunnels connected with the alarm. Go to
Step 7.

If the Type column does contain VTT, attempt to delete these rows:

~

Note  The node does not allow you to delete a valid VT tunnel or one with a valid VT circuit inside.

a. Click the VT tunnel circuit row to highlight it. Complete the “Delete a Circuit” procedure on
page 2-252.

b. If an error message dialog box appears, the VT tunnel is valid and not the cause of the alarm.

c¢. If any other rows contain VTT, repeat Step 6.

If all nodes in the ring appear in the CTC network view, determine whether the circuits are complete:
a. Click the Circuits tab.

b. Verify that PARTIAL is not listed in the Status column of any circuits.

If you find circuits listed as PARTIAL, use an optical test set to verify that these circuits are not working
circuits that continue to pass traffic. For specific procedures to use the test set equipment, consult the
manufacturer.

If the PARTIAL circuits are not needed or are not passing traffic, delete the PARTIAL circuits.
Complete the “Delete a Circuit” procedure on page 2-252.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide.

Log back in and verify that all circuits terminating in the reporting card are active:
a. Click the Circuits tab.
b. Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
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A

Caution

Step 13

Step 14

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-250
for the OC-N and electrical cards.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.1.397 UNEQ-V

>

Warning

>

Warning

A

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: VI-MON, VI-TERM

An SLMF UNEQ VT alarm indicates that the node is receiving SONET path overhead with Bits 5, 6,
and 7 of the V5 overhead byte all set to zeroes. The source of the problem is not the node raising the
alarm, but the node transmitting the VT signal to it. The V in UNEQ-V indicates that the failure has
occurred at the VT layer.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
Clear the UNEQ-V Alarm
Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-230.
Cauﬁ Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.

Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA)
problem.

2.7.398 UNREACHABLE-TARGET-POWER

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.399 UT-COMM-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.1.400 UT-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.401 VCG-DEG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: VCG

The VCAT Group Degraded alarm is a VCAT group alarm. (VCATSs are groups of independent circuits
that are concatenated from different time slots into higher-rate signals.) The alarm occurs when one
member circuit carried by the ML-Series Ethernet card is down. This alarm is accompanied by the
“O0U-TPT” alarm on page 2-177. It only occurs when a Critical (CR) alarm, such as LOS, causes a
signal loss.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the VCG-DEG Condition

Step 1 Look for and clear any Critical (CR) alarms that apply to the errored card, such as the “LOS (2R)” alarm
on page 2-145 or “LOS (OTS)” alarm on page 2-154.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.402 VCG-DOWN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: VCG

The VCAT Group Down alarm is a VCAT group alarm. (VCATSs are groups of independent circuits that
are concatenated from different time slots into higher-rate signals.) The alarm occurs when one or more
member circuits carried by an ML-Series or CE-Series Ethernet card are down. The VCG-DOWN alarm
occurs in conjunction with another Critical (CR) alarm, such as the “LOS (2R)” alarm on page 2-145.

Note If LCAS (Link Capacity Adjustment Scheme) is not enabled, the VCAT group transitions to the down
state with even a single member down. If SW-LCAS is enabled on the VCAT group for ML1 cards, or
HW LCAS is enabled for CE cards, the VCAT group transitions to the VCG-DOWN state only when all
the members are down. The presence of at least one working member causes the VCAT group to remain
in VCG-DEG (VCG degraded) state.

Note  For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the VCG-DOWN Condition

Step 1 Complete the “Clear the VCG-DEG Condition” procedure on page 2-233.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.403 VOA-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.404 VOA-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.405 VOA-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.406 VOA-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.407 VOLT-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: PWR

The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the
power voltages of both TCC2/TCC2Ps are out of range of each other by more than 5 VDC.

Clear the VOLT-MISM Condition

Step1  Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or refer to the
“Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide for power
installation procedures.

Step2  Correct any incoming voltage issues.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC 1 800 553-2447.

2.7.408 VT-SQUELCH-L

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Ring is Squelching VT Traffic condition is raised on an OC-N facility. If the node failure scenario
includes the source node, the node dropping VT will squelch VT traffic. The condition resolves when
the node failure is recovered.

This condition is raised as NA severity by default. However, it indicates that traffic is squelched due to
node failure, that is, traffic outage. Traffic outage can be caused by different problems, such as multiple
LOS alarms, AIS-L, or node power outage. VI-SQUELCH-L is symptomatic and indicates that the user
must investigate which node in a ring is being isolated and what causes node isolation.

~

Note  VT-SQUELCH-L is an informational condition.

2.7.409 WKSWPR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VI-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC
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The Working Switched To Protection condition occurs when a line experiences the “LOS (OCN)” alarm
on page 2-152, the “SD (DS1, DS3)” condition on page 2-196, or the “SD (TRUNK)” condition on
page 2-199.

This condition is also raised when you use the FORCE SPAN, FORCE RING or MANUAL SPAN
command at the network level. WKSWPR is visible on the network view Alarms, Conditions, and
History tabs.

Clear the WKSWPR Condition

Step 1 Complete the “Clear the LOS (OCN) Alarm” procedure on page 2-153.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.410 WTR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VI-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Wait To Restore condition occurs when the “WKSWPR” condition on page 2-235 is raised, but the
wait-to-restore time has not expired, meaning that the active protect path cannot revert to the working
path. The condition clears when the timer expires and traffic switches back to the working path.

A

Caution  DS-1 traffic loss can occur on a DS-1 with 1:N protection if a DS-1 card is reset with the protect card in
the WTR state.

~

Note  WTR is an informational condition and does not require troubleshooting.

2.7.411 WVL-MISMATCH

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8 Traffic Card LED Activity

ONS 15454 traffic card LED behavior patterns are listed in the following sections. These sections give
behavior for card insertion, reset, and side-switch.
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2.8.1 Typical Traffic Card LED Activity After Insertion

When a card is inserted, the following LED activities occur:

1. The red FAIL LED turns on and remains illuminated for 20 to 30 seconds.
The red FAIL LED blinks for 35 to 45 seconds.

All LEDs blink once and turn off for 5 to 10 seconds.

The ACT or ACT/SBY LED turns on. The SF LED can persist until all card ports connect to their
far-end counterparts and a signal is present.

s w N

2.8.2 Typical Traffic Card LED Activity During Reset

While a card resets, the following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.

2. The white LED with the letters “LDG” appears on the reset card in CTC.
3. The green ACT LED appears in CTC.

2.8.3 Typical Card LED State After Successful Reset

When a card successfully resets, the following LED states are present:
e If you are looking at the physical ONS 15454, the ACT/SBY LED is illuminated.

e If you are looking at node view of the ONS 15454, the current standby card has an amber LED
depiction with the initials “SBY,” and this has replaced the white “LDG” depiction on the card in
CTC.

e Ifyou are looking at node view of the ONS 15454, the current active card has a green LED depiction
with the initials “ACT,” and this has replaced the white “LDG” depiction on the card in CTC.

2.8.4 Typical Cross-Connect LED Activity During Side Switch

When a XC10G card is switched in CTC from active (ACT) to standby (SBY) or from SBY to ACT, the
following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.
2. The standby card yellow SBY LED becomes a green ACT LED, indicating it is now active.
3. The active card green ACT LED becomes a yellow SBY LED, indicating it is now standby.

2.9 Frequently Used Alarm Troubleshooting Procedures

This section gives common procedures that are frequently used when troubleshooting alarms. Most of
these procedures are summarized versions of fuller procedures existing elsewhere in the ONS 15454
documentation. They are included in this chapter for the user’s convenience. For further information,
please refer to the Cisco ONS 15454 Procedure Guide.
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2.9.1 Node and Ring Identification, Change, Visibility, and Termination

The following procedures relate how to identify or change BLSR names and node IDs, and how to verify
visibility from other nodes.

Identify a BLSR Ring Name or Node ID Number

Step 1 Log into a node on the network.
Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Step 4 From the Ring Name column, record the ring name, or in the Nodes column, record the Node IDs in the
BLSR. The Node IDs are the numbers in parentheses next to the node name.

Change a BLSR Ring Name

Step 1 Log into a node on the network.

Step2  In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BLSR tabs.

Step4  Highlight the ring and click Edit.

Step 5 In the BLSR window, enter the new name in the Ring Name field.
Step6  Click Apply.

Step7  Click Yes in the Changing Ring Name dialog box.

Change a BLSR Node ID Number

Step 1 Log into a node on the network.

Step2  In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BLSR tabs.

Step4  Highlight the ring and click Edit.

Step5  In the BLSR window, right-click the node on the ring map.

Step6  Select Set Node ID from the shortcut menu.

Step7 In the Edit Node ID dialog box, enter the new ID. The Node ID is the number in parentheses after the
Node Name.

Step8  Click OK.
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Verify Node Visibility for Other Nodes

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Log into a node on the network.

In node view, click the Provisioning > BLSR tabs.
Highlight a BLSR.

Click Ring Map.

In the BLSR Ring Map window, verify that each node in the ring appears on the ring map with a node
ID and IP address.

Click Close.

2.9.2 Protection Switching, Lock Initiation, and Clearing

The following sections give instructions for port, ring, and span switching and switch-clearing
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Force Switch Command

A

This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Force switch.

Caution

A

The Force command overrides normal protective switching mechanisms. Applying this command
incorrectly can cause traffic outages.

Caution

~

Note

Traffic is not protected during a Force protection switch.

A Force command switches traffic on a working path even if the path has signal degrade (SD) or signal
fail (SF) conditions. A Force switch does not switch traffic on a protect path. A Force switch preempts
a Manual switch.

Step 1 In node view, click the Maintenance > Protection tabs.

Step2  In the Protection Groups area, select the protection group with the port you want to switch.

Step3  In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
Protect/Standby port, click this port.

Step 4 In the Switch Commands area, click Force.

Step5  Click Yes in the Confirm Force Operation dialog box.

Step6  If the switch is successful, the group says “Force to working” in the Selected Groups area.
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Initiate a 1+1 Manual Switch Command

~

Note

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Manual switch.

A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual
switch is preempted by a Force switch.

In node view, click the Maintenance > Protection tabs.
In the Protection Groups area, select the protection group with the port you want to switch.

In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
protect/standby port, click this port.

In the Switch Commands area, click Manual.
Click Yes in the Confirm Force Operation dialog box.

If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Clear a 1+1 Force or Manual Switch Command

~

Note

Note

Step 1
Step 2
Step 3
Step 4
Step 5

If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working)
moves traffic back to the working port. In revertive operation, the traffic always switches back to
working. There is no revert to the protect. If ports are not configured as revertive, clearing a Force switch
to protect does not move traffic back.

If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow
the five-minute waiting period (during WTR) before the reversion occurs.

In node view, click the Maintenance > Protection tabs.

In the Protection Groups area, choose the protection group containing the port you want to clear.
In the Selected Group area, choose the port you want to clear.

In the Switching Commands area, click Clear.

Click Yes in the Confirmation Dialog box.

The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured
for revertive switching.
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Initiate a Lock-On Command

S

Note  For I:1and 1:N electrical protection groups, working or protect cards can be placed in the Lock On state.
For a 1+1 optical protection group, only the working port can be placed in the Lock On state.

Step 1 In node view, click the Maintenance > Protection tabs.
Step2  In the Protection Groups list, click the protection group where you want to apply a lock-on.

Step3  If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect
card, make the protect card active if necessary:

a. In the Selected Group list, click the protect card.

b. In the Switch Commands area, click Force.
Step4  In the Selected Group list, click the active card where you want to lock traffic.
Step 5 In the Inhibit Switching area, click Lock On.
Step6  Click Yes in the confirmation dialog box.

Initiate a Card or Port Lockout Command

A
Note  For 1:1 or 1:N electrical protection groups, working or protect cards can be placed in the Lock Out state.
For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

Step 1 In node view, click the Maintenance > Protection tabs.

Step2  In the Protection Groups list, click the protection group that contains the card you want to lockout.
Step3  In the Selected Group list, click the card where you want to lock out traffic.

Step 4 In the Inhibit Switching area, click Lock Out.

Step5  Click Yes in the confirmation dialog box.

The lockout has been applied and traffic is switched to the opposite card.

Clear a Lock-On or Lockout Command

Step 1 In node view, click the Maintenance > Protection tabs.

Step2  In the Protection Groups list, click the protection group that contains the card you want to clear.
Step3  In the Selected Group list, click the card you want to clear.

Step 4 In the Inhibit Switching area, click Unlock.

Step5  Click Yes in the confirmation dialog box.
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The lock-on or lockout is cleared.

Initiate a 1:1 Card Switch Command

~

Note

Step 1
Step 2
Step 3
Step 4

The Switch command only works on the Active card, whether it is working or protect. It does not work
on the Standby card.

In node view, click the Maintenance > Protection tabs.

Click the protection group that contains the card you want to switch.
Under Selected Group, click the active card.

Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to
Protect/Standby.

Initiate a Force Switch for All Circuits on a Path Protection Span

A

This procedure forces all circuits in a path protection from the working span to the protect. It is used to
remove traffic from a card that originates or terminates path protection circuits.

Caution

A

The Force command overrides normal protective switching mechanisms. Applying this command
incorrectly can cause traffic outages.

Caution

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7
Step 8

Traffic is not protected during a Force protection switch.

Log into a node on the network.
In node view, choose Go to Network View from the View menu.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Click the Perform UPSR span switching field.
Choose Force Switch Away from the drop-down list.
Click Apply.

In the Confirm UPSR Switch dialog box, click Yes.
In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do
not switch.
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Initiate a Manual Switch for All Circuits on a Path Protection Span

A

This procedure manually switches all circuits in a path protection from the working span to the protect.
It is used to remove traffic from a card that originates or terminates path protection circuits.

Caution

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

The Manual command does not override normal protective switching mechanisms.

Log into a node on the network.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Click the Perform UPSR span switching field.
Choose Manual from the drop-down list.

Click Apply.

In the Confirm UPSR Switch dialog box, click Yes.
In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Manual. Unprotected circuits do
not switch.

Initiate a Lockout for All Circuits on a Protect Path Protection Span

A

This procedure prevents all circuits in a path protection working span from switching to the protect span.
It is used to keep traffic off cards that originate or terminate path protection circuits.

Caution  The Lock Out of Protect command overrides normal protective switching mechanisms.

Step1  Log into a node on the network. If you are already logged in, continue with Step 2.

Step2  Right-click a network span and choose Circuits.
The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Step3  Click the Perform UPSR span switching field.

Step4  Choose Lock Out of Protect from the drop-down list.

Step5  Click Apply.

Step 6 In the Confirm UPSR Switch dialog box, click Yes.

Step7  In the Protection Switch Result dialog box, click OK.
In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do
not switch.
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Clear an External Switching Command on a Path Protection Span

S

Note

Step 1
Step 2

Step 3

If the ports terminating a span are configured as revertive, clearing a Force or Manual switch to protect
moves traffic back to the working port. If ports are not configured as nonrevertive, clearing a Force
switch to protect does not move traffic back.

Log into a node on the network. If you are already logged in, continue with Step 2.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Initiate a Force switch for all circuits on the span:

a. Click the Perform UPSR span switching field.

b. Choose Clear from the drop-down list.

¢. Click Apply.

d. In the Confirm UPSR Switch dialog box, click Yes.

e. In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Clear. Unprotected circuits do
not switch.

Initiate a Force Ring Switch on a BLSR

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Log into a node on the network. If you are already logged in, continue with Step 2.

From the View menu choose Go to Network View.

In network view, click the Provisioning > BLSR tabs.

Click the row of the BLSR you are switching, then click Edit.

Right-click a BLSR node west port and choose Set West Protection Operation.

In the Set West Protection Operation dialog box, choose Force Ring from the drop-down list.
Click OK.

Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Force Span Switch on a Four-Fiber BLSR

Step 1
Step 2
Step 3
Step 4

Log into a node on the network.
From the View menu choose Go to Network View.
In network view, click the Provisioning > BLSR tabs.

Click the row of the BLSR you are switching, then click Edit.
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Step 7
Step 8
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Right-click a BLSR node west port and choose Set West Protection Operation.
In the Set West Protection Operation dialog box, choose Force Span from the drop-down list.

Click OK.
Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Manual Span Switch on a BLSR

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

From the View menu, choose Go to Network View.
Click the Provisioning > BLSR tabs.
Choose the BLSR and click Edit.

Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Manual Span from the drop-down list.

Click OK.
Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Manual Ring Switch on a BLSR

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

From the View menu, choose Go to Network View.
Click the Provisioning > BLSR tabs.
Choose the BLSR and click Edit.

Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Manual Ring from the drop-down list.

Click OK.
Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Lockout on a BLSR Protect Span

Step 1 From the View menu choose Go to Network View.
Step2  Click the Provisioning > BL.SR tabs.
Step3  Choose the BLSR and click Edit.
Step4  Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).
[ November 2009
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Step5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Lockout Protect Span from the drop-down list.

Step6  Click OK.
Step7  Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate an Exercise Ring Switch on a BLSR

Step 1 Log into a node on the network.

Step2  Click View > Go to Network View.

Step3  Click the Provisioning > BLSR tabs.

Stepd  Click the row of the BLSR you are exercising, then click Edit.

Step5  Right-click the west port of a node and choose Set West Protection Operation.

Step6  In the Set West Protection Operation dialog box, choose Exercise Ring from the drop-down list.
Step7  Click OK.

Step8  Click Yes in the Confirm BLSR Operation dialog box.

Initiate an Exercise Ring Switch on a Four Fiber BLSR

Step1  Log into a node on the network.

Step 2 From the View menu, choose Go to Network View.

Step3  Click the Provisioning > BL.SR tabs.

Step4  Click the row of the BLSR you are exercising, then click Edit.

Step5  Right-click the west port of a node and choose Set West Protection Operation.

Step6  In the Set West Protection Operation dialog box, choose Exercise Span from the drop-down list.
Step7  Click OK.

Step8  Click Yes in the Confirm BLSR Operation dialog box.

Clear a BLSR External Switching Command

Step1  Log into a node on the network.

Step 2 From the View menu, choose Go to Network View.
Step3  Click the Provisioning > BLSR tabs.

Step4  Click the BLSR you want to clear.

Step5  Right-click the west port of the BLSR node where you invoked the switch and choose Set West
Protection Operation.
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Step6  In the Set West Protection Operation dialog box, choose Clear from the drop-down list.
Step7  Click OK.
Step8  Click Yes in the Confirm BLSR Operation dialog box.

2.9.3 CTC Card Resetting and Switching
This section gives instructions for resetting traffic cards, TCC2/TCC2Ps, and cross-connect cards.

A

Caution  For TXP and MXP cards placed in a Y-cable protection group, do not perform a software reset on both
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information
about Y-cable protection groups, refer to the Cisco ONS 15454 DWDM Procedure Guide.

A

Caution  Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for
any reason.

Note  When an AIC-I card is rest in CTC, any subsequent user client operations (such as CTC or TL1 activity)
is paused for approximately 5-10 seconds. The reset does not cause any conditions to be raised.

Note For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Reset a Traffic Card in CTC

Step1  Log into a node on the network. If you are already logged in, continue with Step 2.

Step2  In node view, position the cursor over the optical or electrical traffic card slot reporting the alarm.
Step3  Right-click the card. Choose Reset Card from the shortcut menu.

Stepd  Click Yes in the Resetting Card dialog box.

Reset an Active TCC2/TCC2P Card and Activate the Standby Card
A

Caution  Resetting an active TCC2/TCC2P can be service-affecting.

~

Note  Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change
you made to avoid losing any changes to the database.
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Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Log into a node on the network. If you are already logged in, continue with Step 2.
Identify the active TCC2/TCC2P:

If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green. The
ACT/STBLY LED of the standby card is amber.

Right-click the active TCC2/TCC2P in CTC.
Choose Reset Card from the shortcut menu.
Click Yes in the Confirmation Dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED
appearance, see the “2.8.3 Typical Card LED State After Successful Reset” section on page 2-237.

Double-click the node and ensure that the reset TCC2/TCC2P is in standby mode and that the other
TCC2/TCC2P is active. Verify the following:

e If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green.
The ACT/STBLY LED of the standby card is amber.

e No new alarms appear in the Alarms window in CTC.

Side Switch the Active and Standby Cross-Connect Cards

A

Caution

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6

The cross-connect card side switch is usually service-affecting.

Log into a node on the network. For instructions regarding how to log into a node, refer Cisco ONS 15454
Procedure Guide, Release 8.0. If you are already logged in, continue with Step 2.

Display node view.
Determine the active or standby XC10G card.
The ACT/SBY LED of the active card is green. The ACT/SBY LED of the standby card is amber.

~

Note  You can also position the cursor over the card graphic to display a popup identifying the card as
active or standby.

In node view, click the Maintenance > Cross-Connect > Cards tabs.
Click Switch.

Click Yes in the Confirm Switch dialog box. See the “2.8.4 Typical Cross-Connect LED Activity During
Side Switch” section on page 2-237 for LED information.

~

Note  During a maintenance side switch or soft reset of an active XC10G card, the 1+1 protection
group might display a protection switch. To disallow the protection switch from being displayed,
the protection group should be locked at the node where XC switch or soft reset of an active XC
switch is in progress.
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A

Caution  Active cross connect (XC10G/XCVT) cards should not be physically removed.

The following rules must be followed for removing an Active Cross Connect Card (XC10G/XCVT):

If the active cross connect has to be removed, perform an XCVT/XC10G side switch to change the status
of the card from active to standby and then remove the cross connect card once it goes back to standby.

OR

Perform a lockout on all circuits that originate from the node whose active cross connect card has to be
removed (performing a lockout on all spans will also accomplish the same goal).

2.9.4 Physical Card Reseating, Resetting, and Replacement

A

This section gives instructions for physically reseating and replacing TCC2/TCC2P, cross-connect, and
traffic cards.

Caution

Do not physically replace a card without first making provisions to switch or move traffic to a different
card or circuit. General procedures for this are located in the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239. In-depth traffic switching procedures and information
can be found in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card

A

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

A

Do not perform this action without the supervision and direction of Cisco TAC 1 800 553-2447.

Caution

The TCC2/TCC2P reseat could be service-affecting. Refer to the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for traffic-switching procedures.

Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change
you made to avoid losing any changes to the database.

When a standby TCC2/TCC2P card is removed and reinserted (reseated), all three fan lights could
momentarily turn on, indicating that the fans have also reset.
Step1  Log into a node on the network.
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Step 2

Step 3
Step 4

Ensure that the TCC2/TCC2P you want to reseat is in standby mode. A standby card has an amber
ACT/SBY (Active/Standby) LED illuminated.

When the TCC2/TCC2P is in standby mode, unlatch both the top and bottom ejectors on the
TCC2/TCC2P.

Physically pull the card at least partly out of the slot until the lighted LEDs turn off.
Wait 30 seconds. Reinsert the card and close the ejectors.

~

Note  The TCC2/TCC2P requires several minutes to reboot and display the amber standby LED after
rebooting. Refer to the Cisco ONS 15454 Reference Manual for more information about LED
behavior during a card reboot.

Remove and Reinsert (Reseat) Any Card

A

Caution

Step 1
Step 2
Step 3
Step 4

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Open the card ejectors.
Slide the card halfway out of the slot along the guide rails.
Slide the card all the way back into the slot along the guide rails.

Close the ejectors.

Physically Replace a Traffic Card

A

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Step 1
Step 2
Step 3

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. refer to the procedures in the

“2.9.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-239. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

When you replace a card with the identical type of card, you do not need to make any changes to the
database.

Open the card ejectors.
Slide the card out of the slot.

Open the ejectors on the replacement card.
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Slide the replacement card into the slot along the guide rails.

Close the ejectors.

Physically Replace an In-Service Cross-Connect Card

A

Caution

The cross-connect reseat could be service-affecting. Refer to the “2.9.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-239 for traffic-switching procedures prior to completing this
procedure.

Note  This procedure is placed in the chapter as a quick guide for the user’s convenience. A more detailed
procedure is located in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.
When you replace a card with the identical type of card, you do not need to make any changes to the
database.
Step 1 Determine the active cross-connect card (XCVT/XC10G/XC-VXC-10G). The ACT/SBY LED of the
active card is green. The ACT/SBY LED of the standby card is amber.
>
Note  You can also place the cursor over the card graphic to display a popup identifying the card as
active or standby.
Step2  Switch the active cross-connect card to standby:
a. In the node view, click the Maintenance > Cross-Connect tabs.
b. Under Cross Connect Cards, choose Switch.
c¢. Click Yes in the Confirm Switch dialog box.
)
Note  After the active cross-connect card becomes standby, the original standby slot becomes active.
This causes the ACT/SBY LED to become green on the former standby card.
Step3  Physically remove the new standby cross-connect card from the ONS 15454.
>
Note  An improper removal (IMPROPRMVL) alarm is raised when a card reseat is performed, unless
the card is first deleted in Cisco Transport Controller (CTC). The alarm clears after the card is
replaced.
Step4d  Insert the replacement cross-connect card into the empty slot.
The replacement card boots up and becomes ready for service after approximately one minute.
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2.9.5 Generic Signal and Circuit Procedures

This section gives instructions for verify BER thresholds, deleting circuits, provisioning SDCC
terminations, and clearing loopbacks.

Verify the Signal BER Threshold Level

Step 1 Log into a node on the network.
Step2  In node view, double-click the card reporting the alarm to open the card view.
Step3  Click the Provisioning > Line tabs.

Step4  Under the SD BER (or SF BER) column in the Provisioning window, verify that the cell entry is
consistent with the originally provisioned threshold. The default setting is 1E-7.

Step5  If the entry is consistent with the original provisioning, go back to your original procedure.

Step6  If the entry is not consistent with what the system was originally provisioned for, click the cell to reveal
the range of choices and click the original entry.

Step7  Click Apply.

Delete a Circuit

Step1  Log into a node on the network.

Step 2 In node view, click the Circuits tab.

Step3  Click the circuit row to highlight it and click Delete.
Step4  Click Yes in the Delete Circuits dialog box.

Verify or Create Node Section DCC Terminations

~

Note  Portions of this procedure are different for ONS 15454 DWDM nodes.

Step 1 Log into a node on the network.
Step2 In node view, click the Provisioning > Comm Channels > SDCC tab.

Step3  View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Step 4 If necessary, create a DCC termination:
a. Click Create.

b. In the Create SDCC Terminations dialog box, click the ports where you want to create the DCC
termination. To select more than one port, press the Shift key.

c. In the port state area, click the Set to IS radio button.
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d. Verify that the Disable OSPF on Link check box is unchecked.
e. Click OK.

Clear an OC-N Card Facility or Terminal Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback > Port tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows a state other than IS.
If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.
Click Apply.

~

Note  If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

Clear an OC-N Card Cross-Connect (XC) Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.
Click the Maintenance > Loopback > SONET STS tabs.
Uncheck the XC Loopback check box.

Click Apply.

Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > DS3 tabs or the Maintenance > DS1 tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows a state other than IS.
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Step 7
Step 8

If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Click Apply.

~

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

Clear Other Electrical Card or Ethernet Card Loopbacks

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

This procedure does not apply to DS3XM-6 or DS3XM-12 cards.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows a state other than IS.
If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.
Click Apply.

~

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.
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Step6  In the Admin State column, determine whether any port row shows an admin state other than IS, for
example, OOS,MT.

Step7  If a row shows an admin state other than IS, click in the column cell to display the drop-down list and
select IS.

a~

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port
service state transitions to OOS-AU,FLT.

Step8  Click Apply.

2.9.6 Air Filter and Fan Procedures

This section gives instructions for cleaning or replacing the air filter and reseating or replacing the fan
tray assembly.

Inspect, Clean, and Replace the Reusable Air Filter

To complete this task, you need a vacuum cleaner or detergent and water faucet, a spare filter, and a
pinned hex key.

A

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Although the filter works if it is installed with either side facing up, Cisco recommends that you install
it with the metal bracing facing up to preserve the surface of the filter.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell,
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later
versions of the ONS 15454 use a reusable air filter.

Step2  If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being
careful not to dislodge any dust that could have collected on the filter. If the filter is installed beneath
the fan tray and not in the external filter brackets, open and remove the front door assembly by
completing the following steps:

a. Open the front door of the shelf assembly by completing the following substeps.(If it is already open
or if the shelf assembly does not have a front door, continue with Step 3.)

¢ Open the front door lock.
e Press the door button to release the latch.
e Swing the door open.

b. Remove the front door by completing the following substeps (optional):
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Step 3
Step 4

Step 5
Step 6

Step 7
Step 8

Step 9

A

e Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
e Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
e Secure the dangling end of the ground strap to the door or chassis with tape.

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that could have
collected on the filter.

Visually inspect the air filter material for dirt and dust.

If the reusable air filter has a concentration of dirt and dust, either vacuum or wash the air filter. Prior to
washing the air filter, replace the dirty air filter with a clean air filter and also reinsert the fan-tray
assembly. Wash the dirty air filter under a faucet with a light detergent.

Spare ONS 15454 filters should be kept in stock for this purpose.

a

Note  Cleaning should take place outside the operating environment to avoid releasing dirt and dust
near the equipment.

If you washed the filter, allow it to completely air dry for at least eight hours.

Caution

Step 10

Step 11

A

Do not put a damp filter back in the ONS 15454.

If the air filter should be installed in the external filter brackets, slide the air filter all the way to the back
of the brackets to complete the procedure.

If the filter should be installed beneath the fan-tray assembly, remove the fan-tray assembly and slide the
air filter into the recessed compartment at the bottom of the shelf assembly. Put the front edge of the air
filter flush against the front edge of the recessed compartment. Push the fan tray back into the shelf
assembly.

Caution

Step 12

Step 13
Step 14

If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

a~

Note  On apowered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly
inserted.

To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Rotate the retractable handles back into their compartments.

Replace the door and reattach the ground strap.
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Remove and Reinsert a Fan-Tray Assembly

Step 1

Step 2
Step 3

Use the retractable handles embedded in the front of the fan-tray assembly to pull it forward several
inches.

Push the fan-tray assembly firmly back into the ONS 15454.

Close the retractable handles.

Replace the Fan-Tray Assembly

A

Caution

A

The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that does not
allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution

A

Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or
the connectors on the backplane.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.

Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.

Step 1 Open the front door of the shelf assembly by completing the following steps. If the shelf assembly does
not have a front door, continue with Step 3.
a. Open the front door lock.
b. Press the door button to release the latch.
c. Swing the door open.

Step2 Remove the front door (optional):
a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step3  Push the outer side of the handles on the fan-tray assembly to expose the handles.

Step4  Fold out the retractable handles at the outside edges of the fan tray.

Step5  Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

Step6  When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step7  If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

Cisco ONS 15454 Troubleshooting Guide, R7.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

B 297 Interface Procedures

Step 8

Step 9

Step 10

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket, you can slide
the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray
air filter, see the “Inspect, Clean, and Replace the Reusable Air Filter” section on page 2-255.

Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is
activated.

If you replace the door, be sure to reattach the ground strap.

2.9.7 Interface Procedures

This section includes instructions for replacing an EIA and an AIP.

Replace the Electrical Interface Assembly

~

Note

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6
Step 7
Step 8
Step 9

You need a #2 Phillips screwdriver. If you use high-density BNC EIAs, you also need a BNC insertion
and removal tool.

To remove the lower backplane cover, loosen the five screws that secure it to the ONS 15454 and pull it
away from the shelf assembly.

Loosen the nine perimeter screws that hold the backplane sheet metal cover or EIA in place. Do not
remove the interior screws.

If you are removing an AMP Champ EIA, remove the fastening plate before proceeding. To remove the
fastening plate, loosen the two thumbscrews.

If a backplane cover is attached to the ONS 15454, lift the panel by the bottom to remove it from the
shelf assembly and store the panel for later use.

If an EIA is attached to the ONS 15454, lift the EIA handles and gently pull it away from the backplane.

a~

Note  Attach backplane sheet metal covers whenever EIAs are not installed.

Line up the connectors on the new EIA with the mating connectors on the backplane.

Gently push the EIA until both sets of connectors fit together snugly.

Replace the nine perimeter screws that you removed while removing the backplane cover.

If you are installing an AMP Champ EIA, attach the fastening plate with the two thumbscrews.

Reattach the lower backplane cover.
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Replace the Alarm Interface Panel

A

Caution

A

Do not use a 2A AIP with a 5A fan-tray assembly; doing so causes a blown fuse on the AIP.

Caution

~

Note

A

If any nodes in an Ethernet circuit are not using Software R4.0 or later, there is a risk of Ethernet traffic
disruptions. Contact Cisco TAC at 1 800 553-2447 when prompted to do so in the procedure.

Perform this procedure during a maintenance window. Resetting the active TCC2/TCC2P can cause a
service disruption of less then 50 ms to OC-N or DS-N traffic. Resetting the active TCC2/TCC2P can
cause a service disruption of 3 to 5 minutes on all Ethernet traffic due to spanning tree reconvergence if
any nodes in the Ethernet circuit are not using Software R4.0 or later.

Caution

A

Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and
result in a loss of data. For assistance with AIP replacement contact Cisco TAC 1 800 553-2447.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
This procedure replaces an existing AIP with a new AIP on an in-service node without affecting traffic.
Ethernet circuits that traverse nodes with a software release prior to R4.0 is affected.
You need a #2 Phillips screwdriver.
Step 1 Ensure that all nodes in the affected network are running the same software version before replacing the
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade
document for procedures. No hardware should be changed or circuit repair performed until after the
software upgrade is complete. If you do not need to upgrade software or have completed the software
upgrade, proceed to Step 2.

Step2 Record the MAC address of the old AIP:

a. Log into the node where you are replacing the AIP. For login procedures, refer to the “Connect the
PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.

b. In node view, click the Provisioning > Network > General tabs.

c. Record the MAC address.

Step3  Call Cisco TAC 1 800 553-2447 for assistance in replacing the AIP and maintaining the original MAC
address.
Step4  Unscrew the five screws that hold the lower backplane cover in place.
Step5  Grip the lower backplane cover and gently pull it away from the backplane.
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Step 6
Step 7

Step 8
Step 9
Step 10

A

Unscrew the two screws that hold the AIP cover in place.

Grip the cover and gently pull away from the backplane.

S
Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves the AIP cover is clear plastic. On the 15454-SA-ANSI

shelf (P/N: 800-19857), the AIP cover is metal.

Grip the AIP and gently pull it away from the backplane.
Disconnect the fan-tray assembly power cable from the AIP.

Set the old AIP aside for return to Cisco.

Caution

A

The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the SA AIP,
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149)
shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution

Step 11
Step 12
Step 13
Step 14
Step 15

A

Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD
(P/N: 800-24848) shelf; doing so causes a blown fuse on the AIP.

Attach the fan-tray assembly power cable to the new AIP.

Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.
Replace the AIP cover over the AIP and secure the cover with the two screws.

Replace the lower backplane cover and secure the cover with the five screws.

In node view, click the Provisioning > Network tabs.

Caution

Step 16

Step 17

Step 18
Step 19

Cisco recommends TCC2/TCC2P resets be performed in a maintenance window to avoid any potential
service disruptions.

Reset the standby TCC2/TCC2P:
a. Right-click the standby TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears
on the card in CTC.The reset takes approximately five minutes. Do not perform any other steps until
the reset is complete.

Reset the active TCC2/TCC2P:
a. Right click the active TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a Ldg indication appears on the card
in CTC. The reset takes approximately five minutes and CTC loses its connection with the node.

From the File drop-down list, choose Exit to exit the CTC session.

Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down
list.
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Step20 Record the new MAC address:
a. In node view, click the Provisioning > Network > General tabs.
b. Record the MAC address.
Step21 In node view, click the Circuits tab. Note that all circuits listed are PARTIAL.

Step22 In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box
appears.

Step23 Read the instructions in the Circuit Repair dialog box. If all the steps in the dialog box have been
completed, click Next. Ensure that you have the old and new MAC addresses.

Step24 The Node MAC Addresses dialog box appears. Complete the following steps:
a. From the Node drop-down list, choose the name of the node where you replaced the AIP.
b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 2.
c. Click Next.
Step25 The Repair Circuits dialog box appears. Read the information in the dialog box and click Finish.

The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes or more
depending on the number of circuits provisioned on it.

When the circuit repair is complete, the Circuits Repaired dialog box appears.
Step26 Click OK.

Step27 In the node view of the new node, click the Circuits tab. Note that all circuits listed are DISCOVERED.
If all circuits listed do not have a DISCOVERED status, call the Cisco TAC 1 800 553-2447 to open a
Return Material Authorization (RMA).

Cisco ONS 15454 Troubleshooting Guide, R7.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

B 297 Interface Procedures

Cisco ONS 15454 Troubleshooting Guide, R7.0
m‘ November 2009 |



	Alarm Troubleshooting
	2.1 Alarm Indexes by Default Severity
	2.1.1 Critical Alarms (CR)
	2.1.2 Major Alarms (MJ)
	2.1.3 Minor Alarms (MN)
	2.1.4 NA Conditions
	2.1.5 NR Conditions

	2.2 Alarms and Conditions Listed By Alphabetical Entry
	2.3 Alarm Logical Objects
	2.4 Alarm List by Logical Object Type
	2.5 Trouble Notifications
	2.5.1 Alarm Characteristics
	2.5.2 Condition Characteristics
	2.5.3 Severities
	2.5.4 Alarm Hierarchy
	2.5.5 Service Effect
	2.5.6 States

	2.6 Safety Summary
	2.7 Alarm Procedures
	2.7.1 AIS
	Clear the AIS Condition

	2.7.2 AIS-L
	Clear the AIS-L Condition

	2.7.3 AIS-P
	Clear the AIS-P Condition

	2.7.4 AIS-V
	Clear the AIS-V Condition

	2.7.5 ALS
	2.7.6 AMPLI-INIT
	2.7.7 APC-CORRECTION-SKIPPED
	2.7.8 APC-DISABLED
	2.7.9 APC-END
	2.7.10 APC-OUT-OF-RANGE
	2.7.11 APSB
	2.7.12 APSCDFLTK
	Clear the APSCDFLTK Alarm

	2.7.13 APSC-IMP
	Clear the APSC-IMP Alarm

	2.7.14 APSCINCON
	Clear the APSCINCON Alarm

	2.7.15 APSCM
	Clear the APSCM Alarm

	2.7.16 APSCNMIS
	Clear the APSCNMIS Alarm

	2.7.17 APSIMP
	Clear the APSIMP Alarm

	2.7.18 APS-INV-PRIM
	2.7.19 APSMM
	Clear the APSMM Alarm

	2.7.20 APS-PRIM-FAC
	Clear the APS-PRIM-FAC Condition

	2.7.21 APS-PRIM-SEC-MISM
	Clear the APS-PRIM-SEC-MISM Alarm

	2.7.22 AS-CMD
	Clear the AS-CMD Condition

	2.7.23 AS-MT
	Clear the AS-MT Condition

	2.7.24 AS-MT-OOG
	2.7.25 AUD-LOG-LOSS
	Clear the AUD-LOG-LOSS Condition

	2.7.26 AUD-LOG-LOW
	2.7.27 AUTOLSROFF
	Clear the AUTOLSROFF Alarm

	2.7.28 AUTORESET
	Clear the AUTORESET Alarm

	2.7.29 AUTOSW-AIS
	Clear the AUTOSW-AIS Condition

	2.7.30 AUTOSW-LOP (STSMON)
	Clear the AUTOSW-LOP (STSMON) Condition

	2.7.31 AUTOSW-LOP (VT-MON)
	Clear the AUTOSW-LOP (VT-MON) Condition

	2.7.32 AUTOSW-PDI
	Clear the AUTOSW-PDI Condition

	2.7.33 AUTOSW-SDBER
	Clear the AUTOSW-SDBER Condition

	2.7.34 AUTOSW-SFBER
	Clear the AUTOSW-SFBER Condition

	2.7.35 AUTOSW-UNEQ (STSMON)
	Clear the AUTOSW-UNEQ (STSMON) Condition

	2.7.36 AUTOSW-UNEQ (VT-MON)
	Clear the AUTOSW-UNEQ (VT-MON) Condition

	2.7.37 AWG-DEG
	2.7.38 AWG-FAIL
	2.7.39 AWG-OVERTEMP
	2.7.40 AWG-WARM-UP
	2.7.41 BAT-FAIL
	Clear the BAT-FAIL Alarm

	2.7.42 BKUPMEMP
	Clear the BKUPMEMP Alarm

	2.7.43 BLSROSYNC
	2.7.44 BLSR-SW-VER-MISM
	Clear the BLSR-SW-VER-MISM Alarm

	2.7.45 BPV
	Clear the BPV Alarm

	2.7.46 CARLOSS (CE1000, CE100T)
	Clear the CARLOSS (CE100T) Alarm

	2.7.47 CARLOSS (E1000F, E100T)
	Clear the CARLOSS (E1000F, E100T) Alarm

	2.7.48 CARLOSS (EQPT)
	Clear the CARLOSS (EQPT) Alarm

	2.7.49 CARLOSS (FC)
	2.7.50 CARLOSS (G1000)
	Clear the CARLOSS (G1000) Alarm

	2.7.51 CARLOSS (GE)
	2.7.52 CARLOSS (ISC)
	2.7.53 CARLOSS (ML1000, ML100T, MLFX)
	Clear the CARLOSS (ML1000, ML100T, MLFX) Alarm

	2.7.54 CARLOSS (TRUNK)
	2.7.55 CASETEMP-DEG
	2.7.56 CLDRESTART
	Clear the CLDRESTART Condition

	2.7.57 COMIOXC
	Clear the COMIOXC Alarm

	2.7.58 COMM-FAIL
	Clear the COMM-FAIL Alarm

	2.7.59 CONTBUS-A-18
	Clear the CONTBUS-A-18 Alarm

	2.7.60 CONTBUS-B-18
	Clear the CONTBUS-B-18 Alarm

	2.7.61 CONTBUS-DISABLED
	Clear the CONTBUS-DISABLED Alarm

	2.7.62 CONTBUS-IO-A
	Clear the CONTBUS-IO-A Alarm

	2.7.63 CONTBUS-IO-B
	Clear the CONTBUS-IO-B Alarm

	2.7.64 CTNEQPT-MISMATCH
	Clear the CTNEQPT-MISMATCH Condition

	2.7.65 CTNEQPT-PBPROT
	Clear the CTNEQPT-PBPROT Alarm

	2.7.66 CTNEQPT-PBWORK
	Clear the CTNEQPT-PBWORK Alarm

	2.7.67 DATAFLT
	Clear the DATAFLT Alarm

	2.7.68 DBOSYNC
	Clear the DBOSYNC Alarm

	2.7.69 DISCONNECTED
	Clear the DISCONNECTED Alarm

	2.7.70 DS3-MISM
	Clear the DS3-MISM Condition

	2.7.71 DSP-COMM-FAIL
	2.7.72 DSP-FAIL
	2.7.73 DUP-IPADDR
	Clear the DUP-IPADDR Alarm

	2.7.74 DUP-NODENAME
	Clear the DUP-NODENAME Alarm

	2.7.75 DUP-SHELF-ID
	2.7.76 EHIBATVG
	Clear the EHIBATVG Alarm

	2.7.77 ELWBATVG
	Clear the ELWBATVG Alarm

	2.7.78 ENCAP-MISMATCH-P
	Clear the ENCAP-MISMATCH-P Alarm

	2.7.79 EOC
	Clear the EOC Alarm

	2.7.80 EOC-L
	Clear the EOC-L Alarm

	2.7.81 EQPT
	Clear the EQPT Alarm

	2.7.82 EQPT-DIAG
	Clear the EQPT-DIAG Alarm

	2.7.83 EQPT-MISS
	Clear the EQPT-MISS Alarm

	2.7.84 ERFI-P-CONN
	Clear the ERFI-P-CONN Condition

	2.7.85 ERFI-P-PAYLD
	Clear the ERFI-P-PAYLD Condition

	2.7.86 ERFI-P-SRVR
	Clear the ERFI-P-SRVR Condition

	2.7.87 ERROR-CONFIG
	Clear the ERROR-CONFIG Alarm

	2.7.88 ETH-LINKLOSS
	Clear the ETH-LINKLOSS Condition

	2.7.89 E-W-MISMATCH
	Clear the E-W-MISMATCH Alarm with a Physical Switch
	Clear the E-W-MISMATCH Alarm in CTC

	2.7.90 EXCCOL
	Clear the EXCCOL Alarm

	2.7.91 EXERCISE-RING-FAIL
	Clear the EXERCISE-RING-FAIL Condition

	2.7.92 EXERCISE-SPAN-FAIL
	Clear the EXERCISE-SPAN-FAIL Condition

	2.7.93 EXT
	Clear the EXT Alarm

	2.7.94 EXTRA-TRAF-PREEMPT
	Clear the EXTRA-TRAF-PREEMPT Alarm

	2.7.95 FAILTOSW
	Clear the FAILTOSW Condition

	2.7.96 FAILTOSW-PATH
	Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

	2.7.97 FAILTOSWR
	Clear the FAILTOSWR Condition in a BLSR Configuration

	2.7.98 FAILTOSWS
	Clear the FAILTOSWS Condition

	2.7.99 FAN
	Clear the FAN Alarm

	2.7.100 FC-NO-CREDITS
	Clear the FC-NO-CREDITS Alarm

	2.7.101 FDI
	2.7.102 FE-AIS
	Clear the FE-AIS Condition

	2.7.103 FEC-MISM
	2.7.104 FE-DS1-MULTLOS
	Clear the FE-DS1-MULTLOS Condition

	2.7.105 FE-DS1-NSA
	Clear the FE-DS1-NSA Condition

	2.7.106 FE-DS1-SA
	Clear the FE-DS1-SA Condition

	2.7.107 FE-DS1-SNGLLOS
	Clear the FE-DS1-SNGLLOS Condition

	2.7.108 FE-DS3-NSA
	Clear the FE-DS3-NSA Condition

	2.7.109 FE-DS3-SA
	Clear the FE-DS3-SA Condition

	2.7.110 FE-EQPT-NSA
	Clear the FE-EQPT-NSA Condition

	2.7.111 FE-FRCDWKSWBK-SPAN
	Clear the FE-FRCDWKSWBK-SPAN Condition

	2.7.112 FE-FRCDWKSWPR-RING
	Clear the FE-FRCDWKSWPR-RING Condition

	2.7.113 FE-FRCDWKSWPR-SPAN
	Clear the FE-FRCDWKSWPR-SPAN Condition

	2.7.114 FE-IDLE
	Clear the FE-IDLE Condition

	2.7.115 FE-LOCKOUTOFPR-SPAN
	Clear the FE-LOCKOUTOFPR-SPAN Condition

	2.7.116 FE-LOF
	Clear the FE-LOF Condition

	2.7.117 FE-LOS
	Clear the FE-LOS Condition

	2.7.118 FE-MANWKSWBK-SPAN
	Clear the FE-MANWKSWBK-SPAN Condition

	2.7.119 FE-MANWKSWPR-RING
	Clear the FE-MANWKSWPR-RING Condition

	2.7.120 FE-MANWKSWPR-SPAN
	Clear the FE-MANWKSWPR-SPAN Condition

	2.7.121 FEPRLF
	Clear the FEPRLF Alarm on a Four-Fiber BLSR

	2.7.122 FIBERTEMP-DEG
	2.7.123 FORCED-REQ
	Clear the FORCED-REQ Condition

	2.7.124 FORCED-REQ-RING
	Clear the FORCED-REQ-RING Condition

	2.7.125 FORCED-REQ-SPAN
	Clear the FORCED-REQ-SPAN Condition

	2.7.126 FRCDSWTOINT
	2.7.127 FRCDSWTOPRI
	2.7.128 FRCDSWTOSEC
	2.7.129 FRCDSWTOTHIRD
	2.7.130 FRNGSYNC
	Clear the FRNGSYNC Condition

	2.7.131 FSTSYNC
	2.7.132 FULLPASSTHR-BI
	Clear the FULLPASSTHR-BI Condition

	2.7.133 GAIN-HDEG
	2.7.134 GAIN-HFAIL
	2.7.135 GAIN-LDEG
	2.7.136 GAIN-LFAIL
	2.7.137 GCC-EOC
	2.7.138 GE-OOSYNC
	2.7.139 GFP-CSF
	Clear the GFP-CSF Alarm

	2.7.140 GFP-DE-MISMATCH
	Clear the GFP-DE-MISMATCH Alarm

	2.7.141 GFP-EX-MISMATCH
	Clear the GFP-EX-MISMATCH Alarm

	2.7.142 GFP-LFD
	Clear the GFP-LFD Alarm

	2.7.143 GFP-NO-BUFFERS
	Clear the GFP-NO-BUFFERS Alarm

	2.7.144 GFP-UP-MISMATCH
	Clear the GFP-UP-MISMATCH Alarm

	2.7.145 HELLO
	Clear the HELLO Alarm

	2.7.146 HIBATVG
	Clear the HIBATVG Alarm

	2.7.147 HI-CCVOLT
	Clear the HI-CCVOLT Condition

	2.7.148 HI-LASERBIAS
	Clear the HI-LASERBIAS Alarm

	2.7.149 HI-LASERTEMP
	Clear the HI-LASERTEMP Alarm

	2.7.150 HI-RXPOWER
	Clear the HI-RXPOWER Alarm

	2.7.151 HITEMP
	Clear the HITEMP Alarm

	2.7.152 HI-TXPOWER
	Clear the HI-TXPOWER Alarm

	2.7.153 HLDOVRSYNC
	Clear the HLDOVRSYNC Condition

	2.7.154 I-HITEMP
	Clear the I-HITEMP Alarm

	2.7.155 INCOMPATIBLE-SEND-PDIP
	Clear the INCOMPATIBLE-SEND-PDIP Alarm

	2.7.156 INCOMPATIBLE-SW
	Clear the INCOMPATIBLE-SW Alarm

	2.7.157 IMPROPRMVL
	Clear the IMPROPRMVL Alarm

	2.7.158 INC-ISD
	2.7.159 INHSWPR
	Clear the INHSWPR Condition

	2.7.160 INHSWWKG
	Clear the INHSWWKG Condition

	2.7.161 INTRUSION-PSWD
	Clear the INTRUSION-PSWD Condition

	2.7.162 INVMACADR
	Clear the INVMACADR Alarm

	2.7.163 IOSCFGCOPY
	2.7.164 ISIS-ADJ-FAIL
	Clear the ISIS-ADJ-FAIL Alarm

	2.7.165 KB-PASSTHR
	Clear the KB-PASSTHR Condition

	2.7.166 KBYTE-APS-CHANNEL-FAILURE
	Clear the KBYTE-APS-CHANNEL-FAILURE Alarm

	2.7.167 LAN-POL-REV
	Clear the LAN-POL-REV Condition

	2.7.168 LASER-APR
	2.7.169 LASERBIAS-DEG
	2.7.170 LASERBIAS-FAIL
	2.7.171 LASEREOL
	Clear the LASEREOL Alarm

	2.7.172 LASERTEMP-DEG
	2.7.173 LCAS-CRC
	Clear the LCAS-CRC Condition

	2.7.174 LCAS-RX-FAIL
	Clear the LCAS-RX-FAIL Condition

	2.7.175 LCAS-TX-ADD
	2.7.176 LCAS-TX-DNU
	2.7.177 LKOUTPR-S
	Clear the LKOUTPR-S Condition

	2.7.178 LOA
	Clear the LOA Alarm

	2.7.179 LOCKOUT-REQ
	Clear the LOCKOUT-REQ Condition

	2.7.180 LOF (BITS)
	Clear the LOF (BITS) Alarm

	2.7.181 LOF (DS1)
	Clear the LOF (DS1) Alarm

	2.7.182 LOF (DS3)
	Clear the LOF (DS3) Alarm

	2.7.183 LOF (E1)
	Clear the LOF (E1) Alarm

	2.7.184 LOF (EC1)
	Clear the LOF (EC1) Alarm

	2.7.185 LOF (OCN)
	Clear the LOF (OCN) Alarm

	2.7.186 LOF (STSTRM)
	Clear the LOF (STSTRM) Alarm

	2.7.187 LOF (TRUNK)
	2.7.188 LOGBUFR90
	2.7.189 LOGBUFROVFL
	Clear the LOGBUFROVFL Alarm

	2.7.190 LO-LASERBIAS
	Clear the LO-LASERBIAS Alarm

	2.7.191 LO-LASERTEMP
	Clear the LO-LASERTEMP Alarm

	2.7.192 LOM
	Clear the LOM Alarm

	2.7.193 LOP-P
	Clear the LOP-P Alarm

	2.7.194 LOP-V
	Clear the LOP-V Alarm

	2.7.195 LO-RXPOWER
	Clear the LO-RXPOWER Alarm

	2.7.196 LOS (2R)
	2.7.197 LOS (BITS)
	Clear the LOS (BITS) Alarm

	2.7.198 LOS (DS1)
	Clear the LOS (DS1) Alarm

	2.7.199 LOS (DS3)
	Clear the LOS (DS3) Alarm

	2.7.200 LOS (E1)
	Clear the LOS (E1) Alarm

	2.7.201 LOS (EC1)
	Clear the LOS (EC1) Alarm

	2.7.202 LOS (ESCON)
	2.7.203 LOS (FUDC)
	Clear the LOS (FUDC) Alarm

	2.7.204 LOS (ISC)
	2.7.205 LOS (MSUDC)
	2.7.206 LOS (OCN)
	Clear the LOS (OCN) Alarm

	2.7.207 LOS (OTS)
	2.7.208 LOS (TRUNK)
	2.7.209 LOS-O
	2.7.210 LOS-P (OCH)
	2.7.211 LOS-P (OMS, OTS)
	2.7.212 LOS-P (TRUNK)
	2.7.213 LO-TXPOWER
	Clear the LO-TXPOWER Alarm

	2.7.214 LPBKCRS
	Clear the LPBKCRS Condition

	2.7.215 LPBKDS1FEAC-CMD
	2.7.216 LPBKDS3FEAC
	Clear the LPBKDS3FEAC Condition

	2.7.217 LPBKDS3FEAC-CMD
	2.7.218 LPBKFACILITY (CE1000, CE100T)
	Clear the LPBKFACILITY (CE1000, CE100T) Condition

	2.7.219 LPBKFACILITY (DS1, DS3)
	Clear the LPBKFACILITY (DS1, DS3) Condition

	2.7.220 LPBKFACILITY (E1)
	Clear the LPBKFACILITY (E1) Condition

	2.7.221 LPBKFACILITY (EC1)
	Clear the LPBKFACILITY (EC1) Condition

	2.7.222 LPBKFACILITY (ESCON)
	2.7.223 LPBKFACILITY (FC)
	2.7.224 LPBKFACILITY (FCMR)
	Clear the LPBKFACILITY (FCMR) Condition

	2.7.225 LPBKFACILITY (G1000)
	Clear the LPBKFACILITY (G1000) Condition

	2.7.226 LPBKFACILITY (GE)
	2.7.227 LPBKFACILITY (ISC)
	2.7.228 LPBKFACILITY (OCN)
	Clear the LPBKFACILITY (OCN) Condition

	2.7.229 LPBKFACILITY (TRUNK)
	2.7.230 LPBKTERMINAL (CE1000, CE100T)
	Clear the LPBKTERMINAL (CE1000, CE100T) Condition

	2.7.231 LPBKTERMINAL (DS1, DS3)
	Clear the LPBKTERMINAL (DS1, DS3) Condition

	2.7.232 LPBKTERMINAL (E1)
	Clear the LPBKTERMINAL (E1) Condition

	2.7.233 LPBKTERMINAL (EC1)
	Clear the LPBKTERMINAL (EC1) Condition

	2.7.234 LPBKTERMINAL (ESCON)
	2.7.235 LPBKTERMINAL (FC)
	2.7.236 LPBKTERMINAL (FCMR)
	Clear the LPBKTERMINAL (FCMR) Condition

	2.7.237 LPBKTERMINAL (G1000)
	Clear the LPBKTERMINAL (G1000) Condition

	2.7.238 LPBKTERMINAL (GE)
	2.7.239 LPBKTERMINAL (ISC)
	2.7.240 LPBKTERMINAL (OCN)
	Clear the LPBKTERMINAL (OCN) Condition

	2.7.241 LPBKTERMINAL (TRUNK)
	2.7.242 LWBATVG
	Clear the LWBATVG Alarm

	2.7.243 MAN-REQ
	Clear the MAN-REQ Condition

	2.7.244 MANRESET
	2.7.245 MANSWTOINT
	2.7.246 MANSWTOPRI
	2.7.247 MANSWTOSEC
	2.7.248 MANSWTOTHIRD
	2.7.249 MANUAL-REQ-RING
	Clear the MANUAL-REQ-RING Condition

	2.7.250 MANUAL-REQ-SPAN
	Clear the MANUAL-REQ-SPAN Condition

	2.7.251 MEA (AIP)
	Clear the MEA (AIP) Alarm

	2.7.252 MEA (BIC)
	Clear the MEA (BIC) Alarm

	2.7.253 MEA (EQPT)
	Clear the MEA (EQPT) Alarm

	2.7.254 MEA (FAN)
	Clear the MEA (FAN) Alarm

	2.7.255 MEA (PPM)
	2.7.256 MEM-GONE
	2.7.257 MEM-LOW
	2.7.258 MFGMEM
	Clear the MFGMEM Alarm

	2.7.259 NO-CONFIG
	Clear the NO-CONFIG Condition

	2.7.260 NOT-AUTHENTICATED
	2.7.261 OCHNC-INC
	2.7.262 OCHTERM-INC
	2.7.263 ODUK-1-AIS-PM
	2.7.264 ODUK-2-AIS-PM
	2.7.265 ODUK-3-AIS-PM
	2.7.266 ODUK-4-AIS-PM
	2.7.267 ODUK-AIS-PM
	2.7.268 ODUK-BDI-PM
	2.7.269 ODUK-LCK-PM
	2.7.270 ODUK-OCI-PM
	2.7.271 ODUK-SD-PM
	2.7.272 ODUK-SF-PM
	2.7.273 ODUK-TIM-PM
	2.7.274 OOU-TPT
	Clear the OOT-TPT Condition

	2.7.275 OPEN-SLOT
	Clear the OPEN-SLOT Condition

	2.7.276 OPTNTWMIS
	2.7.277 OPWR-HDEG
	2.7.278 OPWR-HFAIL
	2.7.279 OPWR-LDEG
	2.7.280 OPWR-LFAIL
	2.7.281 OSRION
	2.7.282 OTUK-AIS
	2.7.283 OTUK-BDI
	2.7.284 OTUK-IAE
	2.7.285 OTUK-LOF
	2.7.286 OTUK-SD
	2.7.287 OTUK-SF
	2.7.288 OTUK-TIM
	2.7.289 OUT-OF-SYNC
	2.7.290 PARAM-MISM
	2.7.291 PDI-P
	Clear the PDI-P Condition

	2.7.292 PEER-NORESPONSE
	Clear the PEER-NORESPONSE Alarm

	2.7.293 PLM-P
	Clear the PLM-P Alarm

	2.7.294 PLM-V
	Clear the PLM-V Alarm

	2.7.295 PMI
	2.7.296 PORT-ADD-PWR-DEG-HIGH
	2.7.297 PORT-ADD-PWR-DEG-LOW
	2.7.298 PORT-ADD-PWR-FAIL-HIGH
	2.7.299 PORT-ADD-PWR-FAIL-LOW
	2.7.300 PORT-FAIL
	2.7.301 PORT-MISMATCH
	Clear the PORT-MISMATCH Alarm

	2.7.302 PRC-DUPID
	Clear the PRC-DUPID Alarm

	2.7.303 PROTNA
	Clear the PROTNA Alarm

	2.7.304 PROV-MISMATCH
	2.7.305 PTIM
	2.7.306 PWR-FAIL-A
	Clear the PWR-FAIL-A Alarm

	2.7.307 PWR-FAIL-B
	Clear the PWR-FAIL-B Alarm

	2.7.308 PWR-FAIL-RET-A
	Clear the PWR-FAIL-RET-A Alarm

	2.7.309 PWR-FAIL-RET-B
	Clear the PWR-FAIL-RET-A Alarm

	2.7.310 RAI
	Clear the RAI Condition

	2.7.311 RCVR-MISS
	Clear the RCVR-MISS Alarm

	2.7.312 RFI
	2.7.313 RFI-L
	Clear the RFI-L Condition

	2.7.314 RFI-P
	Clear the RFI-P Condition

	2.7.315 RFI-V
	Clear the RFI-V Condition

	2.7.316 RING-ID-MIS
	Clear the RING-ID-MIS Alarm

	2.7.317 RING-MISMATCH
	Clear the RING-MISMATCH Alarm

	2.7.318 RING-SW-EAST
	2.7.319 RING-SW-WEST
	2.7.320 ROLL
	2.7.321 ROLL-PEND
	2.7.322 RPRW
	Clear the RPRW Condition

	2.7.323 RUNCFG-SAVENEED
	2.7.324 SD (DS1, DS3)
	Clear the SD (DS1, DS3) Condition

	2.7.325 SD (E1)
	Clear the SD (E1) Condition

	2.7.326 SD (TRUNK)
	2.7.327 SD-L
	Clear the SD-L Condition

	2.7.328 SD-L (TRUNK)
	2.7.329 SD-P
	Clear the SD-P Condition

	2.7.330 SD-V
	Clear the SD-V Condition

	2.7.331 SF (DS1, DS3)
	Clear the SF (DS1, DS3) Condition

	2.7.332 SF (E1)
	Clear the SF (E1) Condition

	2.7.333 SF (TRUNK)
	2.7.334 SF-L
	Clear the SF-L Condition

	2.7.335 SF-L (TRUNK)
	2.7.336 SF-P
	Clear the SF-P Condition

	2.7.337 SFTWDOWN
	2.7.338 SF-V
	Clear the SF-V Condition

	2.7.339 SHELF-COMM-FAIL
	2.7.340 SH-INS-LOSS-VAR-DEG-HIGH
	2.7.341 SH-INS-LOSS-VAR-DEG-LOW
	2.7.342 SHUTTER-OPEN
	2.7.343 SIGLOSS
	Clear the SIGLOSS Alarm

	2.7.344 SNTP-HOST
	Clear the SNTP-HOST Alarm

	2.7.345 SPANLENGTH-OUT-OF-RANGE
	2.7.346 SPAN-SW-EAST
	2.7.347 SPAN-SW-WEST
	2.7.348 SQUELCH
	Clear the SQUELCH Condition

	2.7.349 SQUELCHED
	Clear the SQUELCHED Condition

	2.7.350 SQM
	Clear the SQM Alarm

	2.7.351 SSM-DUS
	2.7.352 SSM-FAIL
	Clear the SSM-FAIL Alarm

	2.7.353 SSM-LNC
	2.7.354 SSM-OFF
	Clear the SSM-OFF Condition

	2.7.355 SSM-PRC
	2.7.356 SSM-PRS
	2.7.357 SSM-RES
	2.7.358 SSM-SDN-TN
	2.7.359 SSM-SETS
	2.7.360 SSM-SMC
	2.7.361 SSM-ST2
	2.7.362 SSM-ST3
	2.7.363 SSM-ST3E
	2.7.364 SSM-ST4
	2.7.365 SSM-STU
	Clear the SSM-STU Condition

	2.7.366 SSM-TNC
	2.7.367 STS-SQUELCH-L
	2.7.368 SW-MISMATCH
	Clear the SW-MISMATCH Condition

	2.7.369 SWMTXMOD-PROT
	Clear the SWMTXMOD-PROT Alarm

	2.7.370 SWMTXMOD-WORK
	Clear the SWMTXMOD-WORK Alarm

	2.7.371 SWTOPRI
	2.7.372 SWTOSEC
	Clear the SWTOSEC Condition

	2.7.373 SWTOTHIRD
	Clear the SWTOTHIRD Condition

	2.7.374 SYNC-FREQ
	Clear the SYNC-FREQ Condition

	2.7.375 SYNCLOSS
	Clear the SYNCLOSS Alarm

	2.7.376 SYNCPRI
	Clear the SYNCPRI Alarm

	2.7.377 SYNCSEC
	Clear the SYNCSEC Alarm

	2.7.378 SYNCTHIRD
	Clear the SYNCTHIRD Alarm

	2.7.379 SYSBOOT
	2.7.380 TEMP-MISM
	Clear the TEMP-MISM Condition

	2.7.381 TIM
	Clear the TIM Alarm

	2.7.382 TIM-MON
	Clear the TIM-MON Alarm

	2.7.383 TIM-P
	Clear the TIM-P Alarm

	2.7.384 TIM-S
	Clear the TIM-S Alarm

	2.7.385 TIM-V
	Clear the TIM-V Alarm

	2.7.386 TPTFAIL (CE100T, CE1000)
	Clear the TPTFAIL (CE100T, CE1000) Alarm

	2.7.387 TPTFAIL (FCMR)
	Clear the TPTFAIL (FCMR) Alarm

	2.7.388 TPTFAIL (G1000)
	Clear the TPTFAIL (G1000) Alarm

	2.7.389 TPTFAIL (ML100T, ML1000, MLFX)
	Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

	2.7.390 TRMT
	Clear the TRMT Alarm

	2.7.391 TRMT-MISS
	Clear the TRMT-MISS Alarm

	2.7.392 TX-AIS
	Clear the TX-AIS Condition

	2.7.393 TX-LOF
	Clear the TX-LOF Condition

	2.7.394 TX-RAI
	Clear the TX-RAI Condition

	2.7.395 UNC-WORD
	2.7.396 UNEQ-P
	Clear the UNEQ-P Alarm

	2.7.397 UNEQ-V
	Clear the UNEQ-V Alarm

	2.7.398 UNREACHABLE-TARGET-POWER
	2.7.399 UT-COMM-FAIL
	2.7.400 UT-FAIL
	2.7.401 VCG-DEG
	Clear the VCG-DEG Condition

	2.7.402 VCG-DOWN
	Clear the VCG-DOWN Condition

	2.7.403 VOA-HDEG
	2.7.404 VOA-HFAIL
	2.7.405 VOA-LDEG
	2.7.406 VOA-LFAIL
	2.7.407 VOLT-MISM
	Clear the VOLT-MISM Condition

	2.7.408 VT-SQUELCH-L
	2.7.409 WKSWPR
	Clear the WKSWPR Condition

	2.7.410 WTR
	2.7.411 WVL-MISMATCH

	2.8 Traffic Card LED Activity
	2.8.1 Typical Traffic Card LED Activity After Insertion
	2.8.2 Typical Traffic Card LED Activity During Reset
	2.8.3 Typical Card LED State After Successful Reset
	2.8.4 Typical Cross-Connect LED Activity During Side Switch

	2.9 Frequently Used Alarm Troubleshooting Procedures
	2.9.1 Node and Ring Identification, Change, Visibility, and Termination
	Identify a BLSR Ring Name or Node ID Number
	Change a BLSR Ring Name
	Change a BLSR Node ID Number
	Verify Node Visibility for Other Nodes

	2.9.2 Protection Switching, Lock Initiation, and Clearing
	Initiate a 1+1 Force Switch Command
	Initiate a 1+1 Manual Switch Command
	Clear a 1+1 Force or Manual Switch Command
	Initiate a Lock-On Command
	Initiate a Card or Port Lockout Command
	Clear a Lock-On or Lockout Command
	Initiate a 1:1 Card Switch Command
	Initiate a Force Switch for All Circuits on a Path Protection Span
	Initiate a Manual Switch for All Circuits on a Path Protection Span
	Initiate a Lockout for All Circuits on a Protect Path Protection Span
	Clear an External Switching Command on a Path Protection Span
	Initiate a Force Ring Switch on a BLSR
	Initiate a Force Span Switch on a Four-Fiber BLSR
	Initiate a Manual Span Switch on a BLSR
	Initiate a Manual Ring Switch on a BLSR
	Initiate a Lockout on a BLSR Protect Span
	Initiate an Exercise Ring Switch on a BLSR
	Initiate an Exercise Ring Switch on a Four Fiber BLSR
	Clear a BLSR External Switching Command

	2.9.3 CTC Card Resetting and Switching
	Reset a Traffic Card in CTC
	Reset an Active TCC2/TCC2P Card and Activate the Standby Card
	Side Switch the Active and Standby Cross-Connect Cards

	2.9.4 Physical Card Reseating, Resetting, and Replacement
	Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card
	Remove and Reinsert (Reseat) Any Card
	Physically Replace a Traffic Card
	Physically Replace an In-Service Cross-Connect Card

	2.9.5 Generic Signal and Circuit Procedures
	Verify the Signal BER Threshold Level
	Delete a Circuit
	Verify or Create Node Section DCC Terminations
	Clear an OC-N Card Facility or Terminal Loopback Circuit
	Clear an OC-N Card Cross-Connect (XC) Loopback Circuit
	Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit
	Clear Other Electrical Card or Ethernet Card Loopbacks
	Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit

	2.9.6 Air Filter and Fan Procedures
	Inspect, Clean, and Replace the Reusable Air Filter
	Remove and Reinsert a Fan-Tray Assembly
	Replace the Fan-Tray Assembly

	2.9.7 Interface Procedures
	Replace the Electrical Interface Assembly
	Replace the Alarm Interface Panel




